Contents

1 Introduction ...........................................................................................................................................14
  1.1 Features ...........................................................................................................................................14
    1.1.1 Remote Control ..........................................................................................................................14
    1.1.2 Other Interaction .........................................................................................................................15
    1.1.3 Security .......................................................................................................................................15
    1.1.4 Operating Systems ....................................................................................................................15
    1.1.5 Communication Devices ...........................................................................................................16
  1.2 Documentation ..................................................................................................................................17
    1.2.1 How to Use Netop Documentation .............................................................................................18
    1.2.2 Typographical Conventions ........................................................................................................18
    1.2.3 Standard Buttons .......................................................................................................................18
  1.3 Updates ............................................................................................................................................18
  1.4 Common Controls .............................................................................................................................19
    1.4.1 Window Control ...........................................................................................................................19
    1.4.2 Menu and Toolbar Control ..........................................................................................................19
    1.4.3 Table Control ..................................................................................................................................20

2 Installation ...........................................................................................................................................21
  2.1 Requirements ...................................................................................................................................21
  2.2 Download Installation Files ............................................................................................................22
  2.3 Install ..............................................................................................................................................24
    2.3.1 Change or Remove .......................................................................................................................31
  2.4 Install Alternatives ...........................................................................................................................31
    2.4.1 Install from a Directory ..............................................................................................................32
    2.4.2 Pack’n Deploy .............................................................................................................................32
    2.4.3 Terminal Server ............................................................................................................................32

3 Netop Guest .......................................................................................................................................33
  3.1 Load and Unload ...............................................................................................................................33
    3.1.1 Loading Alternatives ....................................................................................................................33
    3.1.2 Setup Wizard ..................................................................................................................................35
  3.2 Connect Guide ...................................................................................................................................41
    3.2.1 Connect Problems .......................................................................................................................42
  3.3 Host Security Guide ...........................................................................................................................42
    3.3.1 Guest Authentication ....................................................................................................................43
      3.3.1.1 Shared Netop Authentication .................................................................................................43
      3.3.1.2 Individual Netop Authentication ..............................................................................................44
      3.3.1.3 Windows Authentication ..........................................................................................................44
      3.3.1.4 Directory Services Authentication ............................................................................................44
      3.3.1.5 Netop Security Server Authentication ......................................................................................45
      3.3.1.6 RSA SecurID Authentication ....................................................................................................46
      3.3.1.7 Smart Card Authentication ......................................................................................................47
    3.3.2 Security Role .................................................................................................................................47
## Contents

3.3.2.1 Allow Guest To.................................................................48
3.3.2.2 Confirm Access.................................................................49
3.3.3 Guest Profile...........................................................................50
3.3.4 Guest Policy ...........................................................................51
3.3.5 Address Check .......................................................................52
3.3.6 Encryption .............................................................................52
3.4 Netop Guest Window...................................................................53

### 3.4.1 Title Bar............................................................................53
### 3.4.2 Menu Bar ...........................................................................53
  3.4.2.1 File Menu ........................................................................54
  3.4.2.2 Connection Menu..............................................................54
    3.4.2.2.1 Session Commands.........................................................55
    3.4.2.2.2 Action Commands..........................................................57
    3.4.2.2.3 Other Commands............................................................57
  3.4.2.3 Edit Menu..........................................................................58
  3.4.2.4 View Menu........................................................................59
  3.4.2.5 Tools Menu .......................................................................60
  3.4.2.6 Help Menu ........................................................................60

### 3.4.3 Toolbar ............................................................................61
  3.4.3.1 Session Buttons .................................................................61
  3.4.3.2 Action Buttons ..................................................................62
  3.4.3.3 Other Buttons ..................................................................63

### 3.4.4 Tab Panel .........................................................................64
  3.4.4.1 Phonebook Tab .................................................................65
    3.4.4.1.1 Tree Pane ...................................................................66
    3.4.4.1.2 Records Pane ...............................................................67
    3.4.4.1.3 Phonebook Records.......................................................68
    3.4.4.1.4 Phonebook Export and Import .......................................69
  3.4.4.2 Quick Connect Tab .............................................................71
    3.4.4.2.1 Host Section .................................................................71
      3.4.4.2.1.1 Networking .............................................................72
      3.4.4.2.1.2 Point-to-Point or Gateway .......................................72
      3.4.4.2.1.3 Network Point-to-Point ...........................................73
      3.4.4.2.1.4 Infrared .................................................................74
      3.4.4.2.1.5 Gateway Connection ..............................................74
    3.4.4.2.2 Communication Profile Section .......................................75
    3.4.4.2.3 Buttons .......................................................................75
    3.4.4.2.4 Netop Network Tab .......................................................75
    3.4.4.2.5 Windows Network Tab .................................................77
    3.4.4.2.6 Intel vPro Tab ..............................................................78
    3.4.4.2.7 Connect by a Name and/or Address ..............................87
    3.4.4.2.8 Unavailable Networking Communication Devices ..................88
    3.4.4.2.9 Browse for Hosts ..........................................................88
  3.4.4.3 Connections Tab .................................................................89
3.4.4.4 History Tab..................................................................................................................90
3.4.4.4.1 Tree Pane..................................................................................................................90
3.4.4.4.2 Records Pane.............................................................................................................91
3.4.4.4.3 History Records.........................................................................................................92
3.4.4.5 Help Request Tab...........................................................................................................92
3.4.4.6 Recordings Tab................................................................................................................93
3.4.4.6.1 Tree Pane..................................................................................................................94
3.4.4.6.2 Records Pane.............................................................................................................94
3.4.4.6.3 Recording Records.....................................................................................................96
3.4.4.7 Script Tab.......................................................................................................................96
3.4.4.7.1 Tree Pane..................................................................................................................97
3.4.4.7.2 Records Pane.............................................................................................................97
3.4.4.7.3 Script Records..........................................................................................................98
3.4.4.8 Inventory Tab.................................................................................................................98
3.4.4.8.1 Contents Pane...........................................................................................................99
3.4.4.8.2 Details Pane..............................................................................................................99
3.4.4.8.3 Host Computer Inventories.........................................................................................100
3.4.5 Status Bar........................................................................................................................100
3.5 Guest Tools.........................................................................................................................101
3.5.1 Program Options..............................................................................................................102
3.5.1.1 Layout Tab....................................................................................................................103
3.5.1.2 General Tab................................................................................................................105
3.5.1.3 Cache Tab....................................................................................................................107
3.5.1.4 Logon Tab...................................................................................................................108
3.5.1.5 Host Name Tab.............................................................................................................109
3.5.1.6 Directory Services Tab................................................................................................111
3.5.1.7 Remote Control Tab....................................................................................................113
3.5.1.8 Clipboard Tab...............................................................................................................115
3.5.1.9 Monitor Tab................................................................................................................116
3.5.1.10 Audio-Video Chat Tab..............................................................................................117
3.5.1.11 Remote Printing Tab.................................................................................................120
3.5.1.12 Recording Tab...........................................................................................................123
3.5.1.13 Sounds Tab................................................................................................................124
3.5.1.14 Help Request Tab....................................................................................................125
3.5.1.15 Run Tab.....................................................................................................................128
3.5.1.16 Encryption Tab.........................................................................................................130
3.5.1.17 Inventory Tab...........................................................................................................131
3.5.1.18 Smart Card Tab........................................................................................................134
3.5.1.19 Intel vPro Tab.............................................................................................................135
3.5.1.20 Web Update Tab.....................................................................................................136
3.5.2 File Manager Options......................................................................................................139
3.5.3 Log Setup......................................................................................................................139
3.5.4 Maintenance Password.................................................................................................139
3.5.5 Communication Profiles...............................................................................................140
## Contents

3.6.6 Modem Database ......................................................... 141
3.6.7 Check for New Updates .............................................. 141
3.6.8 Publish New Updates ............................................... 141
3.6.9 Debug Trace ............................................................. 141
3.6.10 Run Setup Wizard ................................................... 141
3.6.11 Copy Guest to Removable Media ........................... 141

3.6 Guest Sessions .................................................................. 142

3.6.1 Remote Control ......................................................... 142

3.6.1.1 Title Bar .................................................................. 143

3.6.1.2 Toolbar or Toolbox .................................................. 146

3.6.1.2.1 Session Buttons ................................................. 146

3.6.1.2.2 Action Buttons .................................................. 147

3.6.1.2.3 Control Buttons ................................................. 148

3.6.1.2.4 Multi Guest Session Buttons ........................... 148

3.6.1.2.5 Clipboard Buttons ............................................. 149

3.6.1.2.6 Tool Buttons .................................................... 149

3.6.1.3 Remote Control Display ....................................... 151

3.6.1.4 Status Bar ............................................................. 151

3.6.1.5 Multi Guest Session ................................................ 152

3.6.2 Monitor ....................................................................... 152

3.6.2.1 Monitor Toolbox ................................................... 154

3.6.3 File Transfer .............................................................. 155

3.6.3.1 Title Bar .................................................................. 156

3.6.3.2 Menu Bar .............................................................. 156

3.6.3.2.1 File Menu .......................................................... 157

3.6.3.2.1.1 Copy/Move/Synchronize/Clone ..................... 159

3.6.3.2.1.2 Transfer Status .............................................. 161

3.6.3.2.1.1 Progress Tab ................................................ 162

3.6.3.2.1.2 History Tab .................................................. 163

3.6.3.2.1.3 Session History Tab .................................. 164

3.6.3.2.2 Edit Menu .......................................................... 164

3.6.3.2.3 View Menu ........................................................ 165

3.6.3.2.4 Options Menu ................................................... 166

3.6.3.2.4.1 Options ........................................................ 167

3.6.3.2.4.1 Transfer Tab ................................................ 169

3.6.3.2.4.2 Confirmation Tab ........................................... 170

3.6.3.2.4.3 Layout Tab ................................................... 173

3.6.3.2.4.4 Logging Tab ................................................ 175

3.6.3.2.5 Help Menu ......................................................... 175

3.6.3.3 Toolbar ................................................................. 176

3.6.3.3.1 File Transfer Buttons ....................................... 176

3.6.3.3.2 Other Buttons .................................................. 176

3.6.3.4 Record Panel ........................................................ 177

3.6.4 Chat ........................................................................... 179
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.6.4.1 Multi Chat Session</td>
<td>180</td>
</tr>
<tr>
<td>3.6.5 Audio-Video Chat</td>
<td>181</td>
</tr>
<tr>
<td>3.6.6 Remote Management</td>
<td>182</td>
</tr>
<tr>
<td>3.6.6.1 Title Bar</td>
<td>184</td>
</tr>
<tr>
<td>3.6.6.2 Menu Bar</td>
<td>184</td>
</tr>
<tr>
<td>3.6.6.2.1 File Menu</td>
<td>184</td>
</tr>
<tr>
<td>3.6.6.2.2 View Menu</td>
<td>184</td>
</tr>
<tr>
<td>3.6.6.2.3 Management Menu</td>
<td>185</td>
</tr>
<tr>
<td>3.6.6.2.4 Help Menu</td>
<td>185</td>
</tr>
<tr>
<td>3.6.6.2.5 &lt;Management tool&gt; Menu</td>
<td>186</td>
</tr>
<tr>
<td>3.6.6.3 Toolbar</td>
<td>186</td>
</tr>
<tr>
<td>3.6.6.4 Navigation Panel</td>
<td>187</td>
</tr>
<tr>
<td>3.6.6.5 Display Panel</td>
<td>188</td>
</tr>
<tr>
<td>3.6.6.6 Status Bar</td>
<td>188</td>
</tr>
<tr>
<td>3.6.6.7 Management</td>
<td>188</td>
</tr>
<tr>
<td>3.6.6.7.1 Disk Drives</td>
<td>189</td>
</tr>
<tr>
<td>3.6.6.7.1.1 Disk Drives Menu</td>
<td>190</td>
</tr>
<tr>
<td>3.6.6.7.1.2 Disk Drives Toolbar</td>
<td>191</td>
</tr>
<tr>
<td>3.6.6.7.1.3 Disk Drive Types</td>
<td>192</td>
</tr>
<tr>
<td>3.6.6.7.2 Event Viewer</td>
<td>192</td>
</tr>
<tr>
<td>3.6.6.7.2.1 Event Viewer Menu</td>
<td>193</td>
</tr>
<tr>
<td>3.6.6.7.2.2 Event Viewer Toolbar</td>
<td>194</td>
</tr>
<tr>
<td>3.6.6.7.3 Task Manager</td>
<td>195</td>
</tr>
<tr>
<td>3.6.6.7.3.1 Task Manager Menu</td>
<td>196</td>
</tr>
<tr>
<td>3.6.6.7.3.2 Task Manager Toolbar</td>
<td>197</td>
</tr>
<tr>
<td>3.6.6.7.4 Registry</td>
<td>197</td>
</tr>
<tr>
<td>3.6.6.7.4.1 Registry Menu</td>
<td>199</td>
</tr>
<tr>
<td>3.6.6.7.4.2 Registry Toolbar</td>
<td>203</td>
</tr>
<tr>
<td>3.6.6.7.5 Services</td>
<td>205</td>
</tr>
<tr>
<td>3.6.6.7.5.1 Services Menu</td>
<td>206</td>
</tr>
<tr>
<td>3.6.6.7.5.2 Services Toolbar</td>
<td>207</td>
</tr>
<tr>
<td>3.6.6.7.5.3 Service Installation</td>
<td>208</td>
</tr>
<tr>
<td>3.6.6.7.5.4 Service Properties</td>
<td>210</td>
</tr>
<tr>
<td>3.6.6.7.5.1 General Tab</td>
<td>211</td>
</tr>
<tr>
<td>3.6.6.7.5.2 Log On Tab</td>
<td>212</td>
</tr>
<tr>
<td>3.6.6.7.5.3 Dependencies Tab</td>
<td>214</td>
</tr>
<tr>
<td>3.6.6.7.6 Shared Folders</td>
<td>214</td>
</tr>
<tr>
<td>3.6.6.7.6.1 Shared Folders Menu</td>
<td>215</td>
</tr>
<tr>
<td>3.6.6.7.6.2 Shared Folders Toolbar</td>
<td>215</td>
</tr>
<tr>
<td>3.6.6.7.6.3 Shares Tab</td>
<td>216</td>
</tr>
<tr>
<td>3.6.6.7.6.4 Sessions Tab</td>
<td>217</td>
</tr>
<tr>
<td>3.6.6.7.6.5 Open Files Tab</td>
<td>217</td>
</tr>
<tr>
<td>3.6.6.7.6.6 Share a Folder</td>
<td>217</td>
</tr>
<tr>
<td>3.6.6.7.6.7 Share Properties</td>
<td>219</td>
</tr>
</tbody>
</table>
## Contents

- **3.6.6.7.7 Inventory** ................................................................. 222
- **3.6.6.7.8 Command Console** .................................................. 223
- **3.6.6.7.9 System Control** ....................................................... 224
  - **3.6.6.7.9.1 System Control Menu** ........................................ 226
  - **3.6.6.7.9.2 System Control Toolbar** ..................................... 226
- **3.6.6.8 Netop Sessions** ......................................................... 226
- **3.6.6.9 Details** ....................................................................... 227
- **3.6.7 Demonstrate** .................................................................. 227
- **3.7 Session Tools** .................................................................... 229
  - **3.7.1 Connection Properties** ................................................ 230
    - **3.7.1.1 Connect Tab** ....................................................... 231
    - **3.7.1.2 Logon Tab** ............................................................ 232
    - **3.7.1.3 Protect Item Tab** .................................................. 233
    - **3.7.1.4 Startup Tab** ......................................................... 234
    - **3.7.1.5 Display Tab** .......................................................... 236
    - **3.7.1.6 Keyboard/Mouse Tab** ......................................... 237
    - **3.7.1.7 Compression/Encryption Tab** ................................. 239
    - **3.7.1.8 Desktop Tab** .......................................................... 241
    - **3.7.1.9 Record Tab** ............................................................ 242
    - **3.7.1.10 Custom Tab** ......................................................... 243
  - **3.7.2 Netop Marker Utility** ................................................... 243
    - **3.7.2.1 Title Bar** ............................................................... 244
    - **3.7.2.2 Upper Toolbar** ...................................................... 245
    - **3.7.2.3 Lower Toolbar** ...................................................... 246
    - **3.7.2.4 Status Bar** ............................................................ 246
    - **3.7.2.5 Figure Markers** ...................................................... 246
    - **3.7.2.6 Text Marker** .......................................................... 247
    - **3.7.2.7 Netop Magnifier** .................................................... 249
    - **3.7.2.8 Delete Markers** ...................................................... 250
    - **3.7.2.9 Marker Properties and Help** ................................... 250
  - **3.7.3 Netop Script** ............................................................... 250
    - **3.7.3.1 Global Settings** ..................................................... 252
      - **3.7.3.1.1 General Tab** .................................................... 253
      - **3.7.3.1.2 Transfer Tab** .................................................. 254
      - **3.7.3.1.3 Overwrite/Delete Tab** ..................................... 255
      - **3.7.3.1.4 Advanced Tab** ................................................ 256
      - **3.7.3.1.5 Global Settings in the Script File** ....................... 257
    - **3.7.3.2 Commands** ........................................................... 258
      - **3.7.3.2.1 Connect Command** ......................................... 259
      - **3.7.3.2.2 Wait Command** ............................................... 260
      - **3.7.3.2.3 Run Command** ................................................. 263
      - **3.7.3.2.4 File Transfer Commands** .................................. 264
        - **3.7.3.2.4.1 General Tab** .............................................. 265
        - **3.7.3.2.4.2 Copy Tab** .................................................. 266
3.7.3.2.4.3 Delete ................................................................. 267
3.7.3.2.5 Action Commands ................................................. 267
3.7.3.2.6 Commands in the Script File .................................. 269
3.7.3.3 Script File ................................................................. 271
3.7.3.4 Test a Netop Script .................................................... 272
3.7.3.5 Script Log ................................................................. 273
3.7.4 Netop Screen Video ...................................................... 275
3.7.4.1 Title Bar ................................................................. 276
3.7.4.2 Menu Bar ................................................................. 276
3.7.4.2.1 File Menu ........................................................... 276
3.7.4.2.2 Region Menu ....................................................... 277
3.7.4.2.3 Options Menu ...................................................... 278
3.7.4.2.4 About Menu ....................................................... 282
3.7.4.3 Toolbar ................................................................. 283
3.8 Guest Actions .............................................................. 283
3.8.1 Run Program ............................................................ 284
3.8.1.1 Run Program Browse ............................................. 285
3.8.2 Execute Command ..................................................... 286
3.8.3 Netop Message ......................................................... 286
3.8.3.1 Title Bar ............................................................... 287
3.8.3.2 Menu Bar ............................................................. 287
3.8.3.2.1 File Menu .......................................................... 288
3.8.3.2.2 Edit Menu .......................................................... 288
3.8.3.2.3 Search Menu ..................................................... 289
3.8.3.2.4 Format Menu ..................................................... 289
3.8.3.3 Tool Bar .............................................................. 290
3.8.3.4 Message Pane ....................................................... 291
3.8.3.5 Status Bar ........................................................... 291
3.8.4 Get Inventory ......................................................... 291
4 Netop Host ........................................................................ 292
4.1 Host Startup Guide .......................................................... 292
4.1.1 For Typical Computer Users ....................................... 292
4.1.2 For Advanced Computer Users .................................... 293
4.1.3 Loading Alternatives ............................................... 294
4.1.4 Setup Wizard ........................................................... 295
4.1.4.1 Default Track ...................................................... 297
4.1.4.2 Custom Track ...................................................... 300
4.2 Netop Host Window ....................................................... 305
4.2.1 Title Bar ................................................................. 305
4.2.2 Menu Bar ............................................................... 306
4.2.2.1 File Menu .......................................................... 306
4.2.2.2 View Menu .......................................................... 307
4.2.2.3 Action Menu ....................................................... 307
4.2.2.4 Session Menu ..................................................... 308
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2.2.5 Tools Menu</td>
<td>309</td>
</tr>
<tr>
<td>4.2.2.6 Help Menu</td>
<td>309</td>
</tr>
<tr>
<td>4.2.3 Toolbar</td>
<td>310</td>
</tr>
<tr>
<td>4.2.3.1 Action Buttons</td>
<td>310</td>
</tr>
<tr>
<td>4.2.3.2 Session Buttons</td>
<td>311</td>
</tr>
<tr>
<td>4.2.3.3 Tool Buttons</td>
<td>311</td>
</tr>
<tr>
<td>4.2.4 Tab Panel</td>
<td>312</td>
</tr>
<tr>
<td>4.2.4.1 General Tab</td>
<td>312</td>
</tr>
<tr>
<td>4.2.4.2 Connections Tab</td>
<td>313</td>
</tr>
<tr>
<td>4.2.4.3 History Tab</td>
<td>314</td>
</tr>
<tr>
<td>4.2.4.4 Services Tab</td>
<td>315</td>
</tr>
<tr>
<td>4.2.4.5 Communication Tab</td>
<td>316</td>
</tr>
<tr>
<td>4.2.4.6 Names Tab</td>
<td>316</td>
</tr>
<tr>
<td>4.2.4.7 Messages Tab</td>
<td>317</td>
</tr>
<tr>
<td>4.2.5 Status Bar</td>
<td>318</td>
</tr>
<tr>
<td>4.3 Host Tools</td>
<td>318</td>
</tr>
<tr>
<td>4.3.1 Program Options</td>
<td>319</td>
</tr>
<tr>
<td>4.3.1.1 General Tab</td>
<td>320</td>
</tr>
<tr>
<td>4.3.1.2 Host Name Tab</td>
<td>321</td>
</tr>
<tr>
<td>4.3.1.3 Connection Notification Tab</td>
<td>323</td>
</tr>
<tr>
<td>4.3.1.4 Audio-Video Chat Tab</td>
<td>325</td>
</tr>
<tr>
<td>4.3.1.5 Remote Printing Tab</td>
<td>327</td>
</tr>
<tr>
<td>4.3.1.6 Help Request Tab</td>
<td>329</td>
</tr>
<tr>
<td>4.3.1.7 Run As Tab</td>
<td>331</td>
</tr>
<tr>
<td>4.3.1.8 Directory Services Tab</td>
<td>332</td>
</tr>
<tr>
<td>4.3.1.9 Web Update Tab</td>
<td>335</td>
</tr>
<tr>
<td>4.3.2 Guest Access Security</td>
<td>338</td>
</tr>
<tr>
<td>4.3.2.1 Guest Access Privileges Tab</td>
<td>339</td>
</tr>
<tr>
<td>4.3.2.1.1 Grant All Guests Default Access Privileges</td>
<td>340</td>
</tr>
<tr>
<td>4.3.2.1.2 Grant Each Guest Individual Access Privileges Using Netop Authentication</td>
<td>344</td>
</tr>
<tr>
<td>4.3.2.1.3 Grant Each Guest Individual Access Privileges Using Windows Security Management</td>
<td>347</td>
</tr>
<tr>
<td>4.3.2.1.4 Grant Each Guest Individual Access Privileges Using Directory Services</td>
<td>350</td>
</tr>
<tr>
<td>4.3.2.1.5 Use Netop Security Server</td>
<td>353</td>
</tr>
<tr>
<td>4.3.2.2 Guest Policy Tab</td>
<td>354</td>
</tr>
<tr>
<td>4.3.2.3 MAC/IP Address List Setup Tab</td>
<td>356</td>
</tr>
<tr>
<td>4.3.2.4 Encryption Tab</td>
<td>357</td>
</tr>
<tr>
<td>4.3.2.5 Smart Card Tab</td>
<td>359</td>
</tr>
<tr>
<td>4.3.3 Maintenance Password</td>
<td>360</td>
</tr>
<tr>
<td>4.3.4 Log Setup</td>
<td>361</td>
</tr>
<tr>
<td>4.3.5 Communication Profiles</td>
<td>362</td>
</tr>
<tr>
<td>4.3.6 Modem Database</td>
<td>362</td>
</tr>
<tr>
<td>4.3.7 Check for New Updates</td>
<td>362</td>
</tr>
</tbody>
</table>
5 Common Tools

5.1 Communication Devices

5.1.1 NetBIOS

5.1.1.1 NetBIOS Settings

5.1.1.2 NetBIOS Communication Profile Edit

5.1.2 IPX

5.1.2.1 IPX Settings

5.1.2.2 IPX Communication Profile Edit
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1.2.2.1 Novell Network Numbers</td>
<td>389</td>
</tr>
<tr>
<td>5.1.3 ISDN (CAPI)</td>
<td>389</td>
</tr>
<tr>
<td>5.1.3.1 ISDN (CAPI) Settings</td>
<td>390</td>
</tr>
<tr>
<td>5.1.3.2 ISDN (CAPI) Communication Profile Edit</td>
<td>390</td>
</tr>
<tr>
<td>5.1.3.2.1 Allowed ISDN Numbers</td>
<td>391</td>
</tr>
<tr>
<td>5.1.4 Serial</td>
<td>392</td>
</tr>
<tr>
<td>5.1.4.1 Serial Settings</td>
<td>392</td>
</tr>
<tr>
<td>5.1.4.2 Serial Communication Profile Edit</td>
<td>393</td>
</tr>
<tr>
<td>5.1.5 Windows Modem</td>
<td>394</td>
</tr>
<tr>
<td>5.1.5.1 Windows Modem Settings</td>
<td>394</td>
</tr>
<tr>
<td>5.1.5.2 Windows Modem Communication Profile Edit</td>
<td>395</td>
</tr>
<tr>
<td>5.1.6 TCP/IP</td>
<td>396</td>
</tr>
<tr>
<td>5.1.6.1 TCP/IP Settings</td>
<td>396</td>
</tr>
<tr>
<td>5.1.6.2 TCP/IP Communication Profile Edit</td>
<td>397</td>
</tr>
<tr>
<td>5.1.6.2.1 Advanced TCP/IP Configuration</td>
<td>398</td>
</tr>
<tr>
<td>5.1.6.2.2 IP Broadcast List</td>
<td>401</td>
</tr>
<tr>
<td>5.1.7 TCP/IP (TCP)</td>
<td>402</td>
</tr>
<tr>
<td>5.1.7.1 TCP/IP (TCP) Settings</td>
<td>402</td>
</tr>
<tr>
<td>5.1.7.2 TCP/IP (TCP) Communication Profile Edit</td>
<td>402</td>
</tr>
<tr>
<td>5.1.8 TCP/IP (TCP IPv6)</td>
<td>403</td>
</tr>
<tr>
<td>5.1.8.1 TCP/IP (TCP IPv6) Settings</td>
<td>403</td>
</tr>
<tr>
<td>5.1.8.2 TCP/IP (TCP IPv6) Communication Profile Edit</td>
<td>404</td>
</tr>
<tr>
<td>5.1.9 WebConnect</td>
<td>404</td>
</tr>
<tr>
<td>5.1.9.1 WebConnect Settings</td>
<td>404</td>
</tr>
<tr>
<td>5.1.9.2 WebConnect Communication Profile Edit</td>
<td>405</td>
</tr>
<tr>
<td>5.1.10 Gateway</td>
<td>406</td>
</tr>
<tr>
<td>5.1.10.1 Gateway Settings</td>
<td>406</td>
</tr>
<tr>
<td>5.1.10.2 Gateway Communication Profile Edit</td>
<td>406</td>
</tr>
<tr>
<td>5.1.10.2.1 Gateway Device Group List</td>
<td>407</td>
</tr>
<tr>
<td>5.1.11 Infrared (IrDA)</td>
<td>408</td>
</tr>
<tr>
<td>5.1.11.1 Infrared (IrDA) Settings</td>
<td>408</td>
</tr>
<tr>
<td>5.1.11.2 Infrared (IrDA) Communication Profile Edit</td>
<td>408</td>
</tr>
<tr>
<td>5.1.12 Terminal Server</td>
<td>409</td>
</tr>
<tr>
<td>5.1.12.1 Terminal Server Settings</td>
<td>409</td>
</tr>
<tr>
<td>5.1.12.2 Terminal Server Communication Profile Edit</td>
<td>409</td>
</tr>
<tr>
<td>5.2 Modem Database and Dialog</td>
<td>409</td>
</tr>
<tr>
<td>5.2.1 Modem Database</td>
<td>410</td>
</tr>
<tr>
<td>5.2.1.1 Modem Configuration</td>
<td>411</td>
</tr>
<tr>
<td>5.2.2 Modem Dialog</td>
<td>412</td>
</tr>
<tr>
<td>5.3 Netop Log</td>
<td>412</td>
</tr>
<tr>
<td>5.3.1 Log Setup</td>
<td>413</td>
</tr>
<tr>
<td>5.3.1.1 Log Setup Tab</td>
<td>414</td>
</tr>
<tr>
<td>5.3.1.2 Netop Local Tab</td>
<td>416</td>
</tr>
<tr>
<td>5.3.1.3 Netop Server Tab</td>
<td>417</td>
</tr>
</tbody>
</table>
5.3.1.4 Windows Event Log Tab ................................................................. 419
5.3.1.5 SNMP Traps Tab ............................................................................ 420
5.3.1.6 WebConnect Tab ........................................................................... 421
5.3.2 Local Netop Log .................................................................................. 422
5.3.3 Netop Log Events .................................................................................. 422
  5.3.3.1 Guest Netop Log Events ................................................................. 422
  5.3.3.2 Host and Extended Host Netop Log Events ................................. 424
5.4 System Info ............................................................................................ 428
5.5 NETOP.INI ............................................................................................. 429
  5.5.1 [INSTALL] Section ........................................................................... 429
  5.5.2 [COEXISTENCE] Section ................................................................. 430
  5.5.3 [GUEST], [HOST], [GATEWAY], [NNS] and [NSS] Sections ................. 430
  5.5.4 [IPX] Section ..................................................................................... 431
  5.5.5 [NetBIOS] Section ........................................................................... 431
  5.5.6 [TCP] Section .................................................................................. 431
  5.5.7 [DTL] Section ................................................................................... 431
  5.5.8 [AUDIO] Section ............................................................................. 431
  5.5.9 NETOP.INI Example ......................................................................... 432
5.6 Netop Configuration Files ........................................................................ 432
  5.6.1 Default Location of Netop Configuration Files .................................... 434
  5.6.2 Other Locations of Netop Configuration Files .................................... 434

Index ........................................................................................................... 436
1 Introduction

Welcome to Netop Remote Control, the remote control software from Danware.

We hope that this product will meet your requirements and fulfill your expectations.

If you encounter problems using this product, first consult with its manuals and help systems.

Additional troubleshooting guidance is available from the Netop KnowledgeBase that can be searched for detailed technical information.

The local supplier of your Netop product is available for advising you on how to obtain maximum benefit from it.

As a last resort, submit a support request to Netop Customer & Product Support. We will endeavour to get back to you as soon as possible with a solution to your problem.

Netop Certification, Education and Documentation

This main section includes these sections:

- Features
- Documentation
- Updates
- Common Controls

1.1 Features

Netop Remote Control includes these modules:

- Netop Guest: Enables the computer user to remote control and interact in other ways with another computer that runs Netop Host or extended Host.
- Netop Host: Enables the computer to be remote controlled and interacted with in other ways from a computer that runs Netop Guest.
- Netop Security Server: Extended Host that can manage Guest access security for multiple Hosts.
- Netop Gateway: Extended Host that can route Netop traffic between different communication devices.
- Netop Name Server: Extended Host that can connect Netop modules across segmented networks.

Netop Remote Control features include:

- Remote Control
- Other Interaction
- Security
- Operating Systems
- Communication Devices

1.1.1 Remote Control

Netop Guest can run a Remote Control session with one or multiple Netop Hosts or extended Hosts to show the Host computer screen image to enable the Guest user to work with keyboard and mouse on Host computers and control them in different ways.

A computer that runs Netop Host can be remote controlled from Netop Guest. The Host can allow multiple simultaneous Guest connections to enable a Multi Guest Session in which one connected Guest has keyboard and mouse control while other connected Guests have limited access to the Host computer.
1.1.2 Other Interaction

Netop Guest can run a Monitor session with one or multiple Netop Hosts or extended Hosts to sequentially show their computer screen image and optionally switch to Remote Control.

Netop Guest can run a File Transfer session with one or multiple Netop Hosts or extended Hosts to transfer and manage files and directories. If the Host allows multiple Guest connections, multiple Guests can run separate File Transfer sessions with it at the same time.

Netop Guest can run a Chat session with one or multiple Netop Hosts or extended Hosts to communicate by typed text. If the Host allows multiple Guest connections, multiple Guests can join in a Multi Chat Session with one Host. Netop Host can start a Chat session with one or multiple connected Guests.

One Netop Guest and one Netop Host or extended Host can run an Audio-Video Chat session to communicate by sound and optionally live image. Netop Host can start an Audio-Video Chat session only with a connected Guest that has keyboard and mouse control.

Netop Guest can run a Remote Management session with one or multiple Netop Hosts or extended Hosts to manage Host computers. If the Host allows multiple Guest connections, multiple Guests can run separate Remote Management sessions with it at the same time.

Netop Guest can run a Demonstrate session with one or multiple Netop Hosts or extended Hosts to show a live Guest computer screen image on the Host computer screen.

Netop Guest can run a specified program on a Netop Host or extended Host computer, see Run Program.

Netop Guest can execute a system control command on a Netop Host or extended Host computer, see Execute Command.

Netop Guest can send a Netop Message to a Netop Host or extended Host.

Netop Guest can get the hardware and software inventory of a Netop Host or extended Host computer, see Get Inventory.

Netop Host or extended Host can Request Help from a Netop Guest that offers help services, see Help Request Tab.

1.1.3 Security

You can protect Netop Guest and Netop Host or extended Host setup by a Maintenance Password.

Netop Host or extended Host can protect against unauthorized Guest access and actions:

- Guest Authentication authenticates the Guest by specified credentials.
- A Guest Profile can specify which credentials are required.
- A Security Role specifies what the Guest is allowed to do when connected.
- The Host Guest Policy specifies how certain security issues are handled.
- The Host can apply a Guest Address Check to limit access.

The communication between Netop modules is protected by Encryption.

All Netop Remote Control modules can log Netop events locally and centrally in a Netop Log.

1.1.4 Operating Systems

Netop Remote Control modules are available for a wide range of operating systems. This table shows which features are available in Netop Remote Control modules for different operating systems:

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>Windows</th>
<th>ActiveX</th>
<th>Linux</th>
<th>Solaris</th>
<th>Mac</th>
<th>OS/2</th>
<th>DOS</th>
<th>Windows CE**</th>
<th>Symbian**</th>
</tr>
</thead>
</table>

▼Features
**Introduction**

<table>
<thead>
<tr>
<th>Modules:</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Host</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Security Server</td>
<td></td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Gateway</td>
<td></td>
<td></td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Name Server</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sessions:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote Control</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>File Transfer</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Chat</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Audio-Video Chat</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote Management</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actions:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Program</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Execute Command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netop Message</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monitor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Get Inventory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request Help (Host)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Help Services (Guest)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Host only. ** With a Netop product other than Netop Remote Control version 9.0.

Netop Remote Control modules for different operating systems can interact.

### 1.1.5 Communication Devices

Netop Remote Control modules can communicate by a wide range of Communication Devices. This table shows which Communication Devices are available with different operating systems:

<table>
<thead>
<tr>
<th>Communication Devices</th>
<th>NetBIO S</th>
<th>IPX</th>
<th>ISDN (CAPI)</th>
<th>Window s modem</th>
<th>Serial</th>
<th>TCP/IP</th>
<th>TCP/IP (TCP)</th>
<th>Gateway</th>
<th>Infrared</th>
<th>Terminal</th>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2003</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Windows XP</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Windows NT 4.0</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Windows ME/98SE</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>ActiveX</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Linux</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Solaris</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Mac</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>OS/2</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>DOS</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Windows CE</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Symbian</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>
*Terminal server modules only. **DOS to DOS only.

### 1.2 Documentation

Netop Remote Control documentation includes three *Guides* and four *Help* systems.

This *User’s Guide* in supported languages is available as a downloadable printable PDF file. It contains these chapters:

1. **Introduction**: Explains features, documentation, updates, compatibility and common controls.
2. **Installation**: Explains Netop Remote Control installation.
3. **Netop Guest**: Explains Netop Guest functionality.
4. **Netop Host**: Explains Netop Host functionality.
5. **Common Tools**: Explains tools that are common to all Netop Remote Control modules.

The *Administrator’s Guide* in English is available as a downloadable printable PDF file. It contains these chapters:

2. **Netop Gateway**: Explains Netop Gateway functionality.
3. **Netop Name Management**: Explains Netop Name Server functionality.
4. **Advanced Tools**: Explains advanced Netop Remote Control tools.
5. **Other Operating Systems**: Explains installation and particulars of Netop Remote Control for Linux, Solaris, Mac, OS/2 and DOS.

The *Netop Pack’n Deploy Guide* in English is available as a downloadable printable PDF file. It contains only the *Netop Pack’n Deploy* section of the *Advanced Tools* chapter of the *Administrator’s Guide*.

**Note**: Guide PDF’s are also available from the Netop *KnowledgeBase*.

*Netop Guest Help* that is available from *Netop Guest* (Windows, Linux and Solaris) in the language in which it is installed includes these sections:

- **Introduction**: Explains features, documentation, updates, compatibility and common controls.
- **Installation**: Explains Netop Remote Control installation.
- **Netop Guest**: Explains Netop Guest functionality.
- **Common Tools**: Explains tools that are common to all Netop Remote Control modules.

*Netop Host Help* that is available from *Netop Host*, Netop Security Manager, Netop Security Server, Netop Gateway and Netop Name Server (Windows) in the language in which it is installed includes these sections:

- **Introduction**: Explains features, documentation, updates, compatibility and common controls.
- **Installation**: Explains Netop Remote Control installation.
- **Netop Host**: Explains Netop Host functionality.
- **Common Tools**: Explains tools that are common to all Netop Remote Control modules.

*Netop Security Manager Help* that is available from Netop Security Manager in English explains Netop Security Management functionality.

*Netop Pack’n Deploy Help* that is available from Netop Pack’n Deploy in English explains Netop Pack’n Deploy functionality.

Help system sections contain the same information as the matching manual sections.


**Introduction**

**Note:** You cannot expect the documentation to be updated with the most recent product updates. Look for the most recent update information in the *ReadMe.txt* file that will be updated with major updates.

### 1.2.1 How to Use Netop Documentation

We recommend first-time Netop users to read the *Quick Guide* and then make a test installation and try it out using the Help system for guidance.

We recommend experienced Netop users to review the *User’s Guide* or *Help* system *Introduction* section *Features* section to get up to date with available features.

Read detailed explanations only when needed to clarify the product functionality.

### 1.2.2 Typographical Conventions

These typographical conventions are used in the documentation:

- *Italics* text represents screen text.
- **ALL CAPS** text represents keyboard keys (+ indicates that keys must be pressed at the same time).
- *Lucida Console* font text represents keyboard entries.
- *Colored underlined text* is a jump hotspot. Click the hotspot to jump to the section or topic that explains the underlined text subject.
- *[Square brackets]* are used around optional entries.
- *<Angle brackets>* are used around contents descriptions.

### 1.2.3 Standard Buttons

These standard window buttons will be explained only if their functionality deviates from their standard functionality:

- *OK*: Click this button to close a window to apply window selections.
- *Cancel*: Click this button to close a window without applying window selections.
- *Help*: Click this button to open the *Help* system on the topic that explains the window content.

### 1.3 Updates

Netop products will be improved from time to time through the release of updated builds.

To identify the build of an installed Netop product, select the *Help menu* *About...* command to show the *About...* window. The build number in the format YYYYDDD (Y=year number digit, D=day number digit) will be shown in parentheses next to the version number.

To ensure that your Netop product is up to the current standard, the most recently released build should always be installed.

To update automatically, enable the *Web Update* functionality, see *Web Update Tab*.

To update manually, in the Netop *KnowledgeBase* select *Download Products* to show available downloads. If your installed product version is available with a higher build number, you should download and install it. Installation requires valid license numbers. Products with the same version number down to the first decimal use the same license numbers.

The *ReadMe.txt* file installed with an update will contain the most recent update information.
1.4 Common Controls

This section explains the controls of common Netop Remote Control user interface elements. It includes these sections:

- Window Control
- Menu and Toolbar Control
- Table Control

1.4.1 Window Control

Windows with an icon at the title bar left end share these window controls:

Click the title bar left icon, right-click anywhere in the title bar or press ALT+SPACE to show this standard window control menu:

- **Restore**: Select this command or click the matching title bar right end button to restore a maximized or minimized window to its normal size.

  - **Move**: Select this command to show an arrow-pointed +. Press the keyboard arrow buttons to move the window. Press ENTER to end the operation.

    - **Size**: Select this command to show an arrow-pointed +. Press the keyboard arrow buttons to show a double arrow at a window border and move the window border to resize the window. Press ENTER to end resizing.

    - **Minimize**: Select this command or click the matching title bar right end button to minimize the window. The window can minimize into a taskbar button or a notification area button or if inside a window work panel into a minimized window typically in the lower left corner of the work panel. Click a taskbar minimized window button or double-click a notification area minimized window button to restore the window.

    - **Maximize**: Select this command or click the matching title bar right end button to maximize the window.

    - **Close**: Select this command, click the matching title bar right end button, press ALT+F4 or double-click the title bar icon to close the window without applying window selections. If the window represents a loaded program, the program will be unloaded.

1.4.2 Menu and Toolbar Control

Enabled menu commands will appear in black text. Menu commands that are disabled with the current selection will appear in gray text. Press ALT to enable active window keyboard menu selection that will underline the menu or command letter whose key will select the menu or command. Place the mouse pointer on an active window command to show a hint in the status bar. A command that switches a status `On/Off` can show a check mark or an icon. If check marked or if the icon appears pressed in, the status is `On` and selecting the command will switch the status `Off`. Executing a command will close the menu.

Drag the left end of a toolbar to move it from its default position below the menu bar to place it along a
window border or anywhere outside the window. Enabled toolbar buttons will appear in color. Toolbar buttons that are disabled with the current selection will appear gray. Place the mouse pointer on an active window toolbar button to show a tool tip with the button name and a hint in the status bar. A toolbar button that switches a status On/Off can appear pressed in. If appearing pressed in, the status is On and clicking the button will switch the status Off.

1.4.3 Table Control

Typically, these controls are available with tables in window panes:

Resize the pane by resizing the window by dragging its borders. Change the width of a column by dragging the right border of its heading. Sort records (ascending/descending) by any column by clicking the column heading. If table content extends beyond the pane, it will have scrollbars.

Click a record to select and highlight it. Click a record and while pressing SHIFT click another record to select and highlight both records and records in between. Click a record and while pressing CTRL click other records to select and highlight clicked records.
2 Installation

This main section explains how to install *Netop Remote Control* on a computer that runs on a Windows operating system.

**Note:** Installing *Netop Remote Control* on computers that run on other operating systems is explained in the *Administrator’s Guide Other Operating Systems* chapter.

This main section contains these sections:

- Requirements
- Download Installation Files
- Install
- Install Alternatives

2.1 Requirements

Computers that shall run *Netop Remote Control* must meet certain requirements that are specified in the Netop KnowledgeBase, select Technical Requirements.

**Note:** To install *Netop Remote Control* on a Windows Vista, 2003, XP, 2000 or NT computer, the user must have administrator rights.

Before installing, read the *ReadMe.txt* file that will be available with downloadable installation files. This file contains important general information and may contain update information that was not available when the documentation was last edited.
2.2 Download Installation Files

To download Netop Remote Control installation files, connect to the Netop KnowledgeBase and select Download Products > Netop Remote Control > Windows to show these contents:

Click your preferred Netop Remote Control language version hotspot to show these contents:
It contains these hotspots:

- **View Readme**: Click to show in the right window pane the current version and build ReadMe.txt file contents.
- **View Modification Notes**: Click to show in a new browser window the current version Modification Notes for all builds up to and including the current build if Acrobat Reader is installed on your computer.
- **View Release Notes**: Click to show the current version Release Notes in a new browser window if Acrobat Reader is installed on your computer.
- **Download Manuals**: Click to download available manuals as PDF files in a zipped folder.
- **Download Host**: Click to download NetopRemoteControlHost_<Language abbreviation>.msi from which you can install Netop Host.
- **Download Guest**: Click to download NetopRemoteControlGuest_<Language abbreviation>.msi from which you can install Netop Guest.
- **Download Gateway**: Click to download NetopGateway_<Language abbreviation>.msi from which you can install Netop Gateway.
• Download Security Server: Click to download NetopRemoteControlSecurityServer_<Language abbreviation>.msi from which you can install Netop Security Server.

• Download Name Server: Click to download NetopNameServer_<Language abbreviation>.msi from which you can install Netop Name Server.

2.3 Install

Run a downloaded msi file to show this Welcome to Netop <module> Setup Wizard window:

Click Next to show this window:
Read the license agreement and click *I accept the terms in the license agreement* to enable the *Next* button. Click it to show this window:

### User name:

Specify the user name.

### Organization:

Specify the licensee name.

---

*User name:* [ ]

*Organization:* [ ]
Installation

Serial number: [: Specify the license number.

**Note:** When a Netop module is installed on a computer for the first time, it will run for 30 days if no license number is specified. After this trial period, it will run only if a valid license number is specified.

Click **Next** to show this window:

**Typical**
Installs the most common program features. Recommended for most users.

**Custom**
Allows users to choose which program features will be installed and where they will be installed. Recommended for advanced users.

**Complete**
All program features will be installed (requires most disk space).

Click **Typical** or **Complete** to install typical or all available program features and click **Next** to show the **Windows Firewall Configuration** window.

Click **Custom** and click **Next** to show this window:
In this window, you can exclude installing sub features that you do not need. By default, all sub features will be installed: Select a sub feature to exclude/include it. This table explains available sub features:

<table>
<thead>
<tr>
<th>Sub feature</th>
<th>Available on module: Functionality</th>
<th>Guest</th>
<th>Host</th>
<th>Security Server</th>
<th>Gateway</th>
<th>Name Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Management</td>
<td>Enables Remote Management</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Web Update</td>
<td>Enables Web Update</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Utilities</td>
<td>Enables unhiding module</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Media files</td>
<td>Includes sound and animation files</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Help system</td>
<td>Includes help system</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Readme file</td>
<td>Includes ReadMe file</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Script and code examples</td>
<td>Includes script and code examples</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNMP logging</td>
<td>Enables SNMP logging</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Remote printing</td>
<td>Enables remote printing</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>ActiveX component</td>
<td>Enables ActiveX scripting</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marker mode</td>
<td>Enables Netop Marker Utility</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Advanced feature driver</td>
<td>Enables remote control commands</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Command mode transfer</td>
<td>Enables command mode screen transfer</td>
<td>•</td>
<td>•</td>
<td></td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Security Manager</td>
<td>Installs Netop Security Manager</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code examples</td>
<td>Includes security code examples</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Re-run the setup wizard to change the sub feature selection, see Change or Remove.

Click Reset to restore the original selection.

Click Disk Usage to show this window:
This window that shows the designation, total and available disk space of available disk drive volumes will indicate the disk space requirements of the selected installation. Click OK to close the window.

Click Browse to show this window:

This window shows the selected destination folder name, its content of folders and its path. Click the drop-down box button to show available folders in the path. From the buttons, you can move up in the folder structure and create a folder. Select a folder to show its path and click OK to apply the selection.
When satisfied with the selection in the *Custom Setup* window, click Next to show this window:

It warns you that certain Netop services may require computer restart to work properly. Leave the box checked to allow the computer to restart if required. Click Next to show this window:

Leave the box checked to modify the Windows firewall configuration to enable Netop communication. Click Next to show this window:
Installation

Check the box to save the installation msi file in the directory in which the Netop module is installed to have it available for reinstallation. Click Install to execute installation. When completed, this window will be shown:

Leave the box checked to load the installed module. Click Finish to end the setup wizard.
2.3.1 Change or Remove

You can change or remove a Windows Installer installation from Start > (Settings >) Control Panel > Add or Remove Programs or by re-running the installation.

In the Add or Remove Programs window, select the installed module and click Change or re-run the setup wizard to show the Welcome to Netop <Module> Setup Wizard window. Click Next to show this window:

Click Modify to show the Custom Setup window to change selections and complete installation like Windows Installer.

Click Repair to show a Repair... window like the Ready to Install window to complete re-installation like Windows Installer.

Note: To Modify or Repair, installation files must be available.

Click Remove to show a Remove... window like the Ready to Install window to complete removal like Windows Installer.

In the Add or Remove Programs window, click Remove to remove the module in a small window.

Note: Change or remove will not affect the user configuration of installed modules, see Netop Configuration Files.

2.4 Install Alternatives

These install alternatives are available:

- Install from a Directory
- Pack'n Deploy
- Terminal Server
### 2.4.1 Install from a Directory

To install from a directory, save or copy downloaded `msi` files to the directory. To install, run (double-click) a Netop module `msi` file.

### 2.4.2 Pack’n Deploy

`Netop Pack’n Deploy` enables creating customized setup Netop module installation files (`Pack`) and install with them on remote computers (`Deploy`) or on a local computer (`Silent install`), see the `Netop Pack’n Deploy User’s Guide`.

### 2.4.3 Terminal Server

Installing `Netop Remote Control` on a terminal server computer requires special precautions, see the `Administrator’s Guide Advanced Tools` chapter `Netop in Terminal Server Environments` section.
3 Netop Guest

This main section explains the functionality of Netop Guest on a computer that runs on a Windows operating system.

Note: Netop Guest on a computer that runs on a Linux or Solaris operating system has a similar functionality. The particulars of Netop Guest for other operating systems are explained in the Administrator’s Guide Other Operating Systems chapter.

Netop Guest ActiveX component is explained in the Administrator’s Guide Advanced Tools chapter Netop Guest ActiveX Component section.

Netop Guest can remote control and interact with a computer that runs Netop Host or extended Host. This section includes these sections:

- Load and Unload
- Connect Guide
- Host Security Guide
- Netop Guest Window
- Guest Tools
- Guest Sessions
- Session Tools
- Guest Actions

3.1 Load and Unload

Netop Guest installation is explained in Installation.

To load Netop Guest, select Start > (All) Programs > Netop Remote Control > Guest or use one of the available Loading Alternatives.

If you load Netop Guest for the first time after installation, the Setup Wizard will be shown in front of the Netop Guest Window.

If you have loaded Netop Guest before, the Netop Guest Window will be shown.

To unload Netop Guest, in the Netop Guest Window click the Window Control Close button, select the matching Window Control command or File Menu Exit command or press ALT+F4.

3.1.1 Loading Alternatives

You can load Netop Guest by these alternative methods:

1. In the Windows XP Start menu, select Guest if pinned to your Start menu or in your list of most frequently used programs.

2. Run the Netop Guest program file NGSTW32.EXE from the directory where Netop Guest is installed, typically C:\Program Files\Danware Data\Netop Remote Control\Guest or from a desktop shortcut that you have created.

3. In the Windows Run or Command Prompt window, execute a command that specifies the NGSTW32.EXE path and file name. You can extend this command by any of these switches (add one space before each switch):

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/A :</td>
<td>Start an Audio-Video Chat session with the connected to Host.</td>
</tr>
</tbody>
</table>
### Netop Guest

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/B:&lt;Recording file path and name&gt;</td>
<td>Play back &lt;Recording file path and name&gt;. Do not combine this switch with other switches.</td>
</tr>
<tr>
<td>/C:&lt;Communication profile&gt;</td>
<td>Connect by &lt;Communication profile&gt; to the Host specified by the switch /H: or /P:</td>
</tr>
<tr>
<td>/D:</td>
<td>Disconnect from the connected to Host. Do not combine this switch with other switches.</td>
</tr>
<tr>
<td>/E:&lt;Phonebook file path and name&gt;</td>
<td>Show the Connection Properties of &lt;Phonebook file path and name&gt; or, if combined with a session switch (/A:, /F:, /G:, /R: or /V:), start this session with the &lt;Phonebook file path and name&gt; Host.</td>
</tr>
<tr>
<td>/F:</td>
<td>Start a File Transfer session with the connected to Host.</td>
</tr>
<tr>
<td>/G:</td>
<td>Start a Remote Management session with the connected to Host.</td>
</tr>
<tr>
<td>/H:&lt;Host name&gt;</td>
<td>Connect to the &lt;Host name&gt; Host by an enabled networking communication profile or if specified by the switch /C: that communication profile.</td>
</tr>
<tr>
<td>/LGD:&lt;Gateway logon domain&gt;</td>
<td>When connected to a connecting Netop Gateway, specify &lt;Gateway logon domain&gt; to log on.</td>
</tr>
<tr>
<td>/LGN:&lt;Gateway logon name&gt;</td>
<td>When connected to a connecting Netop Gateway, specify &lt;Gateway logon name&gt; to log on.</td>
</tr>
<tr>
<td>/LGP:&lt;Gateway logon password&gt;</td>
<td>When connected to a connecting Netop Gateway, specify &lt;Gateway logon password&gt; to log on.</td>
</tr>
<tr>
<td>/LHD:&lt;Host logon domain&gt;</td>
<td>When connected to a Host, specify &lt;Host logon domain&gt; to log on.</td>
</tr>
<tr>
<td>/LHN:&lt;Host logon name&gt;</td>
<td>When connected to a Host, specify &lt;Host logon name&gt; to log on.</td>
</tr>
<tr>
<td>/LHP:&lt;Host logon password&gt;</td>
<td>When connected to a Host, specify &lt;Host logon password&gt; to log on.</td>
</tr>
<tr>
<td>/M:[&lt;Recording file path and name&gt;]</td>
<td>Combine this switch with /R: to record the remote control session. If no &lt;Recording file path and name&gt; is specified, a recording file named &lt;Time stamp&gt;-&lt;Guest ID&gt;-&lt;Host ID&gt;.dwr will be saved in the Netop Configuration Files record directory.</td>
</tr>
<tr>
<td>/P:&lt;Telephone number or IP address&gt;</td>
<td>Connect to the &lt;Telephone number or IP address&gt; Host by an enabled point-to-point communication profile or if specified by the switch /C: that communication profile.</td>
</tr>
<tr>
<td>/R:</td>
<td>Start a Remote Control session with the connected to Host.</td>
</tr>
<tr>
<td>/S:&lt;Script file path and name&gt;</td>
<td>Run &lt;Script file path and name&gt;. Do not combine this switch with other switches.</td>
</tr>
<tr>
<td>/V:</td>
<td>Start a Chat session with the connected to Host.</td>
</tr>
<tr>
<td>/X:&lt;Number of pixels from left screen border&gt;[,&lt;Number of pixels from upper screen border&gt;[,&lt;Number of pixels width&gt;[,&lt;Number of pixels height&gt;]]]</td>
<td>Combine this switch with /R: to specify a non-default position and size of the Remote Control window.</td>
</tr>
</tbody>
</table>

**Note:** Use the same command structure to load or control Netop Guest from another application.

### Examples

<Netop Guest program path and file> /E:"C:\Documents and Settings \Administrator\Application Data\Danware Data\Netop Remote Control\Guest..."
Netop Guest

`\PhBook\John.dwc` /R: /M:

Explanation: Load the Guest and connect to the Host of the phonebook entry file `John.dwc` that resides in the Administrator Netop configuration files `PhBook` directory to start a remote control session with it and record the session storing the recording file in its default location with its default name.

<Netop Guest program path and file> /C:TCP/IP /H:Peter /F:

Explanation: Load the Guest and using the communication profile `TCP/IP` connect to the Host named `Peter` to start a file transfer session with it.

<Netop Guest program path and file> /S: C:\SCRIPTS\MY SCRIPT.DWS

Explanation: Load the Guest and run the `C:\SCRIPTS\MY SCRIPT.DWS` script file.

**Note:** Switch paths and file names that contain spaces and special characters must be enclosed by double quotes.

### 3.1.2 Setup Wizard

When you load Netop Guest for the first time after installation, this window will show in front of the Netop Guest Window:

![NetOp Remote Control - Setup Wizard](image)

Welcome to the NetOp Remote Control Setup Wizard

This wizard will guide you through the selection of certain setup options to make the NetOp module ready for use.

Click Next to proceed.

**Note:** By default, Netop Guest setup will be individual to each user, see [Netop Configuration Files](#).

To skip the Setup Wizard, click Cancel to close the window to apply the default setup.

**Note:** The default setup lacks settings that you may need to connect to a Host. We therefore recommend that you run the Setup Wizard. You can re-run the Setup Wizard from the Tools Menu Run Setup Wizard command.

Click Next to show this window:
Select one of these options:

- **Fast connections**: You will typically connect across a local area network (default selection).
- **Slow connections**: You will typically connect across the Internet or by a telephone connection.

Click **Next** to show this window:
Select one of these options:

- **No**: You will not communicate by modem (default selection).
- **Yes**: You will communicate by modem.

Click Next to show this window:

Select one of these options:

- **No**: You will not connect by a NetOp WebConnect service (default selection).
- **Yes**: You will connect by a NetOp WebConnect service.

If you select Yes and click Next, this window will be shown:
Enter the URL address of the WebConnect service, that is the Connection Manager, that you will be using for WebConnect connections.

Then click Test to test that you have entered a valid URL address.

Click Next to go to this window:

Enter logon credentials for the Connection Manager account to be used.
Then click *Test* to test that you have entered valid credentials. Click *Next* to go to this window:

Select *Yes* to choose WebConnect as your default communication profile in the *Quick Connect* tab. Select *No* to choose TCP/IP as your default communication profile in the *Quick Connect* tab. Click *Next* to go to this window:
We recommend that you leave the default Yes, I want to register my NetOp license on-line selection unless you or somebody else in your organization has already registered or will register the license.

Click Next to connect to register or show this window:

We recommend that you leave the default Yes, I want to register my NetOp license on-line selection unless you or somebody else in your organization has already registered or will register the license.

Click Next to connect to register or show this window:

Click Finish to close the window to end the Setup Wizard.
3.2 Connect Guide

You can connect:

- to one Host by a communication profile and a Host name or address, or
- to one or multiple Hosts by Host records.

To connect to one Host by a communication profile and a Host name or address:

1. In the **Tab Panel Quick Connect Tab Communication Profile Section**, select a communication profile that matches a communication profile that is enabled on the Host.
2. In the **Host Section**, specify a Host name or address as required by the selected communication profile.
3. Click the **Buttons Connect** button to connect to start the default type session, see the **Program Options** window **General Tab**, click a **Toolbar Session Buttons** button or select a **Connection Menu Session Commands** command to connect to start a session or click a **Toolbar Action Buttons** button or select a **Connection Menu Action Commands** command to connect to execute an action.
4. Typically, a logon window will be shown to log on to the Host, see Guest Authentication.
5. When logged on to the Host, the session will start or the action will execute.

To connect to one or multiple Hosts by Host records:

- Double-click a **Tab Panel** tab Host record to connect to start the default type session, see the **Program Options** window **General Tab**.
- Select one or multiple **Tab Panel** tab Host records and click a **Toolbar Session Buttons** button or select a **Connection Menu Session Commands** command to connect to start a session.
- Select one or multiple **Tab Panel** tab Host records and click a **Toolbar Action Buttons** button or select a **Connection Menu Action Commands** command to connect to execute an action.

Host records will be available on these **Tab Panel** tabs:

- **Phonebook Tab**: Stores Host records that you have created or saved from the **Quick Connect Tab** or **History Tab**.
- **Quick Connect Tab**: Can show Host browse records on the **Netop Network Tab**, see **Browse for Hosts**, and network computer records on the **Windows Network Tab**.
- **History Tab**: Stores records of previous Host connections.
- **Help Request Tab**: Will show records of pending Host help requests.

If connection fails, see **Connect Problems**.
3.2.1 Connect Problems

If connection to a Host fails, typically this window will be shown:

![Name Not Found]

This window advises you on how to overcome connect problems.

Here is some additional advice:

- Verify that communication can physically reach the Host computer:
  
  If communicating across an IP network, execute this command in a Windows Command Prompt window:
  
  `PING <Host computer IP address>`
  
  This command will send four data packets to the specified IP address requesting replies. If positive replies are received, communication can physically reach the Host computer. If negative replies are received, check your network setup or consult with your network/system administrator.

  If communicating across a modem connection using Windows Modem, the setup of your modem in Windows may not satisfy Netop requirements. Try setting up your modem using Serial instead.

- Verify on the Netop Host window Names tab that the Host will respond to the specified name or address with the selected communication profile. Read in the Communication Device section about the characteristics of the communication device used by the selected communication profile.

- Try connecting to other Hosts starting with Hosts close to you. Try using other communication profiles and other Host names or addresses.

- Read the Host Security Guide.

- Consult with your network/system administrator.

- As a last resort, submit a support request to Netop Customer & Product Support.

3.3 Host Security Guide

A Host and a connecting Gateway can apply Guest Access Security to limit which Guests can connect and what connected Guests are allowed to do. This guide includes these sections:

- Guest Authentication
- Security Role
3.3.1 Guest Authentication

A Host and a connecting Gateway can authenticate a connecting Guest or Guest user by logon credentials.

**Note:** Authentication can validate the credentials submitted by a Guest but cannot verify the identity of a connecting Guest or Guest user.

This section contains these sections:

- Shared Netop Authentication
- Individual Netop Authentication
- Windows Authentication
- Directory Services Authentication
- Netop Security Server Authentication
- RSA SecurID Authentication
- Smart Card Authentication

### 3.3.1.1 Shared Netop Authentication

If the Host or a connecting Netop Gateway uses shared Netop authentication (default selection), this window will be shown on the Guest computer screen when the Guest connects:

Password [:] Specify in this field the shared password specified on the Host or connecting Gateway.

The available number of logon attempts is specified by Host Guest Policy.
3.3.1.2 Individual Netop Authentication

If the Host or a connecting Netop Gateway uses individual Netop authentication, this window will be shown on the Guest computer screen when the Guest connects:

Guest ID: [ ]: Specify in this field a Guest ID specified on the Host or connecting Gateway.

Password: [ ]: Specify in this field the matching password specified on the Host or connecting Gateway.

The available number of logon attempts is specified by Host Guest Policy.

3.3.1.3 Windows Authentication

If the Host or a connecting Gateway uses Windows authentication or if the Host uses Netop Security Server and its Preferred Guest Type is Windows User, this window will be shown on the Guest computer screen when the Guest connects:

User name: [ ]: Specify in this field a Windows logon user name specified in the local or domain Windows Security Management used by the Host computer, the connecting Gateway computer or Netop Security Server.

Password: [ ]: Specify in this field the matching password specified in Windows Security Management.

Domain: [ ]: Specify in this field the matching domain specified in Windows Security Management.

The available number of logon attempts is specified by Host Guest Policy.

3.3.1.4 Directory Services Authentication

If the Host uses Directory Services authentication or if the Host uses Netop Security Server and its Preferred Guest Type is Directory Services User, this window will be shown on the Guest computer screen when the Guest connects:
User name: [:] Specify in this field a directory services user common name specified on the Host or Netop Security Server and on the directory server specified below.

Password: [:] Specify in this field the matching password specified on the directory server.

Directory Server: [:] Specify in this field the matching directory server.

The available number of logon attempts is specified by Host Guest Policy.

3.3.1.5 Netop Security Server Authentication

If the Host uses Netop Security Server and its Preferred Guest Type is Netop Guest ID, this window will be shown on the Guest computer screen when the Guest connects:

Guest ID: [:] Specify in this field a Guest ID specified in the security database used by the Netop Security Server.

Password: [:] Specify in this field the matching password specified in the security database used by the Netop Security Server.

Change Password...: To change the password, click this button to show this window:
Netop Guest

3.3.1.6 RSA SecurID Authentication

If the Host uses Netop Security Server and its Preferred Guest Type is RSA SecurID User, this window will be shown on the Guest computer screen when the Guest connects:

User name: [ ]: Specify in this field your RSA SecurID user name.

Password: [ ]: This field will be included only if triple factor security is specified by Netop Security Server. Specify in the field your triple factor security Netop password.

PASSCODE: [ ]: Specify in this field your RSA SecurID PASSCODE (PIN + token number).

Change Password...: This button will be included only if triple factor security is specified by Netop Security Server. Click it to change your Netop password like in Netop Security Server Authentication.

The available number of logon attempts is specified by Host Guest Policy.
3.3.1.7 Smart Card Authentication

If the Host uses Netop Security Server and its Preferred Guest Type is Smart Card and PIN, this window will be shown on the Guest computer screen when the Guest connects:

Insert your Netop authentication Smart Card into your Smart Card reader and click OK to show a window that requests the matching PIN number. Specify your matching PIN number.

The available number of logon attempts is specified by Host Guest Policy.

3.3.2 Security Role

Netop Host can specify locally and the Netop Security Server security database can specify centrally in Security Roles which actions shall be allowed to a Guest and which confirm access option shall be available to the Host computer user.

Each Security Role specifies these elements:

- Allow Guest To
  - Remote control
  - Use keyboard and mouse
  - Lock keyboard and mouse
  - Blank the screen
  - Transfer clipboard
  - Execute command (Restart, ...)
  - Request chat
  - Request audio chat and transfer sound
  - Request Video
  - Send files to host
  - Receive files from host
  - Run programs
  - Redirect print
  - Remote Manage
  - Retrieve Inventory
  - Send Message
  - Join multi Guest session
  - Act as multi Guest session Administrator
- Confirm access:
  - Yes
  - No

This section includes these sections:

- Allow Guest To
- Confirm Access
3.3.2.1 Allow Guest To

The Host or security database Security Role specification upper part that is indented under Allow Guest to:

- specifies which actions will be allowed to a Guest when connected to the Host. Checked actions will be allowed, unchecked will be denied.

☑ Remote control: Start a Remote Control session to show the Host computer screen image (default: allowed). Indented actions below can be allowed if Remote control is allowed.

☑ Use keyboard and mouse: Execute keyboard and mouse actions on the Host computer screen (default: allowed).

☑ Lock keyboard and mouse: Disable the Host computer keyboard and mouse (default: allowed).

☑ Blank the screen: Make the screen turn black to the Host computer user (default: allowed).

☑ Transfer clipboard: Transfer Guest computer clipboard contents to the Host computer clipboard and vice versa (default: allowed).

☑ Execute command (Restart, ...): Execute Command on the Host computer including other commands like Restart (default: allowed).

☑ Request chat: Start a Chat session with the Host (default: allowed).

☑ Request audio-video chat and transfer sound: Start an Audio-Video Chat session with the Host and transfer the sound of applications running on the Host computer (default: allowed).

☐ Request video: In an Audio-Video Chat session, transfer a Host computer video camera image to the Guest Audio-Video Chat window Remote section video frame (default: denied).

☐ Send files to Host: File Transfer from the Guest computer to the Host computer (default: allowed).

☐ Receive files from Host: File Transfer from the Host computer to the Guest computer (default: allowed).
- Run programs: Run Program on the Host computer (default: allowed).
- Redirect print: Send a print job from one computer to a printing device available to the other computer, see the Program Options window Remote Printing Tab (default: allowed).
- Remote manage: Start a Remote Management session to manage the Host computer system (default: allowed).
- Retrieve inventory: Get Inventory from the Host computer (default: allowed).
- Send message: Send a Netop Message to the Host computer (default: allowed).
- Demonstrate: Demonstrate the Guest computer screen image on the Host computer screen (default: allowed).
- Join multi Guest session: Join a Remote Control session that another Guest runs with the Host (default: allowed).
- Act as multi Guest session administrator: Manage a Remote Control Multi Guest Session (default: allowed).

### 3.3.2.2 Confirm Access

The Host or security database Security Role specification lower part that is indented under Confirm access:

- Confirm access:
  - No
  - Yes, except when
    - Computer locked
    - No user logged on
    - Guest user logged on

- specifies whether the Host computer user shall confirm Guest user access to the Host computer. One of these options will be selected:
  - No: The Host computer user shall not confirm access (default selection).
  - Yes, except when: The Host computer user shall confirm access except in the cases checked below.
    - Computer locked: If the computer is locked, the Host computer user cannot confirm access (default: unchecked).
    - No user logged on: If no user is logged on to the Host computer, no user will be available to confirm access (default: unchecked).
    - Guest user logged on: If Guest credentials match the Host computer user logon credentials, confirm access is typically not justified (default: unchecked).

If the Host user shall confirm access, this message will be shown when the Guest has logged on:
Netop Guest

This message will remain until the Host computer user has confirmed access or confirm access has timed out, see Host Guest Policy. If the Host computer user allows access, the Guest will access the Host computer. If the Host computer user denies access or confirm access times out, the Host will disconnect.

Cancel: Click this button to close the message to disconnect.

3.3.3 Guest Profile

A Guest profile specifies how the Host shall respond to a Guest connection attempt.

By default, the Host will use Shared Netop Authentication for which the Host specifies one Guest profile that is shared by all connecting Guests.

For individual authentication methods, the Host can specify individual Guest profiles or apply Windows Security Management or directory services specified Guest user profiles. Netop Security Server can apply security database specified Guest profiles or Windows Security Management or other external Guest user profiles.

This is the Host window that specifies an Individual Netop Authentication Guest profile:

It specifies Guest credentials that consist of a Guest ID and a Password and selects one of these Call back options:

- **No call back**: The Host will not disconnect and reconnect (default selection).
- **Call back to []**: The Host will disconnect and reconnect to a telephone number or IP address that is specified in the field. Only if the Guest connects from this telephone number or IP address, it can gain access to the Host, see also Address Check.
- **Roving call back**: This window will show on the Guest computer screen:

Enter callback phone number: [ ]: Specify in the field the telephone number or IP address from which the Guest computer connected. The Host will disconnect and reconnect to the specified...
telephone number or IP address. This call back option will not limit Guest access, but the Host
computer organization will carry connection charges during a session.

3.3.4 Guest Policy

A Host and a connecting Gateway can apply these Guest security policies:

- Specify the available number of logon attempts (default: 3) and select which action shall be executed
if all available connecting Guest logon attempts are unsuccessful: Disconnect (default selection),
Disable Host (deny any connection until reset on the Host computer) or Restart Windows.

  **Note:** Restart Windows will typically reload and restart the Host or Gateway.

- Select which action shall be executed after disconnect: None (default selection), Lock computer, Log
off Windows or Restart Windows.

  **Note:** A Guest can connect to a locked Host computer and a Host computer with no user logged on.
The Guest user must unlock or log on to the Host computer to access it.

- Disable file transfer if no user is logged on to the Host computer (default: unselected).

- Record remote control sessions (default: disabled) and disconnect if session recording fails (default:
disabled).

- Timeout (disconnect if not completed within a specified number of seconds):
  - Confirm Access (default: no timeout).
Netop Guest

- **Authentication** (default: no timeout).
- **Inactivity** (no Guest computer keyboard or mouse activity, default: no timeout).

### 3.3.5 Address Check

A Host and a connecting Gateway can allow connections by network communication only from computers with specified MAC and IP addresses:

#### Note:
MAC addresses apply to connections by NetBIOS and IPX communication devices. IP addresses apply to connections by TCP/IP and TCP/IP (TCP) communication devices.

A Host and a connecting Gateway can allow connections by ISDN (CAPI) communication only from telephone numbers in an Allowed ISDN Numbers list (default: not applied).

A Host and a connecting Gateway can allow connections by point-to-point communication only from a specified telephone number or IP address by call back, see Guest Profile (default: not applied).

### 3.3.6 Encryption

Netop communication is protected by encryption, see the Program Options window Encryption Tab.

A Guest can connect only if at least one encryption type enabled on the Guest is also enabled on a connecting Gateway and on the Host.
3.4 Netop Guest Window

When Netop Guest is loaded, this window will be shown:

![Netop Guest Window](image)

It contains these elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**
- **Tab Panel**
- **Status Bar**

3.4.1 Title Bar

This is the Netop Guest Window title bar:

![Netop Guest Title Bar](image)

3.4.2 Menu Bar

This is the Netop Guest Window menu bar:

![Netop Guest Menu Bar](image)

It contains these menus:

- **File Menu**
- **Connection Menu**
- **Edit Menu**
- **View Menu**
Netop Guest

- **Tools Menu**
- **Help Menu**

### 3.4.2.1 File Menu

This is the **Netop Guest Window File menu**:

<table>
<thead>
<tr>
<th>File</th>
<th>Connection</th>
<th>Edit</th>
<th>View</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Import to Phonebook</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export from Phonebook</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Alt+F4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Import to Phonebook**: Select this command to show the *Import to Phonebook* window.

**Export from Phonebook**: Select *Phonebook Tab* directories or records and select this command to show the *Export from Phonebook* window.

**Exit**: Select this command or a *Window Control Close* control to unload Netop Guest.

### 3.4.2.2 Connection Menu

This is the **Netop Guest Window Connection menu**:

<table>
<thead>
<tr>
<th>File</th>
<th>Connection</th>
<th>Edit</th>
<th>View</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Regale Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Transfer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chat</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audio-Video Chat</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Remote Management</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Demonstrate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Run Program</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Execute Command</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Send Message</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Monitor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Get Inventory</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disconnect</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Local File Transfer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Playback session recording</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Connection menu commands** fall into these groups:

- **Session Commands**
- **Action Commands**
- **Other Commands**
### 3.4.2.2.1 Session Commands

These are the [Connection Menu](#) session commands:

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Control</td>
</tr>
<tr>
<td>File Transfer</td>
</tr>
<tr>
<td>Chat</td>
</tr>
<tr>
<td>Audio-Video Chat</td>
</tr>
<tr>
<td>Remote Management</td>
</tr>
<tr>
<td>Demonstrate</td>
</tr>
</tbody>
</table>

To enable session commands, specify a Host name in the [Quick Connect Tab Host Section](#) Name field or select one or multiple [Phonebook Tab](#), [Quick Connect Tab](#), [Connections Tab](#), [History Tab](#) or [Help Request Tab](#) Host records.

**Note:** You can start a session with multiple Hosts at a time only if the session is not running with any selected Host. You can end a session with only one Host at a time.

**Remote Control:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar Remote Control](#) button to start or end a Remote Control session. If a Remote Control session is running with the last selected record Host, the command will be check marked to end the session.

**Monitor:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar Monitor](#) button to start or end a Monitor session. If a Monitor session is running with the last selected record Host, the command will be check marked to end the session.

**File Transfer:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar File Transfer](#) button to start or end a File Transfer session. If a File Transfer session is running with the last selected record Host, the command will be check marked to end the session.

**Chat:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar Chat](#) button to start or end a Chat session. If a Chat session is running with the last selected record Host, the command will be check marked to end the session.

**Audio-Video Chat:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar Audio-Video Chat](#) button to start or end an Audio-Video Chat session. If an Audio-Video Chat session is running with the last selected record Host, the command will be check marked to end the session.

**Note:** If the Guest or the Host is engaged in another audio session, you cannot start an Audio-Video Chat session.

**Remote Management:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar Remote Management](#) button to start or end a Remote Management session. If a Remote Management session is running with the last selected record Host, the command will be check marked to end the session.

**Demonstrate:** Select this command or the matching [Tab Panel](#) record context menu command or click the [Toolbar Demonstrate](#) button to start or end a Demonstrate session. If a Demonstrate session is running with the last selected record Host, the command will be check marked to end the session.

If you start a session with multiple Hosts, this window will be shown:
Netop Guest

The window will show a session type icon and Launch <Session type>.
The pane below will show records of selected Hosts in a table with these column contents:

- **Description**: Progress indicator and Tab Panel record Description column value. These progress indicators can be shown:
  - Command execution in progress
  - Command executed successfully
  - Command execution failed

- **Name**: Tab Panel record Name column value.

- **Phone number**: Tab Panel record Phone number column value.

- **Communication Profile**: Tab Panel record Communication Profile column value.

- **Status**: Textual progress indicator.

Commands will execute sequentially as indicated by the progress indicators and Status column content.

If no other session is running with a selected record Host, starting a session will include connecting to the Host.

**Note**: If Guest Access Security on a selected record Host does not allow the session of the selected command, command execution will fail, see Allow Guest To.

- **Close this dialog box on successful completion**: Check this box to close this window when the command has executed successfully on all selected record Hosts (default: unchecked).

**Cancel/Close**: During progress, this button will show Cancel. Click it to cancel executing the command on the current Host record and proceed to the next. After completion, this button will show Close. Click it to close the window.
3.4.2.2.2 Action Commands

These are the Connection Menu action commands:

- Run Program
- Execute Command
- Send Message
- Monitor
- Get Inventory

To enable action commands, specify a Host name in the Quick Connect Tab Host Section Name field or select one or multiple Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab Host records.

Run Program: Select this command or the matching Tab Panel record context menu command or click the Toolbar Run Program button to show the Run Program menu.

Execute Command: Select this command or the matching Tab Panel record context menu command or click the Toolbar Execute Command button to show the Execute Command menu.

Send Message: Select this command or the matching Tab Panel record context menu command or click the Toolbar Send Message button to show the Netop Message window.

Get Inventory: Select this command or the matching Tab Panel record context menu command or click the Toolbar Get Inventory button to Get Inventory from selected record Host computers.

**Note:** When executing a Run Program, Execute Command or Get Inventory action, the Command Progress Status window will be shown.

3.4.2.2.3 Other Commands

These are the Connection Menu other commands:

- Disconnect
- Local File Transfer
- Playback session recording

Disconnect: Select a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab connected Host record and select this command or the matching record context menu command or click the Toolbar Disconnect button to disconnect.

**Note:** You can disconnect only one Host at a time.

Local File Transfer: Select this command or Netop File Manager window View Menu Local command or click the Toolbar Local File Transfer button or Netop File Manager window Toolbar Local button to start a local File Transfer session.

Playback Session Recording: Select a Recordings Tab record and select this command or the matching record context menu command or double-click the record to play back the session recording.
3.4.2.3 Edit Menu

This is the Netop Guest Window Edit menu:

Cut: Select one or multiple Tab Panel folders or records and select this command or the matching context menu command to remove selected folders or records and place them on the clipboard.

Copy: Select one or multiple Tab Panel folders or records and select this command or the matching context menu command to copy selected folders or records to the clipboard.

Paste: Select a Tab Panel folder and select this command or the matching context menu command to paste the clipboard contents into the selected folder.

Delete: Select one or multiple Tab Panel folders or records and select this command or the matching context menu command or click the Toolbar Delete button to show a confirmation window to confirm deleting selected folders or records.

Caution: Deleting a folder will delete all folders and records in it.

Rename: Select a Tab Panel folder and select this command or the matching context menu command to show this window:

New folder name: [ ]: The field highlights the folder name. Edit it to rename the folder.

New: This command expands into these commands:

Phonebook Entry: Showing the Phonebook Tab, select this command or the matching Records Pane context menu command or click the Toolbar Phonebook Entry button to show the Connection Properties window to create a phonebook record.

Script: Showing the Script Tab, select this command or the matching Records Pane context menu command to show the Script window to create a Netop Script.

Folder: Select a Tab Panel Tree Pane folder and select this command or the Tree Pane context menu New Folder command to show this window:
Enter folder name: [:] Specify in this field a folder name to create this folder in the selected folder.

Refresh: Select this command to refresh the contents of the shown Tab Panel tab. If the Quick Connect Tab is shown, this will Browse for Hosts.

Note: Tab contents will show changes from outside the tab only if refreshed.

Connection Properties: Select a Phonebook Tab, History Tab or Help Request Tab Host record and select this command or the matching context menu command or click the Toolbar Connection Properties button to show the Connection Properties window to view or edit the selected Host record connection properties.

Edit Script: Select a Script Tab record and select this command or the record context menu Edit command to open the record script in the Script window.

3.4.2.4 View Menu

This is the Netop Guest Window View menu:

Tree Window: Select this command or click the Toolbar Tree Window button to hide/show the shown Tab Panel tab Tree Pane (default: shown). If shown, the command will be check marked.

Large Icons: Select this command or click the Toolbar Large Icons button to show the shown Tab Panel tab Records Pane records as horizontal rows of large icons. If selected, the command will be check marked.

Small Icons: Select this command or click the Toolbar Small Icons button to show the shown Tab Panel tab Records Pane records as horizontal rows of small icons. If selected, the command will be check marked.

List: Select this command or click the Toolbar List button to show the shown Tab Panel tab Records Pane records as vertical columns of small icons. If selected, the command will be check marked.

Details: Select this command or click the Toolbar Details button to show the shown Tab Panel tab Records Pane records in a table with details in columns (default selection). If selected, the command will be check marked.

View File Manager Log: Select this command or the Netop File Manager window Options Menu View File Manager Log command to show a Windows Open window that specifies Files of type: Log Files (*.log) to open a File Transfer log (typically named NFM.LOG) to show it in the NFM Log Viewer window.

Modem Dialog: Select this command to show the Modem Dialog window.
3.4.2.5 Tools Menu

This is the Netop Guest Window Tools menu:

- Programs Options
- Site Manager Options
- Log Setup
- Maintenance Password
- Communication profiles
- MODem Database
- Check for New Updates
- Publish New Updates
- Run Setup Wizard
- Copy Guest to removable media
- Debug Trace

Its commands are explained in Guest Tools.

3.4.2.6 Help Menu

This is the Netop Guest Window Help menu:

Contents: Select this command to open the Netop Guest Help system on the Introduction topic. The left pane of the window will show a graphical table of contents.

Online Support: Select this command to open the Support for Netop Remote Control web page to submit a support request.

Apply License/Online Registration: This command will be Apply License if a trial version is installed and Online Registration if a licensed version is installed.

Select Apply License to show this window:

Licensed to: [:] Specify in this field your licensee name.

Serial number: [:] Specify in this field your Guest license number.

OK: Click this button to replace the trial version licensee name and license number by the specified licensee name and license number.

Select Online Registration to open the Netop Product Registration web page to register your Netop product with the manufacturer.
Quick Guide: Select this command to open the Netop Guest Help system on the Connect Guide topic.

Help for this Tab: Select this command or click the Toolbar Help for this Tab button to open the Netop Guest Help system on the topic of the shown Tab Panel tab.

About...: Select this command to show this window:

This window contains information on your Netop Guest installation. The build number in format YYYYDDD (Y=year number digit, D=day number digit) is enclosed in parentheses next to the version number.

System Info...: Click this button to show the System Info window.

3.4.3 Toolbar

The Netop Guest Window toolbar will be shown unless hidden from the Program Options window Layout Tab:

Toolbar buttons are grouped into these sections:

- **Session Buttons**
- **Action Buttons**
- **Other Buttons**

3.4.3.1 Session Buttons

These are the Toolbar session buttons:

To enable session buttons, specify a Host name in the Quick Connect Tab Host Section Name field or select one or multiple Phonebook Tab, Quick Connect Tab, Connections Tab, History Tab or Help Request Tab Host records.

**Note:** You can start a session with multiple Hosts at a time only if the session is not running with any selected Host. You can end a session with only one Host at a time.
**Remote Control:** Click this button or select the Connection Menu or Tab Panel record context menu Remote Control command to start or end a Remote Control session. If a Remote Control session is running with the last selected record Host, the button will appear pressed in to end the session.

**Monitor:** Click this button or select the Connection Menu or Tab Panel record context menu Monitor command to start or end a Monitor session. If a Monitor session is running with the last selected record Host, the button will appear pressed in to end the session.

**File Transfer:** Click this button or select the Connection Menu or Tab Panel record context menu File Transfer command to start or end a File Transfer session. If a File Transfer session is running with the last selected record Host, the button will appear pressed in to end the session.

**Chat:** Click this button or select the Connection Menu or Tab Panel record context menu Chat command to start or end a Chat session. If a Chat session is running with the last selected record Host, the button will appear pressed in to end the session.

**Audio-Video Chat:** Click this button or select the Connection Menu or Tab Panel record context menu Audio-Video Chat command to start or end an Audio-Video Chat session. If an Audio-Video Chat session is running with the last selected record Host, the button will appear pressed in to end the session.

**Note:** If the Guest or the Host is engaged in another audio session, you cannot start an Audio-Video Chat session.

**Remote Management:** Click this button or select the Connection Menu or Tab Panel record context menu Remote Management command to start or end a Remote Management session. If a Remote Management session is running with the last selected record Host, the button will appear pressed in to end the session.

**Demonstrate:** Click this button or select the Connection Menu or Tab Panel record context menu Demonstrate command to start or end a Demonstrate session. If a Demonstrate session is running with the last selected record Host, the button will appear pressed in to end the session.

If you start a session with multiple Hosts, the Command Progress Status window will be shown.

### 3.4.3.2 Action Buttons

These are the Toolbar action buttons:

- **Run Program:** Click this button or select the Connection Menu or Tab Panel record context menu Run Program command to show the Run Program drop-down menu.

- **Execute Command:** Click this button or select the Connection Menu or Tab Panel record context menu Execute Command command to show the Execute Command drop-down menu.

- **Send Message:** Click this button or select the Connection Menu or Tab Panel record context menu Send Message command to show the Netop Message window.

- **Get Inventory:** Click this button or select the Connection Menu or Tab Panel record context menu Get Inventory command to Get Inventory from selected record Host computers.

**Note:** When executing a Run Program, Execute Command or Get Inventory action, the Command Progress Status window will be shown.
3.4.3.3 Other Buttons

These are the Toolbar other buttons:

- **Disconnect**: Select a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab connected Host record and click this button or select the Connection Menu or record context menu Disconnect command to disconnect.

  **Note**: You can disconnect only one Host at a time.

- **Local File Transfer**: Click this button or the Netop File Manager window Toolbar Local button or select the Connection Menu Local File Transfer command or Netop File Manager window View Menu Local command to start a local File Transfer session.

- **Connection Properties**: Select a Phonebook Tab, History Tab or Help Request Tab Host record and click this button or select the Edit Menu or record context menu Connection Properties command to show the Connection Properties window to view or edit the selected Host record connection properties.

- **Phonebook Entry**: Showing the Phonebook Tab, click this button or select the Edit Menu or Records Pane context menu New Phonebook Entry command to show the Connection Properties window to create a phonebook record.

- **Delete**: Select one or multiple Tab Panel folders or records and click this button or select the Edit Menu or context menu Delete command to show a confirmation window to confirm deleting selected folders or records.

  **Caution**: Deleting a folder will delete all folders and records in it.

- **Tree Window**: Click this button or select the View Menu Tree Window command to hide/show the shown Tab Panel tab Tree Pane (default: shown). If shown, the button will appear pressed in.

- **Large Icons**: Click this button or select the View Menu Large Icons command to show the shown Tab Panel tab records as horizontal rows of large icons. If selected, the button will appear pressed in.

- **Small Icons**: Click this button or select the View Menu Small Icons command to show the shown Tab Panel tab records as horizontal rows of small icons. If selected, the button will appear pressed in.

- **List**: Click this button or select the View Menu List command to show the shown Tab Panel tab records as vertical columns of small icons. If selected, the button will appear pressed in.

- **Details**: Click this button or select the View Menu Details command to show the shown Tab Panel tab records in a table with details in columns (default selection). If selected, the button will appear pressed in.

- **Help for this Tab**: Click this button or select the Help Menu Help for this Tab command to open the Netop Guest Help system on the topic of the shown Tab Panel tab.
3.4.4 Tab Panel

This is the Netop Guest Window tab panel:

It can contain up to all of these tabs (default: all):

- **Phonebook Tab**
- **Quick Connect Tab**
- **Connections Tab**
- **History Tab**
- **Help Request Tab**
- **Recordings Tab**
- **Script Tab**
- **Inventory Tab**

By default, the **Quick Connect Tab** will be shown in front.

Organize tab panel tabs from the **Program Options** window **Layout Tab**.
3.4.4.1 Phonebook Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab:

It works like your personal quick-dial telephone directory. However, connecting to a Host requires much more than a phone call:

- You must select the right communication profile
- You must specify the Host name and possible connecting elements correctly
- When connected, you may need to specify logon credentials
- Guest settings should fit Host settings and optimize transmission speed and quality
- Your preferred interactive functionality should be in place when connected

All of this can be specified in Phonebook Records to access Host computers by a few mouse clicks.

The Phonebook tab contains an optional left Tree Pane and a right Records Pane.

The Tree Pane will show the phonebook directory structure. To hide/show the Tree Pane, click the Toolbar TreeWindow button or select the View Menu TreeWindow command (default: shown).

The Records Pane will show the Phonebook Records in the phonebook directory selected in the Tree Pane.
3.4.4.1.1 Tree Pane

This is the Phonebook Tab tree pane:

It will initially contain only a Phonebook element that is the root of the Netop Guest phonebook.

Right-click in the pane to show this context menu:

This menu enables you to manage your Phonebook and phonebook reference directories. You can also manage directory folders by drag and drop.

Commands in the first three sections match Edit Menu commands.

Add Phonebook Reference: Select this command to show this window:

A phonebook reference will link to a directory that contains Phonebook Records, for instance a phonebook shared by multiple users.
Click the [...] button to show a Browse for Folder window to select a directory to specify its name in the Name field and its path in the Folder field. You can edit the Name field phonebook reference name. A new phonebook reference will show in the tree pane as an additional phonebook element that expands into the directories of the selected directory.

*Edit Phonebook Reference*: Select a phonebook reference element and select this command to show the phonebook reference specification in the Add Phonebook Reference window to edit it.

### 3.4.4.1.2 Records Pane

This is the Phonebook Tab records pane:

<table>
<thead>
<tr>
<th>Description /</th>
<th>Name</th>
<th>Phone number</th>
<th>Communication Profile</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>G00002</td>
<td>TCP/IP</td>
<td>G0002</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G00103</td>
<td>TCP/IP</td>
<td>G00103</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CKWINXP</td>
<td>TCP/IP</td>
<td>CKWINXP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GAC001</td>
<td>TCP/IP</td>
<td>GAC001</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GRUD02</td>
<td>TCP/IP</td>
<td>GRUD02</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GS003</td>
<td>TCP/IP</td>
<td>GS003</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LKAPTCP</td>
<td>TCP/IP</td>
<td>LK; {Gateway}</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NETFILTER</td>
<td>TCP/IP</td>
<td>NETFILTER</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WINKPK01</td>
<td>TCP/IP</td>
<td>TDOGADMIN</td>
<td></td>
</tr>
</tbody>
</table>

It will show the Phonebook Records in the Tree Pane selected folder as icons or table records according to the Toolbar or View Menu selection. Details will show records in a table with these column contents:

- **Description**: Communication device type icon (Networking, Point-to-Point, Gateway, Network Point-to-Point or Infrared) and record identifying description.
- **Name**: Host Networking name, if applicable.
- **Phone Number**: Host or Host network Netop Gateway Point-to-Point or Gateway telephone number or IP address or Network Point-to-Point IP address, if applicable.
- **Communication Profile**: Guest Communication Profile name.
- **Comment**: Optional user editable comment. A record generated by Browse for Hosts will show the Host user name, if enabled, and (Gateway) if the Host is a Netop Gateway.

To start a session with selected record Hosts, click a Session Buttons button or select a Session Commands command.

To execute an action on selected record Host computers, click an Action Buttons button or select an Action Commands command.

Double-click a record to start the default type session with the record Host, see the Program Options window General Tab.

Right-click a record or multiple selected records to show this context menu:
The first section contains **Session Commands**.

The second section contains **Action Commands**.

If one record is selected, a <Custom application> command can be included after action commands. Select this command to run the custom application. Assign a custom application to a Phonebook Record on the Connection Properties window Custom Tab.

**Disconnect**: See Other Commands.

Remaining commands match Edit Menu commands. However, the New command opens a slightly different sub-menu containing the following commands:

**Phonebook Entry**: Opens the Connection Properties dialog box which you can use to create a new phonebook entry using the Connect tab.

**Remote Desktop Entry**: Opens the Remote Desktop Connection dialog box, which you can use to create a remote desktop entry. On the General tab, specify logon settings and an .rdp file to be used for the entry. A remote desktop entry will be created and displayed in the records pane of the Phonebook tab together with a pseudo communication profile.

**Intel vPro Entry**: Select this command to add an Intel vPro entry to the phonebook. The command opens the vPro Connection Properties dialog box. On the Connection tab, enter a description and the IP/Host name for the connection. On the Credentials tab, select authentication method and enter credentials depending on the authentication method. If you select the Force using secured connection through TLS check box, a client certificate is required to establish the TLS (Transport Layer Security protocol) connection when the AMT device is configured for mutual TLS authentication. On the Certificate tab, specify the certificate to be used. See also Intel vPro Tab.

**Folder**: Opens the NewFolder box where you can create a new folder to be added to the Phonebook tab tree pane.

### 3.4.4.1.3 Phonebook Records

Phonebook records specify Host Connection Properties.

You can create as many phonebook records as you like, including multiple alternative phonebook records for the same Host.
To swiftly create phonebook records, add **Quick Connect Tab Netop Network Tab** Host records or copy **Quick Connect Tab Netop Network Tab** or **History Tab Records Pane** Host records to the **Phonebook Tab**.

You can create phonebook records by copying phonebook or history dwc files to the **Phonebook Tab** or by importing phonebook data in a comma separated file, see **Phonebook Export and Import**.

To create a phonebook record from scratch, showing the **Phonebook Tab** click the **Toolbar Phonebook Entry** button or select the **Edit Menu or Records Pane** context menu **New Phonebook Entry** command to show the **Connection Properties** window. Select a phonebook record first to base the phonebook record on the connection properties of the selected phonebook record.

To edit a phonebook record, select it and click the **Toolbar Connection Properties** button or select the **Edit Menu or Records Pane** context menu **Connection Properties** command to show its connection properties in the **Connection Properties** window.

You can copy and move phonebook records between the **Phonebook root folder and user-created folders**, also by drag and drop.

Phonebook records will be saved as files with the extension dwc in the PhBook directory that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\PhBook. dwc files are XML format files whose contents can be shown in any text editor. Passwords will be encrypted by a secure algorithm.

To connect to your favorite Hosts without loading Netop Guest first, copy their phonebook records to your computer desktop where they will show as dwc file icons. Double-click the file icon to start the default type session with the Host, see the **Program Options** window **General** tab. If not loaded, Netop Guest will load and run minimized in a notification area Netop Guest button. Right-click the dwc file icon to show a context menu with **Session Commands**, a **Connection Properties** command and standard desktop icon commands.

### 3.4.4.1.4 Phonebook Export and Import

You can export and import phonebook data in a comma separated values (CSV) file.

**Export**

Select a **Phonebook Tab Tree Pane** element or select one or multiple **Records Pane** records and select the **File Menu Export from Phonebook** command to show this window:

![Export from Phonebook](image)

**Export file name: [[Browse...]]:** Specify in this field the CSV file path and name. If you specify only a file name, the export file will be saved in the directory in which Netop Guest is installed. Click [[Browse...]] to show a Windows **Save As** window to select the directory and specify the name of the CSV file to specify the path and name in the **Export file name** field.

☐ **Export Passwords:** Check this box to include phonebook record passwords in the CSV file (default: unchecked).

**Note:** You cannot export phonebook record **Connection Properties** window **Display Tab**, **Keyboard/Mouse Tab**, **Compression/Encryption Tab**, **Desktop Tab** and **Record Tab** properties, but you can specify
CSV File Syntax

The CSV file is a plain text file. It contains for each phonebook record a line of values separated by commas according to this syntax:

`<Folder path>,<Description>,<Phone number>,<Name>,<Comment>,<Communication profile>,<Host logon name>,<Host logon password>,<Host logon domain>,<Gateway logon name>,<Gateway logon password>,<Gateway logon domain>,<Protect item password>,<Wake on LAN MAC address>,<Logon credentials flags>,<Custom application description>,<Custom application command line>.

Passwords will be encrypted as 32-digit hexadecimal checksums prefixed by `ENCRYPTED:`.

Import

Select the File Menu Import to Phonebook command to show this window:

- **Import file name:** Specify in this field the CSV file path and name. Click [Browse...] to show a Windows Open window to select the directory and specify the name of the CSV file to specify the path and name in the Import file name field.

- **Connection Properties...:** Click this button to show the Connection Properties window with the Display Tab, Keyboard/Mouse Tab, Compression/Encryption Tab, Desktop Tab and Record Tab to optionally specify imported phonebook record properties on these tabs.

- **OK:** Click this button to import the CSV file to create Phonebook Records in the CSV file specified phonebook structure.
3.4.4.2 Quick Connect Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab.

It enables you to connect to Hosts that you have not connected to before and Browse for Hosts.

It contains these elements:

- **Host Section**
- **Communication Profile Section**
- **Buttons**
- **Netop Network Tab**
- **Windows Network Tab**
- **Intel vPro Tab**

To connect or Browse for Hosts, first select a communication profile in the Communication Profile Section.

Then:

- **Connect by a Name and/or Address**, or
- **Browse for Hosts** to connect to one or multiple Hosts by records of responding Hosts.

**Note:** If connection fails, see Connect Problems.

### 3.4.4.2.1 Host Section

The contents of this Quick Connect Tab section:

**Host**

Name:

will depend on the Communication Profile Section selected Communication Profile Communication.
Netop Guest

**Device** type:
- Networking
- Point-to-Point or Gateway
- Network Point-to-Point
- Infrared

### 3.4.4.2.1.1 Networking

If in the *Communication Profile Section* you select a *Communication Profile* that uses a Networking Communication Device (NetBIOS (including RemPCNB v. 4.3), IPX (including RemPCIPX v. 4.3), TCP/IP, WebConnect or Terminal Server), the Host Section will have these contents:

![Host Section](image)

**Note:** To connect or browse by multiple networking Communication Profiles, enable them at Guest loading and select *<Any initialized communication>*.

**Name:** [:] To Connect, specify in the field of this drop-down box a name or address that is enabled on the Host, see NetBIOS Settings, IPX Settings, TCP/IP Settings or Terminal Server Settings. To Browse for Hosts, specify any number of Host name beginning characters to request that Hosts whose name begins with these characters respond. The drop-down box list will contain Host names or addresses that have been specified before. Select a name or address in the list to show it in the field.

**Note:** Netop will interpret the Name drop-down box field name according to the default Host name qualifier or a prefixed Host name qualifier, see the Program Options window Host Name Tab.

### 3.4.4.2.1.2 Point-to-Point or Gateway

If in the *Communication Profile Section* you select a *Communication Profile* that uses a Point-to-Point (ISDN (CAPI), Serial or Windows Modem) or Gateway Communication Device, the Host Section will have these contents:

![Host Section](image)

If you connect by Point-to-Point communication directly to a Host:

- specify in the Phone number drop-down box field the Host computer modem telephone number and leave the Name drop-down box field empty.

If you connect by Gateway communication through a Guest network Netop Gateway that connects by Point-to-Point or Network Point-to-Point communication to a Host:
- specify in the *Phone number* drop-down box field the Host computer modem telephone number if using point-to-point communication or IP address if using network point-to-point communication and leave the *Name* drop-down box field empty.

If you connect by **Point-to-Point** communication to a Host network Netop Gateway that connects to a network computer Host:

- specify in the *Phone number* drop-down box field the Host network Netop Gateway computer modem telephone number and optionally specify in the *Name* drop-down box field the Host name, see **Gateway Connection**.

If you connect by **Gateway** communication through a Guest network Netop Gateway that connects by **Point-to-Point** or **Network Point-to-Point** communication to a Host network Netop Gateway that connects to a network computer Host:

- specify in the *Phone number* drop-down box field the Host network Netop Gateway computer modem telephone number if using **Point-to-Point** communication or IP address if using **Network Point-to-Point** communication and optionally specify in the *Name* drop-down box field the Host name, see **Gateway Connection**.

The drop-down box lists will contain telephone numbers, IP addresses and Host names that have been specified before. Select a list entry to show it in the field.

**Note:** Netop will interpret the *Name* drop-down box field Host name according to the default Host name qualifier or a prefixed Host name qualifier, see the **Program Options** window *Host Name Tab.*

### 3.4.4.2.1.3 Network Point-to-Point

If in the **Communication Profile Section** you select a **Communication Profile** that uses a **Network Point-to-Point Communication Device** (TCP/IP (TCP), TCP/IP (TCP IPv6)), the **Host Section** will have these contents:

```
Host

TCP/IP Address: [field]

Name (Optional, use with gateway): [field]
```


If you connect directly to a Host, specify in the IP Address drop-down box field the Host computer IP address and leave the Name drop-down box field empty.

If you connect by Network Point-to-Point communication to a Host network Netop Gateway that connects to a network computer Host, specify in the IP Address drop-down box field the Netop Gateway computer IP address and optionally specify in the Name drop-down box field the Host name, see Gateway Connection.

The drop-down box lists will contain IP addresses and Host names that have been specified before. Select a list entry to show it in the field.

**Note:** Netop will interpret the Name drop-down box field name according to the default Host name qualifier or a prefixed Host name qualifier, see the Program Options window Host Name Tab.

### 3.4.4.2.1.4 Infrared

If in the Communication Profile Section you select a Communication Profile that uses the Infrared (IrDA) Communication Device, the Host Section will have these contents:

If you connect directly to a Host, leave the Name drop-down box field empty.

If you connect by infrared communication to a Host network Netop Gateway that connects to a network computer Host, optionally specify in the Name drop-down box field the Host name, see Gateway Connection.

The drop-down box list will contain Host names that have been specified before. Select a name in the list to show it in the field.

**Note:** Netop will interpret the Name drop-down box field name according to the default Host name qualifier or a prefixed Host name qualifier, see the Program Options window Host Name Tab.

### 3.4.4.2.1.5 Gateway Connection

If you connect by Point-to-Point or Gateway, Network Point-to-Point or Infrared communication to a Host network Netop Gateway without specifying a Host name in the Host Section Name drop-down box field, this window will be shown when connected to the Host network Netop Gateway:

Select one of these options:

- Remote Control Gateway: Connect to the Gateway (default selection).
- Connect to specific Host: [:] Specify in the field a Host network Host name to connect to the Host.
Browse for Hosts: Leave the field empty or specify any number of Host name first characters to Browse for Hosts on the Host network.

3.4.4.2.2 Communication Profile Section

To connect to a Host or Browse for Hosts from the Quick Connect Tab, first select in this section:

- a Communication Profile that will match a Communication Profile that is enabled on the Host or a connecting Netop Gateway.

Initially, the drop-down box selection will be TCP/IP. The drop-down box list will contain the names of Guest Communication Profiles. Select a name in the list to show it in the field.

Edit...: Click this button to show the Communication Profile Edit window to edit the selected Communication Profile.

New...: Click this button to show the Communication Profile Edit window to create a Communication Profile.

Delete: Click this button to delete the selected Communication Profile.

3.4.4.2.3 Buttons

The Quick Connect Tab has these buttons:

Connect: Click this button to connect to a Host by your selection in the Communication Profile Section and your specification in the Host Section to start the default type session, see the Program Options window General Tab. If connection fails, see Connect Problems.

Browse: Click this button to Browse for Hosts by your selection in the Communication Profile Section and your specification in the Host Section to show records of responding Hosts on the Netop Network Tab when the browse has timed out.

Disconnect: This button will be enabled only if connected by a Point-to-Point (ISDN (CAPI), Serial or Windows Modem) or Gateway Communication Device, see Point-to-Point or Gateway. Click the button to disconnect the point-to-point connection.

Connection Properties...: Click this button to show the Connection Properties window with a limited selection of tabs. Selections in this window will apply when connecting or browsing for Hosts from the Quick Connect Tab.

3.4.4.2.4 Netop Network Tab

This Quick Connect Tab tab will show Host records after a Browse for Hosts:

<table>
<thead>
<tr>
<th>Host ID</th>
<th>User Name</th>
<th>Phone number</th>
<th>Communication Profile</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIN2K3L... CK</td>
<td>TCP/IP</td>
<td>(Gateway)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WIN2K3L... CK</td>
<td>TCP/IP</td>
<td>(Gateway)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NETFILTER</td>
<td>TCP/IP</td>
<td>(Gateway)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NetOp Network / Windows Network
Netop Guest

The section title will show Browse list (created <Time>). To update the tab contents, browse again.

The tab pane will show Hosts records as icons or table records according to the Toolbar or View Menu selection (initially empty). Details will show Host records in a table with this column content:

- **Host ID:** Status indicator and Host record identifier, typically a Host specified Host ID or a directory service specified Host user name attribute. These status indicators can be shown:
  - A directory service returned this record, but the Host did not respond.
  - Host responded and is available.
  - Host responded but may not be available because it or another Guest running a session with it does not allow further connections. Verify by connecting.

- **User Name:** Host computer Windows or network logon user name, if enabled.
- **Phone Number:** Host network Netop Gateway telephone number or IP address, if applicable.
- **Communication Profile:** Guest communication profile name.
- **Information:** A Netop Gateway record will show (Gateway).

Click a record Host ID value to specify it in the Host Section Name field.

Double-click the record Host ID value to connect to start the default type session, see the Program Options window General Tab.

Right-click the Host ID value of a record or multiple selected records to show this context menu:

The first menu section contains Session Commands.

The second menu section contains Action Commands.

**Disconnect:** See Other Commands.

**Copy:** Select this command or the matching Edit Menu command to copy selected records to the clipboard. Pasting the clipboard content into a Phonebook Tab folder will save the records as Phonebook Records.

**Add to Phonebook:** Select this command to show a Windows Browse For Folder window to select the folder in which to add selected records as Phonebook Records.
3.4.4.2.5 Windows Network Tab

This Quick Connect Tab tab will contain Windows network names:

The tab pane will initially show records of Windows domains and workgroups recognized by the Guest computer as icons or table records according to the Toolbar or View Menu selection. Details will show domain and workgroup records in a table with these column contents:

- **Name**: Domain icon and domain or workgroup name.

Other columns will be empty.

Double-click a record to expand it into its computer records:

The tab pane will show records of selected domain or workgroup running computers as icons or table records according to the Toolbar or View Menu selection. Note: A computer record verifies that the computer is running but not that Netop Host is running on the computer.

Details will show computer records in a table with these column contents:

- **Name**: Computer icon and computer name.
- **Operating System**: Computer operating system name.
- **Version**: Computer operating system version.
- **Comment**: Computer comment, if any.

Click a record Name value to specify it in the Host Section Name field.

Double-click a record Name value to connect to start the default type session, see the Program Options window General Tab.

Note: The session will start only if Netop Host on the selected computer responds to connecting by the selected communication profile by its computer name.

Right-click the Name value of one or multiple selected records to show this context menu:
This menu matches the Netop Network Tab context menu.

### 3.4.4.2.6 Intel vPro Tab

The Netop Guest provides access to Intel vPro (sometimes also referred to as IAMT - Intel Active Management Technology) functionality which enhances your ability to remote manage enterprise computing facilities. The Netop Remote Control Guest can access vPro even when the computer is turned off, as long as the computer is connected to line power and to a network.

**Note:** Due to a limitation in Intel vPro, it is not possible to establish a connection to Intel vPro on the same computer as the one the Guest is running on.

The Intel Setup and Configuration Service (SCS) provides tools to centrally set up and configure AMT devices. SCS serves as a server for vPro and is also called a provisioning server.

Depending on which permissions the user has, the following SCS realms are relevant when using the vPro Console that the Netop Guest provides access to:

<table>
<thead>
<tr>
<th>Realm</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Info</td>
<td>Required</td>
</tr>
<tr>
<td>EventLogViewer</td>
<td>If the user has permission to this realm, the Event Management tab will be available, but the Remove all and Filters and Subscriptions buttons will be disabled. So the user will not be able to change anything.</td>
</tr>
<tr>
<td>Event Management</td>
<td>If the user has permission to this realm, the Event Management tab will be enabled and all buttons will also be enabled. So the user will be able to make changes.</td>
</tr>
<tr>
<td>Remote Control</td>
<td>If the user has permission to this realm, the Remote Control tab will be enabled and the user will be able to execute remote control commands.</td>
</tr>
<tr>
<td>Redirection Interface</td>
<td>If user has permission to this realm, the user will be able to execute serial/IDE redirection commands from the Remote Control tab.</td>
</tr>
</tbody>
</table>

If the user has permissions to neither the Event Management tab nor the Remote Control tab, an “Authentication failed” message box is displayed. This means that either User or Password is wrong or there are no appropriate permissions for the user in question.

**Note:** Even though computers contain Intel vPro technology, the AMT devices will not be operational until they have been enabled (also called provisioning) in BIOS.

Intel vPro enables you to:
• Remotely access BIOS configuration of the managed computer.

• Remotely boot the managed computer from a floppy or CD-ROM image located on the managing computer.

• Retrieve and view the hardware log file of the managed computer.

The Intel vPro tab will be displayed at the bottom of the Quick Connect tab pane following the Windows Network tab. When you start the Guest, the Intel vPro pane will be empty.

Right-click the Intel vPro pane to display a context menu containing the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scan IP range for Intel vPro enabled computers | Select this command to scan for Intel vPro enabled computers on your network. You can enter one known IP address to scan for or you can enter an IP range to scan. The computers found during the search will be listed in the Intel vPro pane by IP address. See picture above.  
  **Note:**  
  You can also use the Guest Inventory tab (Summary - Intel vPro State) to find Intel vPro enabled computers on your network. |
| Retrieve Intel vPro enabled computers from SCS | Select this command or press the Browse button on the Quick Connect tab to retrieve Intel vPro enabled computers from Intel SCS. You must enter the SCS Web Service URL. See also Intel vPro Tab (Program Options). |

When you have found one or more vPro enabled computers on your network, the above menu will be extended with the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Intel vPro Console</td>
<td>Right-click a computer in the list in the Intel vPro pane and select this command to open the vPro Console from which you can manage the selected computer. You need a user name and password to log on.</td>
</tr>
<tr>
<td>Open Intel vPro Web Interface</td>
<td>Right-click a computer in the list in the Intel vPro pane and select this command to go to the Intel vPro Active Management Technology web page (http) from which you can manage the selected computer. You need to enter a user name and password to log on to the web page.</td>
</tr>
</tbody>
</table>
Netop Guest

Open Intel vPro Web Interface (Secure)  As above, but using secured connection (https).

Add to phonebook Right-click a computer (IP address) in the list in the Intel vPro pane and select this command to add the address to the phonebook.

Note: You can also add Intel vPro entries to the phonebook by right-clicking the right pane on the Phonebook tab.

Delete Right-click a computer in the list in the Intel vPro pane and select this command to remove the computer from the list.

Delete All Right-click the Intel vPro pane and select this command to remove all computers from the list in the Intel vPro pane.

Log on to the vPro Console
1. Right-click a computer in the list in the Intel vPro pane and select Open Intel vPro Console.
2. In the Credentials tab of the displayed Netop vPro Console Logon window, select authentication method:
   - Digest authentication
   - Kerberos authentication

   If you select Digest authentication, enter user name and password. Select the Force using secured connection through TLS check box, if you prefer. Normally Transport Layer Security (TLS) is automatically detected and used when available, but if you select this check box, the vPro Console will only use secured connection to log on to the AMT device. If the AMT device is not configured to use TLS, you will receive an error message and the connection will not be established.

   If you select Kerberos authentication, the tab will look slightly different, and either a current Windows user account or a different user account (user, password, domain) can be used to log on to the AMT device. In addition to the Force using secured connection through TLS check box, you will see a Log on using current Windows account check box. This check box is selected by default, and as a consequence the User name, Password, and Domain fields are disabled, and the credentials of the current Windows user will be used.

   Note: When using Kerberos authentication the console should be connected to the Host using FQDN name (fully qualified domain name). For example, it is not possible to do the Kerberos authentication when connecting to an AMT device using its IP address.

3. If you select the Force using secured connection through TLS check box, a client certificate is required to establish the TLS connection when the AMT device is configured for mutual TLS authentication. Click the Certificate tab and specify the certificate to be used by first selecting either Personal Certificate Storage or File in the Location list and then selecting the certificate in the Certificate combo box.
4. Click Log on to log on to the vPro Console.
The vPro Console

When you have logged on to the vPro Console this is the window that you will be presented with:

The vPro Console window contains a toolbar at the top and two tabs: the Event Management tab, on which you can retrieve and view the Intel vPro Event Log for the computer being managed, and the Remote Control tab, on which you can access the BIOS of the computer, boot from a floppy or CD-ROM image, and manage the power state of the computer remotely.

The Event Management tab

The Event Management tab displays the Intel vPro Event Log for the computer being managed. The events are displayed in the Intel vPro Event Log pane with information about severity, time, and entity together with a description. Selecting an event in the pane will display further details about the event in the area below the pane.

In the bottom right corner of the vPro Console window you see a security indicator, a lock icon. A closed lock indicates that a secured connection is being used, while an open lock indicates that an unsecured connection is being used. In the top right corner you see a network activity indicator that looks like a flower. This icon indicates that the vPro Console is waiting for response from the remote AMT device.

At the top of the vPro Console window you find a toolbar with tools that you can apply to the log. In addition to the Refresh button, the Remove All button, and the Save to File button (save events to a .txt (tab delimited) file or a .csv (comma delimited) file), a Filters and Subscriptions button is available.
Netop Guest

Manage filters, alerts, and subscriptions

The Filters and Subscriptions button opens a window from which you can manage event filters, alerts and subscriptions. The Event Filters, Alerts and Subscriptions window is divided into two areas, on the left a tree pane listing the alerts and filters set on the AMT device and on the right a dialog panel. The dialog panel changes depending on the node selected in the tree pane. The toolbar above the tree pane contains buttons that you can apply to the tree nodes. The toolbar changes depending on the node you select in the tree pane.

Root node

If you select the root node, the dialog panel displays system information on two tabs:

• Use the System Sensors tab to see a list of sensors and a detailed description of the currently selected sensor.

• Use the Alert Settings tab to change the SNMP community strings for alerts.

In addition to the Refresh button on the toolbar, you see an Add Alert button that you can use to add a new alert to the tree.

**Note:** The alert ID entry in the tree can be edited. However, depending on your user rights you may or may not be able to change alert ID entries and associated filters and subscriptions. Non-administrator users cannot change subscriptions owned by other users. Administrators can take ownership of other users' subscriptions (AMT 2.5 and later).
If you select an Alert ID node, the dialog panel displays a list of subscriptions for the alert. When an alert with the specified ID is triggered on the remote AMT device, the PET (Platform Event Trap) or SOAP (Simple Object Access Protocol) event will be sent to all IP addresses or URLs subscribing to this alert.

**Note:** A platform event is defined as an event that is originated directly from platform firmware (BIOS) or platform hardware independently of the state of the operating system or system management hardware. The Platform Event Trap format is used for sending a platform event in an SNMP Trap.

You can select and remove one or more subscriptions (click the first, hold down SHIFT, and click the next) from the list using the Remove button below the list.

You can also add SNMP subscriptions from the Add SNMP subscription section at the bottom of the Alert Subscriptions dialog panel:

1. Enter the IP address you want to subscribe to the alert in the IP address field.
2. Select the Use custom community string check box (available on AMT 2.5 and later, disabled for older versions).
3. When you have selected the Use custom community string check box, the Community string field below will display public by default, but you can change it.
4. Then click the Add button to add the specified IP address to the list of subscriptions.

In addition to the Refresh button on the toolbar, an Add Filter button is available. Use this button to create a new filter with default properties under the currently selected alert ID. The filter properties are displayed in the Event Filter Properties dialog panel on the right. Click the Apply button at the bottom of the dialog panel for the new filter with default properties to be created.

On the toolbar you will also see a Remove button. Use this to remove all filters under the selected alert node and cancel all the subscriptions. You will be prompted for confirmation when you select the Remove button.
If you select a filter node, the dialog panel displays editable properties for the selected filter:

<table>
<thead>
<tr>
<th>Property section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter settings</strong></td>
<td>In the <em>Filter settings</em> section you can enable the filter by selecting the <em>Enable event filter</em> check box. If you don't select the check box, the filter is disabled and no actions are performed.</td>
</tr>
<tr>
<td><strong>Filter criteria</strong></td>
<td>In the <em>Filter criteria</em> section you can set various criteria for the filter. When an event matches the specified filter criteria, the action specified in the <em>Filter action</em> section will be performed.</td>
</tr>
<tr>
<td><strong>Filter action</strong></td>
<td>In the <em>Filter action</em> section you can set the action to be performed when the event matches the specified filter criteria. Selecting the <em>Log event</em> check box will have the effect that events matching the specified filter criteria will be written to the log on the AMT device. Selecting the <em>Alert event</em> check box will have the effect that events matching the specified filter criteria will trigger the alert.</td>
</tr>
<tr>
<td><strong>Alert settings</strong></td>
<td>In the <em>Alert with severity</em> field you can set the Event severity field in a PET alert. When an alert is generated either the event's own severity or a severity for matching filters, whichever has the highest numerical value, will be used for the specified <em>Alert ID</em>.</td>
</tr>
</tbody>
</table>

**Numerical values for severity levels:**

- 00h  Unspecified
Netop Guest

01h Monitor

02h Information

04h OK (return to OK condition)

08h Non-critical, a.k.a Warning

10h Critical

20h Non-recoverable

Example:

We have an event with the severity Monitor and 3 filters match the event. Alert with severity for one filter is set to Unspecified, for the second filter to Information and for the third filter to Critical. The value Critical will then be used. This is because the severities correspond to numerical values: Unspecified corresponds to the lowest value, Monitor corresponds to a higher value, Information corresponds to an even higher value, and Critical corresponds to the highest value of the four.

If all filters have the severity Unspecified, then the event’s original Monitor severity will be used because it constitutes the severity with the highest numerical value.

In the Alert ID list, select the filter’s Alert ID.

You must click the Apply button to save any changes that you make to the filter properties. If you click Close after having made changes to the properties, you will be asked whether you want to save the changes.
The Remote Control tab

The Remote Control tab provides access to the terminal window which you can use for remote BIOS access and floppy/CD-ROM redirection.

The toolbar for the Remote Control tab contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Control</td>
<td>The menu that opens when you click the Remote Control button down arrow on</td>
</tr>
<tr>
<td></td>
<td>the toolbar contains the following menu commands:</td>
</tr>
<tr>
<td></td>
<td>Normal Reboot</td>
</tr>
<tr>
<td></td>
<td>Reboot to BIOS* (If you click the Remote Control button instead of</td>
</tr>
<tr>
<td></td>
<td>the down arrow, this menu command will be selected by default)</td>
</tr>
<tr>
<td></td>
<td>Boot from Console Floppy</td>
</tr>
<tr>
<td></td>
<td>Boot from Console CD</td>
</tr>
<tr>
<td></td>
<td>When you select menu commands on the Remote Control menu, you will be able</td>
</tr>
<tr>
<td></td>
<td>to see the screen of the computer being booted on the Remote Control tab of</td>
</tr>
<tr>
<td></td>
<td>the vPro Console.</td>
</tr>
<tr>
<td>Execute Command</td>
<td>The menu that opens when you click the Execute Command button down arrow</td>
</tr>
<tr>
<td></td>
<td>on the toolbar contains the following menu commands:</td>
</tr>
<tr>
<td></td>
<td>Normal Reboot* (If you click the Execute Command button instead</td>
</tr>
</tbody>
</table>


of the down arrow, this menu command will selected by default)

   *Boot from Console Floppy*
   
   *Boot from Console CD*

When you select menu commands on the *Execute Command* menu, the boot command will be executed on the remote computer, but you will not see the screen of the computer being booted on the *Remote Control* tab of the *vPro Console*.

**Power**

The menu that opens when you click the *Power* button on the toolbar contains the following menu commands that you can use to manage the power state of the remote computer:

   *Power On*
   
   *Power Off*
   
   *Cycle Power Off and On* (default)

**IDE Redirection Settings**

Clicking the *IDE Redirections Settings* button on the toolbar opens the *IDE Redirections Settings* window where you can select settings for *Floppy redirection* and *CD redirection*, that is the drives and image files that are to be used for *Boot from Console Floppy* and *Boot from Console CD*.

**Netop vPro Console Settings**

Clicking the *Terminal Settings* button on the toolbar opens the *Netop vPro Console Settings* window where you can edit settings for the following:

   *Terminal* - Set *Font* and *Emulation*.
   
   *Keyboard* - Set *Special key mode* and *Send Esc button code*.
   
   *Warnings* - Select the warnings that you want to receive in relation to the *Keyboard* settings:
   
      - *Warn if the special key mode cannot be detected automatically*
      - *Warn when trying to detect keyboard mode without having Hardware Assets Realm permission*

### 3.4.4.2.7 Connect by a Name and/or Address

To connect to a Host by a Host name and/or address, identify whether you can connect directly, through a Guest network Netop Gateway or through a Host network Netop Gateway.

To connect directly:

1. Select in the *Quick Connect Tab Communication Profile Section* a *Communication Profile* that matches a *Communication Profile* that is enabled on the Host.

   **Note:** If the *Networking Communication Devices* of the *Communication Profiles* enabled on the Host are unavailable or cannot be enabled on the Guest, see [Unavailable Networking Communication Devices](#).

2. Specify in the *Host Section* a name enabled on the Host, the Host computer modem telephone number or Host computer IP address as required by the *Communication Device* type, see [Networking](#), [Point-to-Point or Gateway](#), [Network Point-to-Point](#) or [Infrared](#).

3. To connect:
Netop Guest

- Click the **Connect** button to connect to start the default type session, see the **Program Options** window **General Tab**, or
- Click a **Toolbar Session Buttons** button or select a **Connection Menu Session Commands** command to connect to start a session, or
- Click a **Toolbar Action Buttons** button or select a **Connection Menu Action Commands** command to connect to execute an action.

To connect through a Guest network Netop Gateway:

1. Select in the **Communication Profile Section** a **Communication Profile** that uses the **Gateway Communication Device** to show the **Host Section** explained in the **Point-to-Point or Gateway** topic.
2. Specify in the **Host Section** what is required to connect to the Host and connect as explained above.

To connect through a Host network Netop Gateway:

1. Select in the **Communication Profile Section** a **Communication Profile** that will connect to the Host network Netop Gateway.
2. Specify in the **Host Section** **Phone number** or **IP address** drop-down box field the Host network Netop Gateway computer modem telephone number or IP address as required and in the **Name** drop-down box field the Host name and connect as explained above.

If connection fails, see **Connect Problems**.

**Note**: If the Host is connected to by a **Networking Communication Device**, you can **Browse for Hosts** to verify that the Host is available.

### 3.4.4.2.8 Unavailable Networking Communication Devices

If the **Networking Communication Devices** of the **Communication Profiles** that are enabled on the connect to Netop module are unavailable or cannot be enabled on the connect from Netop module, you can connect or **Browse for Hosts** through a Netop Gateway.

The **Terminal Server Communication Device** is available on a terminal server Netop module but unavailable on a network computer Netop module. To connect between a network computer Netop module and a terminal server Netop module, a terminal server console Netop Gateway can route the communication, see also the **Administrator’s Guide** Advanced Tools chapter **Netop in Terminal Server Environments** section.

On Guest and Host, enable **Networking Communication Profiles**.

On Netop Gateway, enable matching **Networking Communication Profiles**.

Connect by **<Any initialized communication>** that will use enabled **Networking Communication Profiles** and request that any Netop Gateway that receives the communication shall route it to other enabled **Networking Communication Profiles**.

### 3.4.4.2.9 Browse for Hosts

If you can connect to a Host directly or indirectly through a Host network Netop Gateway by a **Networking Communication Device**, you can also browse for Hosts.

**Note**: When you connect by a **Networking Communication Device** using the Host name qualifier **H::** (Host ID) or **U::** (User name), you actually always browse (broadcast a name) to request Hosts to respond by the specified name. Host name qualifiers are explained in the **Program Options** window **Host Name Tab** topic.

To browse for all directly reachable Hosts, select in the **Quick Connect Tab Communication Profile Section** a communication profile that uses a **Networking Communication Device**, leave the **Host Section** empty and click the **Browse** button to show records of responding Hosts on the **Netop Network Tab**.

Specify in the **Host Section** any number of name first characters to limit the browse response to names with these first characters.
To browse indirectly through a Host network Netop Gateway, see Gateway Connection. This will also show records of responding Hosts on the Netop Network Tab.

If you use the LDAP:: Host name qualifier, a browse for Hosts will search directory services specified on the Program Options window Directory Services Tab for users to show matching user name attributes and user address attributes (typically IP addresses) on the Netop Network Tab. The Guest will browse by the received user address attributes to indicate which Hosts are available.

Specify in the Host Section a user name mask (a user name with wildcard characters like * designating any characters) to limit the directory services search to matching users.

From the Netop Network Tab, you can connect to responding Hosts by record selection.

3.4.4.3 Connections Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab:

It will show records of connected Hosts as icons or table records according to the Toolbar or View Menu selection. Details will show Host records in a table with these column contents:

- **Sessions**: Icons of running sessions.
- **Name**: Host Networking communication name, if applicable.
- **Phone Number**: Host or Host network Netop Gateway Point-to-Point or Gateway communication telephone number or IP address or Network Point-to-Point communication IP address, if applicable.
- **Communication Profile**: Guest communication profile name.

Right-click a record to show this context menu:

- **Remote Control**
- **File Transfer**
- **Chat**
- **Audio-Video Chat**
- **Remote Management**
- **Run Program**
- **Browse**
- **Execute Command**
- **Send Message**
- **Get Inventory**
- **Disconnect**

The first section contains Session Commands.

The second section contains Action Commands.

Disconnect: See Other Commands.
3.4.4.4 History Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab:

It stores records of historical Host connections.

It contains an optional left Tree Pane and a right Records Pane.

The Tree Pane will show the history directory structure. To hide/show the Tree Pane, click the Toolbar Tree Window button or select the View Menu Tree Window command (default: shown).

The Records Pane will show the History Records in the history directory selected in the Tree Pane.

3.4.4.4.1 Tree Pane

This is the History Tab tree pane:

It will initially contain only a History folder that will be the root of the History directory structure.

Right-click in the pane to show this context menu:

- Cut
- Copy
- Paste
- New Folder
- Delete
- Rename

From this menu, you can manage your History directories. You can also manage directory folders by drag and drop.

Commands match Edit Menu commands.
3.4.4.4.2 Records Pane

This is the History Tab records pane:

It will show the History Records in the selected Tree Pane folder as icons or table records according to the Toolbar or View Menu selection. Details will show records in a table with these column contents:

- **Description**: Communication device type icon (Networking, Point-to-Point, Gateway, Network Point-to-Point or Infrared) and record identifying description.
- **Created**: Date and time of last connection by this record.
- **Name**: Host Networking name, if applicable.
- **Phone Number**: Host or Host network Netop Gateway Point-to-Point or Gateway telephone number or IP address or Network Point-to-Point IP address, if applicable.
- **Communication Profile**: Guest Communication Profile name.
- **Comment**: Optional user editable comment. A record generated by Browse for Hosts will show the Host user name, if enabled, and (Gateway) if the Host is a Netop Gateway.

To start a session with selected record Hosts, click a Session Buttons button or select a Session Commands command.

To execute an action on selected record Host computers, click an Action Buttons button or select an Action Commands command.

Double-click a record to start the default type session with the record Host, see the Program Options window General Tab.

Right-click a record or multiple selected records to show this context menu:
Netop Guest

The first section contains Session Commands.
The second section contains Action Commands.
Disconnect: See Other Commands.
Remaining commands match Edit Menu commands.

3.4.4.4.3 History Records

A history record will automatically be created in the History Tab History root folder when disconnecting from a Host. An older history record in the folder with the same Description will be overwritten.

You can copy and move history records between the History root folder and user-created folders, also by drag and drop. Copy your favorite history records to the Phonebook Tab to serve as Phonebook Records.

History records will be saved as files with the extension dwc like Phonebook Records in the History directory that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\History.

3.4.4.5 Help Request Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab:

<table>
<thead>
<tr>
<th>Host ID</th>
<th>Time</th>
<th>Help Service</th>
<th>Problem Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG0003</td>
<td>15:30:41</td>
<td>NetOp Help</td>
<td>Remote print setup</td>
</tr>
</tbody>
</table>

Note: To service help requests, enable Communication Profiles at Guest loading and enable help services, see the Program Options window Help Request Tab.

If help requests are pending, this icon will be shown in the Status Bar and in the notification area in the lower right corner of the screen:

Double-click the notification area button to show the Help Request tab.

The Help Request tab pane will show records of pending help requests as icons or table records according to the Toolbar or View Menu selection. Details will show help request records in a table with these column contents:

- **Host ID:** Help request icon and Host identification.
- **Time:** Time of the help request.
- **Help Service:** Name of the help service to which the help request was sent, see the Program Options window Help Request Tab.
- **Problem Description:** Host specified problem description.

To respond to a help request, typically double-click the record to start the default type session, see the Program Options window General Tab.

Right-click a record to show this context menu:
The first section contains **Session Commands**.

*Copy to clipboard* expands into table column name and **All** commands. Select a table column name command to copy the selected table column record value to the clipboard. Select **All** to copy all record values to the clipboard to typically paste them into a help request management system table.

**Note:** The **Program Options** window **Help Request Tab** includes **Advanced Help Service** options.

Remaining commands match **Edit Menu** commands.

**Note:** **Delete** will remove the selected record but not cancel the pending help request.

### 3.4.4.6 Recordings Tab

This **Tab Panel** tab will be shown unless hidden from the **Program Options** window **Layout Tab**:

It provides access to **Remote Control** session recordings.

**Note:** To record **Remote Control** sessions, enable recording generally on the **Program Options** window **Recordings Tab** or for each connection or Host record on the **Connection Properties** window **Record Tab**.

The **Recordings tab** contains an optional left **Tree Pane** and a right **Records Pane**.

The **Tree Pane** will show the recordings directory structure. To hide/show the **Tree Pane**, click the **Toolbar TreeWindow** button or select the **View Menu** **Tree Window** command (default: shown).

The **Records Pane** will show the **Recording Records** in the recordings directory selected in the **Tree Pane**.
3.4.4.6.1 Tree Pane

This is the Recordings Tab tree pane:

It will initially contain only a Recordings root folder.

Right-click in the pane to show this context menu:

- Cut
- Copy
- Paste
- New Folder
- Delete
- Rename

From this menu, you can manage your Recordings directories. You can also manage directory folders by drag and drop.

Commands match Edit Menu commands.

3.4.4.6.2 Records Pane

This is the Recordings Tab records pane:

It will show the Recording Records in the selected Tree Pane folder as icons or table records according to the Toolbar or View Menu selection. Details will show records in a table with these column contents:

- Recorded: Recording icon and recording date and time.
- Duration: Duration of recording.
- Guest ID: Remote controlling Guest name.
- Host ID: Remote controlled Host name.
- Description: Remote controlled Host record Description column value.

Double-click a record to play back the Remote Control session recording in this window:
This window will initially have the same size as the Remote Control Display from which the session was recorded.

The title bar will show the remote controlled Host record Description column value. The window control menu includes playback control commands matching the playback control buttons explained below.

The toolbar contains these playback control buttons:

- **Stop**: Click this button to close the window.
- **Pause**: Click this button to make it appear pressed in to pause playback. Click this button appearing pressed in to release it to resume playback.
- **Play**: Click this button to make it appear pressed in to start playback or resume playback when paused. When playback has ended, this button is disabled.
- **Back**: Click this button to return to the beginning of the recording showing a black show area. The Pause button will appear pressed in and the Play button will be enabled.

**Playback Speed**: By default, the spin box field will show x1 indicating true speed. Click the up/down buttons to change the playback speed by a factor x1 to x20 as shown in the spin box field.

The status bar contains a colored blocks progress indicator and a playback time counter.

Right-click a record or multiple selected records to show this context menu:
Netop Guest

**Playback Recording:** Select this command or double-click the record to play back the last clicked recording record in the Recording Playback window.

Remaining commands match Edit Menu commands.

### 3.4.4.6.3 Recording Records

If Remote Control session recording is enabled, each Remote Control session will create a recording record in the Recordings Tab Recordings root folder.

You can copy and move recording records between the Recordings root folder and user-created folders, also by drag and drop.

Recording records are saved as <Date><Time>-<Guest name>-<Host name>.dwr files in the record directory that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\record. You can play back recording files only from Netop Guest.

### 3.4.4.7 Script Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab:

It provides access to Netop scripts and the Script graphical Netop Script editor window.

**Note:** Netop Scripts are user-specified command structures that can execute scheduled Netop actions, typically file transfers.

The Script tab contains an optional left Tree Pane and a right Records Pane.

The Tree Pane will show the script directory structure. To hide/show the Tree Pane, click the Toolbar TreeWindow button or select the View Menu Tree Window command (default: shown).

The Records Pane will show the Script Records in the script directory selected in the Tree Pane.
3.4.4.7.1 Tree Pane

This is the Script Tab tree pane:

It will initially contain only a "Script" root folder.

Right-click in the pane to show this context menu:

- Cut
- Copy
- Paste
- New Folder
- Delete
- Rename

From this menu, you can manage your "Script" directories. You can also manage directory folders by drag and drop.

Commands match Edit Menu commands.

3.4.4.7.2 Records Pane

This is the Script Tab records pane:

It will show the Script Records in the selected Tree Pane folder as icons or table records according to the Toolbar or View Menu selection. Details will show records in a table with these column contents:

- **Name**: Script icon and script file name.
- **Status**: Status information, e.g. *Edit* if the script is being edited or *Running* if the script is running.
- **Size**: Script file size in bytes.
- **Comment**: An optional comment specified in the Script window.

Double-click a record to run the record script, see Test a Netop Script.

Right-click one or multiple selected records to show this context menu:
Edit: Select this command to open the last selected record script in the Script window.

Run/Stop: Select this command to run/stop the last selected record script, see Test a Netop Script.

Remaining commands match Edit Menu commands.

3.4.4.7.3 Script Records

By default, records of new Netop Scripts will be placed in the Script Tab Script root folder. You can copy and move script records between the Script root folder and user-created folders, also by drag and drop.

Script records are typically saved as files with the extension dws in the script directory that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\script. You can open a Netop Script file in a text editor to edit it. To avoid syntax errors, we recommend that you edit Netop Scripts in the Script window.

3.4.4.8 Inventory Tab

This Tab Panel tab will be shown unless hidden from the Program Options window Layout Tab:

It will show stored Host computer inventories.

It contains a left Contents Pane and a right Details Pane.

The Contents Pane will show the inventory directory structure. Each inventory directory folder can contain Host computer inventories that branch out into inventory elements.

The Details Pane will show details of the inventory directory, Host computer inventory or inventory element selected in the Contents Pane.
3.4.4.8.1 Contents Pane

This is the Inventory Tab contents pane:

It will initially contain only an Inventory root folder.

Right-click a directory folder or a Host computer inventory to show this context menu:

- Cut
- Copy
- Paste
- New Folder
- Delete
- Rename

From this menu, you can manage your Inventory directories. You can also manage directory folders by drag and drop.

Commands match Edit Menu commands.

Select an inventory directory to show summary details of Host computer inventories in it in the Details Pane.

Select a Host computer inventory to show summary details of it in the Details Pane.

Select a Host computer inventory element to show details of it in the Details Pane.

3.4.4.8.2 Details Pane

This is the Inventory Tab details pane:

It will show details of the element selected in the Contents Pane.

If an inventory directory is selected, it will show the directory Host computer inventories as records in a table with inventory details specified on the Program Options window Inventory Tab in columns.

If a Host computer inventory or an inventory element is selected, it will show inventory element details as records in a table with the columns Item and Value.
Right-click a Host computer inventory record to show this context command:

Select this command to delete the Host computer inventory. You cannot delete details of a Host computer inventory.

3.4.4.8.3 Host Computer Inventories

Get Host computer inventories from the Toolbar Get Inventory button or the Connection Menu Get Inventory command.

New Host computer inventories will be placed in the Inventory Tab Inventory root folder. A new inventory will overwrite an older inventory identified by the same Host name. You can copy and move inventories between the Inventory root folder and user-created folders, also by drag and drop.

Host computer inventories will be saved as files with the extension xml in the inventor directory that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\inventor. You can open xml files in any text editor.

To process Host computer inventory information, specify in the Program Options window Inventory Tab Advanced Inventory Options window an inventory processing program.

3.4.5 Status Bar

The Netop Guest Window status bar will be shown unless hidden from the Program Options window Layout Tab:

It can show these icons at its right end:

**Telephone icon:** This icon will be shown if a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device (ISDN (CAPI), Serial, Windows Modem, TCP/IP (TCP), TCP/IP (TCP IPv6) or Infrared (IrDA)) is enabled at Guest loading.

**Yellow pages icon:** This icon will be shown if when a Communication Profile that uses the TCP/IP Communication Device is enabled in the Advanced TCP/IP Configuration window the Use Netop Name Server box is checked. These symbols can be shown on the icon:

- **Nothing:** Specified Netop Name Servers are available.
- **Red X:** None of the specified Netop Name Servers is available.
- **Red exclamation mark:** One of two specified Netop Name Servers is available.

**Life belt icon:** This icon will be shown if a help request is pending, see Help Request Tab.

When the mouse pointer is over a menu command or Toolbar button, the status bar will be cleared and a hint will be shown in it unless disabled on the Program Options window Layout Tab.
3.5 Guest Tools

The Netop Guest Window Tools Menu contains these commands:

- Program Options
- File Manager Options
- Log Setup
- Maintenance Password
- Communication Profiles
- Modem Database
- Check For New Updates
- Publish New Updates
- Run Setup Wizard
- Copy Guest to removable media
- Debug Trace

They are explained in these sections:

- Program Options
- File Manager Options
- Log Setup
- Maintenance Password
- Communication Profiles
- Modem Database
- Check for New Updates
- Publish New Updates
- Debug Trace
- Run Setup Wizard
- Copy Guest to Removable Media

Guest tool settings will be written to Netop Configuration Files that will typically reside in the directory
C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest
3.5.1 Program Options

Select the **Tools Menu** *Program Options* command to show this window:

- **Layout Tab**
- **General Tab**
- **Cache Tab**
- **Logon Tab**
- **Host Name Tab**
- **Directory Services Tab**
- **Remote Control Tab**
- **Clipboard Tab**
- **Monitor Tab**
- **Audio-Video Chat Tab**

It has these tabs:

- **Layout Tab**
- **General Tab**
- **Cache Tab**
- **Logon Tab**
- **Host Name Tab**
- **Directory Services Tab**
- **Remote Control Tab**
- **Clipboard Tab**
- **Monitor Tab**
- **Audio-Video Chat Tab**
Note: Some Program Options changes require Netop Guest to be reloaded to become applied.

3.5.1.1 Layout Tab

This is the Guest Program Options window Layout tab:
Netop Guest

It specifies Netop Guest Window layout options.

Enable

☑ Tool bar: Uncheck this box to remove the Tool bar (default: checked).
☑ Status line: Uncheck this box to remove the Status Bar (default: checked).
☑ Menu hints: Uncheck this box to disable the show of menu command and Toolbar button hints in the Status Bar (default: checked).
☑ Add Guest icon to tray: Uncheck this box to show no Netop Guest button in the notification area when Netop Guest is loaded (default: checked).
☑ Hide Guest from taskbar when minimized: This option will be available only if Add Guest icon to tray is checked. Uncheck this box to show the minimized Netop Guest as a button in the taskbar at the bottom of the screen (default: checked). If checked, the minimized Netop Guest will be shown only as a Netop Guest button in the notification area in the lower right corner of the screen.
☐ Save Guest minimize state on exit: Check this box to load Netop Guest minimized if minimized when last unloaded (default: unchecked).
☐ Stealth mode (hide Guest when started): Check this box to load Netop Guest hidden to the computer user (default: unchecked).

To unhide Netop Guest when loaded in stealth mode, execute showgst.exe that resides in the directory in which Netop Guest is installed.

Tab layout

The scrolling pane contains a check boxed list of available Tab Panel tab names:
☑ Phonebook
☑ Quick Connect
☑ Connections
☑ History
☑ Help Request
☑ Recordings
☑ Script
☑ Inventory

Uncheck a box to remove this tab from the Tab Panel (default: all checked).

Up/Down: The scrolling pane top-to-bottom tab name order controls the Tab Panel left-to-right tab order. Select a scrolling pane tab name and click one of these buttons to move it.

Note: The tab order above is the initial tab order. The Quick Connect Tab will be shown in front.
3.5.1.2 General Tab

This is the Guest Program Options window General tab:

It specifies general connect options.

Host session default mode

Select one of these sessions to start it when you connect to a Host by clicking the Quick Connect Tab Connect button or by double-clicking a Tab Panel tab Host record:

- Remote control (default selection)
- File transfer
- Chat
- Audio-video chat
- Remote management

Inactivity

Inactivity timeout: $[]$ min. ($0 = Unlimited$): Specify in this field a number to disconnect if there has been no Guest user keyboard or mouse activity within the specified number of minutes (default: $0$, range 0-
Netop Guest

999).

Keep Alive

☐ Send keep alive message: Check this box to send a data packet at intervals while connected to alert the Guest if the connection has been lost (default: unchecked).

Note: To maintain an ISDN (CAPI) connection during short periods of inactivity, do not check this box but select the ISDN (CAPI) Communication Profile Edit Short-hold mode option.

Confirm when

☐ Exiting Guest while connected: Check this box to show this warning if you attempt to unload the Guest while being connected to a Host (default: unchecked):

Yes: Click this button to unload the Guest.

No: Click this button to cancel the unload attempt.

Connection

Connection attempts: [ ] (0: Indefinite): Specify in the field a number in the range 1-999 to automatically make this number of connection attempts to connect to a Host (default: 1).

Auto reconnect: [ ]: The field of this drop-down box will show the selected reconnect option if a connection is lost. The drop-down box list contains these options:

- Never: Never reconnect (default selection).
- Abnormal disconnect only: Reconnect only if the connection was lost by an abnormal event.
- Host disconnect only: Reconnect only if the Host disconnected.
- Always: Always reconnect.

Select an option in the list to show it in the field.
3.5.1.3 Cache Tab

This is the Guest Program Options window Cache tab:

It specifies Remote Control screen image disk cache options.

When the Guest Remote Controls a Host in Command Mode, the Guest will store the Host screen image in disk cache memory to transfer only image changes to speed up Host screen image update and save transmission bandwidth.

Select one of these options:

- Use separate cache file for each Host: Reserve a disk cache section for each connected and disconnected Host (default selection). If you connect to many different Hosts, a large total disk cache size will be required to achieve high update and reconnect speed.

- Use shared cache file for all Hosts: Share the available disk cache among connected and disconnected Hosts. Total disk cache size demand will typically be lower.

- Don't save cache between sessions: Share the available disk cache only among connected Hosts. Total disk cache demand will be lowest, but reconnects will be slower.

Limit total disk cache size to: [] KB. (200 - 64000): Specify in the field a number in the range, typically
larger than default if regularly running Command Mode Remote Control sessions with many different Hosts (default: 10000).

### 3.5.1.4 Logon Tab

This is the Guest Program Options window Logon tab:

![Program Options window](image)

It specifies Guest logon and name options.

**Guest ID**: The contents of this field specify the name by which the Guest will identify itself when communicating (default: computer name). You can edit the field content. If the field is empty, the Guest will identify itself by its computer address, typically IP address or network card MAC address.

**Note**: If the Guest runs on a network computer, we recommend naming it by its computer name. If the Guest runs on a terminal server client, we recommend naming it by its user logon name, see the Administrator’s Guide Advanced Tools chapter Netop Naming in a TSE section.

**Authentication**

- **Cache logon passwords**: Check this box to store the most recently used logon credentials in cache memory to apply them when connecting (default: unchecked). Cached logon credentials will be lost when the Guest is unloaded.
Access Server 6.x/5.x

☐ Use Access Server on Guest side: Check this box to enable Guest side authentication with Hosts that are Guest side authentication enabled on an older version Netop Access Server (default: unchecked).

**Note:** Netop Security Server (version 7+ only) does not support Guest side authentication.

☐ Ignore if access to Host cannot be authenticated: Check this box to ignore Guest side authentication with Hosts that are not Guest side authentication enabled on a Netop Access Server (default: unchecked).

### 3.5.1.5 Host Name Tab

This is the Guest *Program Options* window Host Name tab:

![Program Options window](image)

It specifies Host name and Netop Name Server name space ID options.

**Default Host name qualifier**

Netop will interpret a name specified in the *Quick Connect Tab Host Section* Name drop-down box field as a certain type of name according to this default Host name qualifier or a prefixed Host name qualifier (shown in parentheses below). Select one of these options:
Netop Guest

- **Host ID (H::):** Will interpret a Host name without a prefix as a Host ID (default selection).
- **User name (U::):** Will interpret a Host name without a prefix as a user name.
- **DNS name (DNS::):** Will interpret a Host name without a prefix as a Domain Name Server name.
- **LDAP name (LDAP::):** Will interpret a Host name without a prefix as a directory services user attribute value, see Directory Services Tab.

If you specify a Host name qualifier that does not exist, this window will be shown:

![Host Name Qualifiers](image)

Click Help to open the Netop Guest Help system on the Default Host Name Qualifier explanation.

**Duplicate names**

If connecting by a Networking Communication Device, multiple Hosts may respond by the same name, for instance if the same user is logged on to multiple computers. By default, the Guest will connect to the first responding Host.

- **Check for duplicate names before connecting:** Check this box to wait a few seconds for Host responses and show this window if multiple Hosts have responded (default: unchecked):

![Multiple Host Names found](image)

The pane will show responding Hosts as records in a table with these column contents:

- **Host ID:** Availability icon and Host specified Host ID.
- **User Name:** Host computer Windows or network logon user name, if enabled.
- **Communication Profile:** Guest Communication Profile name.
Information: The record of a responding Netop Gateway will show (Gateway).

Double-click a record or select a record and click OK to connect to the record Host.

Netop Name Server

To connect by Name Resolution using Netop Name Server, use a Communication Profile that uses the TCP/IP Communication Device and in its Advanced TCP/IP Configuration window check the Use Netop Name Server box and specify the resolving Netop Name Server addresses. You must also specify the same Name Space ID as the Netop modules that you want to connect to, see the Administrator's Guide Netop Name Management chapter.

Name Space ID: []: Specify in this field the Name Space ID specified by the Netop modules that you want to connect to using Netop Name Server (default: PUBLIC).

3.5.1.6 Directory Services Tab

This is the Guest Program Options window Directory Services tab:

[Image: Program Options window]

It can specify directory services to enable the Guest to connect and Browse for Hosts using the LDAP:: Host name qualifier.

General
Netop Guest

Directory Server: [ ]: Specify in this field the directory server IP address or DNS name (default: none).

Port: [ ]: Specify in this field the port through which to connect to the directory server (default: 389, the Lightweight Directory Access Protocol (LDAP) port).

☐ Use secure connection: Check this box to connect to the directory server by a secure connection. The LDAP secure connection port number is 636.

Base DN: [ ]: Specify in this field the directory services distinguished name from which a search shall start (default: none).

Credentials Tab

This tab can specify the credentials by which the Guest will log on to the directory server. The credentials determine the user rights by which directory services information will be available.

☐ Anonymous bind: Leave this box checked to search the directory service with anonymous user rights (default: checked). Uncheck the box to enable the fields below.

User DN: [ ]: Specify in this field a directory service user distinguished name to search the directory service with the rights of this user.

Password: [ ]: Specify in this field the matching password.

Confirm password: [ ]: Re-specify in this field the password for confirmation.

Settings Tab

Specify on this tab the settings for searching directory services for user attribute values to return matching name and address attribute values. Initially, the fields are empty.

For guidance on filling in the fields, click Default to show this window:

Select Directory Service

Select the Directory Service from the list below. If your Directory Service is not listed, the values can be set manually.

Microsoft Active Directory

OK Cancel

The field of the drop-down box will show the selected directory service name (default: Microsoft Active Directory). The drop-down box list will contain names of available directory services. Select a directory service name in the list to show it in the field.

Click OK to specify the selected directory service available default settings in the matching Settings tab
fields.

User search filter: [:]: Specify or edit the user search filter designation.

User attribute: [:]: Specify or edit the user attribute designation.

Name attribute: [:]: Specify or edit the name attribute designation.

Address attribute: [:]: Specify or edit the address attribute designation.

Search name prefix: [:]: Specify or edit any prefix (e.g. cn=) that shall be added before search values.

3.5.1.7 Remote Control Tab

This is the Guest Program Options window Remote Control tab:

It specifies general Remote Control session options.

Note: You can specify individual Remote Control session options for each Tab Panel Host record, connection from the Quick Connect Tab or running Remote Control session in the Connection Properties window.
Netop Guest

☑️ Toolbar: Uncheck this box to hide the Remote Control window toolbar (default: checked).

☑️ Toolbox in full screen: Uncheck this box to hide the Remote Control full screen display toolbox (default: checked).

☑️ Full screen toolbox roll-up: Uncheck this box to not reduce the full screen show toolbox to its title bar when not in use (default: checked).

☑️ Status line: Uncheck this box to hide the Remote Control window status bar (default: checked).

Hot keys assignment

You can assign hot keys (keystroke combinations) to specified actions. By default, CTRL+Z is assigned to Zoom in and out (switch between Remote Control window and full screen). Assign desired hot keys by checking boxes and specifying a character in the last field.

Remote control window

☑️ Host window auto scroll: Uncheck this box to disable automatic Host screen image scroll when the mouse pointer approaches Remote Control window borders (default: checked).

☐ Show full screen as topmost window: Check to show the Remote Control full screen display in front of any other window (default: unchecked).

☐ Show full screen on all monitors: Check to show the Remote Control full screen display on all available monitors (default: unchecked).

☑️ Auto take control: Uncheck this box to disable acquiring Multi Guest Session keyboard and mouse control by a keystroke or mouse click, see Multi Guest Session Buttons (default: checked).

Switch to window mode password: [:] Specify in this field a password to request this password to switch from full screen to window (default: none). The field will show password characters as dots or asterisks.

Disconnect password: [:] Specify in this field a password to request this password to disconnect (default: none). The field will show password characters as dots or asterisks.
3.5.1.8 Clipboard Tab

This is the Guest Program Options window Clipboard tab:

It specifies Remote Control clipboard transfer options.

**Automatic clipboard transfer**

☑ **Automatically transfer clipboards below [ ] kb**: Leave checked to enable contents placed on the Netop Guest computer or Netop Host computer clipboard during a Remote Control session to automatically become the clipboard contents of both computers if smaller than the number of kilobytes specified in the field. Uncheck to disable.

☐ **Show progress dialog during transfer**: Check to show a small window with a progress bar while clipboard contents are being transferred from one computer to the other.
Netop Guest

3.5.1.9 Monitor Tab

This is the Guest Program Options window Monitor tab:

It specifies Monitor options.

Monitor interval: \[ \] s: Specify in this field a number in the range 1 - 999 to switch to the next Host after monitoring a Host for this number of seconds (default: 15).

☐ Start Monitor in full screen: Check this box to initially show monitored Host screen images in full screen mode (default: unchecked). If unchecked, Host screen images will initially be shown in window mode.
3.5.1.10 Audio-Video Chat Tab

This is the Guest Program Options window Audio-Video Chat tab:

It specifies audio and video chat options.

**Audio-video chat settings**

- **Start audio chat when conference is started**: Uncheck this box to disable sound transfer at session start (default: checked). If checked, sound transfer will be enabled at session start.

- **Start video when conference is started**: Check this box to enable image transfer at session start (default: unchecked). If unchecked, image transfer will be disabled at session start.

**Audio Chat**

- **General**
  - **Enable full-duplex audio**: Uncheck this box to disable sound transfer in both directions at the same time (default: checked).

  **Note**: Some computer sound systems do not support full-duplex audio.
Silence level: Drag this slide to specify the microphone sound input level below which no sound data shall be transferred (default: second tick from left).

Line hold: Drag this slide to specify the time after the microphone sound input level has dropped below the Silence level in which sound data shall be transferred (default: seventh tick from left).

**Note:** Try out different Silence level and Line hold settings to optimize sound transfer.

Check sound system: Click this button to check the computer sound system to show a result message.

Advanced...: Click this button to show this window:

![Advanced audio settings window](image)

**Playback**

Preferred device: [ ]: The field of this drop-down box will show the preferred audio playback device (default: *<Use any available device>*). The drop-down box list will contain the names of available playback devices. Select a name in the list to show it in the field.

**Record**

Preferred device: [ ]: The field of this drop-down box will show the preferred audio recording device (default: *<Use any available device>*). The drop-down box list will contain the names of available recording devices. Select a name in the list to show it in the field.

**Note:** If multiple sound devices are connected to the computer, *<Use any available device>* may select a connected device instead of the computer sound system. In that case, select the computer sound system.

**Audio Compression**

Try audio compression codecs in the following order: [ ]: This pane will contain a Windows prioritized list of Guest computer available mono audio compression codecs.
**Up/Down:** Select a codec and click a button to move it up or down in the prioritized list.

**Use defaults:** Click this button to restore the default codec priority.

**Note:** Netop will use the highest prioritized Guest computer codec that is also available on the Host computer.

### Video

**Capture size []:** The field of this drop-down box will show the selected video capture frame width times height in pixels (default: 160 x 120). The drop-down box list will contain available video capture frame sizes. Select a video capture frame size in the list to show it in the field.

**Advanced...**: Click this button to show this window:

**Select driver to use:** If a video camera has been installed on the computer, the field of this drop-down box will show its driver name. The drop-down box list will contain the names of installed video drivers. Select a driver name in the list to show it in the field.

If a camera that uses the driver whose name is shown in the **Select driver to use** drop-down box field is enabled, the image frame will show its captured image.

**Format:** Click this button to show the *Windows Video Format* window to format the video capture image.

**Properties:** Click this button to show the *Windows Video Source* window to specify video source properties.

☐ **Disable compression:** Check this box to disable video data compression (default: unchecked).
Netop Guest

3.5.1.11 Remote Printing Tab

This is the Guest *Program Options* window *Remote Printing* tab:

It specifies remote Netop printers and incoming print job redirection.

**Remote NetOp printers**

The pane will show the names of Netop printers in the Guest computer Windows *Printers* folder (initially none).

You can add a Netop printer on the Guest computer to enable sending a Guest computer print job to a Host computer printing device (remote printer).

**Note:** You can also add a Netop printer on a Host computer to enable sending a Host computer print job to a Guest computer printing device.

Add printer...: Click this button to show this window:
Follow these guidelines that will remain on the screen while you add a Netop printer. Click Ready to start adding a Netop printer.

**Note:** The Netop printer and the selected remote printing device driver must be installed on the computer that sends the print job. Special instructions for remote printing from DOS applications are available in the Netop KnowledgeBase.

*Remove printer:* Select a Netop printer in the pane and click this button to remove it.

If you are connected to multiple Hosts while sending a print job to a Netop printer, this window will be shown:

**Redirect print to**

You can redirect a print job sent from the Host computer to the Guest computer to any printer specified on the Guest computer. Select one of these options:

- **Default printer:** Redirect the print job to the default Guest computer printer (default selection).
- **Prompt with a list of available printers:** Select this option and click Browse to show this window:
The pane will show the names of Guest computer printers. Select a name and click OK to specify the printer name in the field to redirect incoming Netop print jobs to this printer.
3.5.1.12 Recording Tab

This is the Guest *Program Options* window *Recording* tab:

It specifies *Remote Control* session recording options.

**Options**

- **Use compatible mode**: *Remote Control* session recording was improved in Netop Remote Control version 8. Older Guest versions cannot play back version 8+ recordings. Check this box to make older version compatible recordings (default: unchecked).

- **Enforce recording**: Check this box to record all *Remote Control* sessions even if the *Connection Properties* window *Record Tab* *Record remote control session* box is unchecked (default: unchecked).

- **Disconnect if recording fails**: Check this box to disconnect if recording a *Remote Control* session fails (default: unchecked).

**Recording**

- **Use the following identity**: A *Recordings Tab* record and recording file name will identify the *Remote Control* session Guest. Select one of these options:
Netop Guest

- **Guest ID**: Identify by the Guest ID, see the *Program Options* window Logon Tab (default selection).
- **Guest user**: Identify by the Guest computer Windows or network logon user name.

### 3.5.1.13 Sounds Tab

This is the Guest *Program Options* window Sounds tab:

![Sound Event Checkboxes](image)

It specifies sounds played upon selected events.

The pane contains these check boxed events:

- **Incoming help request**: A help request has arrived (default: checked).
- **Guest start**: The Guest has loaded (default: unchecked).
- **Guest stop**: The Guest has unloaded (default: unchecked).
- **Session with Host**: A Host session has started (default: unchecked).
- **Disconnect from Host**: A Host has been disconnected (default: unchecked).
- **Communication error**: There has been a communication error (default: checked).
- **Keyboard and mouse assigned or revoked**: In a *Remote Control* session, the Guest has got or lost...
keyboard and mouse control (default: checked).

Check a box to play a sound upon the event. Uncheck to suppress playing a sound upon the event.

Select an event and click Select Sound to open a Windows Open window that specifies Files of type: Sound Files. Open a sound file with the extension .wav to replace the current sound by the sound of the opened sound file and mark the event with (*).

Select an event marked (*) and click Default Sound to reassign the default sound to the event and remove the (*) mark.

Select an event and click Play to play the sound assigned to the event.

3.5.1.14 Help Request Tab

This is the Guest Program Options window Help Request tab:

It specifies help request options.

☐ Enable help request: Check this box to enable the Guest to receive help requests (default unchecked).

**Note:** Netop on Demand Guest has in addition to the Help Request tab below a Service Tickets tab.
that enables it to service help requests by a service ticket number.

Help Service Tab

☐ Enable help services: Uncheck this box to disable the help services specified below (default: checked).

Help service 1-3: [:] Specify in these fields the names of the help services that this Guest shall offer.

Note: Netop Guest can receive Netop Host help requests only if the Enable help request and Enable help services boxes are checked, at least one Help service name is specified and Communication Profiles are enabled at Guest loading. Netop Host uses the term Help provider for a Help service name.

Advanced...: Click this button to show this window:

Advanced Help Service

This window can specify actions that shall execute when a help request arrives.

Action: [:] The field of this drop-down box will show the selected action. The drop-down box list contains these options:

- None: No action (default selection).
- Send message: Run a local program if specified and send a message to the Host. The fields below will become enabled.
- Run local program: Run a local program if specified. The fields below except Send message will become enabled.

Select an option in the list to show it in the field.

Command line: [:] [:] Specify in this field the command line of a Guest computer program, typically a helpdesk program to register the help request. Click […] to show a Windows Open window that specifies Files of type: Programs to select a program file whose command will be shown in the field. You can add these arguments to the command:

- %H: Help request Host name.
- %T: Help request time.
- %P: Help request problem description.

Note: Netop does not undertake to supply or recommend helpdesk programs.
Timeout: [ ] s.: Specify in this field a number (default: 5, range 0-9999, 0 = no timeout) to time out (cancel if unsuccessful) the command specified above after the specified number of seconds.

Send message: [ ] [...]: Specify in this field the path and name of an rtf (Rich Text Format) file to send a Netop message with the rtf file content to the help requesting Host, see Netop Message. Click [...] to show a Windows Open window that specifies Files of type: RTF to open a rtf file whose path and name will be shown in the field.

- Clear help request: Check this box to delete the Help Request Tab record when the actions specified above have executed successfully (default: unchecked).

  Note: Deleting the Help Request Tab record will not cancel the help request.

- Display a notification message when new help request arrives: Check this box to show this message when a help request arrives (default: unchecked):

  ![Help Request Notification](image)

  This window will show the help request Host name, time and, if specified, problem description.

  Yes: Click this button to show the Help Request Tab.

  No: Click this button to close the window.
3.5.1.15 Run Tab

This is the Guest Program Options window Run tab:

It specifies programs to include them in the Run Program drop-down menu.

The pane will show specified programs (initially none) as records in a table with these column contents:

- **Description**: The Run Program drop-down menu program description.
- **Path**: Program file path and name.

**Note**: Table contents will be stored in the runprog.ndb Netop Configuration File that will typically reside in the path `C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest`.

Add…: Click this button to show this window:
File

Type a descriptive text in the Description field. This text will appear on the menu.

File name

Under File name, make sure that the Local file name option has been selected and then click the Browse button to locate the program .exe file.

When the program file is added, the Global file name where the absolute path has been replaced with environment variables is automatically added. This is especially helpful if your computers are running different Windows platforms.

Example of a Local file name and the corresponding Global file name:

C:\Program Files\Adobe\Acrobat 6.0\Reader\AcroRd32.exe  
%ProgramFiles%\Adobe\Acrobat 6.0\Reader\AcroRd32.exe

Tip: Once you have added a program under Local file name and the Global file name has been added automatically, select the Global file name option button so that you do not have to consider which operating system version or operating system language Host computers are using.

Command line switches: If the selected program needs to be started using command line switches, use the Command line switches field to type those. This could for example be starting Internet Explorer with a specific address or for Adobe Acrobat Reader, the name of the document to read.

Run

Under Run, select Normal, Maximized or Minimized to define how the program should start when opened from the Run Program button on the toolbar or from the Run Program command on the Connection menu.

Properties...: Select a record in the pane and click this button to show its properties in the Run window to edit them.

Delete: Select a record in the pane and click this button to delete it.
**3.5.1.16 Encryption Tab**

This is the Guest *Program Options* window Encryption tab:

It specifies enabled encryption types.

The communication between Netop modules is protected by encrypting transmitted data. One encryption type is used by version 6.5- Netop Remote Control modules. A range of encryption types is available on version 7.0+ Netop Remote Control modules. Communicating Netop modules will automatically negotiate to encrypt communication by an encryption type that is enabled on both modules, see the *Connection Properties* window *Compression/Encryption Tab*. Netop modules on which no common encryption type is enabled cannot communicate.

The pane shows check boxed available encryption type icons and names. Leave a box checked to enable the encryption type (default: all checked): Uncheck to disable.

- **Netop 6.x/5.x Compatible**: Netop Remote Control version 6.5- compatible encryption.
- **None**: Does not encrypt data but ensures session uniqueness.
- **Data integrity**: Verifies data integrity.
- **Keyboard**: Encrypts and verifies keyboard, mouse, logon and password data.
Data integrity and Keyboard: Encrypts keyboard, mouse, logon and password data and verifies data integrity.

- High: Encrypts and verifies integrity of all data at a high security level.
- Very High: Encrypts and verifies integrity of all data at a very high security level.

*Show Details:* Select an encryption type and click this button to show encryption details.

**3.5.1.17 Inventory Tab**

This is the Guest Program Options window Inventory tab:

![Program Options Window](image)

**Summary view**

The pane contains a check boxed list of available inventory details. Check/uncheck boxes to select the inventory details of the Inventory Tab summary inventory view that will be shown in the Details Pane when a folder is selected in the Contents Pane. The pane top-to-bottom order of checked inventory details will determine the left-to-right order of Details Pane columns.

*Up/Down:* Select an inventory detail and click a button to move it up or down in the pane.
Select All: Click this button to check all inventory details.
Deselect All: Click this button to uncheck all inventory details.
Advanced...: Click this button to show this window:

This window specifies inventory processing and custom inventory items.

Run program after inventory scan
You can specify an inventory processing program to automatically process each newly retrieved Host computer inventory. Select one of these options:

○ Disable: Disable running the program specified below (default selection).
○ Run for each Host: Run the program specified below when a Host computer inventory has been retrieved.
○ Run after all scans have completed: Run the program file specified below when a batch of Host computer inventories has been retrieved.

File name: [][Browse...]: Specify in the field an inventory processing program file path and name including required command line switches. Click Browse to show a Windows Open window specifying Files of type: Programs to open an inventory processing program file the path and name of which will be shown in the field.

Note: Netop does not undertake to supply or recommend inventory processing programs.

Custom inventory items
The pane will show records of custom inventory items (initially none) in a table with these column contents:

- Name: Inventory item name.
- Type: Inventory item type.
Argument: Inventory item argument.

Add...: Click this button to show this window:

This window specifies a custom inventory item.

**Name:** Specify in this field the custom inventory item name.

**Item type:** The field of this drop-down box will show the selected inventory item type. The drop-down box list contains inventory item types that determine the argument fields below:

- **Environment variable:** Field: Environment variable (default selection).
- **Registry key:** Drop-down box: Registry key, field: Sub key.
- **Ini File:** Field: File name, field: Section, field: Key.
- **File Information:** Field: File name.
- **DLL:** Field: DLL file name, field: DLL argument.
- **ASCII File Content (max 512 bytes):** Field: File name.

Select an inventory item type in the list to show it in the field. Specify in the argument fields below the arguments that define the custom inventory item.

**OK:** Click this button to show the custom inventory item specification as a record in the Custom inventory items table.

**Edit:** Select a record in the pane and click this button to show its specification in the Custom Inventory Item window to edit it.

**Delete:** Select a record in the pane and click this button to delete it.

**Note:** The pane contents will be stored in the Netop Configuration File InvCuItm.xml that will typically reside in the path C:Documents and Settings<User name>Application DataDanware DataNetop Remote ControlGuest.
3.5.1.18 Smart Card Tab

This is the Guest Program Options window Smart Card tab:

It specifies the Smart Card reader whose reading will be applied to Smart Card Authentication.

Select Smart Card reader: []: The field of this drop-down will show the name of the selected Smart Card reader. The drop-down box list will contain Default and the names of connected Smart Card readers found by Windows. Select an option in the list to show it in the field.
3.5.1.19 Intel vPro Tab

This is the Guest Program Options window Intel vPro tab:

Select the Connect to SCS check box and enter the SCS Web Service URL in the field below. The address is then saved in the system, so that every time you select the Retrieve Intel vPro Enabled Computers from SCS command on the context menu for the Quick Connect Intel vPro tab pane you won't be prompted to enter the address.

See also:

Intel vPro Tab
3.5.1.20 Web Update Tab

This is the Guest Program Options window Web Update tab:

It specifies web update options to automatically update the Netop Guest installation.

**Update server:** Specify in this field the web address of the server from which to download Guest update files (default: update.netop.com, the Netop manufacturer web update server).

**Note:** To update many Netop installations in an organization, we recommend to Publish New Updates to an internal web update server.

**HTTP Proxy:** Specifying an HTTP proxy is typically not required. Before specifying an HTTP proxy, click Update now to test the web update connection. If this yields a message indicating connection to the update server, specify no HTTP proxy. If Update now yields no connection, click Detect to make Netop attempt to detect the HTTP proxy server to show its name and port number in the HTTP Proxy field. Click Update now to test the connection. If unsuccessful, consult with your network/system administrator about what must be specified in the HTTP Proxy field (format: <Server name>:<Port number>).

**Update now:** Click this button to connect to the update server specified in the Update server field. A Web Update message will notify you if connection to the update server failed, if no updates are available.
or if updates are available and in the latter case ask you if you want to download and install updates.

*Schedule*...: Click this button to show this window:

This window specifies a schedule of checks for updates including download and installation of available update files.

**Schedule**

Select one of these options:

- **Disabled**: Disable automatic web update (default selection). The other sections in the window will be disabled.
- **Automatic download, prompt before install**: Automatically download any update files and prompt the user when downloaded.
- **Automatic download and install**: Automatically download and install any update files.
  - **Allow system restart after install**: Check this box to automatically restart the computer after update installation, if required (default: unchecked). Leave unchecked to deny automatic restart to after installation show a message that restart is required to complete the installation.

**Run**

Select one of these options:

- **At loading**: Check for updates when the Guest is loaded (default selection). The *Delay* section in the image above will be shown.

  **Delay**

  - **[ ] minute delay**: Specify in this field a number to delay the web update by the specified number of minutes (default: 0, range 0-99).
- **Daily**: Check for updates on a daily basis. This section will be shown:
Start at

[] every [] day: In the first field, specify the time of the day (default: 12:00). In the second field, specify by a number an interval in days (default: 1, range 1-99).

☐ Randomize within the hour: Check this box to randomize the update time within the hour following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is first loaded thereafter.

☐ Weekly: Check for updates on a weekly basis. This section will be shown:

Start at

12:00 every 1 week

☑ Monday ☐ Tuesday ☐ Wednesday

☐ Thursday ☐ Friday ☐ Saturday

☐ Randomize within the hour

Start at

[] every [] week: In the first field, specify the time of the day (default 12:00). In the second field, specify by a number an interval in weeks (default: 1, range 1-99).

☐ <Weekday>: Check boxes to run scheduled web updates on selected weekdays (default: Monday only checked).

☐ Randomize within the hour: Check this box to randomize the update time within the hour following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is first loaded thereafter.

☐ Monthly: Check for updates on a monthly basis. This section will be shown:

Start at

12:00 on the 1 day of the month (1 - 28)

☐ Randomize within the hour

Start at

[] on the [] day of the month: In the first field, specify the time of the day (default: 12:00). In the second field, specify by a number the day of the month (default: 1, range 1-28).

☐ Randomize within the hour: Check this box to randomize the update time within the hour following the specified time to avoid crowding (default: unchecked).

Note: If the Guest is not loaded at the scheduled time, web update will run when the Guest is first loaded thereafter.

Start date

Year: [] Month: [] Day: []: Select in the drop-down boxes the schedule start date (default: today).
3.5.2 File Manager Options

Select the Tools Menu File Manager Options command to show the Netop File Manager - Options window.

3.5.3 Log Setup

Select the Tools Menu Log Setup command to show the Log Setup window.

3.5.4 Maintenance Password

Select the Tools Menu Maintenance Password command to show this window:

A maintenance password will protect executing Tools Menu setup commands to prevent unauthorized Guest setup changes.

Old Password: []: Specify in this field the current maintenance password (initially none, the field will be disabled). Keystrokes will show as dots or asterisks.

New Password: []: Specify in this field the new password (maximum 16 characters).

Confirm Password: []: Specify in this field the new password for confirmation.

Note: Disable maintenance password protection by leaving the New Password and Confirm Password fields blank.

If maintenance password protection is applied, selecting any Tools Menu setup command will show this window:

Enter password: []: Specify in this field the maintenance password.

If the specified password is wrong, an error message will be shown. There is no limit to the number of maintenance password attempts.
3.5.5 Communication Profiles

Select the Tools Menu Communication Profiles command to show this window:

From this window, you can enable/disable, create, edit and delete communication profiles.

**Note:** A communication profile is a named configuration of a Communication Device. You can create multiple communication profiles with different configurations of each Communication Device.

*Communication Profile List:* This pane contains a check boxed list of Guest communication profiles. Check boxes to enable communication profiles at Guest loading (default: all unchecked).

**Note:** Enable communication profiles at Guest loading only to:

- Enable receiving help requests, see the Program Options window Help Request Tab.
- Connect or Browse for Hosts by Unavailable Networking Communication Devices.
- Browse for Hosts by multiple Networking Communication Devices.
- Request the Gateway Device Group List by multiple Networking Communication Devices.

If none of these purposes are relevant to you, you should not enable communication profiles at Guest loading.

**New:** Click this button to show the Communication Profile Edit window to create a communication profile.

**Edit:** Select in the pane a communication profile to highlight it and click this button to show the Communication Profile Edit window to edit it.

**Delete:** Select in the pane a communication profile and click this button to delete it.

**Note:** To apply changes to enabled communication profiles, you must reload the Guest.
3.5.6 Modem Database

Select the **Tools Menu** Modem Database command to show the Modem window.

3.5.7 Check for New Updates

Select the **Tools Menu** Check for New Updates command to connect to the web update server specified on the **Program Options** window Web Update Tab to check for new updates to the Guest installation.

3.5.8 Publish New Updates

Select the **Tools Menu** Publish New Updates command to show a Windows Browse for Folder window. Select a network folder to copy web update files for the installed version of Netop Remote Control from the URL specified on the **Program Options** window Web Update Tab to the specified network folder to enable network users to web update their Netop installation from it.

3.5.9 Debug Trace

Normally, this command is not included in the **Tools Menu**. Select the **Help Menu** About command to show the About Netop Remote Control Guest window and press ALT+Z to include the Debug Trace command in the **Tools Menu**. Select Debug Trace to save a debug trace of recent Netop communication. This window will be shown:

![Debug Trace Window]

It shows where the debug trace is saved.

Yes: Click this button to show the content of the debug trace. It is a text file that logs Netop communication events without logging communicated data. Its interpretation requires Netop expertise.

No: Click this button to close the window.

**Note:** A debug trace may be requested by Netop supporters to troubleshoot communication problems.

3.5.10 Run Setup Wizard

Select the **Tools Menu** Run Setup Wizard command to run the Setup Wizard.

3.5.11 Copy Guest to Removable Media

Connect a removable data storage device to your computer, e.g. by a USB socket, and select the **Tools Menu** Copy Guest to Removable Media command to show a Windows Browse For Folder window. Select the removable data storage device to copy your Guest installation including your personal Guest settings to the removable data storage device.

This will enable you to take your Netop Guest with you to plug the removable data storage device into any compatible Windows computer and run the Guest from there.

A complete Netop Guest installation will use around 15 MB of data storage space plus the space used by personal Guest settings.
3.6 Guest Sessions

Netop Guest on one computer can connect to Netop Host on another computer to run one or multiple session types at the same time, see Connect Guide.

These session types are available:

- Remote Control
- Monitor
- File Transfer
- Chat
- Audio-Video Chat
- Remote Management
- Demonstrate

Netop Host can on its Program Options window General Tab Allow multiple simultaneous Guest connections:

- Multiple Guests running a Remote Control session with one Host will run a joint Multi Guest Session.
- Multiple Guests running a File Transfer session with one Host will run separate sessions.
- Multiple Guests running a Chat session with one Host will run a joint Multi Chat Session.
- Each Guest and each Host can run only one audio session including Audio-Video Chat at a time.
- Multiple Guests running a Remote Management session with one Host will run separate sessions.

3.6.1 Remote Control

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a remote control session with a Host to show the Host computer screen image on the Guest computer.

The Guest can connect to start a remote control session from the Quick Connect Tab, from a Phonebook Tab or History Tab record or in response to a help request from a Help Request Tab record.

When connected, the Guest can start and end a remote control session from a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab record or from the Remote Management Netop Sessions Remote Control command.

Note: If the Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple remote control session Guests will run a joint Multi Guest Session.

An image of the Host computer screen will be shown on the Guest computer screen, typically in this window:
It contains these elements:

- **Title Bar**
- **Toolbar or Toolbox**
- **Remote Control Display**
- **Status Bar**

### 3.6.1.1 Title Bar

This is the Remote Control window title bar:

It will show the name or address by which you connected to the Host.

The title bar menu contains additional commands:
Send Keystrokes: This command expands into these commands:

**Note:** This command will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To. Using these keystroke combinations from the keyboard can have undesired effects.

*Send Ctrl+Esc:* Select this command or click the Toolbar or Toolbox Send Ctrl+Esc button to send the keystroke combination CTRL+ESC to the Host to show the Start menu on a Windows Host computer or the Window List on an OS/2 Host computer.

*Send Ctrl+Alt+Del:* Select this command or click the Toolbar or Toolbox Send Ctrl+Alt+Del button to send the keystroke combination CTRL+ALT+DEL to the Host to show the security dialog box on a Windows 2003/XP/2000 Host computer or restart an OS/2 Host computer.

**Note:** Send Ctrl+Alt+Del is disabled with a Windows ME, 98 or 95 Host computer. Select Restart Host PC to restart the Host computer.

*Send Alt+Tab:* Select this command to send the keystroke combination ALT+TAB to the Host to typically shift the active window clockwise on the Host computer screen.

*Send Alt+Shift+Tab:* Select this command to send the keystroke combination ALT+SHIFT+TAB to the Host to typically shift the active window counterclockwise on the Host computer screen.

*Send Print Screen:* Select this command to send a PRINT SCREEN command to the Host to copy an image of the Host computer screen to the Host computer clipboard.

*Send Alt+Print Screen:* Select this command to send an ALT+PRINT SCREEN command to the Host to copy an image of the Host computer screen active window to the Host computer clipboard.

**Clipboard:** This command expands into these commands:

*Send to Host:* Select this command or click the Toolbar or Toolbox Send Clipboard button to send the Guest computer clipboard content to the Host computer clipboard.

**Note:** This command will be disabled if Host Guest Access Security does not allow Transfer clipboard, see Allow Guest To.

*Retrieve from Host:* Select this command or click the Toolbar or Toolbox Retrieve Clipboard button to retrieve the Host computer clipboard content to the Guest computer clipboard.

**Note:** This command will be disabled if Host Guest Access Security does not allow Transfer clipboard, see Allow Guest To.
Save Screen to Clipboard: Select this command or click the Toolbar or Toolbox Save Screen to Clipboard button to capture the Host computer screen image to the Guest computer clipboard.

Save Screen to File: Select this command or click the Toolbar or Toolbox Save Screen to File button to capture the Host computer screen image and show a Windows Save As window that suggests the file name <Host name>-<Date>-<Time>.bmp and the Netop Configuration Files SnapShot directory. You can change the file name and directory before saving.

Connection Properties: Select this command or click the Toolbar or Toolbox Connection Properties button to show the Connection Properties window with limited options.

Full Screen: Select this command or click the Toolbar or Toolbox Full Screen button to show the Host computer screen image in full screen.

Note: Press the zoom hot key to toggle between window and full screen. The zoom hot key is CTRL+Z unless modified, see the Program Options window Remote Control Tab.

Marker Mode: Select this command to check mark it or click the Toolbar or Toolbox Marker Mode button to make it appear pressed in to start Netop Marker Utility. Select the check marked command to uncheck it or click the pressed in button to release it to stop Netop Marker Utility.

Note: This command will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To.

Mouse marker: Select this command to check mark it or click the Toolbar or Toolbox Mouse marker button to show on the Host computer screen a large red mouse pointer arrow when you click in the Host screen image. Select the check marked command to uncheck it or click the pressed in button to release it to stop Mouse marker.

Note: This command will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To.

Restart Host PC: Select this command or click the Toolbar or Toolbox Restart Host PC button to show a confirmation window to confirm restarting the Host computer.

Note: This command will be disabled if Host Guest Access Security does not allow Execute command (Restart, ...), see Allow Guest To.

Lock Keyboard and Mouse: Select this command to check mark it or click the Toolbar or Toolbox Lock Keyboard and Mouse button to make it appear pressed in to disable the Host computer keyboard and mouse. Select the check marked command to uncheck it or click the pressed in button to release it to enable the Host computer keyboard and mouse.

Note: This command will be disabled if Host Guest Access Security does not allow Lock keyboard and mouse, see Allow Guest To.

Blank Display: Select this command to check mark it or click the Toolbar or Toolbox Blank Display button to make it appear pressed in to make the Host computer screen turn black to the Host computer user. Select the check marked command to uncheck it or click the pressed in button to release it to unblank the Host screen.

Note: This command will be disabled if Host Guest Access Security does not allow Blank the screen, see Allow Guest To. While Blank Display works with most Host computers, the design of some display adapters prevents applying it.

Transfer Sound: Select this command to check mark it or click the Toolbar or Toolbox Transfer Sound button to make it appear pressed in to transfer Host computer application sound. Select the check marked command to uncheck it or click the pressed in button to release it to not transfer sound.

Note: This command will be disabled if the Guest or the Host is engaged in another audio session or if Host Guest Access Security does not allow Request audio chat and transfer sound, see Allow Guest To.

Note: For Transfer Sound to work, these conditions must be met:

1. On the Host, the Advanced Audio Settings window Record section Preferred device drop-down box

145
must select the computer sound system.

2. The Host computer sound system must support sound mix.

3. The Host must specify the sound mix recording mode name of the Host computer sound system, see [AUDIO] Section.

Refresh: Select this command to redraw the Host screen image.

3.6.1.2 Toolbar or Toolbox

The Remote Control window toolbar or full screen toolbox will be shown unless disabled from the Program Options window Remote Control Tab.

The window toolbar contains these buttons:

The full screen show toolbox contains the same buttons:

The toolbox will roll up to show only its title bar unless disabled from the Program Options window Remote Control Tab.

The toolbar and toolbox contain these button groups:

- Session Buttons
- Action Buttons
- Control Buttons
- Multi Guest Session Buttons
- Clipboard Buttons
- Tool Buttons

3.6.1.2.1 Session Buttons

These are the Remote Control Toolbar or Toolbox session buttons:
**Remote Control:** This button will appear pressed in during a Remote Control session. Click the pressed in button to release it to end the Remote Control session.

**File Transfer:** Click this button to make it appear pressed in to start a File Transfer session. Click the pressed in button to release it to end the File Transfer session.

**Note:** This button will be disabled if Host Guest Access Security does not allow both of Send files to Host and Receive files from Host, see Allow Guest To.

**Chat:** Click this button to make it appear pressed in to start a Chat session. Click the pressed in button to release it to end the Chat session.

**Note:** This button will be disabled if Host Guest Access Security does not allow Request chat, see Allow Guest To.

**Audio-Video Chat:** Click this button to make it appear pressed in to start an Audio-Video Chat session. Click the pressed in button to release it to end the Audio-Video Chat session.

**Note:** This button will be disabled if Host Guest Access Security does not allow Request audio chat and transfer sound, see Allow Guest To, if the Guest or the Host is engaged in another audio session or if another Guest has keyboard and mouse control, see Multi Guest Session Buttons.

**Remote Management:** Click this button to make it appear pressed in to start a Remote Management session. Click the pressed in button to release it to end the Remote Management session.

**Note:** This button will be disabled if Host Guest Access Security does not allow Remote manage, see Allow Guest To.

**Demonstrate:** Click this button to make it appear pressed in to start a Demonstrate session. Click the pressed in button to release it to end the Demonstrate session.

**Note:** This button will be disabled if Host Guest Access Security does not allow Demonstrate, see Allow Guest To.

**Note:** You can also control sessions from the Netop Guest Window.

### 3.6.1.2.2 Action Buttons

These are the Remote Control Toolbar or Toolbox action buttons:

**Run Program:** Click this button to show the Run Program drop-down menu to run a program on the Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Run programs, see Allow Guest To.

**Execute Command:** Click this button to show the Execute Command drop-down menu to execute a command on the Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Execute command (Restart, ...), see Allow Guest To.

**Send Message:** Click this button to show the Netop Message window to send a Netop message to the Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Send message, see Allow Guest To.

**Get Inventory:** Click this button to Get Inventory from the Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Retrieve inventory, see Allow Guest To.
**Netop Guest**

**Note:** You can also execute actions from the Netop Guest Window.

### 3.6.1.2.3 Control Buttons

These are the Remote Control Toolbar or Toolbox control buttons:

- **Disconnect:** Click this button or the Netop Guest Window Toolbar Disconnect button or select the Connection Menu Disconnect command to disconnect from the Host.

- **Connection Properties:** Click this button or select the Remote Control window Title Bar menu Connection Properties command to show the Connection Properties window with limited options.

- **Full Screen:** Click this Remote Control window toolbar button or select the Remote Control window Title Bar menu Full Screen command to show the Host computer screen image in full screen, see Remote Control Display.

Click this Remote Control full screen toolbox button to show the Host computer screen image in a window, see Remote Control Display.

**Note:** Press the zoom hot key to toggle between window and full screen. The zoom hot key is CTRL+Z unless modified, see the Program Options window Remote Control Tab.

- **Send Ctrl+Esc:** Click this button or select the Remote Control window Title Bar menu Send Ctrl +Esc command to send the keystroke combination CTRL+ESC to the Host to show the Start menu on a Windows Host computer or the Window List on an OS/2 Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To. Using this keystroke combination from the keyboard can have undesired effects.

- **Send Ctrl+Alt+Del:** Click this button or select the Remote Control window Title Bar menu Send Ctrl+Alt+Del command to send the keystroke combination CTRL+ALT+DEL to the Host to show the security dialog box on a Windows 2003/XP/2000/NT Host computer or restart an OS/2 Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To. Using this keystroke combination from the keyboard can have undesired effects. Send Ctrl+Alt+Del will be disabled with Windows ME, 98 and 95 Host computers. Click or select Restart Host PC to restart the Host computer.

- **Restart Host PC:** Click this button or select the Remote Control window Title Bar menu Restart Host PC command to show a confirmation window to confirm restarting the Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Execute command (Restart, ...), see Allow Guest To.

### 3.6.1.2.4 Multi Guest Session Buttons

These are the Remote Control Toolbar or Toolbox multi Guest session buttons:

- **Take Keyboard and Mouse Control:** Click this button to take keyboard and mouse control.

**Note:** This button will be disabled if the Guest has keyboard and mouse control. If on the Program Options window Remote Control Tab the Auto take control box is checked, alternatively click in the Remote Control Display or strike a key to take keyboard and mouse control.
Start Multi Chat: Click this button to start a Chat session that will include all Guests connected to the Host.

**Note:** This button will be disabled if only one Guest is connected to the Host or if a Multi Chat Session is running.

Show Connection List: Click this button to show on the Host computer screen the Connection List window that will show records of connected Guests.

Suspend Further Connections: Click this button to make it appear pressed in to deny further Guest connections. Click the pressed in button to release it to allow further Guest connections.

**Note:** This button will be disabled if the Host on its Program Options window General tab does not Allow multiple simultaneous Guest connections.

Disconnect All Guests Except Your Own: Click this button to disconnect other connected Guests.

**Note:** This button will be disabled if only one Guest is connected to the Host.

### 3.6.1.2.5 Clipboard Buttons

These are the Remote Control Toolbar or Toolbox clipboard buttons:

Send Clipboard: Click this button or select the Remote Control window Title Bar menu Send (Clipboard) to Host command to send the Guest computer clipboard contents to the Host computer clipboard.

**Note:** This button will be disabled if Host Guest Access Security does not allow Transfer clipboard, see Allow Guest To.

Retrieve Clipboard: Click this button or select the Remote Control window Title Bar menu Retrieve (Clipboard) from Host command to retrieve the Host computer clipboard contents to the Guest computer clipboard.

**Note:** This button will be disabled if Host Guest Access Security does not allow Transfer clipboard, see Allow Guest To.

Save Screen to Clipboard: Click this button or select the Remote Control window Title Bar menu Save Screen to Clipboard command to capture the Host computer screen image to the Guest computer clipboard.

Save Screen to File: Click this button or select the Remote Control window Title Bar menu Save Screen to File command to capture the Host computer screen image and show a Windows Save As window that suggests the file name <Host name>-<Date>-<Time>.bmp and the Netop Configuration Files SnapShot directory. You can change the file name and directory before saving.

### 3.6.1.2.6 Tool Buttons

These are the Remote Control Toolbar or Toolbox tool buttons:

Marker Mode: Click this button to make it appear pressed in or select the Remote Control window Title Bar menu Marker Mode command to check mark it to start Netop Marker Utility. Click the pressed in button to release it or select the check marked command to uncheck it to stop Netop Marker Utility.

**Note:** This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To.
**Mouse marker:** Click this button to make it appear pressed in or select the Remote Control window Title Bar menu **Mouse marker** command to show on the Host computer screen a large red mouse pointer arrow when you click in the Host screen image. Click the pressed in button to release it or select the check marked command to uncheck it to stop Mouse marker.

**Note:** This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To.

**Blank Display:** Click this button to make it appear pressed in or select the Remote Control window Title Bar menu **Blank Display** command to check mark it to make the Host computer screen turn black to the Host user. Click the pressed in button to release it or select the check marked command to uncheck it to unblank the Host screen.

**Note:** This button will be disabled if Host Guest Access Security does not allow Blank the screen, see Allow Guest To. While Blank Display works with most Host computers, the design of some display adapters prevents applying it.

**Lock Keyboard and Mouse:** Click this button to make it appear pressed in or select the Remote Control window Title Bar menu **Lock Keyboard and Mouse** command to check mark it to disable the Host computer keyboard and mouse. Click the pressed in button to release it or select the check marked command to uncheck it to enable the Host computer keyboard and mouse.

**Note:** This button will be disabled if Host Guest Access Security does not allow Lock keyboard and mouse, see Allow Guest To.

**Transfer Sound:** Click this button to make it appear pressed in or select the Remote Control window Title Bar menu **Transfer Sound** command to check mark it to transfer Host computer application sound. Click the pressed in button to release it or select the check marked command to uncheck it to not transfer sound.

**Note:** This button will be disabled if the Guest or the Host is engaged in another audio session or if Host Guest Access Security does not allow Request audio chat and transfer sound, see Allow Guest To.

**Note:** For Transfer Sound to work, these conditions must be met:

1. On the Host, the Advanced Audio Settings window Record section Preferred device dropdown box must select the computer sound system.
2. The Host computer sound system must support sound mix.
3. The Host must specify the sound mix recording mode name of the Host computer sound system, see [AUDIO] Section.
3.6.1.3 Remote Control Display

The Remote Control window display panel will show an image of the Host computer screen:

In full screen, the Host computer screen image will cover the Guest computer screen, see the Toolbar or Toolbox Full Screen button or the Title Bar menu Full Screen command.

Specify general Remote Control session options on the Program Options window Remote Control Tab.

Specify Remote Control session options for each Host record or session in the Connection Properties window.

By default, the Guest user and the Host user can work in the Host computer screen image at the same time.

The Guest user can control Host user access to the Host computer screen image in the Connection Properties window Startup Tab Actions section and from Remote Control Toolbar or Toolbox Tool Buttons or window Title Bar menu commands.

On the other hand, Host Guest Access Security and other Host tools enable the Host user or system administrators to limit Guest access and actions on the Host computer, see Host Security Guide.

3.6.1.4 Status Bar

The Remote Control window status bar will be shown unless hidden from the Program Options window Remote Control Tab:

The left field will show the icon of the encryption type used in the communication between the Guest and the Host, see the Connection Properties window Compression/Encryption Tab.

The next field with a recording icon will appear if the session is being recorded, see the Connection Properties window Record Tab.

The two next fields will show the Guest mouse and keyboard mode, see the Connection Properties window Keyboard/Mouse Tab.

The right field will show the duration of the Remote Control session.
3.6.1.5 Multi Guest Session

If on the Host Program Options window General Tab the Allow multiple simultaneous Guest connections box is checked, multiple Guests can connect to it to run a joint multi Guest Remote Control session.

Host Guest Access Security specifies which multi Guest session actions are allowed to a Guest, see Allow Guest To.

- If the Join multi Guest session box is checked, the Guest can join a Remote Control session that another Guest runs with the Host (typically checked).

- If the Act as multi Guest session administrator box is checked, the Guest can manage a multi Guest session, see Multi Guest Session Buttons (typically checked).

In a multi Guest Remote Control session, one Guest at a time can have keyboard and mouse control. The Guest that has keyboard and mouse control can execute all actions allowed to it. Guests that do not have keyboard and mouse control can execute only a limited range of actions.

The Host window title bar will typically show the name of the Guest that has keyboard and mouse control, see the Host Program Options window Connection Notification Tab. Other connected Guests will be indicated by +<Number of other connected Guests>.

3.6.2 Monitor

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can monitor Host computers.

The Guest can connect to monitor Host computers from the Quick Connect Tab or from Phonebook Tab or History Tab records, see Connect Guide.

Note: The Guest cannot monitor a Host computer with which it runs a Remote Control session.

Select Tab Panel Host records and click the Toolbar Monitor button or select the Connection Menu Monitor command to show the Monitor Toolbox and start connecting to the first selected record Host.

Note: If required by Host Guest Access Security, the Guest must log on to each Host to monitor it, see Guest Authentication.

When connected, the Host computer screen image will be shown, typically in this window:
This window resembles the Remote Control window, but only these Toolbar or Toolbox buttons and matching Title Bar menu commands will be enabled:

**Full Screen:** Click this window toolbar button to show the Host computer screen image in full screen, see Remote Control Display.

Click this full screen toolbox button to show the Host computer screen image in a window, see Remote Control Display.

**Note:** Press the zoom hot key to toggle between window and full screen. The zoom hot key is CTRL+Z unless modified, see the Program Options window Remote Control Tab.

**Show Connection List:** Click this button to show on the Host computer screen the Connection List window that shows records of connected Guests.

**Save Screen to Clipboard:** Click this button to capture the Host computer screen image to the Guest computer clipboard.

**Save Screen to File:** Click this button to capture the Host computer screen image to show a Windows Save As window that suggests the file name <Host name>-<Date>-<Time>.bmp and the Netop Configuration Files SnapShot directory. You can change the file name and directory before saving.

The window Status Bar mouse and keyboard control fields will show No Mouse and No Keyboard to indicate that monitoring provides no mouse and keyboard control in the Host screen image.

Other Remote Control Display functionalities are available.

When the Program Options window Monitor Tab specified Monitor interval has expired, the Guest will disconnect and connect to the next selected record Host.

You can control monitoring from the Monitor Toolbox.
3.6.2.1 Monitor Toolbox

This is the Monitor toolbox:

Its title bar will show:

- While monitoring: Monitoring: <Host name>, <Number> s., where <Number> will count down from the Program Options window Monitor Tab specified Monitor.interval to zero. After countdown, the Guest will disconnect and connect to the next selected record Host.
- While holding countdown: Holding: <Host name>.
- While remote controlling: Remote controlling: <Host name>.

It contains these buttons:

- **End:** End monitoring.
- **Continue:** Continue countdown after Hold.
- **Hold:** Hold countdown.
- **Previous:** Monitor previous Host.
- **Next:** Monitor next Host.

**Remote Control/Monitor:** Switch between monitor and remote control. The button will show a remote control icon in monitor mode and a monitor icon in remote control mode.

**Full Screen/Window:** Switch between window and full screen. The button will show a window to full screen icon in window mode and a full screen to window icon in full screen mode.

**Host List:** Show a list of monitored Hosts. Select a Host to monitor it.

Monitor remote control does not enable full Remote Control functionality but enables mouse and keyboard control and these additional Toolbar or Toolbox buttons and matching Title Bar menu commands:

**Connection Properties:** Click this button or select the Title Bar menu Connection Properties command to show the Connection Properties window with a limited tab and option selection.

**Send Ctrl+Esc:** Click this button or select the Title Bar menu Send Ctrl+Esc command to send the keystroke combination CTRL+ESC to the Host to show the Start menu on a Windows Host computer or the Window List on an OS/2 Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To. Using this keystroke combination from the keyboard can have undesired effects.

**Send Ctrl+Alt+Del:** Click this button or select the Title Bar menu Send Ctrl+Alt+Del command to send the keystroke combination CTRL+ALT+DEL to the Host to show the security dialog box on a Windows 2003/XP/2000/NT Host computer or restart an OS/2 Host computer.

**Note:** This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To. Using this keystroke combination from the keyboard can have undesired effects. Send Ctrl+Alt+Del will be disabled with Windows ME, 98 and 95 Host computers.

**Send Clipboard:** Click this button or select the Title Bar menu Send Clipboard to Host command to send the Guest computer clipboard contents to the Host computer clipboard.
Note: This button will be disabled if Host Guest Access Security does not allow Transfer clipboard, see Allow Guest To.

Retrieve Clipboard: Click this button or select the Title Bar menu Retrieve Clipboard from Host command to retrieve the Host computer clipboard content to the Guest computer clipboard.

Note: This button will be disabled if Host Guest Access Security does not allow Transfer clipboard, see Allow Guest To.

Marker Mode: Click this button to make it appear pressed in or select the Title Bar menu Marker Mode command to check mark it to start Netop Marker Utility. Click the pressed in button to release it or select the check marked command to uncheck it to stop Netop Marker Utility.

Note: This button will be disabled if Host Guest Access Security does not allow Use keyboard and mouse, see Allow Guest To.

Lock Keyboard and Mouse: Click this button to make it appear pressed in or select the Title Bar menu Lock Keyboard and Mouse command to check mark it to disable the Host computer keyboard and mouse. Click the pressed in button to release it or select the check marked command to uncheck it to enable the Host computer keyboard and mouse.

Note: This button will be disabled if Host Guest Access Security does not allow Lock keyboard and mouse, see Allow Guest To.

3.6.3 File Transfer

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a file transfer session with a Host to transfer files between the Guest and Host computer.

The Guest can connect to start a file transfer session from the Quick Connect Tab, from a Phonebook Tab or History Tab record or in response to a help request from a Help Request Tab record.

When connected, the Guest can start and end a file transfer session from a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar or Toolbox File Transfer button or the Remote Management Netop Sessions File Transfer command.

Note: If the Host allows multiple simultaneous Guest connections, see Guest Sessions, multiple file transfer session Guests will run separate sessions.

This window will be shown on the Guest computer screen:
No window will be shown on the Host computer screen.

This window contains these main elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**
- **Two Record Panels** for the Guest to the left and for the Host (the Guest in a local file transfer session) to the right.

### 3.6.3.1 Title Bar

This is the **Netop File Manager** window title bar:

It will show the name by which you connected to the Host or **Guest** in a local file transfer session.

### 3.6.3.2 Menu Bar

This is the **Netop File Manager** window menu bar:

It contains these menus:

- **File Menu**
- **Edit Menu**
- **View Menu**
- **Options Menu**
Help Menu

3.6.3.2.1 File Menu

This is the Netop File Manager window File menu:

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy File(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move File(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sync File(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clone File(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drive Info</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>Alt+CR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>Alt+F4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Copy Files:** Select Record Panel records and select this command or the matching Record Panel context menu command, press any matching keyboard shortcut, see Layout Tab, or click the Toolbar Copy Files button to show the Copy window.

**Note:** Alternatively, drag records from one Record Panel to the other and drop them to typically show the Transfer Status window.

**Move Files:** Select Record Panel records and select this command or the matching Record Panel context menu command, press any matching keyboard shortcut, see Layout Tab, or click the Toolbar Move Files button to show the Move window.

**Sync Files:** Select this command or click the Toolbar Synchronize Files button to show the Synchronize window.

**Note:** By default, synchronization will transfer directories and files to include directories and files that exist in either Record Panel in both Record Panels replacing older files by newer files. On the Options window Transfer Tab, you can select the Synchronize options Transfer only if file exists and Transfer only one way.

**Clone Files:** Select this command or click the Toolbar Clone Files button to show the Clone window.

**Note:** Cloning will transfer all directories and files in the selected Record Panel to the unselected Record Panel deleting existing directories and files in it.

**New Folder:** Select this command, press any matching keyboard shortcut, see Layout Tab, or click the Toolbar New Folder button to show this window:

**Enter name for new folder []:** Specify in this field the new folder name.

**OK:** Click this button to close the window to create the folder in the selected Record Panel.

**Drive Info:** Select this command to show this window:
**Drive Information**

**Drives:** This pane will show icons and letters of the drives found on the selected Record Panel computer. Select a drive to show information on the drive in the Information section.

**Information:** This section will show information on the drive selected in the Drives pane:

- **Type:** Drive type.
- **File System:** Drive file system.
- **Used Space:** Drive used space in bytes.
- **Free Space:** Drive free space in bytes.
- **Capacity:** Drive capacity in bytes.

**Delete:** Select Record Panel records and select this command or the matching Record Panel context menu command, press the matching keyboard shortcut, see Layout Tab, or click the Toolbar Delete button to delete selected records. A confirmation window may be shown, see Confirmation Tab.

**Caution:** Deleting a directory will delete directories and files in it.

**Rename:** Select a Record Panel record and select this command or the matching Record Panel context menu command or press any matching keyboard shortcut, see Layout Tab, to show this window:

**Enter new name:** The field highlights the current record name. Edit it to rename the record.

**Properties:** Select a Record Panel record and select this command or the matching Record Panel context menu command, press the matching keyboard shortcut, see Layout Tab, or click the Toolbar Properties button to show this window:
It will show the properties of the selected record including attributes that you can change.

Close: Select this command, press any matching keyboard shortcut, see Layout Tab, or use any matching Window Control to close the Netop File Manager window to end the File Transfer session.

3.6.3.2.1.1 Copy/Move/Synchronize/Clone

Selecting any of the Netop File Manager window File Menu Copy Files, Move Files, Sync Files or Clone Files commands or clicking any of the matching Copy Files, Move Files, Synchronize Files or Clone Files buttons will show this window:

Note: For the File Transfer operations Copy Files, Move Files, Synchronize Files and Clone Files, this window will differ only by its title bar operation name.
This window specifies the File Transfer operation. A few details can be modified before execution:

From

*Computer:* Will show the selected Record Panel designation.

*Folder/File:* Will show the selected Record Panel selection path, for one selected directory `<Directory path>`\*.*, for one selected file `<Directory path>`\<File name>`.

To

*Computer:* Will show the unselected Record Panel designation.

*Folder/File:* []: Will highlight the unselected Record Panel current directory path and for one selected directory `*.`, for one selected file `<File name>`. You can edit the field contents to specify another destination directory and/or file name.

Selected

*Folders:* Will show the number of selected directories.

*Files:* Will show the number of selected files.

Options

- *Include subfolders:* Will be enabled and checked if you have selected directories. Leave it checked to transfer also selected directory subdirectories and their file contents. Uncheck it to transfer only selected directories and their file contents.

- *End session when finished:* Check this box to end the File Transfer session when this file transfer is finished (default: unchecked).

OK: Click this button to execute the file transfer to show the Transfer Status window.

Options: Click this button to show the Options window to view and optionally change the option selections for this file transfer operation only.
3.6.3.2.1.2 Transfer Status

This window will be shown after clicking OK in the Copy.Move/Synchronize/Clone window or executing a File Transfer by drag and drop:

It contains these tabs:

- **Progress Tab**
- **History Tab**
- **Session History Tab**

*Close*: This button will be enabled after file transfer. Click it to close the window.

*Cancel*: This button will be enabled during file transfer. Click it to cancel a file transfer in progress. You cannot undo executed file transfer actions.
This is the **File Transfer** *Transfer Status* window *Progress* tab:

It contains these sections:

**Current Command**
Will during file transfer show the command being executed. Will after file transfer show *Transfer ended*.

**Overall Progression**
- *Files transmitted*: Will show the number of transferred files.
- *Total files*: Will show the number of selected files.
- *Bytes transmitted*: Will show the number of transferred bytes.
- *Total bytes*: Will show the number of bytes in selected files.
- *Elapsed time*: Will show the elapsed transfer time.
- *Estimated time*: Will show the estimated total transfer time.

The overall file transfer progress will be indicated by colored blocks.

**Sending/Sent/Receiving/Received**
Will during file transfer show the path and name of the file being transferred. Will after file transfer show the path and name of the last transferred file.

The progress of the current or last file transfer will be indicated by colored blocks.

These values will be shown below the progress indicator:
- *Bytes sent/received*: Number of bytes sent or received in the current or last file transfer.
- BPS: Transfer speed of the current or last file transfer in bytes per second.
- Total Bytes: Number of bytes in the current or last file transfer.

☐ *End session when finished*: Check this box to end the File Transfer session when this file transfer is finished (default: unchecked).

This is the File Transfer Transfer Status window History tab:

Its pane will graphically show the events of the current or last file transfer like Script Log events. Click [+] buttons to expand and [-] buttons to collapse the event structure.
This is the **File Transfer** **Transfer Status** window **Session History** tab:

Its pane will show the events of this **File Transfer** session like **Script Log** events. Click [+] buttons to expand and [-] buttons to collapse the event structure.

### 3.6.3.2.2 Edit Menu

This is the **Netop File Manager** window **File** menu:

- **Select All**: Select this command or press any matching keyboard shortcut, see **Layout Tab**, to select all directories and files in the selected **Record Panel**.
- **Select By**: Select this command, press any matching keyboard shortcut, see **Layout Tab**, or click the **Toolbar Select Files** button to show this window:

<table>
<thead>
<tr>
<th>Select</th>
<th>Ctrl+A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select By</td>
<td>+</td>
</tr>
<tr>
<td>Deselect By</td>
<td>-</td>
</tr>
<tr>
<td>Invert Selection</td>
<td>*</td>
</tr>
<tr>
<td>Clear Selection</td>
<td></td>
</tr>
</tbody>
</table>

164
Select the files: [ ]: In this field, replace "*." designating all directories and files by a file mask (a file name with wildcard characters like "*" designating any characters) to select files and directories with common name characters.

OK: Click this button to select unselected directories and files in the selected Record Panel by the file mask.

Deselect By: Select this command or press any matching keyboard shortcut, see Layout Tab, to show this window:

Deselect the files: [ ]: In this field, replace "*." designating all directories and files by a file mask (a file name with wildcard characters like "*" designating any characters) to deselect files and directories with common name characters.

OK: Click this button to deselect selected directories and files in the selected Record Panel by the file mask.

Invert Selection: Select this command or press any matching keyboard shortcut, see Layout Tab, to make all selected directories and files unselected and all unselected directories and files selected in the selected Record Panel.

Clear Selection: Select this command to deselect all directories and files in the selected Record Panel.

3.6.3.2.3 View Menu

This is the Netop File Manager window View menu:

Large Icons: Select this command to check mark it or click the Toolbar Large Icons button to make it appear pressed in to show Record Panel records as horizontal rows of large icons.

Small Icons: Select this command to check mark it or click the Toolbar Small Icons button to make it appear pressed in to show Record Panel records as horizontal rows of small icons.

List: Select this command to check mark it or click the Toolbar List button to make it appear pressed in to show Record Panel records as vertical columns of small icons.

Details: Select this command to check mark it or click the Toolbar Details button to make it appear pressed in to show Record Panel records in a table with details in columns (default selection).

Local: Select this command to check mark/uncheck it or click the Toolbar Local button to make it appear pressed in/released to switch between remote and local file transfer (default: unchecked/released for remote file transfer).
Arrange Icons: This command expands into these commands:

- **By Name:** Select this command or press any matching keyboard shortcut, see Layout Tab, to sort Record Panel file records by file name, ascending/descending like the Details selection.
- **By Type:** Select this command or press any matching keyboard shortcut, see Layout Tab, to sort Record Panel file records by extension, ascending/descending like the Details selection.
- **By Size:** Select this command or press any matching keyboard shortcut, see Layout Tab, to sort Record Panel file records by size, ascending/descending like the Details selection.
- **By Date:** Select this command or press any matching keyboard shortcut, see Layout Tab, to sort Record Panel file records by time, ascending/descending like the Details selection.
- **Auto Arrange:** Select this command to uncheck/check mark it to disable/enable automatically sorting file records after changes by the current selection (default: check marked for Auto Arrange enabled).

**Note:** Directory folder records in alphabetically ascending order will always be shown before files. In Details, sort file records ascending/descending by clicking column headings.

**Refresh:** Select this command or press any matching keyboard shortcut, see Layout Tab, to retrieve new information from the computers to refresh Record Panel contents.

### 3.6.3.2.4 Options Menu

This is the Netop File Manager window Options menu:

```
File  Edit  View  Options  Help

Options

View File Manager log file
Script
```

**Options:** Select this command, click the Toolbar Options button, click the Copy/Move/Synchronize/Clone window Options button or select the Netop Guest Window Tools Menu File Manager Options command to show the Options window.

**View File Manager Log:** Select this command or the matching Netop Guest Window View Menu command to show a Windows Open window that specifies Files of type: Log Files (*.log) to open a File Transfer log file to show its contents in this window:
Its pane will show File Transfer session events like Script Log events. Click [+] buttons to expand and [-] buttons to collapse the event structure.

Open Log...: Click this button to show a Windows Open window that specifies Files of type: Log Files (*.log) to open another File Transfer log file in the window.

Script: Select this command or click the Toolbar Script button to show the Script window to create or open a Netop Script.

3.6.3.2.4.1 Options

Select the Netop File Manager window Options Menu Options command, click the Toolbar Options button, click the Copy/Move/Synchronize/Clone window Options button or select the Netop Guest Window Tools Menu File Manager Options command to show this window.
It contains these tabs:

- **Transfer Tab**
- **Confirmation Tab**
- **Layout Tab**
- **Logging Tab**
This is the Options window Transfer tab:

![NetOp File Manager - Options window]

It contains these sections:

**Synchronize**
- **Transfer only if file exists**: Check this box to synchronize files only if they exist in the unselected Record Panel (default: unchecked).
- **Transfer only one way**: Check this box to synchronize files only from the selected Record Panel to the unselected Record Panel (default: unchecked).

**General Transfer**
- **Include subfolders**: Leave this box checked to transfer also the contents of subdirectories of selected directories (default: checked).
- **Use delta file transfer**: Leave this box checked to compare source files with matching destination files and transfer only differences between source and destination files to save transmission bandwidth (default: checked).
- **Enable crash recovery**: Leave this box checked to transfer files in a way that they can be recovered after a computer or network crash during file transfer (default: checked).
- **Close dialog when finished**: Check this box to close the Transfer Status window when a file transfer is finished (default: unchecked).
- **End session when finished**: Check this box to end the File Transfer session when a file transfer is finished (default: unchecked).

**Default**: Click this button to restore the tab default settings.
This is the *Options* window *Confirmation* tab:

It contains this section:

**Confirm when...**

- **Delete non-empty folders**: Leave this box checked to show this confirmation window if you are about to delete a directory that contains directories or files (default: checked):

  ![NetOp File Manager - Delete](image)

  *Skip*: Click this button to skip deleting the specified directory.

  *Delete*: Click this button to delete the specified directory.

  *Advanced...*: Click this button to show this window:
It will show your *Delete* confirmation selections to enable you to change them for this file transfer operation before continuing.

*Cancel:* Click this button to cancel the file transfer at this point. You cannot undo executed file transfer actions.

- **Overwriting/deleting files:** Check this box to show this window or the *Delete* window if you are about to overwrite or delete files (default: unchecked):

```
NetUp File Manager - Advanced
```

- **Confirm when...**
  - ✔️ Deleting non-empty folders.
  - ✔️ Deleting files.
  - ✔️ Deleting read-only files.
  - ✔️ Deleting hidden files.
  - ✔️ Deleting system files.

```
NetUp File Manager - Overwrite
```

This file already exists, would you like to overwrite it?

- **File:** Host "C:\test.bat"
- **Size:** 4 bytes (4 bytes)
- **Created:** 12:20:2004
- **Modified:** 12:26:2004 01:50
- **Accessed:** 01:06:2006

- **Skip:** Click this button to skip overwriting the specified file.
- **Overwrite:** Click this button to overwrite the specified file.
- **Advanced...:** Click this button to show this window:
Always skip...
Check boxes in this section to skip file transfer in this file transfer operation in case of checked properties (default: all unchecked):

☐ Existing files
☐ Read-only files
☐ Hidden files
☐ System files
☐ On file write error
☐ On file read error

Confirm when...
This section will show your Overwrite/Delete confirmation selections to enable you to change them for this file transfer operation before continuing.

☑ Overwriting existing files: Leave this box checked to show the Overwrite window if you are about to overwrite existing files (default: checked).

☑ Overwriting/deleting read-only files: Leave this box checked to show the relevant confirmation window if you are about to overwrite/delete read-only files (default: checked).

☑ Overwriting/deleting hidden files: Leave this box checked to show the relevant confirmation window if you are about to overwrite/delete hidden files (default: checked).

☑ Overwriting/deleting system files: Leave this box checked to show the relevant confirmation window if you are about to overwrite/delete system files (default: checked).

☑ Overwriting/deleting read-only files: Leave this box checked to show the relevant confirmation window if you are about to overwrite/delete read-only files (default: checked).

☑ Overwriting/deleting hidden files: Leave this box checked to show the relevant confirmation window if you are about to overwrite/delete hidden files (default: checked).
**Overwriting/deleting system files:** Leave this box checked to show the relevant confirmation window if you are about to overwrite/delete system files (default: checked).

**Drag and drop (copying files with the mouse):** Check this box to show a confirmation window before executing a drag and drop file transfer (default: unchecked).

*Default:* Click this button to restore the tab default settings.

This is the *Options* window *Layout* tab:

It contains these sections:

**Screen**

- **Show toolbar:** Leave this box checked to show the *Netop File Manager* window *Toolbar* (default: checked).
- **Show status bar:** Leave this box checked to show a status bar at the bottom of the two *Record Panels* (default: checked).
- **Save session path at exit:** Leave this box checked to show the same *Record Panel* contents when starting a *File Transfer* session with the same Host next time (default: checked). Uncheck to always show the system drive contents when starting a *File Transfer* session.

**Keyboard**

Select one of these options:

- **Use system hotkey layout:** Select this option to use the operating system hot key layout, see the table below (default selection).
- **Use Netop hotkey layout:** Select this option to use the Netop hot key layout, see the table below.

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows hot key</th>
<th>Netop hot key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Files</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Move Files</td>
<td>F6</td>
<td></td>
</tr>
</tbody>
</table>
## Netop Guest

<table>
<thead>
<tr>
<th>Command</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Folder</td>
<td>F7</td>
</tr>
<tr>
<td>Delete</td>
<td>DELETE F8</td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Close</td>
<td>ALT+F4 F10</td>
</tr>
<tr>
<td>Properties</td>
<td>ALT+ENTER SHIFT+F1</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Select by</td>
<td>+</td>
</tr>
<tr>
<td>Deselect by</td>
<td>-</td>
</tr>
<tr>
<td>Invert selection</td>
<td>*</td>
</tr>
<tr>
<td>Arrange Icons By Name</td>
<td>CTRL+F3</td>
</tr>
<tr>
<td>Arrange Icons By Type</td>
<td>CTRL+F4</td>
</tr>
<tr>
<td>Arrange Icons By Size</td>
<td>CTRL+F6</td>
</tr>
<tr>
<td>Arrange Icons By Date</td>
<td>CTRL+F5</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5 CTRL+R</td>
</tr>
<tr>
<td>Select the left record panel</td>
<td>ALT+F1</td>
</tr>
<tr>
<td>Select the right record panel</td>
<td>ALT+F2</td>
</tr>
<tr>
<td>Help</td>
<td>F1 F1</td>
</tr>
</tbody>
</table>

**Note:** Hot keys will be shown next to menu commands.

### Icons

Select one of these options:

- **Local associated and Host 'exe' icons:** Show Record Panel file icons according to Guest file associations but show Host exe file icons according to Host file associations.

- **Local associated icons:** Show Record Panel file icons according to Guest file associations (default selection, saves transmission bandwidth).

- **Default icons:** Show the same default icon for all Record Panel files (saves transmission bandwidth and processor capacity).

*Default:* Click this button to restore the tab default settings.
This is the *Options* window *Logging* tab:

**Log File**

☑ *Generate log file*: Leave this box checked to generate a file transfer log file when ending a *File Transfer* session (default: checked).

☐ *Append if log file exists*: Check this box to append new log entries to an existing log file (default: unchecked). If unchecked, an existing log file will be overwritten.

**Filename []**: This field will specify the log file (path and) name, by default `NFM.LOG` that will reside in the *Netop Configuration Files* directory, typically `C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest`.

**Browse**: Click this button to show a Windows *Save As* window to specify a log file path and name that will be shown in the field.

**Default**: Click this button to restore the tab default settings.

### 3.6.3.2.5 Help Menu

This is the *Netop File Manager* window *Help* menu:

**Help Topics F1**: Select this command or if the *Netop File Manager* window is active press F1 to open the *Netop Guest Help* system on the *File Transfer* topic. The left window pane will contain a graphical table of contents.
3.6.3.3 Toolbar

The Netop File Manager window toolbar will be shown unless hidden from the Options window Layout Tab:

It contains buttons in these groups:

- File Transfer Buttons
- Other Buttons

### 3.6.3.3.1 File Transfer Buttons

The Netop File Manager window Toolbar file transfer buttons:

- **Copy Files**: Select Record Panel records and click this button or select the File Menu or Record Panel context menu Copy Files command or press any matching keyboard shortcut, see Layout Tab, to show the Copy window.

  **Note**: Alternatively, drag records from one Record Panel to the other and drop them to typically show the Transfer Status window.

- **Move Files**: Select Record Panel records and click this button or select the File Menu or Record Panel context menu Move Files command or press any matching keyboard shortcut, see Layout Tab, to show the Move window.

- **Synchronize Files**: Click this button or select the File Menu Sync Files command to show the Synchronize window.

  **Note**: By default, synchronization will transfer directories and files to include directories and files that exist in either Record Panel in both Record Panels replacing older files by newer files. On the Options window Transfer Tab, you can select the Synchronize options Transfer only if file exists and Transfer only one way.

- **Clone Files**: Click this button or select the File Menu Clone Files command to show the Clone window.

  **Note**: Cloning will transfer all directories and files in the selected Record Panel to the unselected Record Panel deleting existing directories and files in it.

### 3.6.3.3.2 Other Buttons

The Netop File Manager window Toolbar other buttons:

- **New Folder**: Click this button or select the File Menu New Folder command to show the New Folder window.

- **Delete**: Select Record Panel records and click this button, select the File Menu or Record Panel context menu Delete command or press the matching keyboard shortcut, see Layout Tab, to delete selected records. A confirmation window may be shown, see Confirmation Tab.

- **Properties**: Select a Record Panel record and click this button, select the File Menu or Record Panel context menu Properties command or press the matching keyboard shortcut, see Layout Tab, to show the Properties window.
Select By: Click this button or select the Edit Menu Select By command or press any matching keyboard shortcut, see Layout Tab, to show the Select window.

Options: Click this button or select the Options Menu Options command to show the Options window.

Script: Click this button or select the Options Menu Script command to show the Script window to open or create a Netop Script.

Local: Click this button to make it appear pressed in/released or select the View Menu Local command to check mark/uncheck it to switch between remote file transfer and local file transfer (default: released/unchecked for remote file transfer).

Large Icons: Click this button to make it appear pressed in or select the View Menu Large Icons command to check mark it to show Record Panel records as horizontal rows of large icons.

Small Icons: Click this button to make it appear pressed in or select the View Menu Small Icons command to check mark it to show Record Panel records as horizontal rows of small icons.

List: Click this button to make it appear pressed in or select the View Menu List command to check mark it to show Record Panel records as vertical columns of small icons.

Details: Click this button to make it appear pressed in or select the View Menu Details command to check mark it to show Record Panel records in a table with details in columns (default selection).

3.6.3.4 Record Panel

The two Netop File Manager window record panels have identical layout:

The top title bars show <Guest> in the left record panel and the Host name in the right record panel. In a local file transfer session, the right record panel will show Guest.
The selected record panel title bar will have a strong color and the unselected record panel title bar will have a dimmed color. Click in a record panel or press a keyboard shortcut, see Layout Tab, to select it. Press TAB to switch the record panel selection. Record panels will remain equally sized.

The directory bar below contains a left drive drop-down box and a right directory drop-down box.

The field of the drive drop-down box shows the selected drive icon and letter. The drop-down box list will contain the icon, letter and name of local and mapped network drives. Select a drive in the list to show it in the field.

The field of the directory drop-down box will show the path of the selected directory. The drop-down box list will contain the paths of up to 30 directories that have been selected during the current File Transfer session. Select a directory path in the list to show it in the field to show its contents in the records pane below. Alternatively, specify a directory path in the drop-down box field and press ENTER to select the directory.

The records pane below will contain records of directories and files in the selected directory as Large Icons, Small Icons, List or Details. Change the display from the Toolbar or the View Menu. Directory records in alphabetically ascending order are shown before file records. Sort file records by clicking Details column headings or by pressing a keyboard shortcut, see Layout Tab. Details will show record details in a table with these column contents:

- **Name**: Record name.
- **Ext**: <DIR> for directory, file extension for file.
- **Size**: File size in bytes. Directory size is 0 bytes.
- **Date**: Date and time of last record change.
- **Attrib**: First letters of record attributes:
  - r: Read-only
  - a: Archive
  - h: Hidden
  - s: System

Double-click a directory record to select this directory to show its path in the directory bar and its contents in the records pane.

Double-click a records pane top directory record with two period characters (..) to move one step up in the directory tree structure.

The bottom status bar will show the number of bytes in the number of selected record files. Bytes in files in selected directory record directories are not included in the byte count.

Execute file transfers and manage records from Toolbar buttons and menu commands.

Right-click a record or multiple selected records to show this context menu:

<table>
<thead>
<tr>
<th>Open With…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy File(s)</td>
</tr>
<tr>
<td>Move File(s)</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Rename</td>
</tr>
<tr>
<td>Properties</td>
</tr>
</tbody>
</table>

Top section commands that may be different with different file selections and computer setups are similar to Windows Explorer right-click context menu commands.

Lower sections commands match File Menu commands.
Drag selected records in one record pane to the other record pane and drop them to copy them to a record directory, if highlighted, or to the directory whose records are shown in the pane.

Press the right mouse button and drag selected records in one record pane to the other record pane and drop them to show this context menu:

| Copy here | Move here | Cancel |

*Copy here*: Select this command to copy selected records to a record directory, if highlighted, or to the directory whose records are shown in the pane.

*Move here*: Select this command to move selected records to a record directory, if highlighted, or to the directory whose records are shown in the pane.

*Cancel*: Select this command to cancel the attempted file transfer.

### 3.6.4 Chat

If allowed by Host *Guest Access Security*, see Allow Guest To, the Guest can start a chat session with a Host to enable typed text communication between the Guest computer user and the Host computer user.

The Guest can connect to start a chat session from the [Quick Connect Tab](#), from a [Phonebook Tab](#) or [History Tab](#) record or in response to a help request from a [Help Request Tab](#) record.

When connected, the Guest can start and end a chat session from a [Phonebook Tab](#), [Quick Connect Tab](#), [Connections Tab](#) or [History Tab](#) record or from the [Remote Control Toolbar or Toolbox Chat](#) button or the [Remote Management Netop Sessions Chat](#) command.

The Host can start and end a chat session with a Guest that is connected to it, see also [Multi Chat Session](#).

*Note*: If the Host allows multiple simultaneous Guest connections, see [Guest Sessions](#), multiple chat session Guests will run a joint [Multi Chat Session](#) with the Host.

This window will be shown on the Guest computer screen and a similar window will be shown on the Host computer screen:
Its title bar will show the name of the Host.

*Dialog:* This pane will show the chat dialog with the name of the sender preceding each contribution. When the chat dialog exceeds the pane, the pane will get a vertical scroll bar.

*Enter Chat contribution and click Send:* Specify your chat contribution in this pane from the keyboard if the Chat window is active or by pasting text. Edit your chat contribution by the keyboard shortcuts CTRL+X (Cut), CTRL+C (Copy), CTRL+V (Paste) and DEL (Delete).

*Send:* Click this button to move your chat contribution from the *Enter*... pane to the *Dialog* pane where it will be visible to the chat session participants.

*Font:* Click this button to show the Windows *Font* window to format your chat contribution.

*End chat:* Click this button or apply a *Window Control* *Close* control to close the window to end the session.

*Save:* Click this button to show a Windows *Save As* window that will suggest saving the chat dialog in a file named *Chat* <Date> <Time>.rtf in your personal computer directory. You can edit the file path and name before saving.

### 3.6.4.1 Multi Chat Session

If Netop Host allows multiple simultaneous Guest connections, see [Guest Sessions](#), Netop Guest can start a *Chat* session to join a *Chat* session that runs between another Guest and the Host to run a multi *Chat* session.

If multiple Guests are connected to a Host, the Host can start a multi *Chat* session with all connected Guests or a *Chat* session with a selected connected Guest.
A Guest that Host Guest Access Security allows to Act as multi Guest session administrator, see Allow Guest To, can Start Multi Chat with the Host and all connected Guests from a Remote Control Multi Guest Session.

A Guest that ends a multi Chat session will leave the session. The session will end when the Host or the last session Guest ends the session.

3.6.5 Audio-Video Chat

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start an audio-video chat session with a Host to enable sound and live image communication between the Guest computer user and the Host computer user.

The Guest can connect to start an audio-video chat session from the Quick Connect Tab, from a Phonebook Tab or History Tab record or in response to a help request from a Help Request Tab record.

When connected, the Guest can start and end an audio-video chat session from a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar or Toolbox Audio-Video Chat button or the Remote Management Netop Sessions Audio-Video Chat command.

The Host can start an audio-video chat session only with a connected Guest that has keyboard and mouse control.

Note: Each Guest and each Host can run only one audio session including Transfer Sound at a time.

This window will be shown on the Guest computer screen:

A similar window without the toolbar will be shown on the Host computer screen.

The title bar will show the Host name.

The toolbar contains these buttons:

Audio: Typically, this button will appear pressed in to indicate that audio communication is enabled. Click the button to disable/enable audio communication.

Video: Typically, this button will appear released in to indicate that video communication is disabled. Click the button to enable/disable video communication.
Netop Guest

**Note:** If Host *Guest Access Security* does not allow *Request video*, see *Allow Guest To*, you cannot enable video communication.

- **Large:** Click this button to resize the Guest and Host *Audio-Video Chat* window to accommodate a large *Remote* video frame.
- **Medium:** Click this button to resize the Guest and Host *Audio-Video Chat* window to accommodate a medium *Remote* video frame.
- **Small:** Click this button to resize the Guest and Host *Audio-Video Chat* window to accommodate a small *Remote* video frame (default selection).

**End Session:** Click this button or apply a *Window Control Close* control to close the window to end the audio-video chat session.

In the *Remote* section, the video frame will show the remote computer video camera image. If the toolbar *Video* button is released, the frame will show *No Video*. If no camera runs on the remote computer, the frame will show *No Camera*.

In the *Local* section, the video frame will show the local computer video camera image. If the toolbar *Video* button is released, the frame will show *No Video*. If no camera runs on the local computer, the frame will show *No Camera*.

The lower right *Volume* section has two slides and a pane:

- Drag the left loudspeaker slide to adjust the playback volume (default: maximum).
- Drag the middle microphone slide to adjust the recording volume (default: medium).
- The right microphone pane will monitor the recording volume. The pane should remain empty while not talking. Colored blocks should partly but not completely fill the pane while talking.

Specify audio and video options on the *Program Options* window *Audio-Video Chat Tab*.

### 3.6.6 Remote Management

If allowed by Host *Guest Access Security*, see *Allow Guest To*, the Guest can start a remote management session with a Host to access Host computer management tools.

The Guest can connect to start a remote management session from the *Quick Connect Tab*, from a *Phonebook Tab* or *History Tab* record or in response to a help request from a *Help Request Tab* record.

When connected, the Guest can start and end a remote management session from a *Phonebook Tab*, *Quick Connect Tab*, *Connections Tab* or *History Tab* record or from the *Remote Control Toolbar* or *Toolbox Remote Management* button.

**Note:** If the Host allows multiple simultaneous Guest connections, see *Guest Sessions*, multiple remote management session Guests will run separate sessions.

This window will be shown on the Guest computer screen:
No window will be shown on the Host computer screen.

This window provides remote access to a range of Host computer management tools. It contains these main elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**
- **Work panel with a left Navigation Panel and a right Display Panel**
- **Status Bar**

Remote management tools are explained in **Management**.

Netop session tools are explained in **Netop Sessions**.

Host computer details are explained in **Details**.
3.6.6.1 Title Bar

This is the Remote Management window title bar:

Netop Remote Management - CG0003 - Disk Drives

It will show the name of the session Host and of any selected Management tool.

3.6.6.2 Menu Bar

This is the Remote Management window menu bar:

File View Management Help Disk Drives

It contains these menus:

- File Menu
- View Menu
- Management Menu
- Help Menu
- <Management tool> Menu

Note: The <Management tool> menu will be available only if a Management tool is selected. The red Netop kite at the right end of the menu bar will move while remote management information is retrieved from the Host computer.

3.6.6.2.1 File Menu

This is the Remote Management window File menu:

Netop Sessions: This command expands into commands that match the Navigation Panel Netop Sessions section commands.

Exit: Select this command or apply a Window Control Close control to close the Remote Management window to end the session.

3.6.6.2.2 View Menu

This is the Remote Management window View menu:

Toolbar: Select this command to uncheck/check mark it to hide/show the Toolbar (default: check marked to show the Toolbar).

Status Bar: Select this command to uncheck/check mark it to hide/show the Status Bar (default: check marked to show the Status Bar).

Navigation Panel: Select this command to uncheck/check mark it to hide/show the Navigation Panel (default: check marked to show the Navigation Panel).
Note: You can also hide/show the Navigation Panel from its left/right pointer button.

3.6.6.2.3 Management Menu

This is the Remote Management window Management menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
<th>Disk Drives</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Disk Drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Event Viewer</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Registry</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shared Folders</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Inventory</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Command Console</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>System Control</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

It contains these commands that match Navigation Panel Management section commands:

**Disk Drives**: Select this command to show Host computer disk drives information in the Display Panel.

Note: Accessing Host computer Disk Drives requires certain rights on the Host computer, see Management.

**Event Viewer**: Select this command to show Host computer event viewer information in the Display Panel.

Note: Accessing the Host computer Event Viewer requires certain rights on the Host computer, see Management.

**Task Manager**: Select this command to display Host computer task manager information in the Display Panel.

**Registry**: Select this command to show Host computer registry information in the Display Panel.

Note: Accessing Host computer Registry requires certain rights on the Host computer, see Management.

**Services**: Select this command to show Host computer services information in the Display Panel.

Note: Accessing Host computer Services requires certain rights on the Host computer, see Management.

**Shared Folders**: Select this command to show Host computer shared folders information in the Display Panel.

Note: Accessing Host computer Shared Folders requires certain rights on the Host computer, see Management.

**Inventory**: Select this command to show Host computer inventory information in the Display Panel.

**Command Console**: Select this command to show a Host computer command window in the Display Panel.

**System Control**: Select this command to show a Host computer system control window in the Display Panel.

3.6.6.2.4 Help Menu

This is the Remote Management window Help menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
<th>Disk Drives</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Help Index</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Help Index**: Select this command to open the Netop Guest Help system on the Remote Management topic. The left pane will contain a graphical table of contents.
3.6.6.2.5 <Management tool> Menu

This *Remote Management* window menu will be available only if a *Management* tool is selected. It will have the name of the selected *Management* tool, e.g.:

![Menu](Image)

This menu will have different contents with different *Management* tools.

3.6.6.3 Toolbar

The *Remote Management* window toolbar will be shown unless hidden from the *View Menu Toolbar* command if a *Management* tool is selected, e.g.:

![Toolbar](Image)

The toolbar will contain different buttons with different *Management* tools as explained with each *Management* tool.
3.6.6.4 Navigation Panel

The Remote Management window work panel left navigation panel will be shown unless hidden from the View Menu Navigation Panel command or the navigation panel left/right button:

- **Management** section contains Management commands.
- **NetOp Sessions** section contains Netop Sessions commands.
- **Details** section contains Details information.

Click the navigation panel left/right button or select the View Menu Navigation Panel command to hide/show the navigation panel.

Click a section up/down button to collapse/expand it.
3.6.6.5 Display Panel

The *Remote Management* window work panel right display panel:

- will initially show *Select a management tool in the left pane*.

Select a *Management Menu* command or a *Navigation Panel Management* section command to show selected *Management* tool information in the display panel.

**Note:** While management information is being retrieved from the Host, the red Netop kite at the right end of the *Menu Bar* will move.

3.6.6.6 Status Bar

This *Remote Management* window status bar will be shown unless hidden from the *View Menu Status Bar* command:

- Free Space: 30.0 GB
- Total Size: 18.7 GB
- Success
- <Retrieved number of records>/<Total number of records>

It will contain three fields if a *Management* tool is selected.

The left field can contain information on a selected *Management* tool object.

The middle field will show *In progress…* while information is being retrieved from the session Host. When information has been retrieved successfully, it will show *Success*.

The right field will show `<Retrieved number of records>/<Total number of records>`.

3.6.6.7 Management

To start a remote management task, select in the *Management Menu* or *Navigation Panel Management* section one of these commands:

- **Disk Drives**
- **Event Viewer**
- **Task Manager**
- **Registry**
- **Services**
- **Shared Folders**
Netop Guest

- Inventory
- Command Console
- System Control

Note: Accessing Host computer Disk Drives, Event Viewer, Services and Shared Folders requires certain rights on the Host computer. Generally, a Remote Management session acquires the rights of the Host that acquires the rights of the user logged on to the Host computer. To assign required rights to a Remote Management session with a Host on a computer to which no user or a user with insufficient rights is logged on, run the Host as a user with required rights, see the Host Program Options window. Run As Tab.

3.6.6.7.1 Disk Drives

Select the Management Menu or Navigation Panel Management section Disk Drives command to show Host computer disk drive information in the Display Panel:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Total Size</th>
<th>Free Space</th>
<th>File System</th>
<th>Total Used</th>
<th>Free (%)</th>
<th>Used (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hard Disk Drives</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local Disk (C:) Local Disk</td>
<td>30.0 GB</td>
<td>10.7 GB</td>
<td>NTF5</td>
<td>11.3 GB</td>
<td>62%</td>
<td>30%</td>
<td></td>
</tr>
<tr>
<td>Local Disk (D:) Local Disk</td>
<td>110.9 GB</td>
<td>110.9 GB</td>
<td>NTF5</td>
<td>60 MB</td>
<td>99%</td>
<td>1%</td>
<td></td>
</tr>
</tbody>
</table>

**Devices with Removable Storage**

- 3¼ Floppy (A:) 3¼-Inch Floppy Disk 0% 0%
- DVD/CD-RW... CD Drive 0% 0%

**Network Drives**

- doc on 'dan... Disconnected Network Drive 79.7 GB 2.17 GB NTF5 77.6 GB 2% 90%
- con 'danwar... Disconnected Network Drive 79.7 GB 2.17 GB NTF5 77.6 GB 2% 90%
- dtn on 'dan... Disconnected Network Drive 33.9 GB 16.0 GB NTF5 17.1 GB 49% 51%
- Documentation... Network Drive 79.7 GB 2.17 GB NTF5 77.6 GB 2% 90%
- Usb on Dev-f... Network Drive 410.1 GB 4.99 GB NTF5 405.2 GB 1% 99%
- C on 'Cgo02... Disconnected Network Drive 34.4 GB 24.0 GB NTF5 10.5 GB 69% 31%
- Art on 'Dev-f... Network Drive 410.1 GB 4.99 GB NTF5 405.2 GB 1% 99%

Note: This command will be disabled if the Host does not have the right to show Host computer disk drive information. To assign required rights to the Host, run it as a user with required rights, see Management.

Host computer disk drive information will be shown as icons or table records according to the Disk Drives Menu or Disk Drives Toolbar selection. Details will show table records with these column contents:

- **Name**: Disk drive icon and name.
- **Type**: Disk drive type.
- **Total Size**: Disk drive total size in bytes.
- **Free Space**: Disk drive free space in bytes.
- **File System**: Disk drive file system.
- **Total Used**: Disk drive used space in bytes.
- **Free %**: Disk drive free space in percent of total space.
- **Used %**: Disk drive used space in percent of total space.
This section includes these sections:

- **Disk Drives Menu**
- **Disk Drives Toolbar**
- **Disk Drive Types**

### 3.6.6.7.1.1 Disk Drives Menu

If the *Disk Drives* management tool is selected, in the *Menu Bar*, press ALT+D or right-click in the *Display Panel* to show this menu:

<table>
<thead>
<tr>
<th>View</th>
<th>Large Icons</th>
<th>Small Icons</th>
<th>List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh F5</td>
<td>Details</td>
<td>Show in Groups</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**View:** Select this command or click the *Disk Drives Toolbar View* button to expand into these commands:

- **Large Icons**: Select this command to dot mark it to show records as horizontal rows of large icons.
- **Small Icons**: Select this command to dot mark it to show records as horizontal rows of small icons.
- **List**: Select this command to dot mark it to show records as vertical columns of small icons.
- **Details**: Select this command to dot mark it to show records in a table with details in columns (default selection).
- **Show in Groups**: On a Windows 2003 or XP computer, select this command to uncheck/check mark it to ungroup/group records by drive type (default: check marked to group).

**Refresh F5:** Select this command, press F5 or click the *Disk Drives Toolbar Refresh* button to retrieve new data from the Host computer to refresh the *Display Panel* contents.

**Properties:** Select a record and select this command or click the *Disk Drives Toolbar Properties* button to show this window:
This window will show the selected record disk drive properties.

### 3.6.6.7.1.2 Disk Drives Toolbar

If the Disk Drives management tool is selected, this Toolbar will be shown unless hidden from the View Menu Toolbar command:

- **View**: Click this button or select the matching Disk Drives Menu View command to show the View submenu.
- **Refresh**: Click this button, select the Disk Drives Menu Refresh command or press F5 to retrieve new data from the Host computer to refresh the Display Panel contents.
- **Properties**: Select a record and click this button or select the Disk Drives Menu Properties command to show record disk drive properties in the Properties window.

When a disk drive record is selected, the left Status Bar field will show Free Space: <Bytes of free space> Total Space: <Bytes of total space>. 

![Disk Drive Properties](image)
3.6.6.7.1.3 Disk Drive Types

In the **Disk Drives** management tool **Display Panel**, these disk drive types can be shown:

- **Floppy Disk**: Host computer diskette drive.
- **Local Disk**: Host computer hard disk or partition.
- **Compact Disk**: Host computer CD drive.
- **RAM disk**: Part of Host computer memory allocated to file storage.
- **Removable Disk**: Removable file storage device.
- **Mounted Disk**: Drive attached to an empty folder in an NTFS volume.
- **Network Drive**: Network computer hard disk, partition or directory.

3.6.6.7.2 Event Viewer

Select the **Management Menu** or **Navigation Panel Management** section **Event Viewer** command to show Host computer Windows event logs in the **Display Panel**:

Note: Only Windows NT+ (2003, XP, 2000 and NT) computers record events. The **Event Viewer** command will be enabled only if the Host computer runs on a Windows NT+ operating system. The **Event Viewer** command will be disabled if the Host does not have the right to show Host computer events. To assign required rights to the Host, run it as a user with required rights, see **Management**.

The **Display Panel** will contain tabs named **Application**, **Security** and **System** like the Windows **Event Viewer**. The fourth **File** tab can show a saved event log. Each tab will show Host computer event records in a table with this column content:

- **Type**: Event type icon and description.
- **Date**: Event date.
- **Time**: Event time.
- **Source**: Event source.
- **Category**: Event category, if applicable.
- **Event**: Event ID.
- **User**: Event user name or N/A if not a user event.
- **Computer**: Event computer name.

This section includes these sections:

- **Event Viewer Menu**
- **Event Viewer Toolbar**

### 3.6.6.7.2.1 Event Viewer Menu

If the *Event Viewer* management tool is selected, in the **Menu Bar** select *Event Viewer*, press ALT+E or right-click in the **Display Panel** to show this menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
<th>Event Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Open...</strong> Ctrl+O</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Save...</strong> Ctrl+S</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Clear</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Refresh</strong> F5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Log Properties</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Event Properties</strong></td>
</tr>
</tbody>
</table>

**Open Ctrl+O**: Select this command, press CTRL+O or click the **Event Viewer Toolbar** **Open** button to show this window:

**Open Saved Event Log**

- **File resides on**: Select one of these options:
  - **Guest computer**: Open a saved event log that resides on the Guest computer (default selection).
  - **Host computer**: Open a saved event log that resides on the Host computer.

- **File path and name**: Specify in this field the saved event log file path and name.

- **Log type**: The field of this drop-down box will show *(Unspecified)*. The drop-down box list contains the options *(Unspecified)*, *Application*, *Security* and *System*. Select an option in the list to show it in the field.

**Note**: Opening a saved event log will overwrite the current **File** tab contents.

**Save Ctrl+S**: Select this command, press CTRL+S or click the **Event Viewer Toolbar** **Save** button to show this window:
It will save the shown event log in a file.

Save file on: Select one of these options:
- Guest computer: Save the event log file on the Guest computer (default selection)
- Host computer: Save the event log file on the Host computer.

File path and name: [ ]: Specify in this field the file path and name.

Note: Event binary data in the Event Properties window Data section will be available only if you save the event log file with the default extension .evt.

Clear: Select this command or click the Event Viewer Toolbar Clear button to show this window:

Yes: Click this button to show the Save Event Log window to save the contents of the shown event log in a file before clearing it. When closing the Save Event Log window, all events in the shown event log will be cleared.

No: Click this button to clear all events in the shown event log.

Cancel: Click this button to abandon clearing the shown event log.

Refresh F5: Select this command, press F5 or click the Event Viewer Toolbar Refresh button to retrieve new data from the Host computer to refresh the tab contents.

Log Properties: Select this command or click the Event Viewer Toolbar Properties button to show a Properties window like the Windows <Log type> Properties window with a similar functionality.

Event Properties: Select a tab record and select this command or double-click a tab record to show an Event Properties window like the Windows <Event Type> Properties window with a similar functionality.

3.6.6.7.2.2 Event Viewer Toolbar

If the Event Viewer management tool is selected, this Toolbar will be shown unless hidden from the View Menu Toolbar command:

Save: Click this button, select the Event Viewer Menu Save command or press CTRL+S to show the Save Event Log window.

Open: Click this button, select the Event Viewer Menu Open command or press CTRL+O to show the Open Saved Event Log window.
Clear: Click this button or select the Event Viewer Menu Clear command to show the Clear Event Log window.

Refresh: Click this button, select the Event Viewer Menu Refresh command or press F5 to retrieve new data from the Host computer to refresh the Display Panel content.

Properties: Click this button or select the Event Viewer Menu Log Properties command to show a Properties window like the Windows <Log type> Properties window with a similar functionality.

Stop: Click this button to stop retrieving information from the Host computer. Retrieved information will be shown.

### 3.6.6.7.3 Task Manager

Select the Management Menu or Navigation Panel Management section Task Manager command to show Host computer running applications and processes in the Display Panel:

The Display Panel will contain Applications and Processes tabs.

The Applications tab will contain records of applications running on the Host computer like the Windows NT+ (Windows 2003, XP, 2000 and NT) computer Task Manager window Applications tab in a table with these column contents:

- **Task**: Windows icon and application description.
- **Status**: Will show Running if the application is running on the Host computer.

The Processes tab has an upper and a lower pane:

The upper pane will contain records of processes running on the Host computer like the Windows NT+ (Windows 2003, XP, 2000 and NT) computer Task Manager window Processes tab in a table with these column contents:

- **Image Name**: Process or executable file name.
- **PID**: Process identification number.
- **CPU Usage**: Percent of the currently used central processing unit (CPU) resources used by this process.
Netop Guest

- **Time**: Time that the process has run in the format HH:MM:SS:TTT (H=Hour digit, M=Minute digit, S=Second digit, T=Thousands fraction of a second digit).
- **Kernel Time**: Percent of time running in kernel mode.
- **User Time**: Percent of time running in user mode.
- **Threads**: Number of threads running in the process.
- **Mem Usage**: Bytes of memory used by the process.

The lower pane will contain records of threads run by the process selected in the upper pane in a table with these column contents:

- **ID**: Thread identification number.
- **Time**: Time that the thread has run in the format HH:MM:SS:TTT (H=Hour digit, M=Minute digit, S=Second digit, T=Thousands fraction of a second digit).
- **Kernel Time**: Percent of time running in kernel mode.
- **User Time**: Percent of time running in user mode.
- **Priority**: Priority ranking number (a high number means high priority for CPU resources).

This section includes these sections:

- Task Manager Menu
- Task Manager Toolbar

### 3.6.6.7.3.1 Task Manager Menu

If the Task Manager management tool is selected, in the **Menu Bar** select **Task Manager**, press ALT+T or right-click in the Display Panel to show this menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
<th>Task Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>New Task (Run…)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>End Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Refresh</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>F5</td>
</tr>
</tbody>
</table>

**New Task (Run…)**: Select this command or click the Task Manager Toolbar Create Task button to show this window:

**Specify path and name of the program**: Specify in the drop-down box field the Host computer path and name of the executable program file of the application that shall run on the Host computer. The drop-down box list will contain file paths and names that have been specified before. Select a file path and name in the list to show it in the field.

**Note**: Like in the Windows Run… window, a path is not required for files that reside in the Host computer system directory (Windows or WINNT). A path from the system directory or a full path is required for other file locations. The path can contain environment variables.

**End Task/Process**: Select an application or a process in the Display Panel and select this command or click the Task Manager Toolbar End Task/Process button to end the application or process on the
Host computer.

**Caution:** If you end an application, unsaved application data will be lost. If you end a process, the application or system of which it is a part may not function properly.

Refresh F5: Select this command, press F5 or click the **Task Manager Toolbar Refresh** button to retrieve new information from the Host computer to show it in the **Display Panel**.

### 3.6.6.7.3.2 Task Manager Toolbar

If the **Task Manager** management tool is selected, this **Toolbar** will be shown unless hidden from the **View Menu** command:

- **Create Task:** Click this button, select the **Task Manager Menu New Task** command or press Ctrl+S to show the **Create New Task** window.
- **End Task/Process:** Select a task or process and click this button or select the **Task Manager Menu End Task/Process** command to end the selected task or process.
- **Refresh:** Click this button, select the **Task Manager Menu Refresh** command or press F5 to retrieve new data from the Host computer to refresh the **Display Panel** contents.

**Note:** When the **Task Manager** management tool is selected or refreshed, the left **Status Bar** field will show **Processes:** <Number of processes> / **CPU Usage** <Percent CPU usage> %.

### 3.6.6.7.4 Registry

Select the **Management Menu** or **Navigation Panel Management** section **Registry** command to show the Host computer Windows registry like in the Windows Registry Editor window in the **Display Panel**:

<table>
<thead>
<tr>
<th>Sub tree</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_CLASSES_ROOT</td>
<td>Specifies file and data associations that point to HKEY_LOCAL_MACHINE\Software\Classes keys. Its keys determine how applications load and associate with data files.</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER</td>
<td>Specifies the profile of the user currently logged on to the computer. Its keys that are part of the logged on user’s keys in HKEY_USERS take precedence over HKEY_LOCAL_MACHINE keys for duplicated data.</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE</td>
<td>Specifies the Windows configuration on the computer and determines how Windows loads.</td>
</tr>
<tr>
<td>HKEY_USERS</td>
<td>Contains a <strong>DEFAULT</strong> sub tree that specifies the user profile when no</td>
</tr>
</tbody>
</table>
user is logged on to the computer and a sub tree that specifies the user profile of the user currently logged on to the computer.

**HKEY_CURRENT_CONFIG** Specifies the hardware profile that determines how the installed software uses available hardware. It specifies associations between **HKEY_LOCAL_MACHINE\Software keys and HKEY_LOCAL_MACHINE\System keys.**

Each sub tree expands into a tree structure of keys. This image shows the **Display Panel** with an expanded **Host computer Windows registry:**

The left **keys** pane contains registry keys and the right **values** pane will contain value records of the key selected in the keys pane.

**Keys Pane**

This pane contains an expandable tree structure of keys shown as named folders. Click [+] buttons to expand and [-] buttons to collapse keys. Double-click a key folder to expand/collapse it. Click a key folder to open it and show its value records in the values pane.

A key folder that has not been opened will be gray. A key folder that has been opened will be yellow.

**Values Pane**

Select a key in the keys pane to show in this pane its values as records in a table with these column contents:

- **Name**: Value type icon and value name. The name of the first value is always *(Default)*.
- **Type**: Type designation, see the table below.
- **Data**: Value data in the required format, see the table below. The first value is always *(value not set)*.

<table>
<thead>
<tr>
<th>Value Type</th>
<th>Type Designation</th>
<th>Value Data Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>String Value</td>
<td>REG_SZ</td>
<td>One value that must be a string of characters.</td>
</tr>
<tr>
<td>Binary Value</td>
<td>REG_BINARY</td>
<td>One value that must be a string of hexadecimal digit pairs. Each hexadecimal digit pair is interpreted as a byte value.</td>
</tr>
</tbody>
</table>
This section includes these sections:

- **Registry Menu**
- **Registry Toolbar**

### 3.6.6.7.4.1 Registry Menu

If the *Registry* management tool is selected, in the *Menu Bar* select *Registry* or press ALT+R to open this menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Registry</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### New:

This command expands into these commands:

- **Key**
  - Select this command to create a **keys** pane key as a sub key of the selected key. Replace the highlighted default key name by the desired key name by typing or pasting from the clipboard (CTRL+V).

- **String Value**
  - Select this command to create a **values** pane string value record for the **keys** pane selected key. Replace the highlighted default value name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-click the record and select **Modify** to show this window:

  **Edit String**

  - **Value Name:** [ ]: This disabled field will show the value name.
Value Data: []: Specify in this field the value data as a string of characters.

Binary Value: Select this command to create a values pane binary value record for the keys pane selected key. Replace the highlighted default value name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-click the record and select Modify to show this window:

Value Name: []: This disabled field will show the value name.

Value Data: []: Specify in this pane the value data as a string of hexadecimal digit pairs.

DWORD Value: Select this command to create a values pane DWORD value record for the keys pane selected key. Replace the highlighted default value name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-click the record and select Modify to show this window:

Value Name: []: This disabled field will show the value name.

Value Data: []: Specify in this field the value data as a string of 1-8 digits according to the selected base, see below.

Base: Select one of these options:

- Hexadecimal: Select this option to interpret digits as hexadecimal (default selection).
- Decimal: Select this option to interpret digits as decimal.

Multi-String Value: Select this command to create a values pane multi-string value record for the keys pane selected key. Replace the highlighted default value name by the desired value name by
typing or pasting from the clipboard (CTRL+V). Right-click the record and select Modify to show this window:

![Edit Multi String](image)

**Value Name:** [:] This disabled field will show the value name.

**Value Data:** [:] Specify in this pane the value data as strings of characters separated by a null character.

**Expandable String Value:** Select this command to create a values pane expandable string value record for the keys pane selected key. Replace the highlighted default value name by the desired value name by typing or pasting from the clipboard (CTRL+V). Right-click the value record and select Modify to show the Edit String window to specify the value data.

**Find… Ctrl+F:** Select this command, press CTRL+F or click the Registry Toolbar Find button to show this window:

![Find](image)

**Find What:** [:] Specify in this field the string of characters that shall be searched for.

**Look at:** Uncheck boxes to not search for these types of elements:
- **Keys:** Leave this box checked to find keys whose name contains the specified string of characters (default: checked).
- **Values:** Leave this box checked to find value records whose name contains the specified string of characters (default: checked).
- **Data:** Leave this box checked to find value data that contain the specified string of characters (default: checked).
Netop Guest

- **Match Whole String Only:** Check this box to find only elements that exactly match the specified string of characters (default: unchecked).

- **Find Next:** Click this button or press F3 to start or continue the search from the selected key or value downwards.

- **Find Next F3:** Select this command or press F3 to search for the next occurrence of the character string specified in the **Find** window.

- **Delete Del:** Select a keys pane key folder or values pane value record and select this command, press DELETE or click the Registry Toolbar Delete button to show a confirmation window to confirm deleting the selected key or value. You cannot delete predefined sub trees and (default) value records.

- **Caution:** Deleting a key will delete all of its sub keys.

- **Rename:** Select a keys pane key or values pane value record and select this command to highlight and frame the selected key or value name to change it. You cannot rename predefined sub trees and (default) value names.

- **Import…:** Select this command or click the Registry Toolbar Import button to show an Import Registry File window like a Windows Open window that specifies Files of type: Registration Files (*.reg) to open a registration file to import its contents into the Host computer registry.

- **Extreme Caution:** Importing a registration file will overwrite any matching keys and value records. If imported keys and value records and other keys and value records mismatch, the registry will become corrupted to make the Host computer unusable.

- **Export…:** Select a keys pane key and select this command or click the Registry Toolbar Export button to show an Export Registry File window like a Windows Save As window that specifies Files of type: Registration Files (*.reg) to specify the path and name of a file that will contain the keys and value records of the selected key branch.

- **Modify:** Select a values pane value record and select this command or click the Registry Toolbar Modify button to show the value type matching Edit <Value type> window, see above, to modify value data. You cannot modify the (default) value record (value not set) data.

- **Copy Key Name:** Select a keys pane key and select this command or click the Registry Toolbar Copy Key Name button to copy the registry path and name of the selected key to the clipboard.

- **Refresh F5:** Select this command, press F5 or click the Registry Toolbar Refresh button to retrieve new data from the Host computer to refresh the Display Panel contents.

- **Organize Favorites…:** Select this command to show this window:

  ![Organize Favorites](image)

  The pane will show your favorites in the Registry Toolbar right drop-down box list (initially none).

  **Delete:** Select a favorite in the pane and click this button to delete it.

  **Add To Favorites:** Select a keys pane key and select this command or click the Registry Toolbar Add To Favorites button to show this window:
**Favorite Name: []**: This field will show the name of the selected key. You can edit the field contents to name the added favorite as desired. Click OK to add the key to your favorites.

**Note:** Your favorites will be available in the Registry Toolbar right favorites drop-down box list.

Right-click a keys pane folder to show this menu:

| Collapse | Expand/Collapse: Select this bolded command or double-click the key to expand/collapse the key folder.  
Other menu commands are explained above.  
Right-click a values pane record to show this menu: | Key |
|---|---|
| New | String Value 
Binary Value 
DWORD Value 
Multi-String Value 
Expandable String Value |
| Find… | 
| Delete | 
| Rename | 
| Export… | 
| Copy Key Name | 
| Add to Favorites | 

Menu commands are explained above.

**3.6.6.7.4.2 Registry Toolbar**

If the Registry management tool is selected, this Toolbar will be shown unless hidden from the View Menu Toolbar command:

New: Click this button or select the Registry Menu New command to show the New submenu.

Delete: Select a keys pane key folder or a values pane value record and click this button or select the Registry Menu Delete command to show a confirmation window to confirm deleting the selected key or value record. You cannot delete predefined sub trees and (default) value records.
Caution: Deleting a key will delete all of its sub keys.

Find: Click this button or select the Registry Menu Find command to show the Find window.

Import: Click this button or select the Registry Menu Import command to show an Import Registry File window like a Windows Open window that specifies Files of type: Registration Files (*.reg) to open a registration file to import the registration file specifications into the Host computer registry.

Extreme Caution: Importing a registration file will overwrite any matching registry keys and value records. If imported keys and value records and other keys and value records mismatch, the registry will become corrupted to make the Host computer unusable.

Export: Select a keys pane key and click this button or select the Registry Menu Export command to show an Export Registry File window like a Windows Save As window that specifies Files of type: Registration Files (*.reg) to specify the path and name of a file that will contain the keys and value records of the selected key branch.

Modify: Select a values pane value record and click this button or select the Registry Menu Modify command to show the value type matching Edit <Value type> window to modify value data. You cannot modify the (default) value record (value not set) value data.

Copy Key Name: Select a keys pane key and click this button or select the Registry Menu Copy Key Name command to copy the registry path and name of the selected key to the clipboard.

Refresh: Click this button, select the Registry Menu Refresh command or press F5 to retrieve new data from the Host computer to refresh the Display Panel content.

Add to Favorites: Select a key and click this button or select the Registry Menu Add to Favorites command to show the Add to Favorites window.

<Favorites>: By default, the field of this drop-down box will be empty. The drop-down box list will contain your favorite keys (initially none). Select a favorite key in the list to show it in the field to show this favorite key in the keys pane.
3.6.6.7.5 Services

Select the Management Menu or Navigation Panel Management section Services command to show Host computer services in the Display Panel:

![Screen shot of a table showing service information]

**Note:** You can manage services only on Windows NT+ (2003, XP, 2000 and NT) computers. The Services command will be enabled only if the Host computer runs on a Windows NT+ operating system. The Services command will be disabled if the Host does not have the right to manage Host computer services. To assign required rights to the Host, run it as a user with required rights, see Management.

The Extended tab will in a left column show the selected service name, hotspots that enable its available actions and its description. The alternative Standard tab will show only the table:

![Screen shot of a table showing service information]

The table will contain records of available services with these column contents:

- **Name:** Service icon and name.

205
Netop Guest

- **Description**: Service description.
- **Status**: Started, Stopped or Paused.
- **Startup Type**: Automatic, Manual or Disabled.
- **Log On As**: LocalSystem, NT AUTHORITY/LocalService, NT AUTHORITY/NetworkService or <User name>.

This section includes these sections:

- **Services Menu**
- **Services Toolbar**
- **Service Installation**
- **Service Properties**

### 3.6.6.7.5.1 Services Menu

If the **Services** management tool is selected, in the **Menu Bar** select **Services**, press ALT+S or right-click in the **Display Panel** to show this menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Add...</strong> Ctrl+N</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Remove</strong> Del</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Start</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Stop</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Pause</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Resume</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Restart</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Refresh</strong> F5</td>
</tr>
</tbody>
</table>

**Add... Ctrl+N**: Select this command, press CTRL+N or click the **Services Toolbar Add** button to show the **Service Installation** wizard.

**Remove Del**: Select a record and select this command, press DELETE or click the **Services Toolbar Remove** button to show a confirmation window to confirm removing it.

**Caution**: Removing a service may affect dependent services, see **Dependencies Tab**. If you remove a service of a running application, the service will become **Stopped** and **Disabled**. When the application is unloaded, the record will be removed.

**Start**: Select this command or click the **Services Toolbar Start/Resume** button to start the selected service.

**Stop**: Select this command or click the **Services Toolbar Stop** button to stop the selected service.

**Caution**: Stopping a service may affect dependent services, see **Dependencies Tab**.

**Pause**: Select this command or click the **Services Toolbar Pause** button to pause the selected service.

**Caution**: Pausing a service may affect dependent services, see **Dependencies Tab**.

**Resume**: Select this command or click the **Services Toolbar Start/Resume** button to resume the selected service.

**Restart**: Select this command or click the **Services Toolbar Restart** button to stop and start the selected service.
Caution: Restarting a service may affect dependent services, see Dependencies Tab.

Refresh: Select this command or click the Services Toolbar Refresh button to retrieve new information from the Host computer to refresh the Display Panel contents.

Properties: Select a record and select this command or double-click a record to show the service Properties window.

3.6.6.7.5.2 Services Toolbar

If the Services management tool is selected, this Toolbar will be shown unless hidden from the View Menu Toolbar command:

Add: Click this button, select the Services Menu Add command or press CTRL+N to show the Service Installation wizard.

Remove: Select a record and click this button, select the Services Menu Remove command or press DELETE to show a confirmation window to confirm removing the record.

Caution: Removing a service may affect dependent services, see Dependencies Tab. If you remove a service of a running application, the service will become Stopped and Disabled. When the application is unloaded, the record will be removed.

Start/Resume: Click this button or select the Services Menu Start or Resume command to start or resume the selected service.

Stop: Click this button or select the Services Menu Stop command to stop the selected service.

Caution: Stopping a service may affect dependent services, see Dependencies Tab.

Pause: Click this button or select the Services Menu Pause command to pause the selected service.

Caution: Pausing a service may affect dependent services, see Dependencies Tab.

Restart: Click this button or select the Services Menu Restart command to stop and start the selected service.

Caution: Restarting a service may affect dependent services, see Dependencies Tab.

Refresh: Click this button, select the Services Menu Refresh command or press F5 to retrieve new data from the Host computer to refresh the Display Panel contents.
3.6.6.7.5.3 Service Installation

If the Services management tool is selected, click the Services Toolbar Add button or select the Services Menu Add command to show this first Service Installation wizard window:

Service Name: []: Specify in this field the service name.

Service Display Name: []: Specify in this field the name by which the service shall be displayed.

Click Next to show this window:

Service Executable File Location: []: Specify in this field the Host computer path and name of the service executable file.

Click Next to show this window:
The options in this window are explained for the Properties window Log On Tab.
Click Next to show this window:

Select one of these options:

- **Automatic**: Start this service automatically, typically when the operating system starts (default selection).
- **Manual**: Start this service manually.
- **Disabled**: Disable starting this service.
- **Start service after installation**: Leave this box checked to start this service after its installation (default: checked). If Disabled is selected above, the service will not start.

**Finish**: Click this button to install the service on the Host computer to show its record in the Display Panel.
3.6.6.7.5.4 Service Properties

If the Services management tool is selected, double-click a service record or select a service record and select the Services Menu Properties command to show this window:

It enables viewing and changing Host computer service properties on these tabs:

- **General Tab**
- **Log On Tab**
- **Dependencies Tab**

After making changes on the tabs, click OK to apply changes.

**Caution:** Do not change Host computer service properties unless you know the consequences of the changes. Keep notes of changes to enable restoring service properties if changes cause an unexpected Host computer behaviour.
This is the **Service Properties** window **General** tab:

- **Service Name:** Will show the service name.
- **Display Name:** Will show the name by which the service is shown.
- **Description:** Will show any description of the service.
- **Path to Executable:** Will show the Host computer path to the service executable file.
- **Startup Type:** The field of this drop-down box will show the selected service startup type. The drop-down box list contains the options **Automatic**, **Manual** and **Disabled**. Select an option in the list to show it in the field.

**Note:** If you select **Disabled**, a **Started** service will keep running. If **Disabled**, you can **Resume** a **Paused** service but you cannot **Start** a **Stopped** service.

- **Service Status:** Will show the service status (**Started**, **Paused** or **Stopped**).
- **Start:** If enabled, click this button to start the service.
- **Stop:** If enabled, click this button to stop the service.
- **Pause:** If enabled, click this button to pause the service.
- **Resume:** If enabled, click this button to resume the service.

**Caution:** Stopping or pausing a service may affect dependent services, see **Dependencies Tab**.

- **Start Parameters:** This field will be enabled if the service is **Stopped**. Specify in this field any command line parameters that shall apply when starting the service.
Note: Specified Start Parameters will not be saved. One backslash (\) will be interpreted as an ESCAPE character. Specify two backslashes for each parameter backslash.

This is the Service Properties window Log On tab:

It specifies the log on properties of the selected record Host computer service.

Log On As: Select one of these options:

- **Local System Account**: Select this option to make the selected record Host computer service log on as a local system account that has extensive rights on the Host computer but no rights on other computers (typically the default selection).

- **Allow Service to Interact with the Desktop**: Leave this box checked to allow the service to show user interaction windows on the desktop (typically checked).

- **This Account**: Select this option to make the selected Host computer service log on as a user account. Click Browse to show this window:
**List Names From:** [ ]: The list of this drop-down box will contain the names of domains recognized by the Host computer. Select a name in the list to show it in the field.

**Groups and Users:** [ ]: This pane will show records of users recognized by the domain shown in the **List Names From** drop-down box field in a table with these column contents:
- **User Name**: Windows logon user name.
- **Full Name**: Windows user full name, if available.
- **Description**: Windows user description, if available.

Double-click a record to add it to the **Added Users** pane below.

**Added Users:** [ ]: This pane can contain only one record. To remove it from the pane, double-click it.

Click **OK** to close the window to specify the **Added Users** pane record user name in the **Service Properties** window **Log On** tab **This Account** field.

Alternatively, specify the user name in the **This Account** field.

**Password:** [ ]: Specify in this field the password that shall be used with the user name specified in the **This Account** field. Keyboard entries will show as asterisks (*):

**Confirm Password:** [ ]: Re-specify the password in this field for confirmation.

**Note:** To use the **Local Service** account, in the **This Account** field specify NT AUTHORITY \LocalService. To use the Network Service account, in the **This Account** field specify NT AUTHORITY \NetworkService. Do not specify a password for these accounts.
This is the Service Properties window Dependencies tab:

It shows in the upper pane Host computer system components on which the selected record service depends and in the lower pane Host computer system components that depend on the selected record service. If there are dependencies, the pane background will be white, otherwise gray. You cannot change dependencies on this tab.

Caution: If system components depend on the selected record service, the Host computer may not function properly if the properties of the service are changed.

3.6.6.7.6 Shared Folders

Select the Management Menu or Navigation Panel Management section Shared Folders command to show Host computer shares, sessions and open files in the Display Panel:

Note: The Shared Folders command will be disabled if the Host does not have the right to manage Host computer shared folders. To assign required rights to the Host, run it as a user with required rights, see Management.
This section includes these sections:
- **Shared Folders Menu**
- **Shared Folders Toolbar**
- **Shares Tab**
- **Sessions Tab**
- **Open Files Tab**
- **Share a Folder**
- **Share Properties**

### 3.6.6.7.6.1 Shared Folders Menu

If the **Shared Folders** management tool is selected, in the **Menu Bar** select **Shared Folders**, press ALT+S or right-click in the **Display Panel** to show this menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Management</th>
<th>Help</th>
<th>Shared Folders</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Add... Ctrl+N</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Remove Del</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Refresh F5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Properties</td>
</tr>
</tbody>
</table>

**Add... Ctrl+N**: Showing the **Shares Tab**, select this command, press CTRL+N or click the **Shared Folders Toolbar Add** button to **Share a Folder**.

**Remove Del**: Select a record and select this command, press DELETE or click the **Shared Folders Toolbar Remove** button to show a confirmation window to confirm removing the record share or disconnecting the session or file user.

**Note**: Remove may cause loss of data to session or file users. Typically, you should not remove **Special Shares**.

**Refresh F5**: Select this command, click the **Shared Folders Toolbar Refresh** button or press F5 to retrieve new information from the Host computer to refresh the **Display Panel** contents.

**Properties**: Showing the **Shares Tab**, select a record and select this command, click the **Shared Folders Toolbar Properties** button or double-click a record to show the selected record share **Properties** window.

### 3.6.6.7.6.2 Shared Folders Toolbar

If the **Shared Folders** management tool is selected, this **Toolbar** will be shown unless hidden from the **View Menu Toolbar** command:

<table>
<thead>
<tr>
<th>Share</th>
<th>Menu</th>
<th>Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Add**: Showing the **Shares Tab**, click this button, select the **Shared Folders Menu Add** command or press CTRL+N to **Share a Folder**.

**Remove**: Select a record and click this button, select the **Shared Folders Menu Remove** command or press DELETE to show a confirmation window to confirm deleting the record.

**Note**: Remove may cause loss of data to session or file users. Typically, you should not remove **Special Shares**.

**Refresh**: Click this button, select the **Shared Folders Menu Refresh** command or press F5 to retrieve new data from the Host computer to refresh the **Display Panel** contents.
**Properties:** Showing the Shares Tab, select a record and click this button, select the Shared Folders Menu Properties command or double-click the record to show the selected record share Properties window.

### 3.6.6.7.6.3 Shares Tab

This is the Shares tab:

![Shares Tab](image)

It shows Host computer shared resources as table records with these column contents:

- **Share Name:** Shared resource icon and name.
- **Folder Path:** Directory path or resource description, if available.
- **Type:** Unknown or resource type name.
- **# Client Connections:** Number of current connections from remote computers.
- **Description:** Shared resource description, if available.

You can manage shared resources from the Shared Folders Menu and Shared Folders Toolbar.

#### Special Shares

For administrative and system use, the operating system automatically creates special shares as hidden resources, typically with $ as the last character in the share name.

**Note:** Typically, you should not delete or change special shares. If you delete or change special shares, they may become restored when the server service or the computer is restarted.

These special shares can be shown on the Shares tab:

- `<Drive letter>$`: Enables administrators to connect to the root directory of a drive.
- **ADMIN$:** Enables remote administration of a computer. Its path is always the path of the system root directory.
- **IPC$:** Enables inter program communication by named pipes during remote administration and when viewing a computer's shared resources. It cannot be deleted.
- **NETLOGON:** Required on domain controllers. If you remove it, domain client computers will lose functionality.
- **SYSVOL:** Required on domain controllers. If you remove it, domain client computers will lose functionality.
- **PRINT$:** Used during remote administration of printers.
- **FAX$:** A server folder that stores temporary telefax files and telefax cover pages. It is used by clients when sending a telefax.
3.6.6.7.6.4 Sessions Tab

This is the Shared Folders Sessions tab:

- **User**: Session user icon and Windows logon name.
- **Computer**: Session computer name or address.
- **Type**: Session computer operating system type.
- **Transport**: Session communication device specification.
- **# Open Files**: Number of session open files.
- **Connected Time**: Session time in format HH:MM:SS (H=Hour digit, M=Minute digit, S=Second digit).
- **Idle Time**: Time since last session user action in format HH:MM:SS (H=Hour digit, M=Minute digit, S=Second digit).
- **Guest**: Will show Yes if the session user is logged on to Windows by a Guest account with typically very limited rights. Will show No if not.

You can manage sessions from the Shared Folders Menu and Shared Folders Toolbar.

3.6.6.7.6.5 Open Files Tab

This is the Shared Folders Open Files tab:

- **Open File**: File icon, path and name.
- **Accessed By**: File session user Windows logon name.
- **# Locks**: File number of locks.
- **Mode**: File permission type.

You can manage open files from the Shared Folders Menu and Shared Folders Toolbar.

3.6.6.7.6.6 Share a Folder

If the Shared Folders management tool is selected, showing the Shares Tab click the Shared Folders Toolbar Add button, select the Shared Folders Menu Add command or press CTRL+N or to show this window:
Netop Guest

Share a Folder Wizard

Welcome to the Share a Folder wizard

This wizard helps you to share a folder on the computer you have selected. People using other computers can gain access to the contents of the folder over the network.

To continue, click Next.

Click Next to show this window:

Computer name: CG0003

Specify the path to the folder you want to share.

Folder path: 

Example: C:\Docs\Public

Computer name: [ ]: Will show the name of the Host computer.
Folder path: [ ]: Specify in this field the Host computer path of a folder that shall be shared.
Click Next to show this window:
### Share a Folder Wizard

Type information about the share for users.

**Share name:** [Program Files]

**Share path:** \CG6003\Program files

**Description:**

---

*Share name:* [:] Will show the share name, by default the folder name specified in the previous wizard window. You can edit the share name.

**Note:** If you use $ as the last character of the share name, the shared folder will be hidden to not appear to a browsing network user. Network users can map a drive to a hidden shared folder.

*Share path:* [:] Will show the share path as specified in the previous wizard window.

*Description:* In this field, you can specify a share description that will be shown in the Description column on the Shares Tab.

*Finish:* Click this button to end the Share a Folder Wizard to add the share record on the Shares Tab.

*Tip:* To create share permissions, double-click the record to show the Properties window.

### 3.6.6.7.6.7 Share Properties

If the Shared Folders management tool is selected, showing the Shares Tab double-click a record or select a record and click the Shared Folders Toolbar Properties button or select the Shared Folders Menu Properties command to show this window:
It contains a **General** tab and, if permissions can be assigned to the share, a **Share Permissions** tab.

This **General** tab specifies general share properties.

*Share name: [:]* Will show the share name that you cannot change in this window.
Folder path: []: Will show the share path or resource specification that you cannot change in this window.

Description: []: Will show the share description that will be disabled with certain Special Shares. If enabled, you can change the field contents.

User limit: For some shares, the options in this section are disabled. If enabled, select one of these options:

- Maximum allowed: Allow the maximum available number of simultaneous users of the share (default selection).

- Allow this number of users: []: Select this option to limit the number of simultaneous users of the share. The spin box will show the allowed number of users (default: 1). Click the up/down buttons to adjust the number or specify the number in the spin box.

**Note:** The maximum available number of users may be limited by the applicable software license.

This **Share Permissions** tab specifies share permissions.

*Group or user names:* []: This pane will show groups and users as table records with these column contents:

- **User Name:** Group or user icon and name.
- **Full Name:** User full name, if available.
- **Description:** Group or user description, if available.

*Add…:* Click this button to show the Select Users window to add groups and/or users.

*Remove:* Select a record in the pane and click this button to remove it.

*Permissions:* This section will specify the permissions of the group or user selected in the pane above. Check boxes in the **Allow** column to grant permissions. Check boxes in the **Deny** column to deny permissions even if granted on the file system level:
Netop Guest

- **Full Control**: Change permissions and change file system level permissions.
- **Change**: Read permissions and add files and sub folders, change data in files and delete subfolders and files.
- **Read**: View file and sub folder names, view data in files and run program files.

**Note**: Checking an upper box will check lower boxes. Share permissions apply only to network users. They do not apply to users that log on locally including terminal server users. Preferably, assign permissions to groups and add users to groups rather than assign identical permissions to multiple users. If you change permissions for Special Shares, the original permissions may be restored when the server service or the computer is restarted.

### 3.6.6.7.7 Inventory

Select the Management Menu or Navigation Panel Management section Inventory command to show the Host computer inventory in the Display Panel:

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>2/2/2006, 1:19:19 PM</td>
</tr>
<tr>
<td>Method</td>
<td>0 (0x0000)</td>
</tr>
<tr>
<td>Host ID</td>
<td>CG0003</td>
</tr>
<tr>
<td>Communication Profile</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>XML Schema Version</td>
<td>2003077</td>
</tr>
</tbody>
</table>

**Note**: The Inventory command will be disabled if the Host computer does not run on a Windows operating system.

The Host computer inventory will be displayed like on the Netop Guest Window Tab Panel Inventory Tab. However, in Remote Management the Host computer inventory information will not be stored on the Guest computer and cannot be processed.

In the **Menu Bar**, select Inventory or press ALT+I to show this menu:

**Refresh F5**: Select this command, click the Inventory Toolbar Refresh button or press F5 to retrieve new information from the Host computer to refresh the Display Panel contents.

This Toolbar will be shown unless hidden from the View Menu Toolbar command:

**Refresh**: Click this button, select the Inventory Menu Refresh command or press F5 to retrieve new information from the Host computer to refresh the Display Panel contents.
3.6.6.7.8 Command Console

Select the Management Menu or Navigation Panel Management section Command Console command to show this window:

Select one of these options:

- **Use Host account**: Open the Command Console with the rights of the Host (default selection).
  
  **Note**: The Host will typically have the rights of the user logged on to the Host computer. The Host can have the rights of another user specified on the Host Program Options window Run As Tab.

- **Use this account information**: Open the Command Console with the rights of the account with these computer logon credentials:
  
  - Logon Name: [:] Specify in this field a Host computer domain recognized user name.
  - Password: [:] Specify in this field the matching password. Characters will show as asterisks.
  - Domain: [:] Specify in this field the matching domain name.

- **Load user profile**: Leave this box checked to load the user profile of the specified account on the Host computer (default: checked).

Click **OK** to show the Host computer Command Prompt window in the Display Panel:
This enables you to specify commands that will execute on the Host computer.
In the Menu Bar, select Command Console or press ALT+C to show this menu:

Restart: Select this command or click the Command Console Toolbar Restart button to restart Command Console to show the Startup Information window.

This Toolbar will be shown unless hidden from the View Menu Toolbar command.

Restart: Click this button or select the Command Console Menu Restart command to restart Command Console to show the Startup Information window.

3.6.6.7.9 System Control

Select the Management Menu or Navigation Panel Management section System Control command to show these Display Panel contents:

They enable you to control the Host computer system status.

Current Host state

This section shows the Host computer user logon status:

Logged off/Logged on <Logged on user name>: Logged off indicates that no user is logged on to the Host computer. Logged on <Logged on user name> specifies the name of the user logged on to the Host computer.

Note: You can log on to the Host computer from a Remote Control session.

Action to perform

Select one of these actions to execute it when you click the Display Panel or System Control Toolbar Send button or select the System Control Menu Send command:
Lock computer (Windows NT, 2000, XP only): Lock the Host computer (default selection, works only with Windows 2003, XP, 2000 or NT Host computers).

- Log off user: Log off the Host computer user.
- Restart computer: Restart the Host computer.
- Shut down computer: Shut down the Host computer.

Options

In this section, you can specify a message to the Host computer user:

- Prompt user Timeout for prompt: [] seconds: Check the box to send a message to the Host computer user and enable the other section elements (default: unchecked). Specify in the spin box the number of seconds after showing the message the action shall execute (default: 1, range 1-999).

- Message to display: []: Specify in this pane up to four lines of message text.

- Allow user to cancel: Check this box to enable an Abort button by which the Host computer user can cancel the action (default: unchecked).

- Close open programs without saving data: Check this box to close open Host computer programs without saving data when executing the action (default: unchecked). If unchecked, Host computer programs will keep running if the Host computer is locked or the Host computer user is logged off.

Send: Click this button or the System Control Toolbar Send button or select the System Control Menu Send command to execute the action specified in the Action to perform section with the options specified in the Options section and below.

If the Prompt user box is checked, a message like this will be shown on the Host computer screen:

![Logging Off Computer dialog box](image)

The Time: display in format HH:MM:SS (H=Hour digit, M=Minute digit, S=Second digit) will count down to 00:00:00 before the action executes.

Note: You cannot cancel a sent System Control command. However, if the Host user message Abort button is enabled, you can click it in a Remote Control session to cancel the action.

This section includes these sections:

- System Control Menu
- System Control Toolbar
Netop Guest

3.6.6.7.9.1 System Control Menu

If the System Control management tool is selected, in the Menu Bar select System Control, press ALT + S or right-click in the Display Panel to show this menu:

![System Control Menu](image)

Refresh F5: Select this command, click the System Control Toolbar Refresh button or press F5 to retrieve new information from the Host computer to refresh the Display Panel contents.

Send: Select this command or click the System Control Toolbar Send button or Display Panel Send button to execute the action specified in the Display Panel.

3.6.6.7.9.2 System Control Toolbar

If the System Control management tool is selected, this Toolbar will be shown unless hidden from the View Menu Toolbar command:

![System Control Toolbar](image)

Refresh: Click this button, select the System Control Menu Refresh command or press F5 to retrieve new data from the Host computer to refresh the Display Panel contents.

Send: Click this button or the Display Panel Send button or select the System Control Menu Send command to execute the action specified in the Display Panel.

3.6.6.8 Netop Sessions

In the Navigation Panel Netop Sessions section:

![Netop Sessions](image)

or in the File Menu Netop Sessions submenu:

- select a Netop Session command to start or stop another Netop session with the remote managed Host.

Navigation Panel command icons will show a red X if a session is running.

File Menu commands will begin with Start if no session is running or Stop if a session is running.

If Host Guest Access Security does not allow the Guest to start a type of session, the command will be disabled, see Allow Guest To.

Start Audio Chat will be disabled if the Guest and Host computers are not both interactive audio enabled or if any of them is running another audio session including Transfer Sound.
3.6.6.9 Details

The Navigation Panel Details section:

will show these details:

- Host ID
- Host computer IP or MAC address
- Guest communication profile name
- Encryption type icon and name
- Host computer operating system name
- Remote Management session duration in format HH:MM:SS (H=hour digit, M=Minute digit, S=Second digit)

You cannot execute any actions from this section.

3.6.7 Demonstrate

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can start a Demonstrate session with a Host to show the Guest computer screen image on the Host computer.

The Guest can connect to start a Demonstrate session from the Quick Connect Tab or from a Phonebook Tab or History Tab record.

When connected, the Guest can start and end a Demonstrate session from a Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab record or from the Remote Control Toolbar or Toolbox Demonstrate button.

This Maskwindows window will be shown:
It enables you to mask Guest computer screen elements so that they will be shown as black rectangles in the Host computer screen *Netop Demonstration* window Guest computer screen image.

The *Loaded applications* pane will contain Guest computer loaded application elements that expand into application screen elements. All Guest computer screen elements except the Windows taskbar will be represented by an application screen element.

**Note:** The Guest computer screen desktop surface with icons is represented by the *explorer.exe* application *Program Manager* item.

To mask/unmask a screen element, select it in the pane and click + to mask and - to unmask.

A masked element will be indicated by . If an application is masked, its unmasked screen elements will be masked as indicated by .

☐ *New screen window warning:* Check to show this *New window* window if a new screen element that does not belong to a masked application element will open on the Guest computer screen:

Click one of these buttons:

- *Mask window:* Click to open the screen element masking it.
- *Mask application:* Click to open the screen element masking its application element.
- *Do not mask:* Click to open the screen element without masking.

*Refresh:* Click to refresh the pane contents with the changes that happened while the *Mask windows* window was shown.

*OK:* Click to apply closing the window and showing the *Netop Demonstration* window on the selected
Host computer screen.

During a *Demonstrate* session, this toolbox will be shown on the Guest computer screen:

![Screen](image)

It has these buttons:

- **Stop demonstrate**: Click or having selected a *Tab panel* Host record click the record context menu or *Connection* menu check marked *Demonstrate* command or the *Toolbar* orange background *Demonstrate* button to stop the *Demonstrate* session.

- **Mask windows**: Click to show the *Mask windows* window.

### 3.7 Session Tools

This section explains these session tools:

- **Connection Properties**
- **Netop Marker Utility**
- **Netop Script**
- **Netop Screen Video**
3.7.1 Connection Properties

This is the Guest *Connection Properties* window:

It specifies a range of properties that can be applied individually to Host connections to optimize them according to user preferences. It contains these tabs:

- Connect Tab
- Logon Tab
- Protect Item Tab
- Startup Tab
- Display Tab
- Keyboard/Mouse Tab
- Compression/Encryption Tab
- Desktop Tab
- Record Tab
- Custom Tab

You can show the *Connection Properties* window from Tab Panel tabs and the Remote Control display:

- Showing the Phonebook Tab, select the Edit Menu or Records Pane context menu New Phonebook Entry command or click the Toolbar Phonebook Entry button to show the all tabs Connection Properties window with default selections to create a Phonebook Record.
• Showing the **Phonebook Tab** or **History Tab**, select a Host record and select the **Edit Menu** or record context menu **Connection Properties** command or click the **Toolbar Connection Properties** button to show the all tabs **Connection Properties** window to view or edit the Host record connection properties.

• Showing the **Quick Connect Tab**, click the **Connection Properties** button to show a limited tabs **Connection Properties** window that specifies the properties that apply to connections from the **Quick Connect Tab** to view or edit them.

• Showing the **Help Request Tab**, select a Host record and select the **Edit Menu** or record context menu **Connection Properties** command or click the **Toolbar Connection Properties** button to show a limited tabs **Connection Properties** window to view or edit the Host record connection properties.

• In the **Remote Control** display, select the window **Title Bar** menu **Connection Properties** command or click the **Toolbar or Toolbox Connection Properties** button to show a limited tabs **Connection Properties** window in which you can change certain properties while the session runs.

3.7.1.1 Connect Tab

This is the Guest **Connection Properties** window **Connect** tab:

---

**Host PC Information**

- **Description:** [ ] The contents of this field identifies the Host record. If you showed the **Connection Properties** window from the **Phonebook Tab** or **History Tab**, the field will be empty. You can leave the field empty to automatically specify the applicable Host **Name** or **Phone number/IP address** field contents in it when creating the Host record. You can edit the field contents.
Netop Guest

Phone number/IP address: [:] This field will be included if the communication profile selected in the Communication section Communication profile drop-down box uses a Point-to-Point or Gateway or Network Point-to-Point communication device. It must specify the Host telephone number or IP address if connecting directly to the Host, otherwise the Host network connecting Netop Gateway telephone number or IP address.

Name [(optional with Gateway)]: [:] If the field label does not include (optional with Gateway), this field must specify the name by which the Host will respond, see Networking. If the field label includes (optional with Gateway), this field can be empty to Browse for Hosts, see Gateway Connection, or specify the name by which the Host will respond.

Comments: [:] This field can specify a comment that will be shown in the Tab Panel tab records pane Details view Comment column (default: empty).

Communication

Communication profile: [:] The field of this drop-down box list specifies the selected communication profile name (default: TCP/IP). The drop-down box list will contain available Guest Communication Profiles. Select a name in the list to specify it in the field.

Wake on LAN MAC address: [:] In this field, you can specify the MAC address of the Host computer network card if Wake on LAN enabled to enable starting the Host computer by connecting to the Host, see Execute Command (default: empty).

3.7.1.2 Logon Tab

This is the Guest Connection Properties window Logon tab:

![Connection Properties window](image)

It will be included unless you show the Connection Properties window from the Remote Control display.
It specifies Host and Host network connecting Gateway logon credentials to connect without being prompted for logon credentials.

It has two tabs with identical contents:

**Host logon/Gateway logon**

*Logon name:* [ ] Specify in this field the logon name, if required (default: empty).

*Logon password:* [ ] Specify in this field the matching logon password, if required (default: empty).

*Logon domain:* [ ] Specify in this field the name of the authenticating Windows domain or the name of the directory server on which user credentials are stored, if required (default: empty).

☐ *Use current logon credentials for Windows Security authentication:* Check this box to log on by the Windows logon user name, password and domain of the Guest computer user (default: unchecked).

**3.7.1.3 Protect Item Tab**

This is the Guest **Connection Properties** window **Protect Item** tab:

![Connection Properties window](image)

It will be included only if you show the **Connection Properties** window from the **Phonebook Tab** or **History Tab**. It enables you to protect a Host record and file by a password.

*Password:* [ ] Specify in this field a password (default: empty).

*Confirm password:* [ ] Re-specify in this field the password for confirmation (default: empty).

*Connect without password:* Select this check box if you want the Guest user to be able to use a
phonebook entry without knowing the password. The password protection will then only apply to the contents of the connection properties, so that these are protected against being changed unintentionally.

**Note:** Password characters will show as asterisks or dots. Leave fields empty to disable password protection.

If a Host record is password protected, this window will be shown when accessing it:

Specify the required password in the field. There is no limit to the number of password attempts.

### 3.7.1.4 Startup Tab

This is the Guest **Connection Properties** window **Startup** tab:

It will be included unless you show the **Connection Properties** window from the **Remote Control** display. It specifies **Remote Control** session startup properties.

**Host window startup size**
Select one of these options:

- **Windowed**: Show the Host screen image in a Remote Control window (default selection). If the Host screen image has less pixels than the display panel, the Host screen image will be surrounded by black borders. If the Host screen image has more pixels than the display panel, the display panel will have scrollbars. If on the Display Tab the option Fit window to Host screen is selected, the window may resize up until its maximized size.

- **Full screen**: Show the Host screen image in Remote Control full screen to cover the entire Guest computer screen. If the Host screen image has less pixels than the Guest computer screen, the Host screen image will be surrounded by black borders. If the Host screen image has more pixels than the Guest computer screen, the Guest computer screen will have scrollbars.

- **Maximized**: Show the Host screen image in a maximized Remote Control window that covers the entire Guest computer screen except the Windows taskbar. If the Host screen image has less pixels than the display panel, the Host screen image will be surrounded by black borders. If the Host screen image has more pixels than the display panel, the display panel will have scrollbars.

- **Minimized**: Show the Remote Control window as a button in the Windows taskbar.

**Remote control window startup size**

- **Enable**: Check this box to enable this section’s elements and apply their values. Leave unchecked to apply the last shown Remote Control window position and size (default: unchecked).

  - **x**: Specify in this field the horizontal pixels offset of the startup Remote Control window upper left corner from the Guest computer screen upper left corner (default: 0).
  
  - **y**: Specify in this field the vertical pixels offset of the startup Remote Control window upper left corner from the Guest computer screen upper left corner (default: 0).

  - **Width**: Specify in this field the pixels width of the startup Remote Control window (default: 0).
  
  - **Height**: Specify in this field the pixels height of the startup Remote Control window (default: 0).

**Actions**

- **Lock Host keyboard and mouse**: Check this box to disable the Host computer keyboard and mouse at startup, see also Lock Keyboard and Mouse button and Lock Keyboard and Mouse command (default: unchecked).

- **Blank Host display**: Check this box to make the Host computer screen appear black to the Host user at startup, see also Blank Display button and Blank Display command (default: unchecked).

- **Transfer sound**: Check this box to transfer Host computer application sound at startup, see also Transfer Sound button and Transfer Sound command (default: unchecked).

- **Suspend other Guests from connecting to Host**: Check this box to deny further Guest connections to the Host at startup, see also Suspend Further Connections button (default: unchecked).
3.7.1.5 Display Tab

This is the Guest Connection Properties window Display tab:

It will always be included in the Connection Properties window. It specifies Remote Control session Host screen image display properties.

**Host Window Fit**

Select one of these options:

- **Fit window to Host screen**: Resize the Remote Control window to fit the 1:1 scale Host screen image within its display panel. If the Host screen image has more pixels than the maximized Remote Control window display panel, the display panel will have scrollbars (default selection).
- **Fit Host screen to window**: Scale the Host screen image to fit within the Remote Control window display panel.
- **Do not fit**: Display the part of the 1:1 scale Host screen image that will fit within the Remote Control window display panel. If the Host screen image has less pixels than the display panel, it will be surrounded by black borders. If the Host screen image has more pixels than the display area, the display panel will have scrollbars.

**Limit number of colors in bitmap mode**

Note: This section will be disabled if the Connection Properties window is shown from the Remote Control display.

Select one of these options:
No, use actual number of colors: Shows true colors, consumes most transmission bandwidth (default selection)

Max 256 colors: Shows reduced palette colors, consumes less transmission bandwidth.

Max 16 colors: Shows crude colors, consumes little transmission bandwidth.

Max 2 colors: Shows black and white colors, consumes minimum transmission bandwidth.

DOS Box Font

In Command Mode, command prompt window characters will by default be shown using the Guest computer system default font.

System default: Uncheck this box to enable selecting another font (default: checked).

Select Font...: Click this button to show the Windows Font window to select the command prompt window font.

3.7.1.6 Keyboard/Mouse Tab

This is the Guest Connection Properties window Keyboard/Mouse tab:

- Remote keyboard (Send all keystrokes to host)
- Local keyboard (Don’t send special keystrokes)
- No keyboard control
- Use Guest Keyboard layout
- Don’t transfer Host Num Lock, Scroll Lock, Insert and Caps Lock

It will always be included in the Connection Properties window. It specifies Remote Control session keyboard and mouse control properties.

Keyboard

Select one of these options:

- Remote keyboard (Send all keystrokes to Host): Send all Guest computer keystrokes to the Host
Netop Guest

- Local keyboard (Don’t send special keystrokes): Send Guest computer keystrokes except Send Keystrokes keystroke combinations to the Host computer. Send Send Keystrokes keystroke combinations to the Guest computer.
- No keyboard control: Send all Guest computer keystrokes to the Guest computer.
- Use Guest keyboard layout: If Guest and Host computer keyboard layouts are different, some Guest computer keystrokes may come out wrong on the Host computer. To avoid this, check this box (default: unchecked).
- Don’t transfer Host Num Lock, Scroll Lock, Insert and Caps Lock: With some display adapters, enabling these Host computer keyboard options may cause the Guest computer keyboard lights to flash. To avoid this, check this box (default: unchecked).

Mouse

Select one of these options:
- Remote mouse (send all mouse events): Send all Guest computer mouse events (clicks, drags and moves) to the Host computer (default selection).
- Local mouse (Only send clicks and drags): Send only Guest computer mouse clicks and drags to the Host computer to save transmission bandwidth.
- No mouse control: Send no Guest computer mouse events to the Host.
- Display Host mouse movements: Check this box to move the Guest computer mouse pointer in concert with Host computer mouse pointer movements (default: unchecked).

Note: To suppress Guest computer mouse pointer movements induced by the Host computer, press and hold CTRL.
3.7.1.7 Compression/Encryption Tab

This is the Guest Connection Properties window Compression/Encryption tab:

It will always be included in the Connection Properties window. It specifies data transmission properties.

**Compression level**

Netop can compress transmitted data to speed up transmission across slow communication links. However, data compression takes time.

Select one of these options:

- **Automatic**: Selects compression based on the properties of the used Communication Profile. In most cases, this will provide the fastest transmission (default selection).
- **No compression**: Typical selection for fast communication links.
- **Low**: Typical selection for medium fast communication links.
- **High**: Typical selection for slow communication links.

**Host screen transfer**

*Note:* This section will be disabled if the Connection Properties window is shown from the Remote Control display.

Select one of these options:

- **Transfer Host screen as commands**: Typically faster, but with some Host computer display adapters
some Host screen image details may be lost or corrupted (default selection).

- **Transfer Host screen as bitmap**: Typically slower, but transfers Host screen image details correctly.
- **Disable accelerated bitmap transfer**: Accelerated bitmap transfer is by default used between version 7.6+ Netop modules. Check this box to disable accelerated bitmap transfer in the unlikely event that it causes problems (default: unchecked).

### Cache

**Note**: This section will be disabled if the [Connection Properties](#) window is shown from the Remote Control display. Total Netop cache memory sharing and size is specified on the [Program Options](#) window Cache Tab.

**Command Mode** Host screen transfer stores the screen image in cache memory and transfers only image changes to save transmission bandwidth and optimize update speed.

**Cache size**: The field of this drop-down box shows the selected cache memory size option (default: Automatic). The drop-down box list contains the options Automatic and values from None to 10240 kb. Automatic will select the cache memory size based on the properties of the used Communication Profile. In most cases, this will provide the optimum. Select another option in the list to show it in the field.

**Preferred Encryption Type**: The field of this drop-down box will show the encryption type preferred by the Guest (default: Netop 6.x/5.x Compatible). The drop-down box list contains the names of available encryption types, see the [Program Options](#) window Encryption Tab. Select an encryption type in the list to show it in the field to prefer it.

If the preferred encryption type is enabled on Guest and Host, it will be applied. If Netop 6.x/5.x Compatible is preferred and not enabled on Guest and Host, this message will be shown when connecting:

```
ngstw32
The Host doesn’t allow NetOp 6.x/5.x Compatibility encryption mode. Select a higher encryption level in connection properties.
```

In this case, select another preferred encryption type.

If another encryption type is preferred and this encryption type is not enabled on the Host, an encryption type that is enabled on both of Guest and Host will be applied.

If no common encryption type is enabled on Guest and Host, this message will be shown:

```
Error
Could not connect because the Guest and the Host could not agree on a common encryption profile. None of the encryption profiles enabled in program options on this Guest are enabled on the Host.
```

In this case, enable additional encryption types on the [Program Options](#) window Encryption Tab to achieve a match.

**Note**: The icon of the encryption type used in a Remote Control session will be shown in the window Status Bar.
3.7.1.8 Desktop Tab

This is the Guest Connection Properties window Desktop tab:

Optimize screen transfer

Advanced Host computer desktop features will slow down Command Mode Host screen transfer and are typically unimportant to the Guest user. Therefore, Netop by default transfers the Host screen image without advanced desktop features. If unacceptable, select which advanced desktop features to transfer.

Select one of these options:
- **Always**: Always transfer without advanced desktop features (default selection).
- **Only when high compression**: Transfer without advanced desktop features only with high compression, see Compression/Encryption Tab.
- **Never**: Never transfer without advanced desktop features.

Optimization parameters

Select one of these options:
- **Full optimization**: Transfer without the desktop features listed below (default selection).
- **Custom optimization**: Enable the Custom options section below to uncheck selected boxes to enable transfer of selected advanced desktop features.
Netop Guest

Custom options
- Disable wallpaper
- Disable screen saver
- Disable animation gimmicks
- Disable full window drag
- Disable Active Desktop

By default, all boxes are checked.

3.7.1.9 Record Tab

This is the Guest Connection Properties window Record tab:

- Record remote control session: Check this box to record a Remote Control session (default: unchecked).

Note: This section will be disabled if the Connection Properties window is shown from the Remote Control display. Recording a Remote Control session will create a record on the Recordings Tab. Checking the Program Options window Recording Tab Enforce recording box will record Remote Control sessions regardless of the selection on this tab. Recording will reduce Remote Control session transfer speed.
3.7.1.10 Custom Tab

This is the Guest **Connection Properties** window *Custom* tab:

![Connection Properties window](image)

It will be included only if you show the **Connection Properties** window from the **Phonebook Tab** or **History Tab**. It specifies the properties of a custom application command.

**Description**: Specify in this field a custom application name that will be added as an command to the Host record context menu (default: empty).

**Command line**: Specify in this field the custom application command line (program file path, name and switches, default: empty). Click **Browse** to show a Windows **Open** window that specifies **Files of type: Programs** to open a program file to specify its path and name in the field.

### 3.7.2 Netop Marker Utility

**Netop Marker Utility** enables creating figure and text markers on top of the Netop Host computer screen image and magnifying a section of the screen image.

**Note**: The **Netop Marker Utility** program VITAWRAP.EXE resides on the Netop Host computer and marks and magnifies on top of the Netop Host computer screen.

To load **Netop Marker Utility** from Netop Guest, click the **Remote Control** display **Toolbar** or **Toolbox Marker Mode** button to make it appear pressed in or select the **Remote Control** window **Title Bar** menu **Marker Mode** command to check mark it.

To unload **Netop Marker Utility** from Netop Guest, click the **Remote Control** display **Toolbar** or **Toolbox Marker Mode** button to release it or select the check marked **Remote Control** window **Title Bar** menu **Marker Mode** command to uncheck it.
To load *Netop Marker Utility* from Netop Host, run (double-click) the *VITAWRAP.EXE* file that resides in the directory where Netop Host is installed.

To unload *Netop Marker Utility* from Netop Host, use Windows *Task Manager*.

Loading *Netop Marker Utility* will show this window on top of the Netop Host computer screen:

It contains these elements:

- **Title Bar**
- **Upper Toolbar**
- **Lower Toolbar**
- **Status Bar**

### 3.7.2.1 Title Bar

This is the *Netop Marker Utility* window title bar:

Click the title bar icon or right-click in the title bar to show this menu:

The top section contains window control commands, see *Window Control*. The other sections contain these types of *Netop Marker Utility* commands:
Figure marker commands, see Figure Markers
Text marker command, see Text Marker
Magnifier command, see Netop Magnifier
Undo and Clear All commands, see Delete Markers
Properties and Help commands, see Marker Properties and Help

Select Minimize to minimize the Netop Marker Utility window into this Host computer screen notification area button:

Behind the pencil, the most recently enabled marker tool symbol will be shown.

Right-click this button to show this menu:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
<td>Restores the Netop Marker Utility window</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Enables the ellipse tool</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Enables the rectangle tool</td>
</tr>
<tr>
<td>Arrow</td>
<td>Enables the arrow tool</td>
</tr>
<tr>
<td>Line</td>
<td>Enables the line tool</td>
</tr>
<tr>
<td>Freehand</td>
<td>Enables the freehand tool</td>
</tr>
<tr>
<td>Text</td>
<td>Enables the text tool</td>
</tr>
<tr>
<td>Magnifier</td>
<td>Enables the magnifier tool</td>
</tr>
<tr>
<td>Font</td>
<td>Selects the font</td>
</tr>
<tr>
<td>Color</td>
<td>Selects the color</td>
</tr>
<tr>
<td>Line Width</td>
<td>Selects the line width</td>
</tr>
<tr>
<td>Undo</td>
<td>Clears the undo history</td>
</tr>
<tr>
<td>Clear all</td>
<td>Clears all undo history</td>
</tr>
<tr>
<td>Help</td>
<td>Opens the Help menu</td>
</tr>
</tbody>
</table>

It contains a Restore command that will restore the Netop Marker Utility window and the same Netop Marker Utility commands as the Netop Marker Utility Title Bar Menu.

3.7.2.2 Upper Toolbar

This is the Netop Marker Utility window upper toolbar:

It contains these buttons:

- **Draw Ellipse**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Ellipse command to enable the ellipse tool, see Figure Markers.
- **Draw Rectangle**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Rectangle command to enable the rectangle tool, see Figure Markers.
- **Draw Arrow**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Arrow command to enable the arrow tool, see Figure Markers.
- **Draw Lines (Stop=MB2)**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Line command to enable the
sectioned line tool, see Figure Markers.

**Draw Freehand**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Freehand command to enable the freehand tool, see Figure Markers.

**Show Free Text**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Text command to enable the Text Marker tool.

**Show Magnifier**: Click this button to make it appear pressed in or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Magnifier command to show the Netop Magnifier window.

**Undo**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Undo command to delete the most recently selected marker, see Delete Markers.

**Clear All**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Clear All command to delete all markers, see Delete Markers.

### 3.7.2.3 Lower Toolbar

This is the Netop Marker Utility window lower toolbar:

![Lower Toolbar Buttons]

It contains these buttons:

- **Select Font**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Font command to show the Windows Font window to select a text marker font, see Marker Properties and Help.

- **Select Color**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Color command to show the Windows Color window to select a marker color, see Marker Properties and Help.

- **Select Pen Thickness**: Click this button to show a line width drop-down box or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Line Width command to select a figure marker or text marker frame line width, see Marker Properties and Help.

- **Help**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Help command to open Netop Host Help on the Netop Marker Utility topic, see Marker Properties and Help.

### 3.7.2.4 Status Bar

This is the Netop Marker Utility window status bar:

![Status Bar]

It will show a hint to the mouse pointer position button or highlighted menu command.

### 3.7.2.5 Figure Markers

To select a figure marker tool with the mouse, in the Upper Toolbar click the figure marker button to make it appear pressed in or in the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu select the figure marker command to change the mouse pointer into a pencil with the figure marker shape.

To enable a figure marker tool from the keyboard, place the mouse pointer on the active Netop Marker Utility window Upper Toolbar figure marker button and press F9 to change the mouse pointer into a pencil with the figure marker shape. Alternatively, while the Netop Marker Utility window is active press ALT+SPACE to show the Netop Marker Utility Title Bar Menu and press the figure marker command.
first character keyboard key or highlight the figure marker command and press ENTER.  
To create a figure marker with the mouse, drag (sectioned line: click). To end a sectioned line, right-click.

To draw a figure marker from the keyboard, move the figure marker with the arrow keys. Press INSERT to engage, move with the arrow keys and press INSERT to disengage or section a line. To end a sectioned line, press F10.

To move a marker or change its appearance, move the mouse pointer to it to show an arrow-pointed +. To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change appearance, right-click or press F10 to show this menu:

<table>
<thead>
<tr>
<th>Color</th>
<th>Line Width</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 pixels</td>
</tr>
<tr>
<td></td>
<td>4 pixels</td>
</tr>
<tr>
<td></td>
<td>6 pixels</td>
</tr>
<tr>
<td></td>
<td>8 pixels</td>
</tr>
<tr>
<td></td>
<td>10 pixels</td>
</tr>
<tr>
<td></td>
<td>12 pixels</td>
</tr>
<tr>
<td></td>
<td>15 pixels</td>
</tr>
<tr>
<td></td>
<td>24 pixels</td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Clear all</td>
<td></td>
</tr>
</tbody>
</table>

**Color:** Select this command or click the marker and click the Lower Toolbar Select Color button to show the Windows Color window to change the marker color selection (default: Red).

**Line Width:** Select this command to expand it into a selection of numbers of pixels or click the marker and click the Lower Toolbar Select Pen Thickness button to show a drop-down box with a selection of line widths to change the marker line width selection (default: 2 pixels).

**Undo:** Select this command to delete the selected marker.

**Clear All:** Select this command to delete all markers.

Click outside the menu or press F10 to close the menu.

To change figure marker tool properties, right-click or press F10 to show this menu:

<table>
<thead>
<tr>
<th>Color</th>
<th>Line Width</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 pixels</td>
</tr>
<tr>
<td></td>
<td>4 pixels</td>
</tr>
<tr>
<td></td>
<td>6 pixels</td>
</tr>
<tr>
<td></td>
<td>8 pixels</td>
</tr>
<tr>
<td></td>
<td>10 pixels</td>
</tr>
<tr>
<td></td>
<td>12 pixels</td>
</tr>
<tr>
<td></td>
<td>16 pixels</td>
</tr>
<tr>
<td></td>
<td>24 pixels</td>
</tr>
</tbody>
</table>

This menu is similar to the Figure Marker Menu but has **Unselect** instead of **Undo**.

**Unselect:** Select this command, press ESCAPE, click the Upper Toolbar pressed in figure marker button to release it or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu figure marker command to unselect the figure marker tool to restore the normal mouse pointer.

**Note:** Selecting another marker tool will unselect the selected marker tool.

### 3.7.2.6 Text Marker

To select the text marker tool with the mouse, in the Upper Toolbar click the **Show Free Text** button to make it appear pressed in or in the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu select **Text** to change the mouse pointer into an angle that indicates a text marker box corner.
To select the text marker tool from the keyboard, place the mouse pointer on the active *Netop Marker Utility* window *Upper Toolbar Show Free Text* button and press F9 to make the button appear pressed in and change the mouse pointer into an angle that indicates a text marker box corner.

Alternatively, while the *Netop Marker Utility* window is active press ALT+SPACE to show the *Netop Marker Utility Title Bar Menu* and press the T key or highlight the *Text* command and press ENTER.

To unselect the text marker tool, press ESCAPE or use one of the selection procedures explained above to release the *Show Free Text* button and restore the normal mouse pointer.

**Note:** Selecting another marker tool will unselect the selected marker tool.

When the text marker tool is selected:

- To create a text marker with the mouse, drag a dotted rectangle to show the *Text Marker* window.
- To create a text marker from the keyboard, move the text marker tool with the arrow keys. Press INSERT to engage, move with the arrow keys to create a dotted rectangle and press INSERT to disengage and show this window:

![Text Marker Window](image)

This window specifies the text marker contents and appearance.

In the pane, specify the text marker text. Right-click to show an edit menu.

*Use frame:* [ ] The field of this drop-down box will by default show *No* to create no frame around the text marker. The drop-down box list contains *No* and a selection of frame line widths. Select an option in the list to show it in the field.

*Font:* Click this button to show the Windows *Font* window to change the text marker font and color selection (default: *Arial Bold 30pt Red*).

*OK:* Click this button to close the *Text Marker* window to show the text marker.

To move a marker or change its appearance, move the mouse pointer to it to show an arrow-pointed +. To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change appearance, right-click or press F10 to show this menu:

```
Font
Line Width
  2 pixels
  1 pixels
  6 pixels
  3 pixels
  10 pixels
  12 pixels
  16 pixels
  24 pixels

Undo
Clear all
```

This menu is similar to the *Figure Marker Menu* but has *Font* instead of *Color.*
Font: Select this command to show the Windows Font window to change the text marker font and color selection (default: Arial Bold 30pt Red).

Note: This menu will include a Line Width command only if a framed text marker is selected.

3.7.2.7 Netop Magnifier

To show the Netop Magnifier window with the mouse, in the Upper Toolbar click the Show Magnifier button to make it appear pressed in or in the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu select Magnifier.

To show the Netop Magnifier window from the keyboard, place the mouse pointer on the active Netop Marker Utility window Upper Toolbar Show Magnifier button and press F9 to make the button appear pressed in.

Alternatively, while the Netop Marker Utility window is active press ALT+SPACE to show the Netop Marker Utility Title Bar Menu and press M or highlight the Magnifier command and press ENTER.

If the mouse pointer is outside this window, the window pane will show a magnified image of the mouse pointer surroundings.

To move the window, drag its title bar or place the mouse pointer in the title bar, press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To resize the window, drag its sides or corners or position the mouse pointer on a side or corner to show a double arrow, press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change the pane image magnification, drag the right side scroll bar button or place the mouse pointer above or below it and press F9. Its top position will show a 1:1 scale image.

Right-click in the window or place the mouse pointer in the window and press F10 to show this menu:

| Close       | Ctrl+C
|-------------|--------
| Refresh     | F5     
| Refresh Rate| ...    

Close: Select this command or click the Upper Toolbar Show Magnifier button appearing pressed in to release it to close the Netop Magnifier window.

Copy Ctrl+C: Select this command or press CTRL+C to copy the pane contents to the clipboard.

Refresh F5: The pane image will refresh when the mouse pointer is moved but by default not refresh if the mouse pointer is not moved. Select this command or press F5 to refresh the pane image.

Refresh Rate...: Select this command to show this window:
Netop Guest

☐ Enable refresh timer: Check this box to refresh the pane image if the mouse pointer is not moved (default: unchecked).

Interval (tenths of seconds): [:] Specify in this field a number to refresh at the specified interval (default: 20).

3.7.2.8 Delete Markers

To delete markers, click one of these Upper Toolbar buttons or select the matching Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu command:

Undo: Delete the most recently selected marker.

Clear All: Delete all markers.

Note: When Netop Marker Utility is unloaded, all markers and any Netop Magnifier window will disappear.

3.7.2.9 Marker Properties and Help

Specify marker properties and show help from the Lower Toolbar buttons or the matching Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu commands:

Select Font/Font: Click this button or select this command to show the Windows Font window to select a Text Marker font and color (default: Arial Bold 30pt Red).

Select Color/Color: Click this button or select this command to show the Windows Color window to select a figure marker color (default: Red).

Select Pen Thickness/Line Width: Click this button to show a line width drop-down box or select this command to expand it into a selection of numbers of pixels to select a figure marker or text marker frame line width (default: 2 pixels).

Help: Click this button or select this command to open the Netop Host Help system on the Netop Marker Utility topic.

3.7.3 Netop Script

A Netop script is a user specified command structure that can execute a Netop task, typically an unattended scheduled file transfer.

To create a Netop script, in the Edit Menu or the Script Tab Records Pane context menu select New Script or in the Netop File Manager window Toolbar click the Script button or select the Netop File Manager window Options Menu Script command to show the Script window.

To view or edit an existing Netop script, on the Script Tab select the script record and select the Edit Menu or Records Pane context menu Edit Script command to show the script in the Script window:
It creates and edits a Netop script in a graphical structure.

**Script File**

*Filename []*: This field will show the script file path and name (default: empty). To create a Netop script, specify the script file name in the field. If you do not specify a file extension and a path, the script file will get the extension *dws* and reside in the *Netop Configuration Files* directory, typically \%documents and settings\%<User name>\Application Data\Danware Data\Netop Remote Control\Guest\script. If you create a new script, you will be prompted for confirmation. Click *Yes* to show the *Global Settings* window.

*Open Script*: Click this button to show a Windows *Open* window that specifies *Files of type: Netop Script Files (*.dws)* to open a Netop script file in the window to show its path and name in the *Filename* field.

*Comment []*: This field can contain a comment that will be shown in the *Script Tab Records Pane Comment column.*

*Save Script*: Click this button to save a new or edited script.

If a script is opened in the window, the upper pane will show the script contents in an expandable graphical tree structure, see *Test a Netop Script* (default: empty).

If a script is opened in the window, the lower pane will show debug messages, see *Test a Netop Script* (default: empty).

*Add*: Click this button to add a script command in the upper pane under the selected script command, see *Commands*.

*Edit*: Select a script command in the upper pane and click this button to show the matching editing window, see *Commands*.

*Run Script*: Click this button to run the script, see *Test a Netop Script*.  

251
Delete: Select a script command in the upper pane and click this button to delete it and the command sub tree under it.

3.7.3.1 Global Settings

This is the Guest Netop Script Global Settings window:

It specifies the Netop Script global settings that will apply as default settings for the following script Commands.

It will be shown when you create a Netop Script. To edit the global settings of an opened Netop Script, in the Script window upper pane select the Global Settings element and click Edit. The window has these tabs:

- General Tab
- Transfer Tab
- Overwrite/Delete Tab
- Advanced Tab

Note: Global Settings in the Script File explains how global settings will appear in the script file.
3.7.3.1.1 General Tab

This is the Guest Netop Script Global Settings window General tab:

It specifies the global file transfer direction.

*From:* [:] The field of this drop-down box will show the global source Netop module name (default: Guest). The drop-down box list contains the options Guest and Host. Select an option in the list to show it in the field.

*To:* [:] This disabled field will show the From drop-down box unselected Netop module name.
3.7.3.1.2 Transfer Tab

This is the Guest Netop Script Global Settings window Transfer tab:

It specifies global file transfer settings.

☑ Use delta file transfer: Leave this box checked to compare source files with destination files and transfer only the difference between source files and destination files to save transmission bandwidth (default: checked).

☑ Enable crash recovery: Leave this box checked to transfer files in a way that they can be recovered after a computer or network crash during transfer (default: checked).
3.7.3.1.3 Overwrite/Delete Tab

This is the Guest Netop Script Global Settings window Overwrite/Delete tab:

It specifies global overwrite and delete settings.

- **Allow overwriting/deleting existing files/folders**: Leave this box checked to allow overwriting and deleting files and folders on the destination computer (default: checked).
- **Allow overwriting/deleting system files**: Leave this box checked to allow overwriting and deleting system files on the destination computer (default: checked).
- **Allow overwriting/deleting read-only files**: Leave this box checked to allow overwriting and deleting read-only files on the destination computer (default: checked).
- **Allow overwriting/deleting hidden files**: Leave this box checked to allow overwriting and deleting hidden files on the destination computer (default: checked).
This is the Guest Netop Script Global Settings window Advanced tab:

It specifies global error handling and log file settings.

**Error Handling**

*On communication error [ ]:* The field of this drop-down box specifies the action in case of a communication error. The drop-down box list contains these options:

- **Exit:** End the script.
- **Next Host:** Proceed to the next Host specified in the script (default selection).
- **Retry 1 time:** Retry the failed command once.
- **Retry 2 times:** Retry the failed command twice.
- etc.
- **Retry 9 times:** Retry the failed command 9 times.

Select an option in the list to show it in the field.

*On transfer error [ ]:* The field of this drop-down box specifies the action in case of a file transfer error. The drop-down box list contains these options:

- **Exit:** End the script.
- **Next Host:** Proceed to the next Host specified in the script.
- **Next File:** Proceed to the next file specified in the script (default selection).
- **Retry 1 time:** Retry the failed command once.
- **Retry 2 times:** Retry the failed command twice.
- etc.
- **Retry 9 times:** Retry the failed command 9 times.

Select an option in the list to show it in the field.
Log File

- **Generate log file**: Leave this box checked to generate a log file when running the script (default: checked).
- **Append if log exists**: Check this box to append the log to an existing log file with the specified name (default: unchecked). Leave unchecked to overwrite.

<Log file path and name>[/Browse]: This field will specify the log file path and name (default: SCRIPT.LOG). Click Browse to show a Windows Open window that specifies Files of type: Log Files (*.log) to open a log file to specify its path and name in the field. If no path is specified, the log file will reside in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\.

**Note**: The script log file is explained in Script Log.

- **Restart script when finished**: Check this box to restart the script at script end (default: unchecked).
- **Close Guest when finished**: Check this box to unload Netop Guest at script end (default: unchecked).

### 3.7.3.1.5 Global Settings in the Script File

**Netop Script Global Settings** will appear in the script file as explained in this table:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SET Copy</td>
<td>G_H</td>
<td>Transfer from Guest to Host.</td>
</tr>
<tr>
<td></td>
<td>H_G</td>
<td>Transfer from Host to Guest.</td>
</tr>
<tr>
<td>SET Delta</td>
<td>No</td>
<td>Do not use Delta file transfer.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Use Delta file transfer.</td>
</tr>
<tr>
<td>SET CrashRecovery</td>
<td>No</td>
<td>Do not enable crash recovery.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Enable crash recovery.</td>
</tr>
<tr>
<td>SET OverwriteExisting</td>
<td>No</td>
<td>Do not overwrite/delete existing files.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Overwrite/delete existing files.</td>
</tr>
<tr>
<td>SET OverwriteSystem</td>
<td>No</td>
<td>Do not overwrite/delete system files.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Overwrite/delete system files.</td>
</tr>
<tr>
<td>SET OverwriteReadOnly</td>
<td>No</td>
<td>Do not overwrite/delete read-only files.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Overwrite/delete read-only files.</td>
</tr>
<tr>
<td>SET OverwriteHidden</td>
<td>No</td>
<td>Do not overwrite/delete hidden files.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Overwrite/delete hidden file.</td>
</tr>
<tr>
<td>SET OnComError</td>
<td>Exit</td>
<td>On a communication error, end the script.</td>
</tr>
<tr>
<td></td>
<td>NextHost</td>
<td>On a communication error, proceed to the next Host in the script.</td>
</tr>
<tr>
<td></td>
<td>&lt;Number&gt;</td>
<td>On a communication error, retry connecting &lt;Number&gt; times (1 to 9).</td>
</tr>
<tr>
<td>SET OnError</td>
<td>Exit</td>
<td>On a transfer error, end the script.</td>
</tr>
<tr>
<td></td>
<td>NextHost</td>
<td>On a transfer error, proceed to the next Host in the script.</td>
</tr>
<tr>
<td></td>
<td>NextFile</td>
<td>On a transfer error, proceed to the next file in the script.</td>
</tr>
<tr>
<td></td>
<td>&lt;Number&gt;</td>
<td>On a transfer error, retry transferring &lt;Number&gt; times (1 to 9).</td>
</tr>
<tr>
<td>SET LogAppend</td>
<td>No</td>
<td>Do not append a log in an existing log file.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Append a log in an existing log file.</td>
</tr>
<tr>
<td>SET Log</td>
<td>None</td>
<td>Do not generate a script log.</td>
</tr>
<tr>
<td></td>
<td>&quot;&lt;Log file path and name&gt;&quot;</td>
<td>Generate a script log in the specified log file.</td>
</tr>
<tr>
<td>SET AtEnd</td>
<td>None</td>
<td>Do not restart the script at script end.</td>
</tr>
<tr>
<td></td>
<td>Restart</td>
<td>Restart the script at script end.</td>
</tr>
</tbody>
</table>
3.7.3.2 Commands

To specify the first command of a Netop Script, in the Script window upper pane select the Global Settings element and click Add to show this drop-down menu:

<table>
<thead>
<tr>
<th>Add..</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image] Connect</td>
</tr>
<tr>
<td>![Image] Wait</td>
</tr>
<tr>
<td>![Image] Run</td>
</tr>
</tbody>
</table>

This menu contains script commands that can execute on the Guest:

**Connect**: Select this command to show the Connect to Host window to add a Connect Command that will connect to a Host.

**Wait**: Select this command to show the Wait Dialog window to add a Wait Command that will delay script execution.

**Run**: Select this command to show the Run Program window to add a Run Command that will run a program on the Guest computer.

A Connect command will branch the script into commands that execute with or on the connected Host computer or in case of a local Connect command on the Guest computer.

In the upper pane, click the [+ ] button before a Connect command to expand it and select the expanded Connect command or a command below it and click Add to show this menu:

<table>
<thead>
<tr>
<th>Add..</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image] Copy</td>
</tr>
<tr>
<td>![Image] Move</td>
</tr>
<tr>
<td>![Image] Sync</td>
</tr>
<tr>
<td>![Image] Clone</td>
</tr>
<tr>
<td>![Image] Delete</td>
</tr>
<tr>
<td>![Image] Wait</td>
</tr>
<tr>
<td>![Image] Run</td>
</tr>
<tr>
<td>![Image] Logoff</td>
</tr>
<tr>
<td>![Image] Restart</td>
</tr>
<tr>
<td>![Image] Poweroff</td>
</tr>
<tr>
<td>![Image] Lock</td>
</tr>
<tr>
<td>![Image] Inventory</td>
</tr>
<tr>
<td>![Image] Send Message</td>
</tr>
</tbody>
</table>

This menu contains script commands that can execute with a connected Host or a Guest connected locally to itself:

**Copy** to **Delete**: Select one of these commands to show a <File transfer> window to add a File Transfer Command.

**Wait**: Select this command to show the Wait Dialog window to add a Wait Command to delay script execution.

**Run**: Select this command to show the Run Program window to add a Run Command to run a program on the connected to computer.

**Logoff** to **Send Message**: Select one of these commands to add an Action Command to execute an action on the connected to computer.

**Note**: Commands in the Script File explains how commands will appear in the script file.
3.7.3.2.1 Connect Command

To add a *Connect* command to a Netop Script, in the *Script* window upper pane select *Global Settings* or the command unbranched under *Global Settings* after which you want to connect to a Host or locally to the Guest and click *Add*. In the *Guest Commands* drop-down menu select *Connect* to show the *Connect to Host* window.

To edit a *Connect* command of an opened Netop Script, in the *Script* window upper pane select a *Connect* command and click *Edit* to show the *Connect to Host* window:

![Connect to Host window]

This window adds or edits a *Connect* command.

*Connect using*: [:] The field of this drop-down box will show the selected connect option. The drop-down box list contains these options:

- **Phonebook file**: Connect to a Host by its Netop phonebook file (default selection).
- **Communication profile**: Connect to a Host by a communication profile and a Host name and/or a Host computer telephone number or IP address.
- **Local**: Connect locally to the Guest computer.

Select an option in the list to show it in the field.

If you select *Phonebook file*, this will be shown below:

*Phonebook file*: [:][Browse]: Click Browse to show a Windows *Open* window that specifies *Files of type*: *Netop Phonebook Files (*.dwc)* to open a phonebook file to show its path and name in the field.

Alternatively, specify the path and name in the field.

If you select *Communication profile*, this will be shown below:
Netop Guest

**Communication profile [:]** The field of this drop-down box will show the selected communication profile (default: TCP/IP). The drop-down box list will contain available Guest Communication Profiles. Select one in the list to show it in the field.

*Host connect information> [:]** Specify Host connect information in one or two fields according to the communication profile selection above, see Host Section (default: empty). In a field in which you can specify an IP address, you can also specify an IP address range, e.g. 192.168.1.1-192.168.1.5, to connect to multiple Host computers from one script.

*Logon name [:]** Specify in this field any logon name required by the Host (default: empty).

*Logon password [:]** Specify in this field the matching password (default: empty).

*Logon domain [:]** Specify in this field the matching domain or directory server (default: empty).

☐ *Use current login credentials for Windows Security authentication:* Check this box to log on to the Host by the Windows logon user credentials of the Guest computer user (default: unchecked).

If you select Local, no further specification is required.

Click **OK** to specify the added or edited Connect command in the **Script** window upper pane.

**Note:** Commands in the Script File explains how commands will appear in the script file.

### 3.7.3.2.2 Wait Command

To add a **Wait** command to a Netop Script, in the **Script** window upper pane select the command after which you want to wait before continuing script execution and click **Add**. Select **Wait** to show the Wait Dialog window.

To edit a **Wait** command in an opened Netop Script, in the **Script** window upper pane select a **WAIT** command and click **Edit** to show the Wait Dialog window:
This window adds or edits a **Wait** command.

**Type:** 
The field of this drop-down box will show the selected wait type. The drop-down box list contains these wait types:

- **Delay:** Delay script execution for a specified time.
- **Wait until:** Wait until a specified date and time to continue script execution (default selection).
- **Repeat daily:** Repeat script execution daily at a specified time.
- **Repeat weekly on day:** Repeat script execution weekly at a specified time on specified weekdays.
- **Repeat monthly on day:** Repeat script execution monthly at a specified time on specified weekdays.
- **Repeat monthly on date:** Repeat script execution monthly at a specified time on specified dates.

Select a wait type in the list to show it in the field.

If you select **Delay**, this section will be shown below:

```
Delay: HH[-MM][-SS]:
```

Specify a delay between 00-00-00 and 23-59-59 (default: 12-00-00).

If you select **Wait until**, this section will be shown below:

```
Time: HH[-MM][-SS] [AM/PM]:
```

Specify a time of day between 00-00-00 AM and 11-59-59 PM (default: 12:00:00 AM).

```
Date: MM[-DD][-YYYY]:
```

Optionally, specify a date between 01-01-1900 and 12-31-2200 (default: <Current date>).

**Note:** If you clear the **Date** fields, script execution will wait until the next occurrence of the time of day specified in the **Time** fields.

If you select one of the remaining wait types, this section will be shown below:
Netop Guest

Time: HH[MM][SS] [AM/PM]: Specify a time of day between 00-00-00 AM and 11-59-59 PM (default: 12:00:00 AM).

Select days...: This button will not be included if you selected Repeat daily in the Type drop-down box. Click this button to show one of these windows:

If you selected Repeat weekly on day in the Type drop-down box:

```
Wait - Select days

Select days:

<table>
<thead>
<tr>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
</tr>
</thead>
</table>
```

If you selected Repeat monthly on day in the Type drop-down box:

```
Wait - Select days

Select days:

<table>
<thead>
<tr>
<th>First</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second</td>
<td>Mon</td>
<td>Tue</td>
<td>Wed</td>
<td>Thu</td>
<td>Fri</td>
<td>Sat</td>
<td>Sun</td>
</tr>
<tr>
<td>Third</td>
<td>Mon</td>
<td>Tue</td>
<td>Wed</td>
<td>Thu</td>
<td>Fri</td>
<td>Sat</td>
<td>Sun</td>
</tr>
<tr>
<td>Fourth</td>
<td>Mon</td>
<td>Tue</td>
<td>Wed</td>
<td>Thu</td>
<td>Fri</td>
<td>Sat</td>
<td>Sun</td>
</tr>
<tr>
<td>Last</td>
<td>Mon</td>
<td>Tue</td>
<td>Wed</td>
<td>Thu</td>
<td>Fri</td>
<td>Sat</td>
<td>Sun</td>
</tr>
</tbody>
</table>
```

If you selected Repeat monthly on date in the Type drop-down box:
Click days or dates to give them a white frame to select them (default: (first) Monday or 1).

Note: Commands in the Script File explains how commands will appear in the script file.

### 3.7.3.2.3 Run Command

To add a *Run* command to a Netop Script, in the *Script* window upper pane select the command after which you want to run a program and click *Add*. Select *Run* to show the *Run Program* window.

**Note:** A *Run* command unbranched under *Global Settings* or under a local *Connect* command will execute on the Guest computer. A *Run* command under a *Connect* command other than a local *Connect* command will execute on the Host computer. The specified program file must reside on the computer on which it shall run.

To edit a *Run* command in an opened Netop Script, in the *Script* window upper pane select a *RUN* command and click *Edit* to show the *Run Program* window:

**This window adds or edits a Run command.**

If you are adding a *Run* command, the field will be empty. If you are editing a *Run* command, the field will show the program path and command. Specify or edit the program path and command. You can include command line switches.

**Browse:** Click this button to show a Windows Open window that specifies *Files of type:* *_exe files (*.exe)* to open an *exe* file to show its path and name in the field above.

**Note:** See also *Run Program.*

**Timeout []:** The field of this drop-down box will show the selected timeout (default: *1 Min*). The drop-
down box list contains timeouts from None to Never with from 5 Sec to 10 Min in between. None will cause script execution to proceed without waiting for program execution to complete. A specific timeout will cause a script error if program execution has not completed within the specified timeout. Never will cause script execution to wait for program execution to complete before proceeding.

**Note:** An invalid command specification will cause a script error, see Test a Netop Script.

**Note:** Commands in the Script File explains how commands will appear in the script file.

### 3.7.3.2.4 File Transfer Commands

To add a file transfer command to a Netop Script, in the Script window upper pane select the command after which you want to add a file transfer command and click Add. In the Host Commands drop-down menu select Copy, Move, Synchronize, Clone or Delete to show the matching <File transfer> window.

To edit a file transfer command in an opened Netop Script, in the upper pane select a file transfer command and click Edit to show the matching <File transfer> window.

The Copy Dialog, Move Dialog, Synchronize Dialog and Clone Dialog windows have the same contents:

**Copy dialog**

![Copy dialog window](image)

They have General, Transfer, Copy, Overwrite/Delete and Advanced tabs.

The Transfer, Overwrite/Delete and Advanced tabs have the same contents as the Global Settings window Transfer, Overwrite/Delete and Advanced tabs. On these tabs, you can modify the Global Settings for each file transfer command. The Log File section and the Restart script when finished and Unload Guest when finished check boxes are disabled.

These tabs have different contents:

- **General Tab**
- **Copy Tab**

The Delete window has different contents:

- **Delete**

**Note:** Commands in the Script File explains how commands will appear in the script file.
3.7.3.2.4.1 General Tab

This is the Copy Dialog window General tab:

It specifies which folders and files shall be copied, moved, synchronized or cloned by a File Transfer Command.

**From**

(Upper drop-down box): The field of this drop-down box will show the selected source Netop module name (default: the Global Settings window General Tab From section selection). The drop-down box list contains the options Guest and Host. Select an option in the list to show it in the field.

(Lower field): If you are adding a file transfer command, this field will be empty. If you are editing a file transfer command, the field will show the source specification. Specify or edit the source. Use a file mask (a file name with wildcard characters like * signifying any characters) to specify multiple file names with common characters. The file mask *.* specifies a directory.

Note: A Synchronize or Clone command must specify a source directory.

**Browse**

Note: This section will be enabled only if the From section upper drop-down box field shows Guest.

Folders...: Click this button to show a Windows Browse for Folder window to select a source directory whose path and name (ending with *.*) will be shown in the lower field.

Files...: This button will be disabled if you are specifying a Synchronize or Clone command. Click it to show a Windows Open window that specifies Files of type: All Files (*.*) to open a source file whose path and name will be shown in the lower field.

**To**

(Upper field): This disabled field will always show the From section upper drop-down box unselected option.

(Lower field): If you are adding a file transfer command, this field will be empty. If you are editing a file transfer command, the field will show the destination specification. Specify or edit the destination that will typically be a directory path ending with *. To rename a single transferred file, specify a
destination file name.

**Note:** A Synchronize or Clone command must specify a destination directory.

**Browse**

**Note:** This section will be enabled only if the From section upper drop-down box field shows Host.

*Folders*...: Click this button to show a Windows Browse for Folder window to select a destination directory whose path ending with *.* will be shown in the lower field. Existing files in the destination directory with the same location and name as transferred files will be overwritten by transferred files, except in the case of unmodified synchronization where source and destination directory older files will be overwritten by newer files in either directory.

*Files*...: This button will be disabled if you are specifying a Synchronize or Clone command. Click it to show a Windows Open window that specifies Files of type: All Files (*.*) to open a destination file whose path and name will be shown in the lower field to rename a single transferred file into this name overwriting the existing file.

**Note:** An invalid file transfer specification will cause a script error, see Test a Netop Script.

### 3.7.3.2.4.2 Copy Tab

This is the Copy Dialog window Copy tab:

![Copy Dialog Window](image)

It specifies special File Transfer Command parameters.

- **Copy files newer than:** [ ] Check this box and specify a date in the fields to transfer only files newer than the specified date (default: unchecked).

- **Include subfolders:** Check this box to transfer files in subdirectories of a specified directory (default: unchecked). Leave unchecked to transfer only specified directory files.

- **Copy hidden and system files:** Leave this box checked to transfer hidden and system files (default: checked). Uncheck to not transfer hidden and system files.

- **Copy only if file exists on target:** Leave this box unchecked to transfer all specified files (default: unchecked). Check this box to transfer only files that exist on the destination computer in the specified location.
Netop Guest

☐ Transfer only one way: This option will be enabled only with a Synchronize command. Check the box to transfer files only from the source computer to the destination computer (default: unchecked).

**Note:** With a Clone command, all options except Include subfolders will be disabled.

### 3.7.3.2.4.3 Delete

This is the File Transfer Command Delete window.

![Delete Window](image)

It specifies which directory or files to delete and associated options.

**From**

(Upper drop-down box) [ ]: The field of this drop-down box will show the selected Netop module name (default: the Global Settings window General Tab From section unselected option). The drop-down box list contains the options Guest and Host. Select an option in the list to show it in the field.

(Lower field) [ ]: Specify a directory or file path and name. Use a file mask (a file name with wildcard characters like * signifying any characters) to specify multiple file names with common characters. The file mask *.* specifies a directory.

**Options**

☐ Include subfolders: Check this box to delete a specified directory, its subdirectories and files in them (default: unchecked). Leave unchecked to delete only files in a specified directory.

☑ Delete hidden and system files: Leave this box checked to delete hidden and system files (default: checked). Uncheck to not delete hidden and system files.

☐ Delete read only files: Check this box to delete read-only files (default: unchecked). Leave unchecked to not delete read-only files.

### 3.7.3.2.5 Action Commands

**Netop Script** action commands include the simple commands Logoff, Restart, Poweroff and Lock and the composite commands Inventory and Send Message.

**Note:** Action commands will work only with a connected Host, not if connected locally to the Guest.

To add an action command to a Netop Script, in the Script window upper pane select the command after which you want to execute it. Click Add and in the drop-down menu select one of these commands:

- **Logoff:** Add a command that will log off the Host computer user from Windows.
- **Restart:** Add a command that will restart Windows on the Host computer.
Netop Guest

- **Poweroff**: Add a command that will close down and power off the Host computer.
- **Lock**: Add a command that will lock the Host computer.
- **Inventory**: Show this window:

  ![Inventory Window](image)

  **Inventory step**: The field of this drop-down box will show the selected Inventory step option. The drop-down box list contains these options:
  - **One Step**: Generate, retrieve, copy and complete a Host computer inventory.
  - **Generate**: Generate inventory on the Host computer.
  - **Retrieve**: Save the generated inventory into the Host computer %TEMP%\si_out.xml file.
  - **Complete**: Move a Host computer inventory file copied to the Guest computer to the inventor directory to enable showing it on the Inventory Tab. The inventor directory resides in the Netop Configuration Files directory, typically C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest\inventor.

  **Note**: To make the retrieved inventory available for completion on the Guest computer, it must be copied by a Copy File Transfer Command from the Host computer to the Guest computer, typically to the %TEMP% directory.

  Select an option in the list to show it in the field.

  **Inventory file path**: This field will be enabled only if Complete is shown in the Inventory step drop-down box field. Specify the Guest computer path and name of the inventory file that shall be completed.

- **Send Message**: Show this window:

  ![Send Message Window](image)

  **Send Message step**: The field of this drop-down box will show the selected Send Message step option. The drop-down box list contains these options:
  - **One Step**: Copy a Guest computer Netop Message file to the Host computer Messages directory and show it in a Message window on the Host computer screen.
  - **Display Message**: Show a Netop Message file that resides in the Host computer Messages directory in a Message window on the Host computer screen.

  **Note**: Create and save the Netop Message file in the Netop Message window.

  Select an option in the list to show it in the field.

  **Message path**: Specify in this field the Guest computer (One Step) or Host computer (Display Message) path and name of the Netop Message file that shall be (copied and) shown. Click
Browse to show a Windows Open window that specifies Files of type: Rtf Files (*.rtf) to open a Guest computer Netop Message file to show its path and name in the field.

**Note:** The Host computer Messages directory that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host\Messages is identified by the environment variable %RootConfig%Messages. To show in the Message window on the Host computer screen, the Netop Message file name must use the syntax <Date>T<Time>:<Sender>.rtf with the date format YYYY-MM-DD and the time format HH-MM-SS.

**Note:** Commands in the Script File explains how commands will appear in the script file.

### 3.7.3.2.6 Commands in the Script File

Script commands will appear in the Netop Script file as explained in this table:

<table>
<thead>
<tr>
<th>Command/Setting</th>
<th>Arguments/Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect /Mode=Phonebook</td>
<td>&lt;Drive&gt;:&lt;Path&gt;&lt;File&gt;</td>
<td>Connect to the Host of the phonebook file &lt;Drive&gt;:&lt;Path&gt;&lt;File&gt;.</td>
</tr>
<tr>
<td>Connect /Mode=CommProfile</td>
<td>Profile=&quot;&lt;Communication profile&gt;&quot; Name=&quot;&lt;Host name or IP address range&gt;&quot; Loginame=&quot;&lt;Logon name&gt;&quot; Loginpassword=&quot;&lt;Password (encrypted)&gt;&quot; Logindomain=&quot;&lt;Domain or directory service name&gt;&quot; LoginCredentials=&quot;&lt;Yes/No&gt;&quot;</td>
<td>Connect using the communication profile &lt;Communication profile&gt; to &lt;Host name or IP address range&gt; logging on to the Host by &lt;Logon name&gt;, &lt;Password&gt; and &lt;Domain or directory service name&gt; or current Windows credentials &lt;Yes/No&gt;.</td>
</tr>
<tr>
<td>Connect /Mode=Guest</td>
<td></td>
<td>Connect locally to the Guest.</td>
</tr>
<tr>
<td>WAIT /Mode=Delay</td>
<td>HH:MM:SS</td>
<td>Wait for HH:MM:SS before proceeding.</td>
</tr>
<tr>
<td>WAIT /Mode=Repeat</td>
<td>HH:MM:SS</td>
<td>Repeat daily at HH:MM:SS (hours).</td>
</tr>
<tr>
<td>WAIT /Mode=WeekDay</td>
<td>Days=&quot;&lt;n1&gt;,&lt;n2&gt;,...&quot; HH:MM:SS</td>
<td>Repeat weekly on days number &lt;n1&gt;, &lt;n2&gt; and others specified (1=Monday, 2=Tuesday, etc.) at HH:MM:SS (hours).</td>
</tr>
<tr>
<td>WAIT /Mode=MonthDay</td>
<td>Days=&quot;&lt;n1&gt;,&lt;n2&gt;,...&quot; HH:MM:SS</td>
<td>Repeat monthly on days number &lt;n1&gt;, &lt;n2&gt; and others specified (1=Monday of first week, 8=Monday of second week, 29=Monday of last week) at HH:MM:SS (hours).</td>
</tr>
<tr>
<td>WAIT /Mode=MonthDate</td>
<td>Days=&quot;&lt;n1&gt;,&lt;n2&gt;,...&quot; HH:MM:SS</td>
<td>Repeat monthly on dates number &lt;n1&gt;, &lt;n2&gt; and others specified at HH:MM:SS (hours).</td>
</tr>
<tr>
<td>Run &lt;Drive&gt;:&lt;Path&gt;&lt;File&gt;</td>
<td>[[]&lt;Any command line switch&gt;]</td>
<td>Run the program &lt;drive&gt;:&lt;path&gt;&lt;file&gt;. Command line switches can be added.</td>
</tr>
<tr>
<td></td>
<td>/Guest</td>
<td>Run the program &lt;drive&gt;:&lt;path&gt;&lt;file&gt; on the Guest.</td>
</tr>
<tr>
<td></td>
<td>/TimeOut=0</td>
<td>Run the program &lt;drive&gt;:&lt;path&gt;&lt;file&gt; and proceed immediately without waiting for its execution to</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td><strong>COPY</strong> <code>&lt;Source&gt;&lt;Destination&gt;</code></td>
<td>Copy the <code>&lt;Source&gt;</code> folders or files on the source computer to the <code>&lt;Destination&gt;</code> folder or file on the destination computer.</td>
<td></td>
</tr>
<tr>
<td><code>/&lt;Setting without SET&gt;</code></td>
<td>Apply the specified setting to the file transfer. If unspecified, Global Settings in the Script File will apply.</td>
<td></td>
</tr>
<tr>
<td><code>/D=YYYY-MM-DD</code></td>
<td>Copy files newer than Year-Month-Date.</td>
<td></td>
</tr>
<tr>
<td><code>/S</code></td>
<td>Include subfolders.</td>
<td></td>
</tr>
<tr>
<td><code>/H</code></td>
<td>Copy hidden and system files.</td>
<td></td>
</tr>
<tr>
<td><code>/U</code></td>
<td>Copy only if file exists in the destination directory.</td>
<td></td>
</tr>
<tr>
<td><strong>MOVE</strong> <code>&lt;Source&gt;&lt;Destination&gt;</code></td>
<td>Move the <code>&lt;Source&gt;</code> folder(s) or file(s) on the source computer to the <code>&lt;Destination&gt;</code> folder or file on the destination computer.</td>
<td></td>
</tr>
<tr>
<td><code>/&lt;Setting without SET&gt;</code></td>
<td>Apply the specified setting to the file transfer. If unspecified, Global Settings in the Script File will apply.</td>
<td></td>
</tr>
<tr>
<td><code>/D=YYYY-MM-DD</code></td>
<td>Move files newer than YYYY-MM-DD.</td>
<td></td>
</tr>
<tr>
<td><code>/S</code></td>
<td>Include subfolders.</td>
<td></td>
</tr>
<tr>
<td><code>/H</code></td>
<td>Move hidden and system files.</td>
<td></td>
</tr>
<tr>
<td><code>/U</code></td>
<td>Move only if file exists in the destination directory.</td>
<td></td>
</tr>
<tr>
<td><strong>SYNC</strong> <code>&lt;Source&gt;&lt;Destination&gt;</code></td>
<td>Synchronize the <code>&lt;Source&gt;</code> folder on the source computer with the <code>&lt;Destination&gt;</code> folder on the destination computer.</td>
<td></td>
</tr>
<tr>
<td><code>/&lt;Setting without SET&gt;</code></td>
<td>Apply the specified setting to the file transfer. If unspecified, Global Settings in the Script File will apply.</td>
<td></td>
</tr>
<tr>
<td><code>/D=YYYY-MM-DD</code></td>
<td>Synchronize files newer than Year-Month-Date.</td>
<td></td>
</tr>
<tr>
<td><code>/S</code></td>
<td>Synchronize subfolders.</td>
<td></td>
</tr>
<tr>
<td><code>/H</code></td>
<td>Synchronize hidden and system files.</td>
<td></td>
</tr>
<tr>
<td><code>/U</code></td>
<td>Synchronize only files that already exist in the destination directory.</td>
<td></td>
</tr>
<tr>
<td><code>/OneWay=Yes</code></td>
<td>Transfer files only from the source computer.</td>
<td></td>
</tr>
<tr>
<td><strong>CLONE</strong> <code>&lt;Source&gt;&lt;Destination&gt;</code></td>
<td>Clone the <code>&lt;Source&gt;</code> folder on the source computer to the <code>&lt;Destination&gt;</code> directory on the destination computer.</td>
<td></td>
</tr>
</tbody>
</table>
3.7.3.3 Script File

Below is an example of a Netop Script file. The script file is shown to the left and explanations to each line to the right. You can save a script file as a *.dws or *.txt file.

**Script file**

```
;This is my new script;*************************
"Script"

SET Copy=G_H
SET Delta=Yes
SET CrashRecovery=Yes
SET OverwriteExisting=Yes
SET OverwriteSystem=Yes
SET OverwriteReadOnly=Yes
SET OverwriteHidden=Yes
SET OnComError=NextHost
SET OnError=NextFile
SET AtEnd=None
SET CloseGuest=No
SET AppendLog=No
SET Log="SCRIPT.LOG"

Connect Mode=Phonebook “C: \Documents and Settings \User1\Application Data \Danware Data\Netop Remote Control\Guest\PhBook\Host1.
```

**Explaination**

- The script must start with a semicolon (;) followed by an optional comment.
- Start the script.

**Global settings:**

- Transfer files from Guest to Host.
- Use delta file transfer.
- Enable crash recovery.
- Allow overwriting/deleting existing files/folders.
- Allow overwriting/deleting system files.
- Allow overwriting/deleting read-only files.
- Allow overwriting/deleting hidden files.
- On a communication error, proceed to the next Host.
- On a transfer error, proceed to the next file.
- Do not restart the script at script end.
- Do not unload the Guest at script end.
- Do not append an existing log in the log file.
- Create a log in the file SCRIPT.LOG.

**Commands:**

- Connect to the Host of the phonebook file Host1.dwc in the default phonebook directory of the computer user User1.
Copy the file `C:\test.txt` on the source computer (in this case Guest) to the C:\ folder on the destination computer (in this case Host).

Disconnect.

End the script.

### 3.7.3.4 Test a Netop Script

A completed Netop Script may look like this in the Script window:

![Script window]

Note: This is the script example in Script File.

While creating and editing a script in the Script window, the lower debug messages pane will report any syntax errors.

These syntax errors can be shown:

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Unterminated string, e.g. &quot;test.txt&quot; (no end quotes).</td>
</tr>
<tr>
<td>102</td>
<td>More than 512 characters in a line.</td>
</tr>
<tr>
<td>103</td>
<td>Invalid character, e.g. drive specification É:.</td>
</tr>
<tr>
<td>201</td>
<td>Invalid boolean parameter value, e.g. SET OverwriteHidden=True.</td>
</tr>
<tr>
<td>202</td>
<td>A line starting without a command.</td>
</tr>
<tr>
<td>203</td>
<td>Too many commands.</td>
</tr>
<tr>
<td>204</td>
<td>Unknown command.</td>
</tr>
<tr>
<td>205</td>
<td>Invalid enumeration parameter value, e.g. SET OnComError=11.</td>
</tr>
<tr>
<td>206</td>
<td>Out of range integer parameter value, e.g. /Timeout=1500.</td>
</tr>
<tr>
<td>207</td>
<td>Too many parameters.</td>
</tr>
<tr>
<td>208</td>
<td>Unknown parameter name, e.g. SET ComErr=5.</td>
</tr>
</tbody>
</table>
Syntax error, e.g. SET OverwriteSystem=5.

A SET command occurs before a Script command.

The script ends without a ScriptEnd command.

A file transfer command occurs before a Connect command.

A Connect command occurs before the previous connection was ended.

**Note:** You can avoid most of these syntax errors by creating the script in the **Script** window.

A script will execute from its beginning to its end, in the **Script** window from top to bottom, completing each **Connect** branch before proceeding to the next **Connect** branch.

To test a script shown in the **Script** window, click the **Run Script** button and see if the script executes its actions and if it reports any execution errors in the debug messages pane. If the script fails, edit it and re-run it until it executes as intended.

You can view script errors in a **Script Log**.

### 3.7.3.5 Script Log

Running a **Netop Script** will generate a script log if selected on the **Global Settings** window **Advanced Tab**.

By default, the script log file named **SCRIPT.LOG** will reside in the **Netop Configuration Files** directory, typically `C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\Guest`.

To view the script log graphically, in the **View Menu** select **View File Manager Log** to show a Windows **Open** window that specifies **Files of type:** **Log Files (*.log)** to open the script log in this window:

The **NFM Log Viewer** window is explained in **Options Menu**.

The graphical script log shows script execution like the **Script** window. Script errors are indicated by red exclamation marks and are explained in clear text.

Open the script log file in a text editor like **Notepad** to show a textual log:
The textual log contains lines of logged events like a table of records with the columns Date, Time, Error code, Extended error code, Action code, Action specification.

The script log can show these error codes:

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No error</td>
</tr>
<tr>
<td>01</td>
<td>Syntax error</td>
</tr>
<tr>
<td>02</td>
<td>Invalid command</td>
</tr>
<tr>
<td>03</td>
<td>Memory error</td>
</tr>
<tr>
<td>04</td>
<td>Script busy</td>
</tr>
<tr>
<td>05</td>
<td>Command canceled</td>
</tr>
<tr>
<td>06</td>
<td>Script not initialized</td>
</tr>
<tr>
<td>07</td>
<td>Internal Error - no control handler</td>
</tr>
<tr>
<td>08</td>
<td>Internal Error - no copy handler</td>
</tr>
<tr>
<td>09</td>
<td>Internal Error - invalid state</td>
</tr>
<tr>
<td>10</td>
<td>Error opening log file</td>
</tr>
<tr>
<td>11</td>
<td>Error writing log file</td>
</tr>
<tr>
<td>12</td>
<td>Invalid log version</td>
</tr>
<tr>
<td>13</td>
<td>Internal error</td>
</tr>
<tr>
<td>14</td>
<td>User does not have read rights</td>
</tr>
<tr>
<td>15</td>
<td>User does not have write rights</td>
</tr>
<tr>
<td>16</td>
<td>Program timeout</td>
</tr>
<tr>
<td>17</td>
<td>Command not supported by Host</td>
</tr>
<tr>
<td>32</td>
<td>Internal error</td>
</tr>
<tr>
<td>33</td>
<td>Folder not empty</td>
</tr>
<tr>
<td>34</td>
<td>Path does not exist</td>
</tr>
<tr>
<td>35</td>
<td>File does not exist</td>
</tr>
<tr>
<td>36</td>
<td>File already exists</td>
</tr>
</tbody>
</table>
Among many others, the script log can show these action codes:

<table>
<thead>
<tr>
<th>Action Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE ROPEN</td>
<td>File opened for reading</td>
</tr>
<tr>
<td>FILE WOPEN</td>
<td>File opened for writing</td>
</tr>
<tr>
<td>FILERCLOSE</td>
<td>File closed after reading</td>
</tr>
<tr>
<td>FILEWCLOSE</td>
<td>File closed after writing</td>
</tr>
<tr>
<td>FILE DEL</td>
<td>File deleted</td>
</tr>
<tr>
<td>DIR DEL</td>
<td>Directory deleted</td>
</tr>
<tr>
<td>LOG OPEN</td>
<td>Log file opened</td>
</tr>
<tr>
<td>LOG CLOSE</td>
<td>Log file closed</td>
</tr>
<tr>
<td>ERROR</td>
<td>Error during transfer</td>
</tr>
<tr>
<td>CALL</td>
<td>Connected to Host</td>
</tr>
<tr>
<td>CALLEND</td>
<td>Disconnected from Host</td>
</tr>
</tbody>
</table>

Note: Advanced Netop scripting is explained in the Administrator's Guide Advanced Tools chapter Netop Scripting ActiveX Control section.

### 3.7.4 Netop Screen Video

If Netop Guest is installed, click Start > All Programs > Netop Remote Control > Tools > Screen video or run the ScreenCapture.exe file in the Screen Video subdirectory of the directory in which Netop Guest is installed to show this window:

![NetOp ScreenVideo](image)

**How to record a screen video**

1. Load Netop screen video as explained above.
2. Click the Toolbar Record button (red dot), select the File menu Record command or press the Record/Pause keyboard shortcut (initially F8) to show a rectangular frame mouse pointer that will outline the screen area of which a video will be recorded.
3. Position the frame as desired and click to start recording. While recording, colored flashing corners
Netop Guest

will indicate the frame.

4. Click the Toolbar Stop button (blue square), select the File menu Stop command or press the Stop keyboard shortcut (initially F9) to stop recording to show a Windows Save As window.

5. Specify a file name and click Save to save the recording as an avi file, by default in the Netop ScreenCaptures directory in your My Documents directory.

The Netop Screen Video window contains these elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**

### 3.7.4.1 Title Bar

This is the Netop Screen Video window title bar:

![NetOp ScreenVideo](image)

While pausing recording, the title will flash Paused.

### 3.7.4.2 Menu Bar

This is the Netop Screen Video window menu bar:

```
File  Region  Options  About
```

It contains these menus:

- **File**
- **Region**
- **Options**
- **About**

### 3.7.4.2.1 File Menu

This is the Netop Screen Video window File menu:

```
File  Region  Options  About
   Record
   Stop
   Pause
   Exit
```

It contains these commands:

- **Record**: Select, click the Toolbar Record button or press the Record/Pause keyboard shortcut (initially F8) to start recording a screen video. Recording region options are explained in the Region Menu section. Other options are explained in Options Menu section.
- **Stop**: Select, click the Toolbar Stop button or press the Stop keyboard shortcut (initially F9) to stop recording.
- **Pause**: Select, click the Toolbar Pause button or press the Record/Pause keyboard shortcut (initially F8) to pause recording. While pausing, the Title bar title will flash Paused. To resume recording, select Record.
- **Exit**: Select or select the Title bar Window control menu Close command, click the Title bar Close button or press ALT+F4 to close the Netop Screen Video window to unload Netop Screen Video
3.7.4.2.2 Region Menu

This is the Netop Screen Video window Region menu:

- Dragged region: Select to check mark this command as the selected region option to show cross hairs to drag a region when clicking the Toolbar Record button, selecting the File menu Record command or pressing the Record/Pause keyboard shortcut (initially F8).

- Specified region...: Select to check mark this command as the selected region option (initial selection) to show a specified region when clicking the Toolbar Record button, selecting the File menu Record command or pressing the Record/Pause keyboard shortcut (initially F8). When selected, this window will be shown:

![Specified Region Window]

It specifies a region in these elements:

- **Specify**: Click to change the mouse pointer into pencil cross hairs. Drag a rectangular frame to specify its pixels dimensions in the enabled fields below.

- **Width [ ]**: Specifies the region pixels width (initially 320).

- **Height [ ]**: Specifies the region pixels height (initially 240).

- **Fixed left top corner**: Check to enable the fields below to specify the region top left corner offset from the screen top left corner (initially unchecked).

- **Left offset [ ]**: Specify the region left border pixels distance from the screen left border (initially 100).

- **Top offset [ ]**: Specify the region top border pixels distance from the screen top border (initially 100).

- **Note**: If unchecked, clicking the Toolbar Record button, selecting the File menu Record command or pressing the Record/Pause keyboard shortcut will show the region that you can drag to the desired position and click to start recording. If checked, clicking the Toolbar Record button, selecting the File menu Record command or pressing the Record/Pause keyboard shortcut will start recording immediately.
Netop Guest

- Full screen: Select to check mark this command as the selected region option to record the entire computer screen.

3.7.4.2.3 Options Menu

This is the Netop Screen Video window Options menu:

<table>
<thead>
<tr>
<th>File</th>
<th>Region</th>
<th>Options</th>
<th>About</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Options</td>
<td>Cursor Options</td>
<td>Record Audio</td>
<td>Audio Options</td>
</tr>
<tr>
<td>Enable Autopan</td>
<td>Autopan Speed...</td>
<td>Program Options</td>
<td>Minimize program on start recording</td>
</tr>
<tr>
<td>Recording Thread Priority</td>
<td>Hide flashing rectangle during recording</td>
<td>Keyboard Shortcuts</td>
<td></td>
</tr>
</tbody>
</table>

It specifies recording options from these commands:

- Video options...: Select to show this window:

[Video Options window]

It specifies video options in these elements:

- Video codec: [ ] [About] [Configure]: Selects one of the video codecs that are available on the computer (typically Microsoft Video 1, if available). Click [About] to show information on the selected video codec. [Configure] will be enabled if a configurable video codec is selected. Click it to show the matching configuration window.
• **Quality**: Drag the slide to select the video quality between 1 to the left and 100 to the right (initially 70).

• You can auto adjust or specify frame rates. Initially, the *Auto adjust* box will be checked to disable the fields and enable the bottom frame rate slide. Its left *Max frame rate* end represents recording 200 frames per second and its right end represents recording 1 frame per minute. It will automatically specify field numbers in two ranges:

<table>
<thead>
<tr>
<th>Recording frame rate</th>
<th>Set key frames every</th>
<th>Capture frame every</th>
<th>Playback rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 - 1 frames/second</td>
<td>Second</td>
<td>0.005 - 1 second</td>
<td>Recording frame rate</td>
</tr>
<tr>
<td>60 - 1 frames/minute</td>
<td>20 frames</td>
<td>1 - 60 seconds</td>
<td>20 frames/second</td>
</tr>
</tbody>
</table>

Uncheck the *Auto adjust* box to disable the bottom frame rate slide and enable the fields to specify numbers in these ranges:

• *Set key frames every [ ] frames*: 1 - 200 (initially 200).

  **Note**: Playback will synchronize at each key frame.

• *Capture frame every [ ] milliseconds*: 1 - 7200000 (2 hours) (initially 5).

• *Playback rate [ ] frames/second*: 1 - 200 (initially 200).

• **Cursor Options...**: Select to show this window:

   ![Cursor Options Window]

   It specifies cursor options in these elements:

   **Cursor display**

   • Select one of these options:
     – *Hide cursor*: Exclude the cursor from the recording.
     – *Show cursor*: Include the cursor in the recording (initial selection).

   If *Show cursor* is selected, select one of these options:
     – *Use default cursor*: Use the current screen cursor.
     – *Use custom cursor [ ]*: Selects one of the cursors that are available on the computer to replace the current screen cursor (initially CONTEXTHELP).
Netop Guest

- Use cursor from file [ ]: Click to select a cursor from the Windows Cursors directory to replace the current screen cursor.

Note: The selected cursor will be shown in the upper right part of the section.

Cursor highlight

- □ Highlight cursor: Check to show a highlight around the cursor (initially unchecked).
- Size [ ]: Drag the slide to change the size of the cursor highlight (initially midsize). Its half size will be shown to the right.
- Shape [ ] [Color]: Selects the shape (initially Circle) and color (initially light yellow) of the highlight. You can change the shape from the drop-down box and the color from the [Color] button that will show a Color window.
- Record audio: Select to check mark/uncheck the command (initially unchecked). If checked, sound playing on and input to the computer will be recorded.
- Audio options...: Select to show this window:

It specifies cursor options in these elements:

- Audio capture device [ ]: Selects an audio capture device that is available on the computer.
- Recording format [ ]: Selects a recording format that is available with the selected audio capture device.
- Compression format [ ] [Choose compression format]: Selects a compression format that is available on the computer and shows it in the two fields. Click Choose compression format to show this window:
It specifies an audio compression format in these elements:

- **Name [] [Save As... ] [Remove]**: Specifies, saves and removes an audio compression format name.
- **Format []**: Selects an available audio compression format type (initially *MPEG Layer-3*).
- **Attributes []**: Selects an available set of audio compression format attributes (initially *56 kBit/s, 22,050 Hz, Stereo 6 kb/sec*).

**Interleave video and audio**

- **Interleave every [] ○ Frames/© Milliseconds**: Leave checked to interleave video and audio (initially checked). Specify a number in the field (initially *100*). Select *Frames* or *Milliseconds* (initial selection).

- **Enable autopan**: Select to check mark this command to automatically move the recording region in concert with the mouse pointer (initially unchecked). Select the check marked command to uncheck it.

- **Autopan speed...**: Select to show this window:

Drag the slide to specify the maximum autopan speed in the range 1 - 200 as shown below right (initially *20*).

**Program options**: Expands into:

- **Minimize upon recording**: Select to check mark/uncheck the command (initially unchecked). If checked, the *Netop Screen Video* window will be minimized to the Windows taskbar while recording.

- **Suppress flashing frame**: Select to check mark/uncheck the command (initially unchecked). If checked, the flashing region frame will be suppressed.

**Recording thread priority**: Expands into:

- **Normal**: Select to check mark to assign normal priority to the recording thread (initial selection).
- **Above normal**: Select to check mark to assign above normal priority to the recording thread.
- **Highest**: Select to check mark to assign highest priority to the recording thread.
Netop Guest

- **Time critical**: Select to check mark to assign time critical priority to the recording thread.
- **Keyboard shortcuts...**: Select to show this window:

![Keyboard Shortcuts Window]

It specifies keyboard shortcuts in these elements:

- **Record/Pause key []**: Selects the Record/Pause keyboard shortcut (initially F8).
- **Stop key []**: Selects the Stop keyboard shortcut (initially F9).
- **Cancel recording key []**: Selects the Cancel recording keyboard shortcut (initially ESCAPE).

### 3.7.4.2.4 About Menu

This is the **Netop Screen Video** window **About** menu:

![About Menu]

It shows **Netop Screen Video** properties from this command:

- **About...**: Select to show this window:
It shows the Netop Screen Video version number and other properties.

3.7.4.3 Toolbar

This is the Netop Screen Video window toolbar:

*Record:* Click, press the Record/Pause keyboard shortcut (initially F8) or select the File menu Record command to start recording a screen video. Recording region options are explained in the Region Menu section. Other options are explained in the Options Menu section.

*Pause:* Click, press the Record/Pause keyboard shortcut (initially F8) or select the File menu Pause command to pause recording. While pausing, the Title bar title will flash Paused. To resume recording, click Record.

*Stop:* Click, press the Stop keyboard shortcut (initially F9) or select the File menu Stop command to stop recording.

3.8 Guest Actions

Netop Guest on one computer can connect to Netop Host on another computer to execute an action, see Connect Guide.

These action types are available:

- Run Program
- Execute Command
- Netop Message
- GetInventory
3.8.1 Run Program

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can run a program on Host computers.

The Guest can connect to run a program from the Quick Connect Tab or from Phonebook Tab or History Tab records, see Connect Guide.

When connected, the Guest can run a program from Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab records or from the Remote Control Toolbar or Toolbox.

Click the Run Program button or select the Connection Menu or record context menu Run Program command to show this menu:

![Run Program button and Browse and commands of programs](image)

It will contain Browse and commands of programs that have been specified on the Program Options window Run Tab.

Select Browse to show the Run Program Browse Run window to specify a program and run it on selected Host computers.

Select a program command to run the program on selected Host computers.

**Note:** The program file must be available on the Host computer in the location specified in the Run Program Browse Run window or on the Run Tab.

Executing a Run Program command, this window will be shown:

![Run Program command progress status](image)

<Run Program icon> Run program: Will show the program file path and name.

The pane will show selected Host records in a table with these column contents:

- Description: Progress indicator and Host connect name or address or Host record Description column value. These progress indicators can be shown:
Command executed successfully
Command execution failed

- **Name**: Host name, if applicable.
- **Phone number**: Host or connecting Netop Gateway modem telephone number or IP address, if applicable.
- **Communication Profile**: Guest communication profile.
- **Status**: Textual progress indicator.

The command will execute sequentially on multiple computers as indicated by the progress indicators and **Status** column contents.

- **Close this dialog box on successful completion**: Check this box to close the window when the command has executed successfully on all selected Hosts (default: unchecked).

**Cancel/Close**: During progress, this button will show *Cancel*. Click it to cancel the command on the computer where it is executing or attempting to execute and proceed to the next Host record. After completion, this button will show *Close*. Click it to close the window.

### 3.8.1.1 Run Program Browse

Select the **Run Program Menu** *Browse* command to show this window:

This window specifies a program and its run properties to run it on selected Host computers.

**File name**

Under **File name**, make sure that the *Local file name* option has been selected and then click the *Browse* button to locate the program .exe file.

When the program file is added, the *Global file name* where the absolute path has been replaced with environment variables is automatically added. This is especially helpful if your computers are running different Windows platforms.

Example of a *Local file name* and the corresponding *Global file name*:

C:\Program Files\Adobe\Acrobat 6.0\Reader\AcroRd32.exe

%ProgramFiles%\Adobe\Acrobat 6.0\Reader\AcroRd32.exe
Netop Guest

**Tip:** Once you have added a program under *Local file name* and the *Global file name* has been added automatically, select the *Global file name* option so that you do not have to consider which operating system version or operating system language Host computers are using.

*Command line switches:* If the selected program needs to be started using command line switches, use the *Command line switches* field to type those. This could for example be starting Internet Explorer with a specific address or for Adobe Acrobat Reader, the name of the document to read.

**Run**

Under *Run*, select *Normal*, *Maximized* or *Minimized* to define how the program should start when opened from the *Run Program* button on the toolbar or the *Run Program* command on the *Connection* menu.

Click *OK* to run the specified program on selected Host computers. The *Command Progress Status* window will be displayed.

### 3.8.2 Execute Command

If allowed by Host *Guest Access Security*, see *Allow Guest To*, the Guest can execute a system control command on Host computers.

The Guest can connect to execute a system control command from the *Quick Connect Tab* or from *Phonebook Tab* or *History Tab* records, see *Connect Guide*.

When connected, the Guest can execute a system control command from Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab records or from the Remote Control Toolbar or Toolbox.

Click the *Execute Command* button or select the *Connection Menu* or record context menu *Execute Command* command to show this menu:

- **Log Off:** Select this command to log off the user from Windows on selected Host computers.
- **Restart:** Select this command to restart selected Host computers.
- **Shut Down:** Select this command to shut down selected Host computers.
- **Lock Workstation:** Select this command to lock selected Host computers.

**Note:** You can lock only Host computers that run on a Windows NT+ (2003, XP, 2000 or NT) operating system.

- **Wake on LAN:** Select this command to start selected Host computers whose *Wake on LAN MAC Address* is specified on the *Connection Properties* window *Connect Tab*.

The *Command Progress Status* window will show command execution.

### 3.8.3 Netop Message

If allowed by Host *Guest Access Security*, see *Allow Guest To*, the Guest can send a *Netop message* to Host computers.

The Guest can connect to send a *Netop message* from the *Quick Connect Tab* or from *Phonebook Tab* or *History Tab* records, see *Connect Guide*.

When connected, the Guest can send a *Netop message* from Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab records or from the Remote Control Toolbar or Toolbox.

Click the *Send Message* button or select the *Connection Menu* or record context menu *Send Message* command to show this window:
In this window, you can create, edit and send a Netop message that will show on the Host computer screen like this:

The Netop Message window contains these elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**
- **Message Pane**
- **Status Bar**

### 3.8.3.1 Title Bar

This is the Netop Message window title bar:

Initially, it will show *Untitled*. If the message has been saved in a file, its path and name will be shown.

### 3.8.3.2 Menu Bar

This is the Netop Message window menu bar:

It contains these menus:

- **File Menu**
3.8.3.2.1 File Menu

This is the Netop Message window File menu:

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Search</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Message</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td>Ctrl+F4</td>
</tr>
</tbody>
</table>

**Send Message**: Select this command or click the Toolbar Send button to send the message to selected Hosts. The Command Progress Status window will show command execution.

**Note**: If Host Guest Access Security does not allow Send Message, the command will not execute, see Allow Guest To.

**New**: Select this command or click the Toolbar New button to empty the Message Pane to create a message. You will be prompted to save any unsaved current message changes.

**Open**: Select this command or click the Toolbar Open button to show a Windows Open window that specifies Files of type: Rtf Files (*.rtf) to open the contents of a rich text format file in the window. You will be prompted to save any unsaved current message changes.

**Save**: This command will be enabled only if a file path and name has been specified for the window message. Select it or click the Toolbar Save button to save the window message in its specified file.

**Save As...**: Select this command to show a Windows Save As window that specifies Files of type: Rtf Files (*.rtf) to save the window message with a specified name and extension in a selected directory.

**Note**: On the Guest computer, a new message is not automatically named, provided with an extension and saved, but when received on a Host computer it is automatically named, provided with an extension and saved.

**Print**: Select this command or click the Toolbar Print button to show a Windows Print window to print the Message Pane contents.

**Close Ctrl+F4**: Select this command or apply the matching Window Control to close the Netop Message window. You will be prompted to save any unsaved current message changes.

3.8.3.2.2 Edit Menu

This is the Netop Message window Edit menu:

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Search</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Clear All</td>
<td></td>
<td></td>
<td>Ctrl+Del</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td></td>
<td>Del</td>
</tr>
</tbody>
</table>
**Undo Ctrl+Z:** Select this command, press CTRL+Z or click the Toolbar **Undo/Redo** button to undo/redo the last **Message Pane** action.

**Cut Ctrl+X:** Select **Message Pane** text and select this command, press CTRL+X or click the Toolbar **Cut** button to remove the selected text and place it on the clipboard.

**Copy Ctrl+C:** Select **Message Pane** text and select this command, press CTRL+C or click the Toolbar **Copy** button to copy selected text to the clipboard.

**Paste Ctrl+V:** Select this command, press CTRL+V or click the Toolbar **Paste** button to paste the clipboard content in the **Message Pane** cursor position.

**Clear All Ctrl+Del:** Select this command or press CTRL+DEL to clear all **Message Pane** contents.

**Delete Del:** Select **Message Pane** text and select this command or press DEL to delete selected text.

### 3.8.3.2.3 Search Menu

This is the **Netop Message** window **Search** menu:

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Search</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find...</td>
<td>Replace...</td>
<td>Next</td>
<td>F3</td>
</tr>
</tbody>
</table>

**Find...:** Select this command or click the Toolbar **Find** button to show the Windows **Find** window to find **Message Pane** text elements.

**Replace...:** Select this command to show the Windows **Replace** window to replace **Message Pane** text elements.

**Next F3:** Select this command or press F3 to highlight the next occurrence of **Find** or **Replace** window specified text elements in the **Message Pane**.

### 3.8.3.2.4 Format Menu

This is the **Netop Message** window **Format** menu:

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Search</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Character</strong></td>
<td>Bold</td>
<td>Italic</td>
<td>Underline</td>
</tr>
<tr>
<td>Font...</td>
<td>Text data</td>
<td>✓ RTF data</td>
<td>Strikeout</td>
</tr>
</tbody>
</table>

**Character:** This command expands into these commands:

- **Bold:** Select **Message Pane** text and select this command to check mark/uncheck it or click the Toolbar **Bold** button to make it appear pressed in/unpressed to bold/unbold selected text.

- **Italic:** Select **Message Pane** text and select this command to check mark/uncheck it or click the Toolbar **Italic** button to make it appear pressed in/unpressed to italicize/un-italicize selected text.

- **Underline:** Select **Message Pane** text and select this command to check mark/uncheck it or click the Toolbar **Underline** button to make it appear pressed in/unpressed to underline/un-underline selected text.

- **Strikeout:** Select **Message Pane** text and select this command to check mark/uncheck it to strikeout/un-strikeout selected text.

**Font...:** Select **Message Pane** text and select this command to show the Windows **Font** window to change selected text font.

**Text data/RTF data:** Select the unchecked command to switch check marks to change the **Message Pane** text data format into the check marked type.
Note: The RTF format supports hyperlinks.

3.8.3.3 Toolbar

This is the Netop Message window toolbar:

![Toolbar Image]

The toolbar contains these buttons:

- **Send**: Click this button or select the File Menu **Send Message** command to send the window message to selected Hosts. The **Command Progress Status** window will show command execution.

  Note: If Host **Guest Access Security** does not allow **Send Message**, the command will not execute, see **Allow Guest To**.

- **New**: Click this button or select the File Menu **New** command to empty the Message Pane to create a message. You will be prompted to save any unsaved current message changes.

- **Open**: Click this button or select the File Menu **Open** command to show a Windows Open window that specifies **Files of type**: Rtf Files (*.rtf) to open the contents of a rich text format file in the window. You will be prompted to save any unsaved current message changes.

- **Save**: This button will be enabled only if a file path and name have been specified. Click it or select the File Menu **Save** command to save the message in its specified file.

- **Print**: Click this button or select the File Menu **Print** command to show a Windows Print window to print the Message Pane contents.

- **Undo/Redo**: Click this button or select the Edit Menu **Undo** command to undo/redo the last Message Pane action.

- **Cut**: Select Message Pane text and click this button, select the Edit Menu **Cut** command or press CTRL+X to remove selected text and place it on the clipboard.

- **Copy**: Select Message Pane text and click this button, select the Edit Menu **Copy** command or press CTRL+C to copy selected text to the clipboard.

- **Paste**: Click this button, select the Edit Menu **Paste** command or press CTRL+V to paste the clipboard contents in the Message Pane cursor position.

- **Find**: Click this button or select the Search Menu **Find** command to show the Windows Find window to find Message Pane text elements.

- **Bold**: Select Message Pane text and click this button to make it appear pressed in/released or select the Format Menu **Bold** command to check mark/uncheck it to bold/un bold selected text.

- **Italic**: Select Message Pane text and click this button to make it appear pressed in/released or select the Format Menu **Italic** command to check mark/uncheck it to italicize/un-italicize selected text.

- **Underline**: Select text in the Message Pane and click this button to make it appear pressed in/released or select the Format Menu **Underline** command to check mark/uncheck it to underline/un-underline selected text.
3.8.3.4 Message Pane

This is the Netop Message window message pane:

```
Message Pane
```

It will show the message contents. The first line of text will describe the message contents on the Host. You can edit, search and format message pane text from menu commands and Toolbar buttons.

To create an unprepared Netop message, type it into the pane.

To create a prepared Netop message, create plain or RTF formatted text in a file and paste it into the pane.

**Note:** RTF formatted text supports hyperlinks, see Format Menu.

3.8.3.5 Status Bar

This is the Netop Message window status bar:

The fields to the right are active:

- **CAPS:** Will show black text if CAPS LOCK is enabled.
- **NUM:** Will show black text if NUM LOCK is enabled.
- **OVR:** Will show black text if INSERT is enabled.

3.8.4 Get Inventory

If allowed by Host Guest Access Security, see Allow Guest To, the Guest can get an inventory of Host computer hardware and software to make it available on the Inventory Tab.

The Guest can connect to get inventory from the Quick Connect Tab or from Phonebook Tab or History Tab records, see Connect Guide.

When connected, the Guest can get inventory from Phonebook Tab, Quick Connect Tab, Connections Tab or History Tab records or from the Remote Control Toolbar or Toolbox.

Click the Get Inventory button or select the Connection Menu or record context menu Get Inventory command to get selected Host computer inventories to make them available on the Inventory Tab.

**Note:** Advanced inventory options are available on the Program Options window Inventory Tab.
4 Netop Host

This main section explains the functionality of Netop Host on a computer that runs on a Windows operating system.

Note: Netop Host on a computer that runs on a Linux, Solaris, Mac OSX, OS/2 or DOS operating systems is explained in the Administrator’s Guide Other Operating Systems chapter.

Netop Host enables a computer to be remote controlled from and interact with a computer that runs Netop Guest.

The Netop Host main section includes these sections:

- Host Startup Guide
- Netop Host Window
- Host Tools
- Host Sessions
- Session Tools
- Host Actions

4.1 Host Startup Guide

This section includes these sections:

- For Typical Computer Users
- For Advanced Computer Users
- Loading Alternatives
- Setup Wizard

4.1.1 For Typical Computer Users

Netop Host is a server type program that enables the matching client type program Netop Guest on another computer to access resources on the Netop Host computer.

Note: If Netop Host runs on your computer, you may experience that sometimes things beyond your control happen on the computer because a user that runs Netop Guest on a remote computer accesses your computer. If your computer belongs to an organization in which administrators manage the setup and security of your computer, you should not need to be concerned if such things happen. However, you should report to your administrator if things that you do not like happen on your computer.

You can typically verify that Netop Host is loaded on your computer by this button in the notification area in the lower right corner of the screen:

NetOp Host - Running (192.168.102.92)

Note: Netop Host can be set up to run in Stealth mode to not show this button, see the Program Options window General Tab.

Its tool tip that will be shown briefly when the mouse pointer is over the button will indicate the Host status (above: Running with the computer IP address 192.168.102.92).

Right-click this button to show this menu:
4.1.2 For Advanced Computer Users

If the setup of your computer and its applications is your own responsibility, you must set up Netop Host.

After a basic Netop Host Installation, Netop Host will not be loaded and will not load and start automatically when starting the computer.

Load Netop Host from Start > (All) Programs > Netop Remote Control > Host or by one of the available Loading Alternatives.

When any user loads Netop Host for the first time after basic Installation, the Setup Wizard will run to initially set up Netop Host. Select default options to apply a usable initial setup that will load and start Netop Host minimized in a Netop Host button, also when starting the computer.
Netop Host

Several Netop Host setup options are available:

- General setup: See Program Options.
- Communication setup: See Communication Profiles.
- Netop log setup: See Log Setup.
- Setup protection: See Maintenance Password.

By the Install Alternative Pack'n Deploy, you can install and deploy Netop Host in a set up state.

### 4.1.3 Loading Alternatives

These Netop Host loading alternatives are available:

- In the Windows XP Start menu, select Host if pinned to your Start menu or in your list of most frequently used programs.
- In the directory where Netop Host was installed, typically the directory C:\Program Files\Danware Data\Netop Remote Control\Host, run (double-click) NHSTW32.EXE.
- Create a desktop shortcut to NHSTW32.EXE and double-click this shortcut.
- In the Windows Run or Command Prompt window, execute a command specifying the NHSTW32.EXE path and file name. This command can include switches according to this syntax:

  \(<\text{Netop Host program path and file}\) [\(<\text{switch1}\>] \[\(<\text{switch2}\>]\)...  

You can use any of these switches:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/C:&lt;communication profile&gt;</td>
<td>Enable &lt;communication profile&gt; in addition to other selected Communication Profiles. The setting will not be stored.</td>
</tr>
<tr>
<td>/I:&lt;Inventory file path and name&gt;</td>
<td>Generate and retrieve the Host computer inventory to store it in &lt;Inventory file path and name&gt;.</td>
</tr>
<tr>
<td>/R:&lt;Host name&gt;</td>
<td>Name the Host by &lt;Host name&gt;. The setting will be stored.</td>
</tr>
<tr>
<td>/W: [+/-]</td>
<td>/W: Start the Host at loading. The setting will not be stored. /W:+ Start the Host at loading. The setting will be stored. /W:- Do not start the Host at loading. The setting will be stored.</td>
</tr>
</tbody>
</table>

Request Help by at least one of these switches:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/HD:&lt;Problem description&gt;</td>
<td>Specifies a problem description.</td>
</tr>
<tr>
<td>/HP:&lt;Help provider&gt;</td>
<td>Specifies a help provider (help service name or service ticket number).</td>
</tr>
<tr>
<td>/HC:&lt;Communication profile&gt;</td>
<td>Specifies a help request communication profile.</td>
</tr>
<tr>
<td>/HA:&lt;Help provider address&gt;</td>
<td>Specifies a help provider address (Guest address or Connection Manager URL. The Connection Manager URL can be omitted if specified in the used WebConnect communication profile).</td>
</tr>
<tr>
<td>/HW:</td>
<td>Must be included with a help request via WebConnect.</td>
</tr>
</tbody>
</table>

Cancel a pending help request by this switch:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/HH:</td>
<td>Cancels a pending help request.</td>
</tr>
</tbody>
</table>

Log on to a Guest network connecting Netop Gateway by these switches:
/LG: <Gateway logon name>  
Specifies a Gateway logon name.

/LGP: <Gateway logon password>  
Specifies a Gateway logon password.

/LGD: <Gateway logon domain>  
Specifies a Gateway logon domain.

**Note:** When the Host is loaded, you can use the same command syntax to change settings or Request Help.

**Examples**

<Netop Host program path and file> /R:John C:/TCP/IP /W:
Explanation: Load the Host with the Host name John, start the Host (do not store) enabling TCP/IP and other selected communication profiles.

<Netop Host program path and file> /R:Peter /W:+
Explanation: Load the Host with the Host name Peter, start the Host (store) enabling selected communication profiles.

<Netop Host program path and file> /HD:"Nothing works" /HP:"Windows Help" /HC:TCP4 /HA:192.168.102.58
Explanation: Load the Host and send a help request with the problem description Nothing works, help provider Windows Help, communication profile TCP4 and IP address 192.168.102.58.

**Note:** Switch parameters that contain spaces or special characters must be enclosed by double quotation marks.

### 4.1.4 Setup Wizard

When **Netop Host** is loaded for the first time after basic Installation or if you select the **Tools Menu Run Setup Wizard** command, this window will be shown:

![NetOp Remote Control - Setup Wizard](image)

This wizard will guide you through the selection of certain setup options to make the NetOp module ready for use.

Click Next to proceed.

This wizard will guide you through Host setup.

Click Cancel to leave the Setup Wizard without changing Host setup.

**Note:** We recommend that you run the Setup Wizard when loading Netop Host for the first time after a
Click Next to show this window:

Select one of these options:

- Default: Follow the Default Track with few setup options (default selection).
- Custom: Follow the Custom Track with a wide range of setup options.

**Note:** For initial setup, we recommend that you follow the Default Track and select default options.

Click Back to show the previous wizard window.

Click Next to show the next wizard window:

- Default Track
- Custom Track
4.1.4.1 Default Track

In the Host Setup Wizard Wizard Mode window, select Default and click Next to show this window:

Select one of these options:

○ **Start with Windows**: Load and start the Host when the computer is switched on (default selection).

○ **Load manually**: Do not load the Host when the computer is switched on. The Host will start when loaded manually.

Click Next to show this window:
Specify password: [ ]: Specify in this field the password that all connecting Guests must specify to connect. Characters will show as dots or asterisks.

Re-enter password: [ ]: Re-specify in this field the password for confirmation.

Click Next to show this window:

Select one of these options:
Yes, I want to register my Netop license on-line: Show the Netop Product Registration web page in your Internet browser when clicking Next (default selection).

No, but remind me later: Show this window when loading the Host next time.

No, I do not want to register my Netop license now: Do not show this window again.

Note: Registering your license with the Netop manufacturer may prove useful if you lose your license certificate or if you want to upgrade to a newer version of the product. Do not register a free trial version license or a license that has already been registered.

Click Next to show this window:

Click Finish to end the Setup Wizard.
4.1.4.2 Custom Track

In the Host Setup Wizard Wizard Mode window, select Custom and click Next to show this window:

The options available in this window are explained in Communication Profiles.

Click Next to show this window:
The options available in this window are explained on the Program Options window General Tab.
Click Advanced to show the Program Options window.
Click Next to show this window:

Select one of these options:

- **All Guests have the same password**: Click Configure to show the Guest Access Security window Guest Access Privileges Tab showing Grant All Guests Default Access Privileges options to review security settings. Click Next to show the Default Guest Access Password window (default selection).

- **Each Guest has its own password**: Click Configure to show the Guest Access Security window Guest Access Privileges Tab showing Grant Each Guest Individual Access Privileges Using Netop Authentication options to select the security role that shall be assigned to added Guests. Click Next to show the Add a Guest Account window.

- **Use Windows Security Management**: Click Configure to show the Guest Access Security window Guest Access Privileges Tab showing Grant Each Guest Individual Access Privileges Using Windows Security Management options to select the security role that shall be assigned to added Windows accounts. Click Next to show the Add a Windows Account window.
Select one of these options:

⊙ Yes, add a Guest: Click Next to show the Guest Credentials window (default selection).
⊙ No: Click Next to show the Register window to end the Setup Wizard.

Guest ID: [ ]: Specify in this field the name by which a connecting Guest must log on.
Specify password: [:] Specify in this field the password by which this Guest must log on. Characters will show as dots or asterisks.

Re-enter password: [:] Re-specify in this field the password for confirmation.

Click Next to add this account to the security role selected from the Security Options window and show the Add Another Account window.

Select one of these options:

- Yes, add another account: Click Next to show the Guest Credentials or Windows Select User/Group window from which this window was shown to add another account (default selection).
- No: Click Next to show the Register window to end the Setup Wizard.
Select one of these options:

- **Yes, add a Windows user**: Click Next to show the Windows Select User window to add a Windows user account to the security role selected from the Security Options window and show the Add Another Account window (default selection).

- **Yes, add a Windows group**: Click Next to show the Windows Select Group window to add a Windows group account to the security role selected from the Security Options window and show the Add Another Account window.

- **No**: Click Next to show the Register window to end the Setup Wizard.
4.2 Netop Host Window

This is the *Netop Host* window:

It contains these elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**
- **Tab Panel**
- **Status Bar**

### 4.2.1 Title Bar

This is the *Netop Host Window* title bar:

The title bar will show Host status information:

- **Loading**: Host is loading.
- **Stopped**: Host communication is disabled.
- **Starting**: Host communication is being enabled.
- **Running**: Host communication is enabled. No Guest is connected.
- **Connected [ (<Guest name>)| (Number>]**: Host communication is enabled. The Guest identified by `<Guest name>` and `<Number>` other Guests are connected.

**Note**: If the *Program Options* window *Connection Notification Tab During Connection* section *Display Guest name (if available) in the title bar* box is checked, the name by which the connected Guest identifies itself will be shown in square brackets. If the *Program Options* window *General Tab Connection* section *Allow multiple simultaneous Guest sessions* box is checked, multiple Guests can be connected at the same time. The number of connected Guests more than one will be shown...
Netop Host

by +<Number>.

- **Disconnecting**: Host communication is enabled. Connected Guests are being disconnected.
- **Help requested**: Host communication is enabled. A help request is pending, see Request Help.
- **Stopping**: Host communication is being disabled.

This status information will also be shown in the **General Tab Status** field, on the Windows taskbar Netop Host button and tool tip and in the notification area Netop Host button tool tip.

Apply a **Window Control Minimize** control to show the Host only as a notification area Netop Host button.

### 4.2.2 Menu Bar

This is the Netop Host Window menu bar:

![Menu Bar](image)

It contains these menus:

- **File Menu**
- **View Menu**
- **Action Menu**
- **Session Menu**
- **Tools Menu**
- **Help Menu**

#### 4.2.2.1 File Menu

This is the Netop Host Window **File** menu:

![File Menu](image)

**View**: This command expands into this command:

**Message**: Select a **Messages Tab** record and select this command or the record context menu **View** command to show the record message in the Netop Message window.

**Save As**: This command expands into this command:

**History**: Select the **History Tab** and select this command or the tab pane context menu **Save As** command to show a Windows **Save As** window that specifies **Save as type**: **All Files (.*.)** to save the pane contents in a file.

**Note**: The **Save As** window **File name** drop-down box field will initially specify the **txt** file name extension, but it will not automatically be added to the specified file name.

**Delete**: This command expands into these commands:

**History**: Select the **History Tab** and select this command or the tab pane context menu **Delete** command to show a confirmation window to confirm deleting the pane contents.

**Messages**: Select **Tab Panel Messages Tab** records and select this command or the record context menu **Delete** command to show a confirmation window to confirm deleting selected records and matching files.
Exit: Select this command or the Netop Host Button Menu Exit command or apply a Window Control Close control to unload the Host.

4.2.2.2 View Menu

This is the Netop Host Window View menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Action</th>
<th>Session</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Toolbar</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File transfer status</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modem dialog</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Toolbar: Select this command to hide/show the Toolbar (default: shown). The command icon will appear pressed in if the Toolbar is shown.

File Transfer Status: This command will be enabled if a Guest is connected. Select it to show the File Transfer Status window.

Modem Dialog: Select this command to show the Modem Dialog window.

4.2.2.3 Action Menu

This is the Netop Host Window Action menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Action</th>
<th>Session</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Start</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Restart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hide</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Start: Select this command or click the Toolbar Start button to start the Host to enable selected Communication Profiles.

If Guest Access Security does not specify any Guest logon credentials, by default this window will be shown when the Host starts:

Security Warning

This Host allows any Guest to access your PC. To prevent unauthorized access it is recommended that you specify password or another form of access restriction.

☐ Don’t show this warning again: Check this box to suppress this security warning (default: unchecked).

Review security settings...: Click this button to show the Guest Access Security window.

Continue: Click this button to close the Security Warning window to start the Host.

Note: To reinstate this security warning if suppressed, while the Host is unloaded delete the Netop Configuration Files nhstconf.ndb file that will typically reside in C:\Documents and Settings \All Users\Application Data\Danware Data\Netop Remote Control\Host to delete the general Host setup. When reloading the Host, the Setup Wizard will run to create a Host setup.
**Netop Host**

*Cancel:* Click this button to close this window without starting the Host.

*Stop:* Select this command or click the Toolbar *Stop* button to stop the Host to disable enabled Communication Profiles.

*Restart:* Select this command or click the Toolbar *Restart* button to stop and start the Host to disable and enable selected Communication Profiles.

**Note:** Some setup changes require Host restart.

*Hide:* Select this command to show a confirmation window to confirm hiding the Host. If hidden, nothing on the screen will indicate that the Host is loaded.

**Note:** If hidden from this command, the Host will be shown when reloaded, e.g. by restarting Windows. If hidden from the Program Options window General Tab Stealth mode option, the Host will be hidden when reloaded. To show a hidden Host, run showhost.exe that by default will reside in the directory where Netop Host is installed.

### 4.2.2.4 Session Menu

This is the Netop Host Window *Session* menu:

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Action</th>
<th>Session</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Connect</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Chat</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Audio-Video Chat</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Request help</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Cancel help</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Disconnect:* This command will be enabled if a Guest is connected. Select it or the Netop Host Button Connected Menu *Disconnect* command or click the Toolbar *Disconnect* button to disconnect from all connected Guests.

**Note:** From the Netop Host Button Connected Menu, you can disconnect from one of multiple connected Guests.

*Chat:* This command will be enabled if a Guest is connected. Select it or the Netop Host Button Connected Menu *Chat* command or click the Toolbar *Chat* button to start a Chat session with all connected Guests.

**Note:** From the Netop Host Button Connected Menu, you can start a Chat session with one of multiple connected Guests.

*Audio-Video Chat:* This command will be enabled if a Guest is connected, unless the Guest or the Host is engaged in another audio session. Select it or the Netop Host Button Connected Menu *Audio-Video Chat* command or click the Toolbar *Audio-Video Chat* button to start an Audio-Video Chat session with the connected Guest that has keyboard and mouse control.

**Note:** From the Netop Host Button Connected Menu, you can pass keyboard and mouse control from one of multiple connected Guests to another.

*Request Help:* This command will be enabled if the Host status is *Running* and if at least one of the Program Options window Help Request Tab Options section Enable help service or Enable service tickets boxes is checked. Select it or the Netop Host Button Menu *Request Help* command or click the Toolbar *Request Help* button to Request Help from a Guest.

*Cancel Help:* This command will be enabled if the Host status is *Help requested*. Select it or the Netop Host Button Menu *Cancel Help* command or click the Toolbar *Cancel Help* button to cancel a pending help request.
4.2.2.5 Tools Menu

This is the Netop Host Window Tools menu:

- Program Options
- Guest Access Security
- Maintenance Password
- Log Setup
- Communication Profiles
- Modem database
- Check For New Updates
- Run Setup Wizard
- Debug Trace

Its commands are explained in Host Tools.

4.2.2.6 Help Menu

This is the Netop Host Window Help menu:

- Contents
- Online support
- Online registration
- Apply License
- Quick Guide
- About...

Contents: Select this command to open the Netop Host Help system that in its left pane shows a graphical table of contents.

Online Support: Select this command to open the Support for Netop Remote Control web page in your Internet browser.

Online Registration: Select to open the Netop Product Registration web page in your Internet browser.

Apply License: Select to show this window:
Netop Host

It enables you to change the installed Netop Host license information.

Licensed to: [: Specify the licensee name.

Serial number: [: Specify the Host license number.

Quick Guide: Select this command to open the Netop Host Help system on the Host Startup Guide topic.

About...: Select this command to show this window:

This window will contain information on your Netop Host installation. The build number in format YYYYDDD (Y=year number digit, D=day number digit) is enclosed in parentheses next to the version number.

System Info...: Click this button to show the System Info window.

4.2.3 Toolbar

This Netop Host Window toolbar will be shown unless hidden from the View Menu Toolbar command:

Toolbar buttons are grouped into these sections:

- Action Buttons
- Session Buttons
- Tool Buttons

4.2.3.1 Action Buttons

These are the Host Toolbar action buttons:

- Start: Click this button or select the Action Menu Start command to start the Host to enable selected Communication Profiles.

  Note: The Security Warning window is explained in the Action Menu section.

- Stop: Click this button or select the Action Menu Stop command to stop the Host to disable all Communication Profiles.
4.2.3.2 Session Buttons

These are the Host Toolbar session buttons:

- **Disconnect:** This button will be enabled if a Guest is connected. Click it or select the Session Menu or Netop Host Button Connected Menu Disconnect command to disconnect from all connected Guests.
  
  **Note:** From the Netop Host Button Connected Menu, you can disconnect from one of multiple connected Guests.

- **Chat:** This button will be enabled if a Guest is connected. Click it or select the Session Menu or Netop Host Button Connected Menu Chat command to start a Chat session with all connected Guests.
  
  **Note:** From the Netop Host Button Connected Menu, you can start a Chat session with one of multiple connected Guests.

- **Audio-Video Chat:** This button will be enabled if a Guest is connected, unless the Guest or the Host is engaged in another audio session. Click it or select the Session Menu or Netop Host Button Connected Menu Audio-Video Chat command to start an Audio-Video Chat session with the connected Guest that has keyboard and mouse control.
  
  **Note:** From the Netop Host Button Connected Menu, you can pass keyboard and mouse control from one of multiple connected Guests to another.

- **Request Help:** This button will be enabled if the Host status is Running and if at least one of the Program Options window Help Request Tab Options section Enable help service or Enable service tickets boxes is checked. Click it or select the Session Menu or Netop Host Button Menu Request Help command to Request Help.

- **Cancel Help:** This button will be enabled if the Host status is Help requested. Click it or select the Session Menu or Netop Host Button Menu Cancel Help command to cancel a pending help request.

4.2.3.3 Tool Buttons

These are the Host Toolbar tool buttons:

- **Program Options:** Click this button or select the Tools Menu Program Options command to show the Program Options window.

- **Guest Access Security:** Click this button or select the Tools Menu Guest Access Security command to show the Guest Access Security window.

- **Communication Profiles:** Click this button or select the Tools Menu Communication Profiles command to show the Communication Profile Setup window.

**Note:** Tool buttons and Tools Menu setup commands will be disabled if configuration files are protected, see Maintenance Password. Tool actions can be protected by a Maintenance Password.
4.2.4 Tab Panel

This is the **Netop Host Window** tab panel:

It will show Host properties on these tabs:

- **General Tab**
- **Connections Tab**
- **History Tab**
- **Services Tab**
- **Communication Tab**
- **Names Tab**
- **Messages Tab**

### 4.2.4.1 General Tab

This is the Host **Tab Panel General** tab:

It will typically be shown in front to show general Host properties.

**Status**: This disabled field will show the Host status like the **Title Bar**, the Windows taskbar button and the **Netop Host Button** tool tip.

**Host ID**: This disabled field will show the Host name specified in the **Program Options** window Host
**NameTab Naming** section, see also **Names Tab**.

**Address []**: This disabled field, the **Status Bar** and the **Netop Host Button** tool tip will show enabled Host computer IP addresses, see **Names Tab**.

### 4.2.4.2 Connections Tab

This is the Host **Tab Panel** **Connections** tab:

<table>
<thead>
<tr>
<th>Sessions</th>
<th>Name</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GUEST 2</td>
<td></td>
</tr>
<tr>
<td>✔️</td>
<td>GUEST 1</td>
<td></td>
</tr>
</tbody>
</table>

If Guests are connected to the Host, this tab will show Guest records in a table with these column contents:

- **Sessions**: Keyboard and mouse control check mark and session icons.
- **Name**: Guest name.

**Note**: The information on this tab can be shown in the **Connection List** window.

Right-click a record to show this context command:

**Change Guest access privileges**: Click to show this window:
Note: This command will be Maintenance password protected if Guest access security is protected.

Its pane contains check boxes available Allow Guest to options. Check/uncheck boxes to enable/disable options.

4.2.4.3 History Tab

This is the Host Tab Panel History tab:

It will show records of connection events since the Host was last loaded in a table with these column contents:

- Time: Event icon, date and time.
Netop Host

- **Name**: Guest name.
- **Event**: Connected or Disconnected.

**Note**: The information on this tab can be shown in the **History List** window.

When the Host is unloaded, records will be lost. Right-click in the pane to show this context menu:

- **Save as**
- **Delete**

**Save As**: Select this command or the **File Menu Save As > History** command to show a Windows Save As window that specifies **Save as type**: All Files (*) to save the pane contents in a file.

**Note**: The **Save As** window will specify the file name *.txt*, but the extension *txt* will not automatically be added to the specified file name.

**Delete**: Select this command or the **File Menu Delete > History** command to show a confirmation window to confirm deleting the pane contents.

### 4.2.4.4 Services Tab

This is the Host **Tab Panel Services** tab:

It will show records of available Netop services in a table with these column contents:

- **Name**: Service icon and name.
- **Details**: Details for each of these Netop services:
  - **Encryption**: The encryption type of the most recent Guest connection, see the **Guest Access Security** window Encryption Tab.
  - **Name Server**: **Available**: 0 if not using Netop Name Server or if no Netop Name Server is available when using Netop Name Server. **Available**: 1 or 2 indicating the number of available Netop Name Servers when using Netop Name Server, see **Advanced TCP/IP Configuration**.
  - **Security Server**: **Available**: 0 if not using Netop Security Server or if no Netop Security Server is available when using Netop Security Server. **Available**: <Number of available Netop Security Servers> indicating the number of available Netop Security Servers when using Netop Security Server, see the **Guest Access Security** window Guest Access Privileges Tab Use Netop Security Server selection.
4.2.4.5 Communication Tab

This is the Host Tab Panel Communication tab:

<table>
<thead>
<tr>
<th>Profile</th>
<th>Device</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>TCP/IP</td>
<td>Ports: 6502/6502</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>TCP/IP</td>
<td>Ports: 6502/6502</td>
</tr>
</tbody>
</table>

It will show records of enabled communication profiles in a table with these column contents:

- **Profile**: Communication device icon and communication profile name.
- **Device**: Communication profile Communication Device.
- **Details**: Communication profile configuration details, see Advanced TCP/IP Configuration.

**Note**: Communication profiles will be enabled if the Host status is Running, Connected or Help Requested.

4.2.4.6 Names Tab

This is the Host Tab Panel Names tab:

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.102.92</td>
<td>IP address</td>
</tr>
<tr>
<td>CG</td>
<td>LAN user</td>
</tr>
<tr>
<td>CG003Z</td>
<td>NetOp Name</td>
</tr>
</tbody>
</table>

It will show records of enabled Host names in a table with these column contents:

- **Name**: Host name.
- **Type**: Host name type.

**Note**: Host names will be enabled if the Host status is Running, Connected or Help Requested.

The Host will respond to Guest connect attempts and browses by its enabled names.

Host computer IP addresses will be enabled as IP address type names if Communication Profiles that
use the Communication Devices TCP/IP, TCP/IP (TCP) or TCP/IP (TCP IPv6) are enabled, see Communication Tab.

Host computer network card MAC addresses will be enabled as MAC address type names if Communication Profiles that use the Communication Devices NetBIOS or IPX are enabled, see Communication Tab.

**Note:** MAC address type names that specify random MAC addresses may be shown when the Host communicates by other communication devices. Guests cannot connect by a random MAC address.

The Host computer Windows or network logon user name will be enabled as a LAN user type name if the Program Options window Host Name Tab Name options section Enable User Name box is checked.

The contents of the Host General Tab Host ID field will be enabled as a Netop name type name.

### 4.2.4.7 Messages Tab

This is the Host Tab Panel Messages tab:

![Messages Tab](image)

It will show records of received Netop Messages in a table with these column contents:

- **Received**: Message icon and received date and time.
- **From**: Guest name.
- **Subject**: Message first text line.

The contents of received Netop Messages will automatically be saved in an rtf file in the Netop Configuration Files Messages directory, typically C:\Documents and Settings\All Users\Application Data\Netop Remote Control\Host\Messages. Files in this directory will be shown as Messages tab records.

Right-click a record or select multiple records and right-click to show this context menu:

- **View**: Select one record and select this command or the File Menu View > Message command to show the selected record message in the Netop Message window.

- **Delete**: Select one or multiple records and select this command or the File Menu Delete > Messages command to show a confirmation window to confirm deleting selected records and their files.
Netop Host

4.2.5 Status Bar

This is the Netop Host Window status bar:

If a Communication Profile that uses a TCP/IP, TCP/IP (TCP) or TCP/IP (TCP IPv6) Communication Device is enabled, the right end of the status bar will show the Host computer IP address. A + will be shown after the IP address if multiple IP addresses are enabled. Click the + to show other enabled IP addresses. The General Tab Address field and the Netop Host Button tool tip will also show enabled IP addresses.

If a Communication Profile that uses the TCP/IP Communication Device is enabled and in its Advanced TCP/IP Configuration window the Use Netop Name Server box is checked, a yellow pages icon will be shown in the status bar. An indicator may appear on the yellow pages icon:

- None: Specified Netop Name Servers are available.
- Red X: No specified Netop Name Server is available.
- Red exclamation mark (!): One of two specified Netop Name Servers is available.

Note: Netop Name Server availability will also be indicated on the Services Tab.

If the mouse pointer is over a menu command or Toolbar button, the status bar will be cleared and a hint to the command or button will be shown.

4.3 Host Tools

Select Host tools from the Tools Menu:

- or from the Toolbar Tool Buttons:

Note: Tools Menu configuration commands and Toolbar Tool Buttons will be disabled if configuration files are protected, see Maintenance Password. Tool actions can be protected by a Maintenance Password.

These Host tools are available:

- Program Options
- Guest Access Security
- Maintenance Password
- Log Setup
4.3.1 Program Options

Click the Toolbar Program Options button or select the Tools Menu Program Options command to show this window:

![Program Options Window]

**Note:** This command and button will be disabled if configuration files are protected, see Maintenance Password. If protected by a Maintenance Password, you must specify the correct password in the Maintenance Password Enter window to access the Program Options window.

This window specifies Host setup on these tabs:

- **General Tab**
- **Host Name Tab**
- **Connection Notification Tab**
- **Audio-Video Chat Tab**
- **Remote Printing Tab**
Netop Host

- Help Request Tab
- Directory Services Tab
- Web Update Tab

Note: Program Options window specifications are stored in the nhstconf.ndb configuration file that resides in the Netop Configuration Files directory, typically C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host. Some Host setup changes require Host restart to apply, see Action Menu or Action Buttons.

4.3.1.1 General Tab

This is the Host Program Options window General tab:

It specifies Startup and Connection options.

Startup

☑ Start Host when loaded: Leave this box checked to start the Host to enable communication when loaded (default: checked).

☑ Load Host at Windows startup (run as service): Leave this box checked to load the Host when Windows starts on the computer (default: checked).

Note: Loading the Host at Windows startup and starting the Host when loaded will make the Host ready for connection when the Host computer is switched on, even if no user is logged on to Windows.

☑ Minimize Host when loaded: Leave this box checked to minimize the Host into a Netop Host Button when loaded (default: checked).
- **Stealth mode (hide Host when started):** Check this box to load the Host hidden to the Host computer user (default: unchecked). If hidden, nothing on the screen will indicate that the Host is loaded.

  **Note:** To show a hidden Host, run `SHOWHOST.EXE` that typically will reside in the directory where the Host is installed.

**Connection**

- **Minimize Host on connection with Guest:** Check this box to minimize the Host window into a **Netop Host Button** when a Guest connects (default: unchecked).

- **Host top most window on connection with Guest:** Check this box to show the Host window in front of any other window when a Guest connects (default: unchecked).

- **Show file transfer status:** Check this box to show the **File Transfer Status** window when a Guest starts a **File Transfer** session (default: unchecked).

- **Send keep alive message:** Check this box to send a data packet at intervals while connected to alert the Host user if the connection has been lost (default: unchecked).

  **Note:** To maintain an **ISDN (CAPI)** connection during short periods of inactivity, do not check this box but select the **Short-hold mode** option.

- **Allow Multiple Simultaneous Guest Sessions:** Leave this box checked to allow multiple Guest connections to the Host at the same time (default: checked).

### 4.3.1.2 Host Name Tab

This is the Host **Program Options** window Host Name tab:
It specifies Host Naming, Name options and the Netop Name Server name space ID.

**Naming**

This section specifies the name by which the Host will identify itself when communicating.

**Note:** To communicate by a Communication Profile that uses a Networking Communication Device (NetBIOS, IPX, TCP/IP, Terminal Server), each Host must use a unique name. A Host that uses a name that is already used by another communicating Host will be denied communicating.

Select one of these options:

- **Enter name or leave name field blank:** Specify in the field below a name or leave the field blank to name the Host by the specified name or leave it without a name.

- **Use environment variable [ ]:** Specify in the field below an environment variable name to name the Host by the value of the specified environment variable.

  **Note:** Do not name a network computer Host by the environment variable USERNAME if it is set up to Load at Windows startup. If you do that, the Host will load before a user logs on to Windows to get the name %USERNAME% and retain this name until reloaded while a user is logged on to get the name <Windows logon user name>. Of multiple Hosts named %USERNAME%, only one can communicate.

  Name a terminal server session Host typically by the environment variable USERNAME, see the Administrator's Guide Advanced Tools chapter Netop in Terminal Server Environments section Netop Naming in a TSE section. To show available Windows environment variables, in a command prompt window type set and press ENTER.

- **Use Windows computer name:** Name the Host by the Host computer Windows name (default selection).

  **Note:** Name a network computer Host typically by the Windows computer name. Do not name a terminal server session Host by the Windows computer name. Terminal server session Hosts share the Windows computer name of the terminal server computer. Of multiple Hosts named by the terminal server computer name, only one can communicate.

- **Prefix with computer workgroup name:** Check this box to prefix the Host computer name by its domain or workgroup name to ensure Host name uniqueness across multiple domains and workgroups (default: unchecked).

  Separate with [:]: The field will initially show the default separator character (:). You can replace it by any other character.

**Name:** The Host name according to the selection above will be shown.

**Name options**

- **Public Host name:** Leave this box checked to respond to Guests that browse for Hosts by the Host name (default: checked).

  **Note:** If the Host computer is connected directly to a public network like the Internet, you may want to uncheck this box to not invite hacking attempts.

- **Enable user name:** Leave this box checked to enable the name of a user logged on to the Host computer to enable connections by the user name (default: checked).

  **Note:** If this box is checked, the user name will appear on the Names Tab. You may want to uncheck this box on a server Host to disable connecting by the name of a temporarily logged on user or the user as which the Host runs, see Run As Tab, to acquire the computer rights of the user.

**Netop Name Server**

**Name Space ID:** [:] The default Name Space ID is PUBLIC. Specify in the field the Name Space ID specified on Guests with which the Host shall be able to communicate by using Netop Name Server.

The Name Space ID will apply only if the Host communicates by a Communication Profile that uses the
TCP/IP Communication Device and for which in the Advanced TCP/IP Configuration window the Use Netop Name Server box is checked and Netop Name Servers are specified.

Note: To apply Naming or Name Space ID changes, restart the Host, see Action Menu or Action Buttons.

4.3.1.3 Connection Notification Tab

This is the Host Program Options window Connection Notification tab:

- **Upon connection**
  - **Play sound**: Check this box to play a sound when a Guest connects (default: unchecked).
  - **Display Connection List**: Check this box to show the Connection List window when a Guest connects (default: unchecked). Specify in the field the number of seconds this window shall be shown (default: 6). The value 0 will make the Connection List window remain on the screen.
  - **Password to close Connection List**: Check this box and specify a password in the field to make the Connection List window remain on the screen until closed manually (default: unchecked). Characters will show as dots or asterisks. To close the Connection List window, specify the password in a Password window.
  - **Display balloon tip**: Check this box to show a balloon tip from the Netop Host Button when a Guest connects (default: unchecked).

- **During connection**
  - **Play sound**: Check this box to play a sound during the connection (default: unchecked).
  - **Interval**: Specify the interval in seconds (10 - 50).
  - **Display Guest name (if available) in the title bar**
  - **Animate icon**

- **After connection**
  - **Display History List**: Check this box to show the History List when a Guest disconnects (default: unchecked).
  - **Password to close History List**: Check this box and specify a password in the field to make the History List window remain on the screen until closed manually (default: unchecked). Characters will show as dots or asterisks. To close the History List window, specify the password in a Password window.
  - **Display balloon tip**: Check this box to show a balloon tip from the Netop Host Button when a Guest disconnects (default: unchecked).

It specifies connection notification options.

Upon connection

- **Play sound**: Check this box to play a sound when a Guest connects (default: unchecked).
  
  Note: The upon connection sound file StartHRC.wav resides in the Media directory of the directory in which Netop Host is installed.

- **Display Connection List [s] (0 = no timeout)**: Check this box to show the Connection List window when a Guest connects (default: unchecked). Specify in the field the number of seconds this window shall be shown (default: 6). The value 0 will make the Connection List window remain on the screen.

- **Password to close Connection List**: Check this box and specify a password in the field to make the Connection List window remain on the screen until closed manually (default: unchecked). Characters will show as dots or asterisks. To close the Connection List window, specify the password in a Password window.

- **Display balloon tip**: Check this box to show a balloon tip from the Netop Host Button when a Guest connects (default: unchecked).
During connection

☐ **Play sound**: Check this box to play a sound during Guest connection at this interval (default: unchecked):

*Interval*: [ ] s. (10-60): Specify in the field a number in the range for the interval between sounds in seconds (default: 10).

**Note**: The during connection sound file ContHRC.wav resides in the Media directory of the directory in which Netop Host is installed.

☑ **Display Guest name (if available) in the title bar**: Leave this box checked to show the connected keyboard and mouse control Guest name in the Title Bar, the Windows taskbar Netop Host button and the Netop Host Button tool tip (default: checked).

☐ **Animate icon**: Check this box to animate the Netop Host Button double corner lines during Guest connection (default: unchecked).

After connection

☐ **Display History List** [ ] s. (0 = no timeout): Check this box to show the History List window when a Guest disconnects (default: unchecked). Specify in the field the number of seconds this window shall be shown (default: 0). The value 0 will make the History List window remain on the screen.

☐ **Password to close History List**: [ ]: Check this box and specify a password in the field to make the History List window remain on the screen until closed manually (default: unchecked). Characters will show as dots or asterisks. To close the History List window, specify the password in a Password window.

☐ **Display balloon tip**: Check this box to show a balloon tip from the Netop Host Button when a Guest disconnects (default: unchecked).
4.3.1.4 Audio-Video Chat Tab

This is the Host Program Options window Audio-Video Chat tab:

It specifies audio and video settings.

Audio Chat

General

☐ Enable full-duplex audio: Leave this box checked to enable sending audio data between Guest and Host in both directions at the same time (default: checked).

Note: Some computer audio systems do not support full-duplex audio.

Microphone sensitivity

Silence level: Drag this slide to set the microphone sound input level below which no audio data shall be sent (default: second tick from left).

Line hold: Drag this slide to adjust the period in which audio data shall continue to be sent after the microphone sound input level has dropped below the Silence level (default: sixth tick from left).

Note: Try out different settings for Silence level and Line hold to optimize audio communication.

Check Sound System: Click this button to check of the computer sound system to show a result message.

Advanced...: Click this button to show this window:
Netop Host

**Advanced audio settings**

**Playback**

*Preferred Device:* [ ]: The field of this drop-down box will show the preferred audio playback device (default: `<Use any available device>`). The drop-down box list contains the names of playback devices found by Windows. Select a name in the list to show it in the field.

**Record**

*Preferred Device:* [ ]: The field of this drop-down box will show the preferred audio recording device (default: `<Use any available device>`). The drop-down box list contains the names of recording devices found by Windows. Select a name in the list to show it in the field.

**Note:** If multimedia devices are connected to the computer, the `<Use any available device>` selection may select a connected device instead of the computer sound system. In that case, select the computer sound system.

**Video Chat**

**Advanced...**: Click this button to show this window:

**Advanced Video**

*Select driver to use:* [ ]: If a video camera is installed, this drop-down box will contain its driver name. Select a driver name in the list to show it in the field.

If a camera that uses the driver whose name is shown in the *Select driver to use* drop-down box field is enabled, the image frame will show its captured image.
Format: Click this button to show the Windows Video Format window to format the video capture image.

Properties: Click this button to show the Windows Video Source window to specify video source properties.

☐ Disable compression: Check this box to disable video data compression (default: unchecked).

4.3.1.5 Remote Printing Tab

This is the Host Program Options window Remote Printing tab:

It specifies remote Netop printers.

**Note:** To send a Host computer print job to a Guest printing device, while the Guest is connected print to a Host computer remote Netop printer that specifies the Guest printing device. Special instructions for remote printing from DOS applications are available in the Netop KnowledgeBase.

Remote Netop printers

This pane will show the names of remote Netop printers in the Host computer Windows Printers folder (initially none).

Add Printer...: Click this button to show this window:
Follow these guidelines that will remain on the screen while you add a remote Netop printer. Click Ready to start adding a remote Netop printer.

Remove Printer: Select a Netop printer in the pane and click this button to remove it.
4.3.1.6 Help Request Tab

This is the Host Program Options window Help Request tab:

It specifies general help request options. If unspecified, the Host user can specify individual options with each help request.

Optional help information

Problem description: [:] To always specify the same problem description, specify it in this field. If the field is left empty, the Help Providers window will be shown when requesting help.

Help provider: [:] To always request help from the same help provider (help service), specify its name in this field. If the field is left empty, the Help Providers window will be shown when requesting help.

Communication

Communication profile

Select one of these options:

○ Use current Host Communication Profile(s): Select this option to send help requests by enabled Communication Profiles (default selection). Unless only one Communication Profile or only Communication Profiles that use Networking Communication Devices are enabled, the Select Help Request Communication Profile window will be shown when requesting help.

○ Use specific Communication Profile [:]: Select this option to select in the drop-down box one of the available Host Communication Profiles.

Advanced...: Click this button to show this window:
Communication

Phone number or IP address: [ ] (Optional): If requesting help by a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device other than Infrared (IrDA), a telephone number or IP address must be specified. If not specified in this field, the Connect to Help Provider window will be shown when requesting help.

Help request timeout if not answered [ ] min. (1 - 60, 0 = unlimited): Specify in the field a number in the range to cancel the help request if not responded to by a help provider within the specified number of minutes (default: 0, i.e. the help request will not be canceled).

Gateway logon

If requesting help by a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device through a Guest network Netop Gateway, it may request logon. If valid Gateway logon credentials are not specified in this section, a Gateway logon window may be shown when requesting help.

Logon name: [ ]: Specify in this field the Gateway logon name (default: empty).

Logon password: [ ]: Specify in this field the Gateway logon password (default: empty).

Logon domain: [ ]: Specify in this field the Gateway logon domain (default: empty).

☐ Use current logon credentials for Windows Security authentication: Check this box to log on by the name, password and domain of the user logged on to Windows on the Host computer (default: unchecked).

Options

☐ Add Help Request icon to the tray: Check this box to add this button identified by the tool tip Netop Help Request to the notification area in the lower right corner of the screen (default: unchecked):

To request help, double-click the button or select the button Request Help context command.

Note: If this button is added, the Host computer user can request help even if the Host is hidden, see Action Menu or Action Buttons.

☑ Enable help service: Leave this box checked to enable help request by a help service, see Request
Help (default: checked).

☐ Enable service tickets: Check this box to enable help request by a service ticket, see Request Help (default: unchecked).

### 4.3.1.7 Run As Tab

This is the Host Program Options window Run As tab:

It can enable always running the Host with the rights of a Windows user account.

If no user is logged on to the Host computer, the Host will run with extensive Host computer rights but no network computer rights, see the Administrator's Guide Advanced Tools chapter Netop Remote Control Processes and Windows Security section.

If a user is logged on to the Host computer, the Host will run with the rights of the logged on user.

A connected Guest will get the rights of the Host limited by applicable Guest Access Security.

For certain purposes, typically to assign network computer rights to the Host when no user is logged on to the Host computer, you can run the Host as a specific user.

**Run Host as specific user**

☐ Enable: Check this box to always run the Host as a specific Windows user account (default: unchecked).

**User name:** [ ] Specify in this field the Windows user account name.

**Password:** [ ] Specify in this field the matching password.
Domain: [:] Specify in this field the matching domain.

**Caution:** Consider carefully in each case the benefits and drawbacks including security risks of always running the Host as a specific Windows user account. In some cases, you should run the Host as a Windows user account created exclusively for this purpose.

- **Automatically change to random password every week:** Check this box to change the password of the credentials specified above immediately and every week into a random password to automatically satisfy a password change policy.

  **Caution:** Do not check this box if the credentials specified above belong to a user person, as the user person cannot know the random password.

### 4.3.1.8 Directory Services Tab

This is the Host *Program Options* window *Directory Services* tab:

It specifies directory services to enable authenticating connecting Guests, see [Grant Each Guest Individual Access Privileges Using Directory Services](#).

**Directory services**

The pane will specify directory services as records in a table with these column contents (initially empty):

- **Name:** Directory service name.
- **Directory Server:** Directory server IP address or DNS name.

Add...: Click this button to show this window:
This window specifies a directory service.

**General**

Name: Specify in this field the name that shall identify this directory service in the Directory services section pane.

Directory server: Specify in this field the directory server IP address or DNS name.

Port: Specify in this field the port through which the Host shall connect to this directory server (default: 389, the Lightweight Directory Access Protocol (LDAP) port).

- Use secure connection: Check this box to connect to this directory server by a secure connection (default: unchecked). The LDAP secure connection port number is 636.

Base DN: Specify in this field the directory service distinguished name from which a search shall start.

**Credentials tab**

This tab will specify the credentials by which the Host will log on to the directory server. The credentials will determine which directory service information will be available to the Host.

- Anonymous bind: Check this box to disable the fields below to search this directory service with anonymous user rights that are typically very limited (default: unchecked).

User DN: Specify in this field a directory service user distinguished name to search the directory service with the rights of this user.

Password: Specify in this field the matching password.

Confirm password: Re-specify in this field the password for confirmation.

**Settings tab**
This tab will specify the search criteria applied to retrieve the properties of a connecting Guest user. Initially, its fields are empty. Click Default to show this window:

This window selects a directory service type.

The field of the drop-down box will show the selected directory service type (default: Microsoft Active Directory). The drop-down box list will contain names of commonly used directory services. If the directory service type of the directory server specified in the Directory Service field is available in the list, select it to show it in the field.

OK: Click this button to close the window to specify the default settings of the selected directory service type in the Settings tab fields.

Note: If the Settings tab fields become filled in from the Select Directory Service window, you will typically not need to edit their contents.

User search filter: []: Optionally (recommended), specify in this field a search filter to limit the search for user attributes to a certain object class.

User attribute: []: Specify in this field the type designation of the searched for user attribute.

User browse filter: []: Optionally (recommended), specify in this field a user browse filter to limit the browse for user attributes to certain object classes.

Group search filter: []: Optionally (recommended), specify in this field a search filter to limit the search for group attributes to a certain object class.

Group attribute: []: Specify in this field the type designation of the searched for group attribute.

Group browse filter: []: Optionally (recommended), specify in this field a group browse filter to limit the browse for group attributes to certain object classes.

OU search filter: []: Optionally (recommended), specify in this field a search filter to limit the search for organizational unit attributes to a certain object class.
Edit...: Select a record in the pane and click this button to show the Directory Service window with the properties of the record directory service to edit them.

Delete: Select a record in the pane and click this button to delete it.

4.3.1.9 Web Update Tab

This is the Host Program Options window Web Update tab:

It specifies web update options to automatically update the Netop Host installation.

**Update server:** [i]: Specify in this field the web address of the server from which to download Host update files (default: update.netop.com, the Netop manufacturer web update server).

**Note:** To update many Netop installations in an organization, we recommend to Publish New Updates to an internal web update server.

**HTTP Proxy:** [i]: Specifying a HTTP proxy is typically not required. Before specifying a HTTP proxy, click Update now to test the web update connection. If this yields a message indicating connection to the update server, specify no HTTP proxy. If Update now yields no connection, click Detect to make Netop attempt to detect the HTTP proxy server to show its name and port number in the HTTP Proxy field. Click Update now to test the connection. If unsuccessful, consult with your network/system administrator about what must be specified in the HTTP Proxy field (format: <Server name>:<Port number>).

**Update now:** Click this button to connect to the update server specified in the Update server field. A Web Update message will notify you if connection to the update server failed, if no updates are available or if updates are available and in the latter case ask you if you want to download and install updates.
Schedule...: Click this button to show this window:

This window specifies a schedule of checks for updates including download and installation of available update files.

**Schedule**

Select one of these options:

- **Disabled**: Disable automatic web update (default selection). The other sections in the window will be disabled.
- **Automatic download, prompt before install**: Automatically download any update files and prompt the user when downloaded.
- **Automatic download and install**: Automatically download and install any update files.

- **Allow system restart after install**: Check this box to automatically restart the computer after update installation, if required (default: unchecked). Leave unchecked to deny automatic restart to after installation show a message that restart is required to complete the installation.

**Run**

Select one of these options:

- **At loading**: Check for updates when the Host is loaded (default selection). The Delay section in the image above will be shown.

**Delay**

- **minute delay**: Specify in this field a number to delay the web update by the specified number of minutes (default: 0, range 0-99).

- **Daily**: Check for updates on a daily basis. This section will be shown:
Start at

[] every [] day: In the first field, specify the time of the day (default: 12:00). In the second field, specify by a number an interval in days (default: 1, range 1-99).

☐ Randomize within the hour: Check this box to randomize the update time within the hour following the specified time to avoid crowding (default: unchecked).

Note: If the Host is not loaded at the scheduled time, web update will run when the Host is first loaded thereafter.

☐ Weekly: Check for updates on a weekly basis. This section will be shown:

<table>
<thead>
<tr>
<th>Start at</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:00</td>
</tr>
<tr>
<td>every</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>week</td>
</tr>
</tbody>
</table>

☐ Monday
☐ Tuesday
☐ Wednesday
☐ Thursday
☐ Friday
☐ Saturday

☐ Randomize within the hour

Start at

[] every [] week: In the first field, specify the time of the day (default 12:00). In the second field, specify by a number an interval in weeks (default: 1, range 1-99).

☐ <Weekday>: Check boxes to run scheduled web updates on selected weekdays (default: Monday only checked).

☐ Randomize within the hour: Check this box to randomize the update time within the hour following the specified time to avoid crowding (default: unchecked).

Note: If the Host is not loaded at the scheduled time, web update will run when the Host is first loaded thereafter.

☐ Monthly: Check for updates on a monthly basis. This section will be shown:

<table>
<thead>
<tr>
<th>Start at</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:00</td>
</tr>
<tr>
<td>on the</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>day of the month (1 - 28)</td>
</tr>
</tbody>
</table>

☐ Randomize within the hour

Start date

Year: [] Month: [] Day: []: Select in the drop-down boxes the schedule start date (default: today).
4.3.2 Guest Access Security

Click the Toolbar Guest Access Security button or select the Tools Menu Guest Access Security command to show this window:

It specifies Guest access security on these tabs:

- Guest Access Privileges Tab
- Guest Policy Tab
- MAC/IP Address List Setup Tab
- Encryption Tab
- Smart Card Tab

Note: General Guest Access Security specifications will be stored in the Netop Configuration Files nhstconf.ndb file that typically resides in the directory C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host.
4.3.2.1 Guest Access Privileges Tab

This is the Guest Access Security window Guest Access Privileges tab:

It specifies the selected Guest access method and its details.

**Guest Access Method**: The field of this drop-down box will specify the selected Guest access method. The drop-down box list contains these Guest access methods:

- **Grant All Guests Default Access Privileges** (default selection)
- **Grant Each Guest Individual Access Privileges Using Netop Authentication**
- **Grant Each Guest Individual Access Privileges Using Windows Security Management**
- **Grant Each Guest Individual Access Privileges Using Directory Services**
- **Use Netop Security Server**

Select a Guest access method in the list to show it in the field to apply it to connecting Guests.
4.3.2.1.1 Grant All Guests Default Access Privileges

This Guest Access Privileges Tab Guest Access Method selection will show these tab contents:

![Guest Access Security Diagram]

This selection assigns one common Security Role named Default Security Role to all Guests that log on to the Host by one common Guest Profile named Default User.

Default Security Role

Select in the left pane the Default Security Role folder to show this security role section to the right:
Under the heading *Allow Guest to* it specifies in a check boxed list which privileges will be granted to a connected Guest. Checked privileges will be allowed, unchecked privileges will be denied. Check/uncheck boxes to change privileges.

- **Remote control:** Start a [Remote Control](#) session (default: allowed). Indented privileges below will apply to a [Remote Control](#) session:
  - Blank the screen: Turn the Host computer screen black to the Host computer user (default: allowed).
  - Lock keyboard and mouse: Disable the Host computer keyboard and mouse (default: allowed).
  - Transfer clipboard: Transfer Guest computer clipboard content to the Host computer clipboard or Host computer clipboard content to the Host computer clipboard (default: allowed).
- **Execute command (Restart, ...):** Execute system control ([Execute Command](#)) and other commands on the Host computer (default: allowed).
- **Request chat:** Start a [Chat](#) session (default: allowed).
- **Request audio chat and transfer sound:** Start an audio session including [Audio-Video Chat](#) and transfer Host application sound (default: allowed).
- **Request Video:** Enable video in an [Audio-Video Chat](#) session (default: allowed).
- **Send files to Host:** [File Transfer](#) from the Guest computer to the Host computer (default: allowed).
- **Receive files from Host:** [File Transfer](#) from the Host computer to the Guest computer (default: allowed).
- **Run programs:** [Run Program](#) on the Host computer (default: allowed).
- **Redirect print:** Send a Host computer print job to a Guest computer printing device and vice versa (default: allowed).
- **Remote Manage:** [Remote Management](#) of the Host computer (default: allowed).
- **Retrieve Inventory:** [Get Inventory](#) from the Host computer (default: allowed).
- **Send Message:** Send a [Netop Message](#) to the Host computer (default: allowed).
**Netop Host**

- **Demonstrate**: Demonstrate the Guest computer screen image on the Host computer screen (default: allowed).
- **Join Multi Guest session**: Join a running Remote Control session (default: allowed).
- **Act as a multi Guest session administrator**: Manage a multi Guest Remote Control session (default: allowed).

Under the heading *Confirm access* it specifies the selected Host computer user access confirmation option:

- **Confirm access**:
  - No
  - Yes, except when
    - Computer locked
    - No user logged on
    - Guest user logged on

Select one of these options:

- **No**: The Host computer user shall not confirm Guest access (default selection).
- **Yes, unless**: The Host computer user shall confirm Guest access unless any checked condition below applies.
  - **Computer locked**: The Host computer is locked (default: unchecked).
  - **No user logged on**: No user is logged on to the Host computer (default: unchecked).
  - **Guest user logged on**: The Guest computer user is logged on to the Host computer (default: unchecked).

**Note**: For practical reasons, the Netop message and Get inventory actions have been exempted from Confirm access security that applies to all other sessions and actions.

If the Host user shall confirm Guest access, a window like this will be shown on the Host computer when a Guest connects:

- **Allow**: Click this button to allow Guest access.
- **Deny**: Click this button to deny Guest access.

**Note**: You can customize the Confirm Access window text in a NETOP.INI file [TEXT_CONFIRM_ACCESS] section, see the Netop KnowledgeBase.

**Default User**

Select in the left pane the Default User Guest element to show these sections to the right:

**Password**

- **Password**: ************
- **Confirm password**: ************
Password: [ ]: Specify in this field a password of up to 16 characters to enable shared password authentication. Characters will show as dots or asterisks.

Confirm password: [ ]: Re-specify in this field the password for confirmation.

**Note:** To disable shared password authentication to request no password from a connecting Guest, clear both fields. This will leave the Host without Guest access authentication to enable any Guest to connect to the Host. Unless suppressed, the Security Warning window will be shown when the Host starts communicating.

Select one of these options:

- **No call back:** Do not apply call back (default selection).
- **Call back to:** [ ]: Specify in the field a telephone number or an IP address to make the Host disconnect and reconnect to the specified telephone number or IP address if a Guest connects by a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device.
  
  **Note:** Call back to a specified telephone number or IP address will enable connections only from a Guest on a computer with this telephone number or IP address. For other Guest address restriction options, see MAC/IP Address List Setup Tab and Allowed ISDN Numbers.

- **Roving call back:** Select this option to request a call back telephone number or IP address from a Guest that connects by a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device. When the Host receives this information, it will disconnect and reconnect to the specified telephone number or IP address.
  
  **Note:** Roving call back is typically used to make connection costs payable by the Host organization, e.g. when a traveling employee connects to the home computer.

**Note:** Default access privileges specifications will be stored in the Netop Configuration Files nhstconf.ndb file that will typically reside in the directory C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host.

When a Guest connects, the Host will request a password, if enabled.

If the Guest returns the Default User password, the Host will grant the Guest the Default Security Role privileges.

You can apply other Guest Access Security options, see Guest Policy Tab, MAC/IP Address List Setup Tab, Encryption Tab and Smart Card Tab.
4.3.2.1.2 Grant Each Guest Individual Access Privileges Using Netop Authentication

This Guest Access Privileges Tab selection will show these tab contents:

This selection will assign an individually named Security Role to each Guest that will log on to the Host by an individually named Guest Profile.

Each Security Role will specify what is allowed to the Guest and the selected confirm access option.

Each Guest Profile will specify Guest logon credentials and the selected call back option.

Initially, the left pane will contain the Security Role folders named Full access, View only, Inventory only and Remote Management only. Each Security Role folder will expand into the Guest Profiles to which the Security Role is assigned as illustrated in the image above.

Double-click a Security Role folder to close (collapse) or open (expand) it. You can move Guest Profiles, also between Security Role folders, by drag and drop.

Select a Security Role folder to show its Security Role section to the right.

Select a Guest Profile element to show its Password section and Call back section to the right.

Right-click a Security Role folder or Guest Profile element to show this context menu:
Add security role
Add Guest
Delete
Rename

**Note:** This menu will contain *Add security role* only if right-clicking a *Security Role* folder.

*Add Security Role*: Select this command or click the matching button below the pane to show this window:

This window creates a *Security Role* folder.

**Name of security role**: [:] Specify in the field the *Security Role* name.

*Add Guest*: Select a *Security Role* folder or a *Guest Profile* element in it and select this command or click the matching button below the pane to show this window:

This window creates a *Guest Profile* element in the selected *Security Role* folder.

**Guest ID**: [:] Specify in this field the name that a Guest that uses this *Guest Profile* must specify to log on to the Host. This will be the name that identifies the *Guest Profile*.

**Note**: A Guest is not limited to logging on by the name that identifies the Guest. Guest logon does not verify Guest identity but validates Guest credentials.

**Password**: See *Password* section.

**Call back**: See *Call back* section.

*Delete*: Select a *Security Role* folder or a *Guest Profile* element and select this command or click the matching button below to show a confirmation window to confirm deleting it.

**Caution**: Deleting a *Security Role* folder will delete all *Guest Profile* elements in it.

*Rename*: Select a *Security Role* folder or a *Guest Profile* element and select this command to show
this window:

 Rename security role/Guest: [/]: Edit the name in the field to rename.

**Note:** Individual Netop access privileges specifications will be stored in the Netop Configuration Files security.ndb file that typically resides in the directory C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host.

When a Guest connects, the Host will request Netop credentials that consist of a Guest ID and password.

If the Guest returns credentials that match a Host Guest Profile, the Host will grant the privileges of the Security Role that is assigned to the Guest Profile.

You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup Tab, Encryption Tab and Smart Card Tab.
4.3.2.1.3 Grant Each Guest Individual Access Privileges Using Windows Security Management

This Guest Access Privileges Tab Guest Access Method selection will show these tab contents:

- **Guest Access Security**
- **Guest Access Privileges**
- **Guest Policy**
- **MAC/IP Address List Setup**
- **Encryption**
- **Smart Card**

This selection will assign an individually named **Security Role** to each Guest that will log on to the Host by Windows logon user credentials.

Each **Security Role** will specify what is allowed to the Guest and the selected confirm access option.

Initially, the left pane will contain the **Security Role** folders named **Full access**, **View only**, **Inventory only** and **Remote Management only**. Each **Security Role** folder will expand into Windows user and group elements to which the **Security Role** is assigned as illustrated in the image above.

Double-click a **Security Role** folder to close (collapse) or open (expand) it. You can move Windows user and group elements, also between Security Role folders, by drag and drop.

Select a **Security Role** folder to show its **Security Role** section to the right.

Select a Windows user or group element to show its **Domain** section, **RAS** section and **Call back** section to the right.

Right-click a **Security Role** folder or Windows user or group element to show this context menu:
Netop Host

Add security role
Add User
Add Group
Delete
Renamed

Note: This menu will contain Add security role and Rename only if right-clicking a Security Role folder.

Add Security Role: Select this command or click the matching button below the pane to show the Security Role window.

Add User: Select a Security Role folder or a Windows user or group element in it and select this command or click the matching button below the pane to show on a Windows 2000+ computer the Windows Select Users window to select one or multiple Windows users to add them to the selected Security Role folder.

On a Windows NT or 9x computer, this window will be shown:

Choose account

Which domain is the account in: [: The drop-down box list will contain domains recognized by the computer. Select one to show it in the drop-down box field as selected.

Select the account to add: [: The drop-down box list will contain the names of users in the domain selected in the drop-down box field above. Select one to show it in the drop-down box field as selected.

Click OK to add the selected Windows user element in the selected Security Role folder.

Add Group: Select a Security Role folder or a Windows user or group element in it and select this command or click the matching button below the pane to show on a Windows 2000+ computer the Windows Select Groups window to select one or multiple Windows groups to add them to the selected Security Role folder.

On a Windows NT or 9x computer, the Choose Account window explained above showing groups instead of users will be shown to add groups.

Delete: Select a Security Role or a Windows user or group element and select this command or click the matching button below the pane to show a confirmation window to confirm deleting it.

Caution: Deleting a Security Role folder will delete all Windows user and group elements in it.

Rename: Select a Security Role folder and select this command to show the Rename window.

Domain:

DANWARE
(danware.local)

This section will show the selected Windows user or group element domain.
This section will be included only if the Host computer runs on a Windows 2003, XP, 2000 or NT operating system.

☐ Get call back information from Windows NT Remote Access Service (RAS): Check this box to use call back information stored in Windows NT Remote Access Service (RAS) (default: unchecked).

Call back: This section will be included only if the box in the RAS section above is unchecked, see Call back section.

Windows User Manager: This button will be included only if the Host computer runs on a Windows 2003, XP, 2000 or NT operating system. Click this button to show the Windows user manager window according to the administrator rights of the user logged on to Windows on the Host computer to manage users and groups.

Note: Individual Windows access privileges specifications will be stored in the Netop Configuration Files secur_NT.ndb file that typically will reside in the directory C:\Documents and Settings\All Users \Application Data\Danware Data\Netop Remote Control\Host.

When a Guest connects, the Host will request Windows credentials that consist of a user name, password and domain.

The Host will query Windows Security Management for credentials validation and group membership information. If the Guest user and/or groups of which the Guest user is a member match a Host Windows user or group element, the Host will grant the privileges of the Security Role that is assigned to the Windows account object.

Note: A Guest user that is assigned different Security Roles individually and as a member of groups will be allowed what is allowed by any applicable Security Role.

You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup Tab, Encryption Tab and Smart Card Tab.
4.3.2.1.4 Grant Each Guest Individual Access Privileges Using Directory Services

This Guest Access Privileges Tab Guest Access Method selection will show these tab contents:

- **Guest Access Security**
  - **Guest Access Privileges**
  - **Guest Policy**
  - **MAC Address List Setup**
  - **Encryption**
  - **Smart Card**

**Guest Access Method**

- Grant each Guest individual access privileges using Directory services

**Individual Guest access privileges using Directory services**

- **Full access**
  - CN=administrator
- **View only**
- **Inventory only**
- **Remote Management only**

**Directory Service**

- Directory Server 1
  - CN=administrator,CN=Users,DC=danware,DC=cc

**CallBack**

- No call back
- Call back to: [empty field]
- Roaming call back

**Buttons**

- Add security role
- Add Group
- Delete
- Add User

This selection will assign an individually named **Security Role** to each Guest that will log on to the Host by directory services user credentials.

Each **Security Role** will specify what is allowed to the Guest and the selected confirm access option.

Initially, the left pane will contain the **Security Role** folders named **Full access**, **View only**, **Inventory only** and **Remote Management only**. Each **Security Role** folder will expand into directory services user and group elements to which the **Security Role** is assigned as illustrated in the image above.

Double-click a **Security Role** folder to close (collapse) or open (expand) it. You can move directory services user and group elements, also between **Security Role** folders, by drag and drop.

Select a **Security Role** folder to show its **Security Role** section to the right.

Select a directory services user or group element to show its **Directory service** section and **CallBack** section to the right.

Right-click a **Security Role** folder or directory services user or group element to show this context menu:
Note: This menu will contain Add Security Role and Rename only if right-clicking a Security Role folder.

Add Security Role: Select this command or click the matching button below the pane to show the Security Role window.

Add User: Select a Security Role folder or a directory services user or group element in it and select this command or click the matching button below the pane to show this window:

The upper pane will show directory services specified on the Program Options window Directory Services Tab with an expandable directory tree structure. Click [+] buttons to expand and [-] buttons to collapse directories showing users with user icons and their common names (cn=<Common name>).

Add: Select a user in the upper pane and click this button to add the user as a record in the lower pane.

Remove: Select a user record in the lower pane and click this button to remove it.

The lower pane will show records of selected users in a table with these column contents:

- **Distinguished Name**: Directory path and common name of the user.
- **Directory Service**: Name of the directory service as specified on the Program Options window.
**Netop Host**

**Directory Services Tab.**

**OK:** Click this button to close the window and add the user records in the lower pane to the selected **Security Role** folder.

**Add Group:** Select a **Security Role** folder or a directory services user or group element in it and select this command or click the matching button below the pane to show the **Select Directory Services Groups** window that is similar to the **Select Directory Services Users** window explained above to add group objects to a **Security Role** folder.

**Delete:** Select a **Security Role** folder or a directory services user or group element and select this command or click the matching button below to show a confirmation window to confirm deleting it.

**Caution:** Deleting a **Security Role** folder will delete all directory services account elements in it.

**Rename:** Select a **Security Role** folder and select this command to show the **Rename** window.

**Directory Service**

Directory Server 1

嗅=administrator,CN=Users,DC=danware,DC=loc

This section will show the directory service name and the selected directory services user or group element distinguished name (dn).

**Call back:** See **Call back** section.

**Note:** Individual directory services access privileges specifications will be stored in the **Netop Configuration Files** secur_DS.ndb file that typically will reside in the directory C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host.

When a Guest connects, the Host will request directory services credentials that consist of a user name, a password and a directory server.

The Host will search the specified directory server to validate returned credentials and to retrieve information on Guest user group memberships. If the Guest user and/or groups of which the Guest user is a member match a Host directory services user or group element, the Host will grant the privileges of the **Security Role** that is assigned to the directory services account element.

**Note:** A Guest user that is assigned different **Security Roles** individually and as a member of groups will be allowed what is allowed by any applicable **Security Role**.

You can apply other Guest access security options, see **Guest Policy Tab**, **MAC/IP Address List Setup Tab**, **Encryption Tab** and **Smart Card Tab**.
4.3.2.1.5 Use Netop Security Server

This Guest Access Privileges Tab Guest Access Method selection will show these tab contents:

This selection will make the Host use Netop Security Server to authenticate each connecting Guest and assign a Security Role to it.

Group ID: [ ]: Specify in this field the 32-digit hexadecimal Netop Security Server group ID that identifies the Netop Security Server group that the Host shall use.


When a Guest connects, the Host will request logon credentials according to Netop Security Management preferences.

The Host will forward returned credentials to Netop Security Server for validation and compilation of the Security Role that shall be assigned to the Guest according to the security data stored in the security database. The Host will apply the resulting Security Role to the Guest.

You can apply other Guest access security options, see Guest Policy Tab, MAC/IP Address List Setup Tab, Encryption Tab and Smart Card Tab.
4.3.2.2 Guest Policy Tab

This is the Guest Access Security window Guest Policy tab:

- **Password**: Maximum invalid password attempts: Specify in this field a number in the range 0 - 9 for the number of logon attempts that will be allowed to a Guest before the action selected in the drop-down box field below will be executed (default: 3).

- **Action if maximum attempts are exceeded**: The field of the drop-down box will show the selected action. The drop-down box list contains these options:
  - **Disconnect**: Disconnect the Guest (default selection).
  - **Disable Host**: Make the Host deny any connection attempt and show this window:

It specifies Guest Access Security policies.

**Password**

- Maximum invalid password attempts: Specify in this field a number in the range 0 - 9 for the number of logon attempts that will be allowed to a Guest before the action selected in the drop-down box field below will be executed (default: 3).

- Action if maximum attempts are exceeded: The field of the drop-down box will show the selected action. The drop-down box list contains these options:
  - Disconnect: Disconnect the Guest (default selection).
  - Disable Host: Make the Host deny any connection attempt and show this window:
• **Restart Windows**: Restart Windows on the Host computer, which - depending on the Host setup - may load and start the Host and make it available for connection.

Select an option in the list to show it in the field.

**Disconnect**

**Action after disconnect: [ ]**: The field of the drop-down box will show the selected action. The drop-down box list contains these options:

- **None**: No action (default selection).
- **Lock computer**: Lock the Host computer to show the Windows *Computer Locked* window. The Host will remain running and available for connection.
- **Log off Windows**: Log off the Host computer user from Windows to show the *Welcome to Windows* window. The Host will remain running and available for connection.
- **Restart Windows**: Restart Windows on the Host computer, which - depending on the Host setup - may load and start the Host and make it available for connection.

Select an option in the list to show it in the field.

**System-wide disconnect hotkey: [ ] Shift [ ] Ctrl [ ] Alt [ ] Win [ ]**: Check any of the first four boxes and optionally specify a character in the last box to compose a keystroke combination that will disconnect all connected Guests if the *Netop Host Window* is active or not (default: empty).

**File Transfer**

- **Disable file transfer before local logon**: Check this box to disable File Transfer if no user is logged on to the Host computer (default: unchecked).

**Record Sessions**

- **Enable**: Check this box to enable Host recording of remote control sessions and enable other section elements (default: unchecked).

**Folder: [ ][Browse...]**: Specify in this field the path of the directory in which session recording files shall be saved. Click *Browse* to show the Windows *Browse for Folder* window to select a folder, the path of which will be specified in the field.

- **Disconnect if recording fails**: Check this box to disconnect if session recording fails (default: unchecked).

**Note**: Session recording files will be named <Time stamp>-<Guest ID>-<Host ID>.dwr. You can play back session recording files only on Netop Guest.

**Timeout**

**Confirm Access: [ ] s. (0 = no timeout)**: Specify in this field a number in the range 1 - 9999 to disconnect if the Host user has not confirmed Guest access within the specified number of seconds (default: 0).

**Authentication: [ ] s. (0 = no timeout)**: Specify in this field a number in the range 1 - 9999 to disconnect if Guest authentication has not completed within the specified number of seconds (default: 0).

**Inactivity: [ ] s. (0 = no timeout)**: Specify in this field a number in the range 1 - 9999 to disconnect if there has been no Guest keyboard or mouse activity within the specified number of seconds (default: 0).
4.3.2.3 MAC/IP Address List Setup Tab

This is the Guest Access Security window MAC/IP Address List Setup tab:

- **Enable MAC/IP address check**: Check this box to limit the network addresses from which a Guest can connect to the addresses specified in the pane and enable the pane and buttons (default: unchecked).

The pane will show records of specified addresses and optional comments (default: none).

**Note**: MAC addresses will apply if communicating by NetBIOS or IPX. IP addresses will apply if communicating by TCP/IP or TCP/IP(TCP).

**Add...**: Click this button to show this window.
MAC/IP address: [ ]: Specify in this field a MAC or IP address.

Comment: [ ]: In this field, you can specify a comment that will be shown next to the address in the pane.

Edit: Select an address record in the pane and click this button to show it in the Add/Edit MAC/IP Address List window to edit it.

Delete: Select an address record in the pane and click this button to delete it.

4.3.2.4 Encryption Tab

This is the Guest Access Security window Encryption tab:

It specifies enabled encryption types.
Netop Host

**Note:** Netop communication will be protected by encryption. One encryption type is available on version 6.5- Netop Remote Control modules. A range of encryption types is available on version 7.0+ Netop Remote Control modules. Communicating Netop modules will automatically negotiate to encrypt communication by an encryption type that is enabled on both modules. Netop modules on which no common encryption type is enabled cannot communicate.

The pane shows check boxed available encryption type icons and names. Leave a box checked to enable the encryption type (default: all checked): Uncheck to disable.

- **Netop 6.x/5.x Compatible:** Netop Remote Control version 6.5- compatible encryption.
- **None:** Does not encrypt data and verify data integrity but verifies session uniqueness.
- **Data integrity:** Verifies data integrity.
- **Keyboard:** Encrypts and verifies keyboard, mouse, logon and password data.
- **Data integrity and Keyboard:** Encrypts keyboard, mouse, logon and password data and verifies data integrity.
- **High:** Encrypts and verifies integrity of all data on a high security level.
- **Very High:** Encrypts and verifies integrity of all data on a very high security level.

*Show Details:* Select an encryption type and click this button to show encryption details.
4.3.2.5 Smart Card Tab

This is the *Guest Access Security* window *Smart Card* tab:

![Smart Card Tab]

It specifies Smart Card logon options.

**Windows Security Management**

Select one of these options:

- **Never log on with Smart Card**: Enable only credentials logon (default selection).
- **Always log on with Smart Card**: Enable only Smart Card logon.
- **Allow both logon with Smart Card and credentials (name, password and domain)**: Enable credentials and Smart Card logon.

**Directory Services**

Select one of these options:

- **Never log on with Smart Card**: Enable only credentials logon (default selection).
- **Always log on with Smart Card**: Enable only Smart Card logon.
- **Allow both logon with Smart Card and credentials (name, password and server)**: Enable credentials and Smart Card logon.

Select one of these options:
 Subject field: Retrieve the user identification from the Smart Card certificate Subject field (default selection).

 Subject alternative name field (must be a User Principal Name (UPN)): Retrieve the user identification from the Smart Card certificate Subject Alternative Name field.

In the field, specify the Smart Card certificate field contents compatible directory services attribute type name only if different from a user object distinguished name.

Note: For Directory Services Smart Card logon to succeed, the Host must be able to resolve the Smart Card certificate user identification into a Directory Services user identification. If the Smart Card certificate user identification and Directory Services user identifications are incompatible, Smart Card logon will fail. To find available Smart Card certificate user identifications, insert the Smart Card and in Internet Explorer click the Tools menu Internet Options command to show the Internet Options window. On the Content tab, click Certificates to show the Certificates window. On the Personal tab, double-click the appropriate certificate record to show the Certificate window. Its Details tab will show the contents of available certificate fields including Subject and Subject alternative name.

4.3.3 Maintenance Password

Select the Tools Menu Maintenance Password command to show this window:

Note: If a maintenance password is specified, maintenance password protection will be enabled and the Maintenance Password command will be protected.

This window specifies a maintenance password, what it protects and Host configuration files protection.

Change Maintenance Password...: Click this button to show this window:

Old Password: [:] This field will be disabled if no maintenance password is specified. To change the current maintenance password, specify it in the field. Characters will show as dots or asterisks.

New Password: [:] Specify in this field a new maintenance password (max. 16 characters).
Netop Host

Confirm Password: [ ]: Re-specify in this field the new maintenance password for confirmation.

**Note:** Disable maintenance password protection by leaving the New Password and Confirm Password fields empty.

Maintenance password required for

- **Guest access security:** Check this box to apply maintenance password protection to the Tools Menu Guest Access Security command and the Toolbar Guest Access Security button (default: unchecked).
- **All other configuration:** Check this box to apply maintenance password protection to all other Tools Menu setup commands and other Toolbar Tool Buttons (default: unchecked).
- **Unload and Stop:** Check this box to apply maintenance password protection to unloading the Host, see Title Bar or File Menu, and stopping the Host, see Action Menu or Action Buttons (default: unchecked).

**Note:** Apply Unload and Stop maintenance password protection to prevent Host stop or unload that will make it unavailable for connection and/or to Protect security configuration files.

**Protect security configuration files**

Select one of these options:

- **Protect by maintenance password only (if applies):** Protect Host setup only by any applied maintenance password protection that does not protect Host configuration files (default selection).
- **Protect files when connected:** Protect Host configuration files and disable Tools Menu setup commands when the Host status is Connected to prevent a connected Guest from changing Host setup.
- **Protect files when connected and running:** Protect Host configuration files and disable Tools Menu setup commands when the Host status is Connected, Help requested or Running to prevent a Host computer user that by maintenance password protection is prevented from stopping or unloading the Host from changing the Host setup.

**Note:** Host configuration files reside in the Netop Configuration Files directory, typically C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\Host.

If maintenance password protection is enabled, selecting a protected command or clicking a protected button will show this window:

![Maintenance Password Window](image)

Enter password: [ ]: Specify in the field the maintenance password. There is no limit to the number of maintenance password attempts.

**4.3.4 Log Setup**

Select the Tools Menu Log Setup command to show the Log Setup window.
4.3.5 Communication Profiles

Click the Toolbar Communication Profiles button or select the Tools Menu Communication Profiles command to show this window:

It enables/disables, creates, edits and deletes communication profiles.

**Note:** A communication profile is a named configuration of a Communication Device. You can create multiple communication profiles with different configurations of each Communication Device.

**Communication Profile List:** This pane contains check boxed Host communication profile names. Check boxes to enable communication profiles when the Host starts communicating (default: LAN (TCP) and TCP/IP checked).

**New:** Click this button to show the Communication Profile Edit window to create a communication profile.

**Edit:** Select in the pane a communication profile and click this button to show the Communication Profile Edit window to edit it.

**Delete:** Select in the pane a communication profile and click this button to delete it.

**Note:** To apply changes to enabled communication profiles, you must restart the Host, see Action Menu or Action Buttons.

4.3.6 Modem Database

Select the Tools Menu Modem Database command to show the Modem window.

4.3.7 Check for New Updates

Select the Tools Menu Check For New Updates command to connect to the update server specified on the Program Options window Web Update Tab to check for any new updates to the Host installation and if specified in the Web Update Schedule window download and install any new updates.

4.3.8 Debug Trace

This command is normally not included in the Tools Menu. To add it, in the Help Menu select About to show the About Netop Remote Control Host window. Press ALT+Z to add the Debug Trace command to the Tools Menu.
Select **Debug Trace** to save a debug trace of recent communication. This window will be shown:

```
Information

Debug trace successfully saved in C:\Documents and Settings\All Users\Application Data\Comware Data\Netop Remote Control\Host\inhost.log.

Do you want to view the debug trace?

Yes   No
```

It will show where the debug trace is saved.

Yes: Click this button to show the debug trace.

No: Click this button to close the window without showing the debug trace.

**Note:** The Netop debug trace is a plain text file that records recent Netop communication events but not transmitted data. Its interpretation requires special Netop expertise. It may be requested by Netop support to troubleshoot communication problems.

**4.3.9 Run Setup Wizard**

Select the **Tools Menu Run Setup Wizard** command to run the **Setup Wizard** to change Host setup in a guided dialog.

**4.4 Host Sessions**

Netop Guest can connect to Netop Host to run one or multiple simultaneous sessions with it.

When a Guest is connected, the **Netop Host Window** will appear like this:

![Netop Host Window](image)

Its **Title Bar** will show **Connected** and if selected in the **Program Options** window **Connection Notification Tab During connection** section the name of the Guest that has keyboard and mouse control in square brackets. If multiple Guests are connected, +1, +2, etc. will indicate the number of additional connected Guests.

Among the **Toolbar Session Buttons**, the **Disconnect**, **Chat** and **Audio-Video Chat** buttons will be enabled (colored). The **Request Help** and **Cancel Help** buttons will be disabled (gray).
Connected will also be showed in the General Tab Status field, on the Windows taskbar Netop Host button and tool tip and in the notification area Netop Host Button tool tip.

The Netop Host Button will have double corner lines. Right-click it to show this menu:

<table>
<thead>
<tr>
<th>Show</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Disconnect ...</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>192.168.102.96</td>
</tr>
<tr>
<td></td>
<td>GRUBB2</td>
</tr>
<tr>
<td>Suspend Connect</td>
<td></td>
</tr>
<tr>
<td>Chat ...</td>
<td>Request Audio-Video Chat</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Restore/Show to History List: See Netop Host Button.

Disconnect: If one Guest is connected, this command does not expand. Select it or the matching Session Menu command or click the Toolbar Disconnect button to disconnect.

If multiple Guests are connected, this command will expand into these commands:

- **All**: Select this command or the Session Menu Disconnect command or click the Toolbar Disconnect button to disconnect all connected Guests.
- **<Guest name>**: Select this command to disconnect only the selected Guest.

Suspend Connect: Select this command to check mark it to deny further Guest connections (default: unchecked). Select the check marked command to uncheck it to allow further Guest connections.

Chat: If one Guest is connected, this command does not expand. Select it or the matching Session Menu command or click the Toolbar Chat button to start a Chat session with the Guest.

If multiple Guests are connected, this command will expand into these commands:

- **All**: Select this command or the Session Menu Chat command or click the Toolbar Chat button to start a multi Chat session with all connected Guests.
- **<Guest name>**: Select this command to start a Chat session with only this Guest.

Audio-Video Chat: Select this command or the matching Session Menu command or click the Toolbar Audio-Video Chat button to start an Audio-Video Chat session with the Guest that has keyboard and mouse control.

Pass Control...: This command will be included if multiple Guests are connected. It expands into connected Guest name commands. The keyboard and mouse control Guest name command will be check marked and disabled. Select another Guest name command to pass keyboard and mouse control to this Guest check marking and disabling its command.

These session types are available:
- Remote Control
- Monitor
- File Transfer
- Chat
- Audio-Video Chat
- Remote Management
- Demonstrate
4.4.1 Remote Control

If allowed by Guest Access Security, Netop Guest can start and end a remote control session that will show the Host computer screen image on the Guest computer screen. The Host computer user can end all sessions by disconnecting, see Session Menu, Session Buttons or Netop Host Button Connected Menu.

If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, multiple Guests can take part in a multi Guest session. One Guest at a time can have keyboard and mouse control, which is indicated in the Title Bar, on the Connections Tab and in the Connection List window. The Host computer user can Pass Control from one connected Guest to another from the Netop Host Button Connected Menu.

No window will be shown on the Host computer screen. The Host computer user and the keyboard and mouse control Guest computer user can work on the Host computer screen at the same time with the same privileges unless limited by Host Guest Access Security or Guest remote control options.

Guest user remote control options include starting other sessions, executing actions, sending system control commands, managing a multi Guest session, sending and receiving clipboard content, loading Netop Marker Utility on the Host computer, blanking the Host computer screen to make it appear black to the Host computer user, disabling the Host computer keyboard and mouse and transferring Host computer application sound. Host Guest Access Security can disallow some or all of these options.

4.4.2 Monitor

If Guest Access Security allows Remote Control, Netop Guest can sequentially monitor the computer screen images of multiple Hosts and switch between monitor mode and Remote Control mode.

On the Host, monitoring will appear like multiple short Remote Control sessions.

4.4.3 File Transfer

If allowed by Guest Access Security, Netop Guest can start and end a file transfer session to enable the Guest computer user to transfer files between the Guest computer and the Host computer. The Host computer user can end all sessions by disconnecting, see Session Menu, Session Buttons or Netop Host Button Connected Menu.

If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, multiple Guests can run a file transfer session at the same time.

No window will be shown on the Host computer screen. To view what is happening during a file transfer session, select the View Menu File Transfer Status command to show this window:
The pane will show browsed Host computer directories and received and deleted files.

To automatically show this window when a file transfer session is started, check the *Program Options* window *General Tab Show file transfer status* box.

Host *Guest Access Security* can limit the Guest file transfer privileges.

### 4.4.4 Chat

If allowed by *Guest Access Security*, Netop Guest can start and end a chat session to enable typed text communication between the Guest computer user and the Host computer user. Netop Host can start and end a chat session with connected Guests from the *Session Menu* or *Netop Host Button Connected Menu Chat* command or the *Toolbar Chat* button and end all sessions by disconnecting, see *Session Menu*, *Session Buttons* or *Netop Host Button Connected Menu*.

If the *Program Options* window *General Tab Allow multiple simultaneous Guest sessions* box is checked, multiple Guests can run a joint multi chat session with one Host. If multiple Guests are connected, selecting the *Session Menu Chat* command or the *Netop Host Button Connected Menu Chat > All* command or clicking the *Toolbar Chat* button will start a chat session with all connected Guests. From the *Netop Host Button Connected Menu*, you can start a chat session with a selected connected Guest.

This window will be shown:
A similar window will be shown on participating Guest computer screens.

**Dialog: []:** This pane will show the chat dialog. A sender identification will precede each contribution.

**Enter Chat contribution and click Send: [] [Send]:** Specify your contribution in the pane and click Send to show it in the Dialog pane of all participants.

**Font…:** Click this button to show the Windows Font window to specify the font of your chat contribution before sending it.

**End chat:** Click this button to end the chat session. You can exclude a Guest from a multi chat session by selecting its check marked command in the Netop Host Button Connected Menu Chat command submenu. Guests can withdraw from a multi chat session. A Guest that has keyboard and mouse control can end a multi chat session.

**Save…:** Click this button to show a Windows Save As window that will suggest to save the dialog in your personal directory as an .rtf file identified by the date and time.

### 4.4.5 Audio-Video Chat

If allowed by Guest Access Security, Netop Guest can start and end an audio-video chat session to enable sound and optionally image communication between the Guest computer user and the Host computer user. The Host computer user can start an audio-video chat session with a connected Guest that has keyboard and mouse control from the Session Menu or Netop Host Button Connected Menu Audio-Video Chat command or the Toolbar Audio-Video Chat button.

**Note:** Each Guest and each Host can at the same time run only one audio session including Transfer Sound (transfers Host computer application sound to the Guest during a Remote Control session). If one connected module runs an audio session, Audio-Video Chat commands and buttons will be...
Netop Host

disabled on both connected modules.

This window will be shown:

![Audio-Video Chat window](image)

A similar window with toolbar button controls will be shown on the Guest computer screen. The Guest Audio-Video Chat window enables the user to enable/disable audio or video and resize the Guest and Host Audio-Video Chat window to accommodate a large, medium or small Remote video frame and end the session. The Host computer user can end the session only by disconnecting, see Session Menu, Session Buttons or Netop Host Button Connected Menu.

In the Remote section, the video frame will show the remote computer video camera image. If video communication is disabled, the frame will show No Video. If no camera runs on the remote computer, the frame will show No Camera.

In the Local section, the video frame will show the local computer video camera image. If video communication is disabled, the frame will show No Video. If no camera runs on the local computer, the frame will show No Camera.

The lower right Volume section has two slides and a pane:

- Drag the left loudspeaker slide to adjust the playback volume (default: maximum).
- Drag the middle microphone slide to adjust the recording volume (default: maximum).
- The right microphone pane will monitor the recording volume. The show should remain empty while not talking. Colored blocks should partly but not completely fill the show while talking.

Specify audio-video chat options on the Program Options window Audio-Video Chat Tab.

4.4.6 Remote Management

If allowed by Guest Access Security, Netop Guest can start and end a remote management session to enable the Guest computer user to access a range of Host computer management tools. The Host computer user can end all sessions by disconnecting, see Session Menu, Session Buttons or Netop Host Button Connected Menu.

If the Program Options window General Tab Allow multiple simultaneous Guest sessions box is checked, multiple Guests can run a remote management session at the same time.

No window will be shown on the Host computer screen.
4.4.7 Demonstrate

If allowed by Guest Access Security, the Guest can demonstrate its computer screen image on the Host computer screen:

This Netop demonstration window will show a live resized Guest screen image in which the Guest user can demonstrate screen events. The Guest user can mask screen elements to make them appear as black rectangles.

The Host user can move, resize, minimize, maximize and restore but not close the Netop demonstration window.

4.5 Session Tools

This session tool is available to the Host:

- Netop Marker Utility

4.5.1 Netop Marker Utility

Netop Marker Utility enables creating figure and text markers on top of the Host screen image and magnifying a section of the Host screen image.

Note: The Netop Marker Utility program vitawrap.exe resides on the Host computer and marks and magnifies on top of the Host computer screen.

To load Netop Marker Utility from the Guest, click the Remote Control display Toolbar or Toolbox Marker Mode button to make it appear pressed in or select the Remote Control/window Title Bar menu Marker Mode command to check mark it.
To unload Netop Marker Utility from the Guest, click the Remote Control display Toolbar or Toolbox Marker Mode button to release it or select the check marked Remote Control window Title Bar menu Marker Mode command to uncheck it.

To load Netop Marker Utility from the Host, run (double-click) the vitawrap.exe file that resides in the directory where Netop Host is installed.

To unload Netop Marker Utility from the Host, on the Windows Task Manager window Applications tab end the Netop Marker Utility task.

Netop Marker Utility will show this window:

![NetOp Marker Utility Window](image)

It contains these elements:

- **Title Bar**
- **Upper Toolbar**
- **Lower Toolbar**
- **Status Bar**

### 4.5.1.1 Title Bar

This is the Netop Marker Utility window title bar:

![NetOp Marker Utility Title Bar](image)

Click the title bar icon or right-click in the title bar to show this menu:
The top section contains window control commands, see Window Control. The other sections contain these types of Netop Marker Utility commands:

- Figure marker commands, see Figure Markers
- Text marker command, see Text Marker
- Magnifier command, see Netop Magnifier
- Undo and Clear All commands, see Delete Markers
- Properties and Help commands, see Marker Properties and Help

Select Minimize to minimize the Netop Marker Utility window into this Host computer screen notification area button:

Behind the pencil, the most recently enabled marker tool symbol will be shown.

Right-click this button to show this menu:
It contains a **Restore** command that will restore the **Netop Marker Utility** window and the same **Netop Marker Utility** commands as the **Netop Marker Utility Title Bar Menu**.

### 4.5.1.2 Upper Toolbar

This is the **Netop Marker Utility** window upper toolbar:

![Toolbar](image)

It contains these buttons:

- **Draw Ellipse**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Ellipse command to enable the ellipse tool, see Figure Markers.

- **Draw Rectangle**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Rectangle command to enable the rectangle tool, see Figure Markers.

- **Draw Arrow**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Arrow command to enable the arrow tool, see Figure Markers.

- **Draw Lines (Stop=MB2)**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Line command to enable the sectioned line tool, see Figure Markers.

- **Draw Freehand**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Freehand command to enable the freehand tool, see Figure Markers.

- **Show Free Text**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Text command to enable the Text Marker tool.

- **Show Magnifier**: Click this button to make it appear pressed in or select the **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** Magnifier command to show the **Netop Magnifier** window.

- **Undo**: Click this button or select the matching **Netop Marker Utility Title Bar Menu** or **Netop Marker Utility Button Menu** command to delete the most recently selected marker, see Delete Markers.
4.5.1.3 Lower Toolbar

This is the Netop Marker Utility window lower toolbar:

It contains these buttons:

- **Select Font**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Font command to show the Windows Font window to select a Text Marker font, see Marker Properties and Help.
- **Select Color**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Color command to show the Windows Color window to select a Figure Marker color, see Marker Properties and Help.
- **Select Pen Thickness**: Click this button to show a line width drop-down box or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Line Width command to select a Figure Marker or Text Marker frame line width, see Marker Properties and Help.
- **Help**: Click this button or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu Help command to open Netop Host Help on the Netop Marker Utility topic, see Marker Properties and Help.

4.5.1.4 Status Bar

This is the Netop Marker Utility window status bar:

It will show a hint to the mouse pointer position button or highlighted menu command.

4.5.1.5 Figure Markers

To select a figure marker tool with the mouse, in the Netop Marker Utility window Upper Toolbar, click the figure marker button to make it appear pressed in or in the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu select the figure marker command to change the mouse pointer into a pencil with the figure marker shape.

To enable a figure marker tool from the keyboard, place the mouse pointer on the active Netop Marker Utility window Upper Toolbar figure marker button and press F9 to change the mouse pointer into a pencil with the figure marker shape. Alternatively, while the Netop Marker Utility window is active press ALT+SPACE to show the Netop Marker Utility Title Bar Menu and press the figure marker command first character keyboard key or highlight the figure marker command and press ENTER.

To create a figure marker with the mouse, drag (sectioned line: click). To end a sectioned line, right-click.

To draw a figure marker from the keyboard, move the figure marker with the arrow keys. Press INSERT to engage, move with the arrow keys and press INSERT to disengage or section a line. To end a sectioned line, press F10.

To move a marker or change its appearance, move the mouse pointer to it to show an arrow-pointed +.

To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change appearance, right-click or press F10 to show this menu:
Netop Host

Color: Select this command or click the marker and click the Netop Marker Utility window Lower Toolbar Select Color button to show the Windows Color window to change the marker color selection (default: Red).

Line Width: Select this command to expand it into a selection of numbers of pixels or click the marker and click the Netop Marker Utility window Lower Toolbar Select Pen Thickness button to show a drop-down box with a selection of line widths to change the marker line width selection (default: 2 pixels).

Undo: Select this command or click the marker and click the Netop Marker Utility window Upper Toolbar Undo button to delete the selected marker.

Clear All: Select this command or click the marker and click the Netop Marker Utility window Upper Toolbar Clear All button to delete all markers.

Click outside the menu or press F10 to close the menu.

To change figure marker tool properties, right-click or press F10 to show this menu:

This menu is similar to the Figure Marker Menu but has Unselect instead of Undo.

Unselect: Select this command, press ESCAPE, click the Netop Marker Utility window Upper Toolbar pressed in figure marker button to release it or select the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu figure marker command to unselect the figure marker tool to restore the normal mouse pointer.

Note: Selecting another marker tool will unselect the selected marker tool.

4.5.1.6 Text Marker

To select the text marker tool with the mouse, in the Netop Marker Utility window Upper Toolbar click the Show Free Text button to make it appear pressed in or in the Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu select Text to change the mouse pointer into an angle that indicates a text marker box corner.

To select the text marker tool from the keyboard, place the mouse pointer on the active Netop Marker Utility window Upper Toolbar Show Free Text button and press F9 to make the button appear pressed in and change the mouse pointer into an angle that indicates a text marker box corner. Alternatively, while the Netop Marker Utility window is active press ALT+SPACE to show the Netop Marker Utility Title Bar Menu and press the T key or highlight the Text command and press ENTER.

To unselect the text marker tool, press ESCAPE or use one of the selection procedures explained above to release the Show Free Text button and restore the normal mouse pointer.
**Note:** Selecting another marker tool will unselect the selected marker tool.

When the text marker tool is selected:

- To create a text marker with the mouse, drag a dotted rectangle to show the *Text Marker* window.
- To create a text marker from the keyboard, move the text marker tool with the arrow keys. Press INSERT to engage, move with the arrow keys to create a dotted rectangle and press INSERT to disengage to show this window:

![Text Marker Window](image)

This window specifies the text marker contents and appearance.

In the pane, specify the text marker text. Right-click to show an edit menu.

*Use frame:* \[]: The field of this drop-down box will by default show \(\text{No}\) to show no frame around the text marker. The drop-down box list contains \(\text{No}\) and a selection of frame line widths. Select an option in the list to show it in the field.

*Font:* Click this button to show the Windows *Font* window to change the text marker font and color selection (default: *Arial Bold 30pt Red*).

*OK:* Click this button to close the *Text Marker* window to show the text marker.

To move a marker or change its appearance, move the mouse pointer to it to show an arrow-pointed +.

To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change appearance, right-click or press F10 to show this menu:

![Text Marker Menu](image)

This menu is similar to the *Figure Marker Menu* but has *Font* instead of *Color*.

*Font:* Select this command to show the Windows *Font* window to change the text marker font and color selection (default: *Arial Bold 30pt Red*).

**Note:** This menu will include a *Line Width* command only if a framed text marker is selected.

### 4.5.1.7 Netop Magnifier

To show the *Netop Magnifier* window with the mouse, in the *Netop Marker Utility* window Upper Toolbar click the *Show Magnifier* button to make it appear pressed in or in the *Netop Marker Utility Title Bar Menu* or *Netop Marker Utility Button Menu* select *Magnifier*. 

375
To show the **Netop Magnifier** window from the keyboard, place the mouse pointer on the active **Netop Marker Utility** window **Upper Toolbar** **Show Magnifier** button and press F9 to make the button appear pressed in. Alternatively, while the **Netop Marker Utility** window is active press ALT+SPACE to show the **Netop Marker Utility Title Bar Menu** and press M or highlight the **Magnifier** command and press ENTER.

If the mouse pointer is outside this window, the window pane will show a magnified image of the mouse pointer surroundings.

To move the window, drag its title bar or place the mouse pointer in the title bar, press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To resize the window, drag its sides or corners or position the mouse pointer on a side or corner to show a double arrow, press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change the pane image magnification, drag the right side scroll bar button or place the mouse pointer above or below it and press F9. Its top position will show a 1:1 scale image.

Right-click in the window or place the mouse pointer in the window and press F10 to show this menu:

<table>
<thead>
<tr>
<th>Close</th>
<th>Ctrl+C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Refresh Rate...</td>
<td></td>
</tr>
</tbody>
</table>

**Close**: Select this command or click the **Netop Marker Utility** window **Upper Toolbar** **Show Magnifier** button appearing pressed in to release it to close the **Netop Magnifier** window.

**Copy Ctrl+C**: Select this command or press CTRL+C to copy the pane contents to the clipboard.

**Refresh F5**: The pane image will refresh when the mouse pointer is moved but by default not refresh if the mouse pointer is not moved. Select this command or press F5 to refresh the pane image.

**Refresh Rate...**: Select this command to show this window:

- **Enable refresh timer**: Check this box to refresh the pane image if the mouse pointer is not moved (default: unchecked).

- **Interval (tenths of seconds)**: Specify in this field a number to refresh at the specified interval (default: 20).
4.5.1.8 Delete Markers

To delete markers, click one of these Netop Marker Utility window Upper Toolbar buttons or select the matching Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu command:

- **Undo**: Delete the most recently selected marker.
- **Clear All**: Delete all markers.

**Note**: When Netop Marker Utility is unloaded, all markers and any Netop Magnifier window will disappear.

4.5.1.9 Marker Properties and Help

Specify marker properties and show help from the Netop Marker Utility window Lower Toolbar buttons or the matching Netop Marker Utility Title Bar Menu or Netop Marker Utility Button Menu commands:

- **(Select) Font**: Click this button or select this command to show the Windows Font window to select a Text Marker font and color (default: Arial Bold 30pt Red).
- **(Select) Color**: Click this button or select this command to show the Windows Color window to select a Figure Marker color (default: Red).
- **Select Pen Thickness/Line Width**: Click this button to show a line width drop-down box or select this command to expand it into a selection of numbers of pixels to select a Figure Marker or Text Marker frame line width (default: 2 pixels).
- **Help**: Click this button or select this command to open Netop Host Help on the Netop Marker Utility topic.

4.6 Host Actions

A Host can Request Help from Guests that offer help services.

A Guest can execute these actions on a Host computer:

- Run Program
- Execute Command
- Netop Message
- Get Inventory

4.6.1 Request Help

The Host user can request help from a Guest that offers help services if the Host status is Running.

Click the Toolbar Request Help button or select the Session Menu, Netop Host Button Menu or Netop Help Request Button Request Help command to request help. The command or button will be enabled if on the Program Options window Help Request Tab one of the Enable help service or Enable service tickets boxes is checked.

If the help request is fully specified on the Program Options window Help Request Tab and a help provider is found, the help request will be delivered.

If on the Program Options window Help Request Tab the Use current Host communication profiles option is selected and more than one Communication Profile is enabled of which one uses a Point-to-Point or Network Point-to-Point Communication Device, this window will be shown:
The pane will show <Any initialized communication> and enabled Communication Profiles. Select <Any initialized communication> to use all enabled Communication Profiles that use a Networking Communication Device or select a Communication Profile. The field will become enabled if you select a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device. Specify in it the telephone number or IP address to connect to.

If a Communication Profile that uses the TCP/IP Communication Device will be used for the help request and on the Program Options window Help Request Tab the Enable service tickets box is checked, this window will be shown:

Select one of these options:

- Use help service to search for help providers: Request help from a help service.
- Use service ticket to connect to a specific help provider: Request help by a received service ticket number to enable these fields:
  
  **Service ticket:** [:] In this field, specify the service ticket number.
  
  **Problem description:** [:] In this field, you can describe your problem.

Note: If on the Program Options window Help Request Tab only the Enable service tickets box is checked, this window will show only enabled service ticket fields. A Netop on Demand enabled Netop Guest can issue service ticket numbers and forward a service ticket number to you to enable...
you to return a help request.

If a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device is selected but no telephone number or IP address has been specified, this window will be shown:

Specify in the field the telephone number or IP address to connect to.

If requesting help by a Communication Profile that uses a Point-to-Point or Network Point-to-Point Communication Device through a Guest network Netop Gateway, it may request logon. If valid credentials were not specified in the Advanced Help Request Options window Gateway logon section, one of these windows can be shown:

- The Shared Netop Authentication window:

Password []: Specify the Gateway security password.

- The Individual Netop Authentication window:

Guest ID: []: Specify a Gateway security recognized Guest ID.
Password: []: Specify the matching password.

- The Windows Authentication window:
User name: [:] Specify a Gateway security recognized Windows user name.

Password: [:] Specify the matching Windows logon password.

Domain: [:] Specify the matching domain.

**Note:** If valid Gateway security credentials were specified in the Program Options window Help Request Tab Advanced Help Request Options section, no logon window will be shown.

If no help provider is found, a message will be shown.

**Note:** To browse for help providers beyond the local network segment if using a Communication Profile that uses the TCP/IP Communication Device, use an IP Broadcast List or Netop Name Server, see Advanced TCP/IP Configuration.

If help providers are found but no Problem description and/or no Help provider was specified on the Program Options window Help Request Tab, this window will be shown:

**Problem description:** [:] This field will show any problem description specified on the Program Options window Help Request Tab. You can leave the field empty or specify or edit a problem description.

**Help providers:** [:] This pane will show the names of found help providers (on Netop Guest named help services). Select one and click Select to deliver the help request to the selected help provider.

When the help request has been delivered, the Toolbar Request Help button and Session Menu Request Help command will become disabled and Cancel Help will become enabled. The Host status will become Help requested to indicate that a help request is pending.
The help providing Guest user will be notified of the pending help request and will typically respond to it by starting a **Remote Control** session.

Click the **Toolbar Cancel Help** button or select the **Session Menu Cancel Help** command to cancel a pending help request.

**Note:** A pending help request may be canceled by timeout if not responded to, see **Advanced Help Request Options**. If the Host is restarted or a Guest connects, a pending help request will be canceled. You can request and cancel help by a command, see **Loading Alternatives**.

### 4.6.2 Run Program

If allowed by **Guest Access Security**, Netop Guest can run a program on the Host computer.

If the program runs in a window, it will be shown on the Host computer screen to enable the Host user to access it. Otherwise, nothing will show on the Host computer screen.

### 4.6.3 Execute Command

If allowed by **Guest Access Security**, Netop Guest can execute these system control commands on the Host computer:

- **Log off**: Log off the Host computer user from Windows.
- **Restart**: Restart the Host computer.
- **Shut down**: Shut down the Host computer.
- **Lock computer**: Lock the Host computer to enable the logged on user or an administrator to unlock it.
- **Wake on LAN**: Start a Host computer equipped with a Wake on LAN enabled network card.

### 4.6.4 Netop Message

If allowed by **Guest Access Security**, Netop Guest can send a Netop message that will show like this on the Host computer screen:

![Netop Message Window](image)

This window contains these elements:

- **Title Bar**
- **Menu Bar**
- **Toolbar**
- **Message Pane**
- **Status Bar**
Netop Host

4.6.4.1 Title Bar

This is the Netop Message window title bar:

The title bar and the automatically saved message file will identify the Netop message by its sender name, date and time.

4.6.4.2 Menu Bar

This is the Netop Message window menu bar:

It contains these menus:
- File Menu
- Edit Menu
- Search Menu

4.6.4.2.1 File Menu

This is the Netop Message window File menu:

Save As…: Select this command to show a Windows Save As window that specifies Save as type: RTF files (*.RTF) to save the message content in a rich text format file.

Note: Files of received message contents will automatically be saved in the Netop Configuration Files Messages directory that typically resides in the directory C:\Documents and Settings\All Users \Application Data\Danware Data\Netop Remote Control\Host. Records of files in this directory will be shown on the Messages Tab.

Print…: Select this command or click the Toolbar Print button to show a Windows Print window to print the Message Pane contents.

Close: Select this command or a Window Control Close control to close the Netop Message window.

4.6.4.2.2 Edit Menu

This is the Netop Message window Edit menu:

Copy: Select text in the Message Pane and select this command, click the Toolbar Copy button or press CTRL+C to copy selected text to the clipboard.

4.6.4.2.3 Search Menu

This is the Netop Message window Search menu:

Find…: Select this command or click the Toolbar Find button to show a Windows Find window to
search for a specified text string in the Message Pane.

Next: Select this command or press F3 to highlight the next occurrence of the text string specified in the Find window.

4.6.4.3 Toolbar

This is the Netop Message window toolbar:

It contains these buttons:

- **Print**: Click this button or select the File Menu Print command to show a Windows Print window to print the Message Pane contents.
- **Copy**: Select text in the Message Pane and click this button, select the Edit Menu Copy command or press CTRL+C to copy selected text to the clipboard.
- **Find**: Click this button or select the Search Menu Find command to show a Windows Find window to search for a specified text string in the Message Pane.

4.6.4.4 Message Pane

This is the Netop Message window message pane:

Drag the Netop Message window borders to resize the message pane.

You can print message pane contents from the Toolbar Print button or the File Menu Print command.

You can copy message pane contents from the Toolbar Copy button or the Edit Menu Copy command.

You can search message pane contents from the Toolbar Find button or the Search Menu Find command.

4.6.4.5 Status Bar

This is the Netop Message window status bar:

It has no functionality.

4.6.5 Get Inventory

If allowed by Guest Access Security, Netop Guest can generate, retrieve and copy an inventory of Host computer hardware and software.

No window will be shown on the Host computer screen.
5 Common Tools

This *Common Tools* main section explains tools that are common to all Netop Remote Control modules. It contains these sections:

- Communication Devices
- Modem Database and Dialog
- Netop Log
- System Info
- NETOP.INI
- Netop Configuration Files

5.1 Communication Devices

Netop uses the term *communication device* for the Netop adaptation of a generally available communication protocol or a Netop proprietary communication protocol.

Netop modules will typically use different configurations of communication devices for different communication environments. Netop uses the term *communication profile* for a named configuration of a communication device.

A newly installed Netop module will include default Communication Profiles. You will typically need to modify the default Communication Profiles or create Communication Profiles to optimize communication in your environment.

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

![Communication Profile Edit](image)

In this window, you can create or edit a communication profile.

Communication information

*Description of communication profile: []*: This field must contain the Communication Profile name that must be unique. You can edit the field contents.

**Note:** You can create multiple differently named communication profiles that use the same communication device.

*Communication device: []*: The field of this drop-down box will show the name of the communication device used by the Communication Profile. The drop-down box list will contain these communication device names:
Common Tools

- **NetBIOS**
- **IPX**
- **ISDN (CAPI)**
- **Serial**
- **Windows Modem**
- **TCP/IP**
- **TCP/IP (TCP)**
- **TCP/IP (TCP IPv6)**
- **WebConnect**
- **RemPCIPX v. 4.3 (Guest only), see IPX**
- **RemPCNB v. 4.3 (Guest only), see NetBIOS**
- **Gateway**
- **Infrared (IrDA)**
- **Terminal Server** (terminal server modules only)

Select a communication device name in the list to show it in the field.

☐ **Use dial-up networking:** This check box will be enabled only if a TCP/IP family communication device is selected in the **Communication device** drop-down box. Check it to expand the **Communication Profile Edit** window with a **Dial-up network connection** section.

The lower window section will be named by the communication device shown in the **Communication device** drop-down box field. In this section, you can specify the configuration of the communication device that shall apply to the **Communication Profile**. Click a communication device name hotspot in the list above to jump to the section that explains the configuration options with each communication device.

The available communication devices fall into three groups by their Netop characteristics:

- **Networking:** NetBIOS, IPX, TCP/IP and Terminal Server. A Netop module can connect to and browse for Netop modules that run on network computers (Terminal Server: - that run in the terminal server environment).

- **Point-to-Point:** ISDN (CAPI), Serial, Windows Modem, Gateway and Infrared (IrDA). A Netop module can connect through a connection between two computers to a Netop module that runs on the other computer or - if Netop Gateway runs on the other computer - connect to and browse for Netop modules that run on computers on the Netop Gateway network or terminal server.

- **Network Point-to-Point:** TCP/IP (TCP) and TCP/IP (TCP IPv6). A Netop module can connect through a network connection between two computers to a Netop module that runs on the other computer or - if Netop Gateway runs on the other computer - connect to and browse for Netop modules that run on computers on the Netop Gateway network or terminal server.

**Note:** Communication Profiles are stored in the Netop Configuration Files `comprof.ndb` file that typically resides in the directory `$HOME\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\<Module name>`.

### 5.1.1 NetBIOS

NetBIOS (Network Basic Input/Output System) is a simple networking protocol.

Netop **NetBIOS** is a **Networking Communication Device** based on the NetBIOS protocol.

**Note:** Each **Communication Profile** that uses **NetBIOS** can support multiple Netop connections. Communication that uses **NetBIOS** in its basic mode (in Windows: *Microsoft NetBEUI*) cannot pass network connection elements like routers. Communication that uses **NetBIOS over IPX** or **TCP/IP** can...
Common Tools

This section includes these sections:

- **NetBIOS Settings**
- **NetBIOS Communication Profile Edit**

### 5.1.1.1 NetBIOS Settings

To connect, specify a name by which the destination Netop module can respond:

- If a Guest connects or browses using the **Host name qualifier** `H:`, the Host can respond by its enabled **Netop Name** and **MAC Address** type **names**.
- If a Guest connects or browses using the **Host name qualifier** `U:`, the Host can respond by its enabled **LAN User** type **name**.
- If a Host requests **help**, a Guest can respond by its enabled **Help service** names.

**NETOP.INI Settings**

These settings can be used in a **Netop.INI** file **[NetBIOS] Section**:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max_Packet_Size</td>
<td><code>&lt;Number&gt;</code></td>
<td><code>&lt;Number&gt;</code> specifies the maximum packet size in bytes. In case of communication problems, try specifying the minimum 512.</td>
</tr>
<tr>
<td>Rcv DG Threads</td>
<td>1 or 2</td>
<td>Default is 2 (two datagram threads). If this causes problems, try specifying 1.</td>
</tr>
</tbody>
</table>

**Resources**

Required NetBIOS resources are typically available on any computer.

### 5.1.1.2 NetBIOS Communication Profile Edit

In the **Communication Profile Setup** window or in the **Quick Connect Tab Communication Profile Section**, click **New** or **Edit** to show this window:

The upper window section is explained in **Communication Devices**.

The Guest **NetBIOS Communication Device** comes in two versions, **NetBIOS** for communicating with Hosts version 5.0+ and **RemPCNB v. 4.3** for communicating with RemPC version 4.3. The lower window section that is named **NetBIOS or RemPC NetBIOS compatibility** has the same contents:

**Adapter number: [f] (0-255):** Specify in this field the adapter number assigned to the applicable NetBIOS mode, see **NetBIOS Adapter Numbers**.

**List...:** Click this button to show the **NetBIOS Adapter Numbers** window.
5.1.1.2.1 NetBIOS Adapter Numbers

In the NetBIOS Communication Profile Edit window NetBIOS/RemPC NetBIOS Compatibility section, click List to show this window:

The pane will show records of available NetBIOS modes in a table with these column contents:

- **Number**: Mode adapter number.
- **Description**: Mode type.
- **Version**: Software version number.
- **Type**: Software type.
- **Max packet size**: Maximum packet size in bytes.
- **MAC Address**: Network adapter MAC address.

**Note**: Network mode records will show the true computer network adapter MAC address. Netop will assign random MAC addresses to inapplicable modes such as dial-up. Do not select any such records.

5.1.2 IPX

IPX (Internetwork Packet Exchange) is a Novell networking protocol.

Netop IPX is a Networking Communication Device based on the IPX protocol. IPX is typically used in network environments with NetWare servers and clients.

**Note**: Each Communication Profile that uses IPX can support multiple Netop connections.

This section includes these sections:

- **IPX Settings**
- **IPX Communication Profile Edit**

5.1.2.1 IPX Settings

To connect, specify a name by which the destination Netop module can respond:

- If a Guest connects or browses using the Host name qualifier \H::, the Host can respond by its enabled Netop Name and MAC Address type names.
- If a Guest connects or browses using the Host name qualifier \U::, the Host can respond by its enabled LAN User type name.
- If a Host requests help, a Guest can respond by its enabled Help service names.

**NETOP.INI Settings**

This setting can be used in a Netop.INI file [IPX] Section:
Common Tools

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max_Packet_Size</td>
<td>&lt;Number&gt;</td>
<td>&lt;Number&gt; specifies the maximum packet size in bytes. In case of communication problems, try specifying the minimum 512.</td>
</tr>
</tbody>
</table>

Network Numbers

To find the network number for a computer with a known name, type this from a command prompt:

```
nlist user=<Name> /a (NetWare 4.x) or
userlist /a (NetWare 3.x)
```

If your computer is attached to a NetWare server that recognizes the name, it will respond with the network number in the address field.

Resources

Netop uses IPX socket 8641 (hexadecimal) when communicating between a Guest and a Host. Netop uses IPX sockets 8186 and 8187 (hexadecimal) when communicating between a Guest and a RemPC. Novell has assigned these sockets to Netop.

5.1.2.2 IPX Communication Profile Edit

In the **Communication Profile Setup** window or in the **Quick Connect Tab Communication Profile Section**, click **New or Edit** to show this window:

![Communication Profile Edit Window](image)

The upper section of this window is explained in **Communication Devices**.

The Guest **IPX Communication Device** comes in two versions, **IPX** for communicating with Hosts version 5.0+ and **RemPCIPX v. 4.3** for communicating with RemPC version 4.3. The lower window section that is named **IPX** or **RemPC IPX compatibility** has the same contents:

**Novell Networks**

Unless a network list has been created, IPX communication will reach only Netop modules on the local network. You can extend communication to remote networks by the options in this section.

Select one of these options:

- **Local network only**: Communicate with the local network only.
- **User defined list of networks**: Enables the **Network list** button. Click this button to show the **Novell Network Numbers** window.
- **Build list of known networks**: Netop will browse to build a network list from information published by
the router information protocol (RIP) to communicate with the networks on the list (default selection).

5.1.2.2.1 Novell Network Numbers

In the IPX Communication Profile Edit window IPX/RemPC IPX Compatibility section, click Network List to show this window:

```
Novell Network Numbers
```

The pane will contain the 8-digit hexadecimal network numbers of selected remote networks (initially none).

Add...: Click this button to show this window:

```
Novell network number
```

Enter network number: [: Specify in this field an 8-digit hexadecimal network number or edit it.

Edit...: Select in the pane a network number and click this button to show the Novell Network Number window to edit it.

Delete: Select in the pane a network number and click this button to delete it.

5.1.3 ISDN (CAPI)

CAPI (Common Applications Programmer’s Interface) enables ISDN (Integrated Services Digital Network) modems connected to each other to negotiate connection parameters. Netop Remote Control version 7.0+ supports only the 32 bit version CAPI 2.0.

Netop ISDN (CAPI) is a Point-to-Point Communication Device based on ISDN (CAPI).

Note: Each of the two ISDN B-channels can support one Netop connection. CAPI will work with Netop only if both ends of an ISDN connection support CAPI. ISDN non-CAPI communication that is not compatible with ISDN (CAPI) communication uses the Serial or Windows Modem Communication
Device. While CAPI 2.0 is compatible with the older 16 bit version CAPI 1.1, by experience we recommend using CAPI 2.0 also at the other end of the connection.

This section includes these sections:

- ISDN (CAPI) Settings
- ISDN (CAPI) Communication Profile Edit

5.1.3.1 ISDN (CAPI) Settings

To connect, specify an ISDN device telephone number.

- If a Guest connects directly to a Host, specify the Host computer ISDN device telephone number.
- If a Guest connects through a remote network Netop Gateway, specify the Gateway computer ISDN device telephone number and optionally the Host name, see Point-to-Point or Gateway.
- If a Host requests help, a Guest connected to directly or through a Guest network Netop Gateway can respond by its enabled Help service names.

Resources

An ISDN device that supports CAPI 2.0 must be connected to the computer. CAPI must be configured and enabled.

5.1.3.2 ISDN (CAPI) Communication Profile Edit

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

![Communication Profile Edit Window]

The upper window section is explained in Communication Devices.

The ISDN section that will be shown if ISDN (CAPI 2.0) is selected in the Communication device drop-down box has these contents:

- **Own number**: If no other applications use the same ISDN line, leave this field empty. If other applications use the same ISDN line, specify in this field that part of your ISDN device telephone number that distinguishes the telephone number used by Netop from telephone numbers used by other applications using the same ISDN line. If connecting through a telephone exchange, specify the last number of digits that are typically used for internal telephone numbers.

- **Enable**
  - Short hold mode
  - Use of 2 E-channels

- **Wait before call back**: Set the number of seconds (1-999)

The lower window section is explained in Communication Devices.

- **ISDN Number check**
  - Enable Guest ISDN-Number check
  - Edit allowed ISDN-Numbers

Enable

- **Short hold mode [] s. (10-250)**: Check this box to suspend the connection during short periods of
inactivity to reduce telephone charges (default: unchecked). On the Guest, an additional field for specifying a short-hold period in the interval 10-250 seconds is available (default: 10).

- **Use of 2 B-channels**: Check this box to use both B-channels to increase transmission speed (default: unchecked).

**Note**: These options will work only if selected at both ends of the connection.

*Wait before call back: [ ] s. (1-999):* Specify in this field a number in the range to wait that number of seconds before call back, if applied, to enable the receiving modem to become ready (default: 10).

### ISDN Number Check (Host only)

- **Enable Guest ISDN number check**: Check this box to allow only Guests whose ISDN device telephone number is in the **Allowed ISDN Numbers** window pane to connect to the Host.

*Edit allowed ISDN numbers...*: Click this button to show the **Allowed ISDN Numbers** window.

#### 5.1.3.2.1 Allowed ISDN Numbers

In the Host **ISDN (CAPI) Communication Profile Edit** window ISDN section, click **Edit allowed ISDN numbers** to show this window:

The pane will show allowed ISDN telephone numbers (initially none).

*Add...*: Click this button to show this window:

**Phone number**

*Enter phone number:* Specify in the field a telephone number or edit it.

*Edit...*: Select a telephone number in the pane and click this button to show the **Phone Number** window to edit it.
Common Tools

Delete: Select a telephone number in the pane and click this button to delete it.

Note: Allowed ISDN numbers are stored in the Netop Configuration Files, anumlist.ndb file that typically resides in the directory C:\Documents and Settings\All Users\Application Data\Danware Data\Netop Remote Control\<Module name>.

5.1.4 Serial

Netop Serial is a Point-to-Point Communication Device that enables analog or digital (non-CAPI ISDN) communication through a telephone connection or a direct cable connection (null modem) between two computer modems.

Note: Each Communication Profile that uses Serial can support only one Netop connection. Netop modem communication requires the same type of modem at both ends of the communication. Available modem types are: analog, non-CAPI ISDN and ISDN (CAPI). ISDN (CAPI) communication uses the ISDN(CAPI) Communication Device.

This section includes these sections:

- Serial Settings
- Serial Communication Profile Edit

5.1.4.1 Serial Settings

To connect, specify a modem telephone number.

- If a Guest connects directly to a Host, specify the Host computer modem telephone number.
- If a Guest connects through a remote network Netop Gateway to a Host, specify the Gateway computer modem telephone number and optionally the Host name, see Point-to-Point or Gateway.
- If a Host requests help, a Guest connected to directly or through a Guest network Netop Gateway can respond by its enabled Help service names.

Resources

To communicate using a digital telephone connection, an ISDN modem that supports the AT command set must be connected to and installed on the computer at both ends.

To communicate using an analog telephone connection, an analog modem that supports the AT command set must be connected to and installed on the computer at both ends.
5.1.4.2 Serial Communication Profile Edit

In the **Communication Profile Setup** window or in the **Quick Connect Tab Communication Profile Section**, click **New** or **Edit** to show this window:

The upper section of this window is explained in **Communication Devices**.

The **Serial** section that will be showed if **Serial** is selected in the **Communication device** drop-down box has these contents:

**Modem**

[ ] **Null Modem (Direct Connection)**: Check this box only if using a null modem cable connection between the Guest modem and the Host modem.

**Modem Name**: [ ]: The list of this drop-down box will contain the names of modems in the Netop **Modem Database**. Search the list to find the name of the modem connected to your computer and select it to show it in the drop-down box field. If the modem name is not in the list, use the options below in the specified order:

1. Download the most recent **Modem Database** from the Netop **KnowledgeBase** to possibly find your modem here.
2. Select **Hayes Compatible Fast**.
3. Look into the modem documentation or modem supplier website to find the required AT command strings to create a modem configuration that applies these AT command strings, see **New Modem**.
4. Send a support request to **Netop Support**. Be sure to include the exact full name of your modem. We will endeavour to get back to you as soon as possible with a solution to your problem.

**New Modem...**: Select a modem in the drop-down list and click this button to show the **Modem Configuration** window to create a modem configuration in the **Modem Database** based on the selected modem.

**Edit Modem...**: Select a modem in the drop-down list and click this button to show the **Modem Configuration** window to edit the modem configuration. If the button is disabled, you cannot edit the selected modem configuration but you can create a modem configuration based on the selected modem configuration, see **New Modem**.
Common Tools

(Settings)

Note: With some modem configurations, only some of the options will be enabled. You cannot edit disabled options. If you need to change non-editable options, create a modem configuration, see New Modem.

Com Port: [:] The field of this drop-down will show the selected communication port (default: Com 1). The drop-down box list will contain the names of serial communication ports on your computer. Select a name in the list to show it in the field.

Data Rate: [:] The field of this drop-down box will show the selected data rate (default: Default). The drop-down box list will contain Default and commonly used data rates. Select a data rate in the list to show it in the field. Default will select the default data rate of your modem. Select a data rate that will accommodate the data rate of your modem and the modem you want to connect to.

Flow Control: [:] The field of this drop-down box will show the selected flow control (default: Default). The drop-down box list will contain flow control options available with your modem. Select a flow control option in the list to show it in the field. Generally, select RTS/CTS (return to send/clear to send).

Dial Type: [:] The field of this drop-down box will show the selected dial type (default: Tone). The drop-down box list contains the options Tone and Pulse. Select Tone unless you are connected to an old-fashioned telephone central that supports only pulse dialing.

Wait before call back: [:] s. (1-999): Specify in this field a number in the range to wait that number of seconds before callback, if applied, to enable the receiving modem to become ready (default: 10).

5.1.5 Windows Modem

TAPI (Telephony Application Program Interface) is a communication protocol that is used for making data/fax/voice calls, including the Windows applets HyperTerminal, Dial-up Networking, Phone Dialer, and other Win32 communication applications.

Netop Windows Modem is a TAPI based Point-to-Point Communication Device that enables analog or digital (non-CAPI ISDN) communication through a telephone connection or a direct cable connection (null modem) between two computer modems.

Note: Each Communication Profile that uses Windows modem can support only one Netop connection. Netop modem communication requires the same type of modem at both ends of the communication. Available modem types are: analog, non-CAPI ISDN and ISDN (CAPI). ISDN (CAPI) communication uses the ISDN (CAPI) Communication Device.

Configuration

When a Netop module is loaded for the first time and the Setup Wizard is run, Netop can automatically detect modems installed in Windows to automatically create Communication Profiles for them in the Communication Profile Setup window.

You can create Communication Profiles for additional Windows modems from the Windows Modem Communication Profile Edit window.

Note: With certain modems, the automatically created Windows modem Communication Profile does not provide satisfactory Netop communication. These cases are typically known by Netop Support that has developed Serial based Communication Profiles that work with these modems, see Serial Communication Profile Edit.

This section includes these sections:

- Windows Modem Settings
- Windows Modem Communication Profile Edit

5.1.5.1 Windows Modem Settings

To connect, specify a modem telephone number.

- If a Guest connects directly to a Host, specify the Host computer modem telephone number.
If a Guest connects through a remote network Netop Gateway to a Host, specify the Gateway computer modem telephone number and optionally the Host name, see Point-to-Point or Gateway.

If a Host requests help, a Guest connected to directly or through a Guest network Netop Gateway can respond by its enabled Help service names.

Resources

To communicate using a digital telephone connection, an ISDN modem that supports the AT command set must be connected to and installed on the computer at both ends.

To communicate using an analog telephone connection, an analog modem that supports the AT command set must be connected to and installed on the computer at both ends.

5.1.5.2 Windows Modem Communication Profile Edit

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

The upper section of this window is explained in Communication Devices.

The Windows Modem section that will be showed if Windows Modem is selected in the Communication device drop-down box has these contents:

Connect Using: [ ]: The field of this drop-down box will show the selected modem. The drop-down box list will contain the names of modems recognized by Windows. Select the modem that you want to use for this communication profile and edit the Description of Communication Profile name above, if desired.

Typically, this is all that is required to configure a Windows modem communication profile. However, these options are available:

Configure: Click this button to show the Windows <Modem name> Connection Preferences window to edit connection preferences.

Dialing Properties: Click this button to show the Windows Phone and Modem Options window Dialing Rules tab to select or specify a location.

Add Modem: Click this button to show the Windows Phone and Modem Options window to add a Windows modem.

Dialing from: and Calling Card: The Windows selections will be shown.

Wait before call back: [ ] s. (1-999): Specify in this field a number in the range to wait that number of seconds before call back, if applied, to enable the receiving modem to become ready (default: 10).
5.1.6 TCP/IP

TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of network communication protocols. It includes among many others UDP (User Datagram Protocol) that is a widely used networking protocol.

Netop TCP/IP is an UDP based Networking Communication Device that will connect by UDP and optionally communicate by TCP/IP (TCP) during a session, see Advanced TCP/IP Configuration.

**Note:** Each Communication Profile that uses TCP/IP can support multiple Netop connections.

This section includes these sections:

- TCP/IP Settings
- TCP/IP Communication Profile Edit

5.1.6.1 TCP/IP Settings

TCP/IP offers three connect options:

- IP Address
- Name Response
- Name Resolution

**IP Address**

You can connect by IP address across segmented IP networks including the Internet. The source module port number must match the destination module port number, see Advanced TCP/IP Configuration.

If you connect from outside a network protected by a network address translation (NAT) firewall or proxy server to a network computer Netop module, specify the firewall or proxy server public IP address with the port number assigned to the network computer, e.g. 192.168.20.51:1234. Ask the firewall or proxy server administrator which port number is assigned to a specific network computer.

**Name Response**

Name response broadcasts a name, the first characters of a name or without a name requesting Netop modules with a matching enabled name to respond. These name response options are available:

- If a Guest connects or browses using the Host name qualifier H::, the Host can respond by its enabled Netop Name type name.
- If a Guest connects or browses using the Host name qualifier U::, the Host can respond by its enabled LAN User type name.
- If a Host requests help, the Guest can respond by its enabled Help service names.

**Note:** A broadcast will reach only computers on the local network segment and computers whose IP address or DNS name is specified in the communication profile IP Broadcast List.

**Name Resolution**

Name resolution will resolve a specified name into its matching IP address. These name resolution options are available:

- In the Advanced TCP/IP Configuration window, check the Use Netop Name Server box and specify the Netop Name Servers that shall be used and in the Program Options window Host Name Tab Netop Name Server section specify the Name Space ID used by the Netop modules you want to connect to. Connect by any enabled destination module name, for a Host help request a Guest Help service name. Netop Name Server will resolve the name into the matching IP address to connect by it across segmented IP networks including the Internet. You can also Browse for Hosts using Netop Name Server.
- If a Guest connects by a name using the Host name qualifier DNS::, a domain name server will
interpret the name as a DNS name and attempt to resolve it into a matching IP address for the Guest to connect by it across segmented IP networks including the Internet.

**Note:** In most cases, if using the **Host name qualifier** `H::`, a domain name server will interpret the name as a DNS name and attempt to resolve it into a matching IP address.

- If a Guest connects by a name using the **Host name qualifier** `LDAP::`, the Guest will search directory services specified on the Guest **Program Options** window **Directory Services Tab** for a user with this name to connect by the matching address attribute that is typically an IP address. You can also **Browse for Hosts** using directory services.

**Connect Problems**

In case of connect problems, first verify that an IP connection is available by from a command prompt typing:

```
PING <Netop module IP address>
```

The PING utility will send four data packets that request a reply. If replies are received, an IP connection is available.

If an IP connection is available and connectivity problems persist, consult with your network/system administrator. As a last resort, submit a support request to **Netop Support**.

**Resources**

TCP/IP uses one port for sending and one port for receiving communication.

By default, Netop Remote Control will use port number 6502 for sending and receiving.

You can use other port numbers, but remember that the source module send port number must always match the destination module receive port number, see **Advanced TCP/IP Configuration**.

**5.1.6.2 TCP/IP Communication Profile Edit**

In the **Communication Profile Setup** window or in the **Quick Connect Tab Communication Profile Section**, click **New** or **Edit** to show this window:

![Communication Profile Edit Window](image)

The upper section of this window is explained in **Communication Devices**.
Common Tools

☐ Use dial-up networking: Check this box to expand the window with the Dial-up network connection section (default: unchecked).

The TCP/IP section will be shown if TCP/IP is selected in the Communication device drop-down box.

Dial-up network connection

Dial-up network profile: []: The field of this drop-down box will show the selected profile. The drop-down box list contains the names of available profiles. Select a profile in the list to show it in the field to connect to a network by this dial-up network profile.

Dialing from: and Calling card: The dialing properties of the selected dial-up network profile will be shown.

Configure: Click this button to show the Windows Dial-up Connection window to configure the dial-up connection.

Dialing properties: Click this button to show the Windows Phone and Modem Options window to edit the dialing properties of the selected dial-up network profile.

Add profile: Click this button to show the Windows Network Connection Wizard to add a dial-up network profile.

TCP/IP

Max packet size (MTU): [] (512 – 5146 bytes): Specify in this field the maximum packet size (range 512-5146, default: 2600).

Note: A high MTU will increase communication speed and a low MTU may contribute to solving communication problems.

☐ Optimize for Internet communication: Check this box to apply settings (MTU, data compression, etc.) optimized for communicating across the Internet.

Advanced...: Click this button to show the Advanced TCP/IP Configuration window.

IP Broadcast List...: Click this button to show the IP Broadcast List window.

5.1.6.2.1 Advanced TCP/IP Configuration

In the TCP/IP Communication Profile Edit window TCP/IP section, the TCP/IP (TCP) Communication Profile Edit window TCP section or the TCP/IP (TCP IPv6) Communication Profile Edit window TCP IPv6 section, click Advanced to show this window
Specify IP Address

- **Use all available IP addresses**: Leave this box checked to use all available IP addresses (default: checked). If the computer has multiple IP addresses and only one of them shall be used for Netop communication, uncheck the box to enable the **IP address** field.

**IP address**: Supply the IP address that shall be used for Netop communication.

Specify Port Numbers

- **Use default port numbers**: Leave this box checked to use the default Netop port number 6502 for **Receive port** and **Send port** (default: checked).

**Note**: Port number 1970 is officially registered to Netop Remote Control. However, port number 6502 is the preferred default port number for compatibility with older Netop versions.

**Receive port**: If the **Use default port numbers** box is checked, 6502 will be shown. If unchecked, you can specify a number in the range 1025 - 65535.

**Send port**: If the **Use default port numbers** box is checked, 6502 will be shown. If unchecked, you can specify a number in the range 1025-65535.

**Note**: The source module **Send port** number must match the destination module **Receive port** number. See also the **Special Note on Receive Port Number** below.

Options

- **Use TCP for session if possible**: Leave this box checked to connect by TCP/IP but if available on Guest and Host switch to TCP/IP (TCP) when connected for high speed session communication (default: checked).

Netop Name Server

**Note**: This section will be enabled only if this window was shown from a Communication Profile that uses TCP/IP.

- **Use Netop Name Server**: This box is checked by default.
Common Tools

- **TCP/IP**

- **Use Netop Name Server**: Check this box to use Netop Name Server to resolve Netop names into IP addresses (default: unchecked).

  **Note**: Using Netop Name Server will facilitate connecting across segmented IP networks including the Internet.

- **Primary**: Leave in this field the default name `nns1.netop.com` of the primary public Netop Name Server on the Internet or specify the IP address or DNS name of a primary Netop Name Server on your corporate network.

- **Secondary**: Leave in this field the default name `nns2.netop.dk` of the secondary public Netop Name Server on the Internet or specify the IP address or DNS name of a secondary Netop Name Server on your corporate network.

- **Ignore port information from Name Server**: Check this box to replace the destination module `Receive port` number received from Netop Name Server by the port number specified below (default: unchecked).

  **Note**: Some types of firewalls replace sent `Receive port` numbers by invalid port numbers to protect network computers against connection attempts. In that case, Netop Name Server will receive, store and return invalid `Receive port` numbers that must be replaced by valid `Receive port` numbers.

- **Use Port**: Specify in this field the port number that shall replace the `Receive port` number received from Netop Name Server (default: 6502).

  **Note**: To use Netop Name Server, you must specify the applicable Name Space ID in the **Program Options** window **Host Name Tab Netop Name Server** section.

**Special Note on Receive Port Number**

The communication devices **TCP/IP** and **TCP/IP (TCP)** including **TCP/IP (TCP IPv6)** use the specified receive port number in different ways:

**TCP/IP** listens by the specified `Receive port` number and specifies this `Receive port` number in sent communication to receive return communication by the specified `Receive port` number. TCP/IP does not allow **Communication Profiles** that specify identical IP addresses and `Receive port` numbers to be enabled at the same time. If you specify the `Receive port` number 0 (zero), sent communication will specify another available `Receive port` number to receive return communication by this `Receive port` number.

**TCP/IP (TCP)** listens by the specified `Receive port` number but specifies by default another available `Receive port` number in sent communication to receive return communication by this `Receive port` number. In this case, a **Communication Profile** that uses TCP/IP (TCP) and a **Communication Profile** that uses TCP/IP with identical IP addresses and `Receive port` numbers can be enabled at the same time.

To specify the listening `Receive port` number in sent **TCP/IP (TCP)** communication, apply this **NETOP.INI** file **[TCP] Section** setting:

```
[TCP]
BindToRecvPort=True
```

If this setting is applied, a **Communication Profile** that uses TCP/IP (TCP) and a **Communication Profile** that uses TCP/IP with identical IP addresses and `Receive port` numbers cannot be enabled at the same time.
5.1.6.2.2 IP Broadcast List

In the TCP/IP Communication Profile Edit window TCP/IP section, click IP Broadcast List to show this window:

Using TCP/IP, connecting or browsing by Name Response will broadcast communication that will reach only computers on the local network segment. To extend broadcasts beyond the local network segment, specify in this window the IP addresses, IP address ranges and DNS names that shall be reached by broadcasts (initially none).

Note: The IP Broadcast List will not be used if connecting by IP Address or connecting or browsing by Name Resolution.

Add...: Click this button to show this window:

Enter DNS name or IP Address: [ ]: Specify in this field an IP address, e.g. 192.168.102.57, an IP address range, e.g. 192.168.102.20-192.168.102.30, or a DNS name, e.g. MAIL_SVR, to add it in the IP Broadcast List window pane.

Caution: Specifying an IP address range will make each broadcast send a number of data packets that matches the number of IP addresses in the range. To avoid excessive network traffic, do not specify larger IP address ranges than justified.

Edit...: Select in the pane an IP address, an IP address range or a DNS name and click this button to show it in the IP Broadcast List (Enter) window to edit it.

Delete: Select in the pane an IP address, an IP address range or a DNS name and click this button to delete it.

□ Disable local subnet broadcast: Check this box to disable local network segment broadcast to send data packets only to the addresses specified in the pane (default: unchecked).
5.1.7 TCP/IP (TCP)

TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of network communication protocols. It includes among many others TCP (Transmission Control Protocol) that is a commonly used point-to-point protocol.

Netop TCP/IP (TCP) is a TCP based Network Point-to-Point Communication Device.

Note: Each Communication Profile that uses TCP/IP (TCP) can support one Netop connection. To support multiple Netop connections, you can create multiple Communication Profiles that use TCP/IP (TCP).

This section includes these sections:
- TCP/IP (TCP) Settings
- TCP/IP (TCP) Communication Profile Edit

5.1.7.1 TCP/IP (TCP) Settings

To connect, specify a computer IP address.

If you connect from outside a network protected by a network address translation (NAT) firewall or proxy server to a network computer Netop module, specify the firewall or proxy server public IP address with the port number assigned to the network computer, e.g. 192.168.20.51:1234. Ask the firewall or proxy server administrator which port number is assigned to a specific network computer.

- If a Guest connects directly to a Host, specify the Host computer IP address.
- If a Guest connects through a remote network Netop Gateway to a Host, specify the Gateway computer IP address and optionally the Host name, see Network Point-to-Point.
- If a Host requests help, a Guest connected to directly or on a remote Netop Gateway network can respond by its enabled Help service names.

Other TCP/IP (TCP) settings are the same as the TCP/IP Settings.

5.1.7.2 TCP/IP (TCP) Communication Profile Edit

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

The upper section of this window is explained in Communication Devices.

- Use dial-up networking: Check this box to expand the window with the Dial-up network connection section (default: unchecked).

The TCP section that will be shown if TCP/IP (TCP) is selected in the Communication device drop-
down box has these contents:

- **Optimize for Internet communication**: Check this box to apply settings (MTU, data compression, etc.) optimized for communicating across the Internet (default: unchecked).

- **Encapsulate in HTTP**: Check this box to wrap data packets as HTTP packets to ease firewall passage (default: unchecked). This is also known as HTTP-tunneling.

- **Use Proxy Settings**: If you select Encapsulate in HTTP, the Use Proxy Settings check box will become available for selection. If you select this check box, proxy authentication is activated in the used communication profile. The application will use the proxy settings defined in Windows.

*Advanced...:* Click this button to show the Advanced TCP/IP Configuration window.

### 5.1.8 TCP/IP (TCP IPv6)

TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of network communication protocols. It includes among many others TCP IPv6 (Transmission Control Protocol for Internet Protocol version 6) that is a recently introduced point-to-point protocol for Internet Protocol version 6 networks.

Netop TCP/IP (TCP IPv6) is a TCP IPv6 based Network Point-to-Point Communication Device.

**Note:** Each Communication Profile that uses TCP/IP (TCP IPv6) can support one Netop connection. To support multiple Netop connections, you can create multiple Communication Profiles that use TCP/IP (TCP IPv6). You can use TCP/IP (TCP IPv6) only between computers connected to an IPv6 network.

This section includes these sections:

- TCP/IP (TCP IPv6) Settings
- TCP/IP (TCP IPv6) Communication Profile Edit

#### 5.1.8.1 TCP/IP (TCP IPv6) Settings

To connect, specify a computer IPv6 address.

- If a Guest connects directly to a Host, specify the Host computer IPv6 address.
- If a Guest connects through a remote network Netop Gateway to a Host, specify the Gateway computer IPv6 address and optionally the Host name, see Network Point-to-Point.
- If a Host requests help, a Guest connected to directly or on a remote Netop Gateway network can respond by its enabled Help service names.
5.1.8.2 TCP/IP (TCP IPv6) Communication Profile Edit

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

The upper section of this window is explained in Communication Devices.

- Use dial-up networking: Check this box to expand the window with the Dial-up network connection section (default: unchecked).

The TCP IPv6 section that will be shown if TCP/IP (TCP IPv6) is selected in the Communication device drop-down box has these contents:

- Optimize for Internet communication: Check this box to apply settings (MTU, data compression, etc.) optimized for communicating across the Internet.

Advanced...: Click this button to show the Advanced TCP/IP Configuration window.

5.1.9 WebConnect

WebConnect is a Netop proprietary Communication Device that enables networked Netop modules to connect easily over the Internet through a Netop connection service called WebConnect without the need to open firewalls for incoming traffic. All traffic will be outgoing.

This section includes the following sections:

- WebConnect Settings
- WebConnect Communication Profile Edit

5.1.9.1 WebConnect Settings

To use the WebConnect Communication Device you must have set up the Guest/Host for WebConnect in the Setup Wizard. See Setup Wizard.
5.1.9.2 WebConnect Communication Profile Edit

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

The upper section of this window is explained in Communication Devices.

- **Use dial-up networking**: Disabled.

The WebConnect section that will be shown if WebConnect is selected in the Communication device drop-down box has these contents:

- **WebConnect Service URL**: Specify the URL of the WebConnect service, i.e. the Connection Manager, that facilitates the WebConnect connection.

- **Optimize for Internet communication**: Check this box to apply settings (MTU, data compression, etc.) optimized for communicating across the Internet (default: checked).

- **Advanced...**: Click this button to show the Advanced TCP/IP Configuration window.

- **Credentials**: Click to show this window:

  Specify the credentials by which the Netop module should identify itself when connecting to the Netop WebConnect service:

  - **Account**: Specify a WebConnect service recognized account.
**Common Tools**

*Password [ ]*: Specify the matching password.

*Confirm Password [ ]*: Re-specify the password for confirmation.

*Domain [ ]*: Specify the matching domain.

### 5.1.10 Gateway

*Gateway* is a Netop proprietary **Point-to-Point Communication Device** that enables a network Netop module to connect through a local network Netop Gateway.

**Note:** Each **Communication Profile** that uses *Gateway* can support only one Netop connection.

This section includes these sections:

- **Gateway Settings**
- **Gateway Communication Profile Edit**

#### 5.1.10.1 Gateway Settings

To connect, specify a modem telephone number or computer IP address according to the selected device group type, see **Gateway Device Group List**.

- If a Guest connects through a local network Netop Gateway directly to a Host, specify the Host computer modem telephone number or computer IP address.

- If a Guest connects through a local network Netop Gateway through a remote network Netop Gateway to a Host, specify the Gateway computer modem telephone number or computer IP address and optionally the Host name, see **Point-to-Point or Gateway**.

- If a Host requests help through a local network Netop Gateway, a Guest connected to directly or on a remote Netop Gateway network can respond by its enabled **Help service** names.

**Resources**

To use *Gateway*, one or multiple outgoing Netop Gateways must run on the local network.

#### 5.1.10.2 Gateway Communication Profile Edit

In the **Communication Profile Setup** window or in the **Quick Connect Tab Communication Profile Section**, click **New** or **Edit** to show this window:
The upper section of this window is explained in Communication Devices.

The Gateway section that will be shown if Gateway is selected in the Communication device drop-down box has these contents:

**Access Gateway via communication profile**: [ ]. The field of this drop-down box will show the name of the Communication Profile that connects to the local network Netop Gateway (default: <Any initialized communication>). The drop-down box list contains <Any initialized communication>, available Communication Profiles that use a Networking Communication Device and Terminal Server. Select a Communication Profile in the list to show it in the field.

Select <Any initialized communication> to connect to or browse for Gateway device groups using any enabled Communication Profile that uses a Networking Communication Device. Select another Communication Profile to connect or browse using only this Communication Profile that does not need to be enabled. Select Terminal Server only if your Netop module resides on a terminal server client.

**Gateway device group**

Gateway device groups are administrator specified names of available outgoing point-to-point and network point-to-point communication on local network Netop Gateways.

Select one of these options:

- **Use device group**: [ ]. Select this option to specify a Gateway device group name in the field (default selection).
- **Browse for device groups**: Select this option to show the [Gateway Device Group List](#) window when connecting.

### 5.1.10.2.1 Gateway Device Group List

When connecting using a Communication Profile that uses the Gateway Communication Device for which in the Gateway Communication Profile Edit window the Browse for device groups option was selected, this window will be shown:

![Gateway Device Group List](#)

Its pane will show Gateway device groups on the local network.

Select: Select a device group in the pane and click this button to connect by the selected device group.
5.1.11 Infrared (IrDA)

Infrared (IrDA) is a Netop proprietary Point-to-Point Communication Device that enables communication between Netop modules on two computers that communicate by infrared light.

**Note:** Each Communication Profile that uses Infrared (IrDA) can support only one Netop connection.

### Configuration

Windows 2003, XP, 2000, ME and 98 support infrared communication according to the protocols and standards of Infrared Data Association (IrDA). Configure infrared communication in Windows.

This section includes these sections:

- **Infrared (IrDA) Settings**
- **Infrared (IrDA) Communication Profile Edit**

#### 5.1.11.1 Infrared (IrDA) Settings

To connect:

- If a Guest connects directly to a Host, specify no name or address.
- If a Guest connects through a Netop Gateway to a Host, optionally specify the Host name, see Infrared.
- If a Host requests help, a Guest connected to directly or on the connected to Netop Gateway network can respond by its enabled Help service names.

### Resources

Infrared communication through transmitters pointing towards each other within working distance must be established.

#### 5.1.11.2 Infrared (IrDA) Communication Profile Edit

In the Communication Profile Setup window or in the Quick Connect Tab Communication Profile Section, click New or Edit to show this window:

![Communication Profile Edit](Image)

The upper section of this window is explained in Communication Devices.

The Infrared (IrDA) section that will be shown when Infrared (IrDA) is selected in the Communication device drop-down box is empty. There are no setting options for the Infrared (IrDA) Communication Device.
5.1.12 Terminal Server

*Terminal Server* is a Netop proprietary *Networking Communication Device* that enables Netop modules that run in a terminal server environment to communicate.

**Note:** Each *Communication Profile* that uses *Terminal Server* can support multiple Netop connections.

This section includes these sections:

- Terminal Server Settings
- Terminal Server Communication Profile Edit

5.1.12.1 Terminal Server Settings

To connect, specify a name by which the destination Netop module can respond:

- If a Guest connects or browses using the *Host name qualifier* `H::`, the Host can respond by its enabled *Netop Name* type name.
- If a Guest connects or browses using the *Host name qualifier* `U::`, the Host can respond by its enabled *LAN User* type name.
- If a Host requests help, a Guest can respond by its enabled *Help service* names.

If Netop Gateway runs on the terminal server console, terminal server Netop modules and Netop modules outside the terminal server environment can connect through it, see the Administrator’s Guide *Advanced Tools* chapter *Netop in Terminal Server Environments* section.

5.1.12.2 Terminal Server Communication Profile Edit

In the *Communication Profile Setup* window or in the *Quick Connect Tab Communication Profile Section*, click *New* or *Edit* to display this window:

The upper section of this window is explained in *Communication Devices*.

The *Terminal Server* section that will be shown when *Terminal Server* is selected in the *Communication device* drop-down box is empty. There are no setting options for the *Terminal Server Communication Device*.

5.2 Modem Database and Dialog

This section explains the *Modem Database* and *Modem Dialog* associated with the *Serial Communication Device*.

It includes these sections:

- Modem Database
- Modem Dialog
5.2.1 Modem Database

Select the **Tools Menu** *Modem Database* command to show this window:

![Modem Database Window]

This window manages the modem database.

**Note:** The modem database is stored in the Netop Configuration Files *modems.ndb* file that will typically reside in the directory `C:\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\<Module name>`.

In the pane, the first *Modem Database YYYYDDD* record specifies the modem database update year and day number. You can download and install the newest available update from the Netop KnowledgeBase Download Updates subsection.

**Note:** Downloading and installing *modems.ndb* will overwrite your current *modems.ndb*.

Other records represent modem configurations created by Netop Support or added by a user.

**New:** Click this button to show the *Modem Configuration* window to create a modem configuration in the modem database. To base a new modem configuration on an available modem configuration, select its record before clicking the button.

**Edit:** Select a record in the pane and click this button to show the *Modem Configuration* window to edit the selected record modem configuration.

**Delete:** Select a record and click this button to delete it. The button will be disabled if you cannot delete the selected record.
5.2.1.1 Modem Configuration

In the **Modem** window, click **New** or **Edit** or in the **Serial Communication Profile Edit** window click **New Modem** or **Edit Modem** to show this window:

![Modem Configuration Window](image)

This window creates or edits a **Modem Database** modem configuration.

**Note:** With some modem configurations, some or all fields will be disabled to protect the original **Modem Database** modem configuration. If you select a **Modem** window modem configuration record and click **New**, the **Modem Configuration** window will show the properties of the selected modem configuration with all fields enabled.

**Name:** This field will contain the modem configuration name that must be unique within the modem database. You can edit the field contents.

**Modem command strings**

These fields specify the modem AT command strings. Consult with your modem manual or the modem manufacturer website to find the AT command strings required by your modem.

**Max data rate [ ]**: The field of this drop-down box will show the selected modem maximum data rate or a default value. The drop-down box list contains typical data rates. Select a data rate applicable to your modem and the modem you want to connect to.

**Settings**

☑️ **RTS/CTS Flow control**: Typically, leave this box checked to use *Return To Send/Clear To Send* flow control (default: checked).

☐ **Ignore carrier signal**: Typically, leave this box unchecked (default: unchecked).
5.2.2 Modem Dialog

Select the View Menu Modem Dialog command to show this window:

During Serial modem connect and disconnect, the pane will show the communication sent by (>>) and received by (<<) your modem. This information will assist you in diagnosing modem connectivity problems.

5.3 Netop Log

Any Netop module can log selected Netop events. Netop events can be logged:

- On the computer in a local Netop log.
- In a Netop Security Server security database in the Netop Log or on an older version Netop Access Server or Netop Log Server.
- In the Windows event log of the computer and another computer.
- In a management information system.
- In the activity log of the WebConnect service that facilitates WebConnect connections.

This section contains these sections:

- Log Setup
- Local Netop Log
- Netop Log Events
5.3.1 Log Setup

Select the Tools Menu Log Setup command to show this window:

It specifies Netop log setup on these tabs:

- **Log Setup Tab**
- **Netop Local Tab**
- **Netop Server Tab**
- **Windows Event Log Tab**
- **SNMP Traps Tab**
- **WebConnect Tab**
5.3.1.1 Log Setup Tab

This is the Log Setup window Log Setup tab:

It specifies logging options.

**Log Events**

- **Log locally**: Check this box to log Netop events in a log file on the computer (default: unchecked).
- **Log on Netop server**: Check this box to log Netop events in a Netop Security Server security database Netop Log of or on an older version Netop Access Server or Netop Log Server (default: unchecked).
- **Log to Windows event log**: Check this box to log Netop events in the Windows event log of the computer and/or of another Windows 2003/XP/2000/NT computer (default: unchecked).
- **Log using SNMP traps**: Check this box to log Netop events by sending SNMP messages to a management information system (default: unchecked).
- **Log using WebConnect**: Check this box to log Netop events to the activity log of the WebConnect service that facilitates the WebConnect connection (default: unchecked).

Netop Security Server has an additional checkbox:

- **Act as log server**: Leave this box checked to enable logging other Netop modules’ Netop events in the security database Netop Log (default: checked).

Netop Host and extended Hosts have additional check boxes, fields and drop-down boxes:

- **Custom Host Name for All Log Events**: Check this box to enable the field and drop-down box below to identify logged events by a customized Host name (default: unchecked). The left field specifies the customized Host name composed from right drop-down box components and keyboard characters. These components are available:
  - `%A`: IP/MAC address
- %I: Host ID
- %C: Computer name
- %L: Windows logon user name

Select a component in the right drop-down box list to add it in the left field.

☐ **Custom Guest Name for Connection and Session Log Events:** Check this box to enable the field and drop-down box below to identify Guests engaged in Connection and Session log events by a customized name. The left field specifies the customized Guest name composed from right drop-down box components and keyboard characters. These components are available:
- %A: IP/MAC address
- %U: Authenticated user name
- %I: Guest ID
- %C: Computer name
- %L: Windows logon user name

Select a component in the right drop-down box list to add it in the left field.

This is an example of a custom Host and Guest name *Local Netop Log*:

- 20080903,14:10,Host1+User1,0,00000,00000,HCON +,User2@192.168.1.2
- 20080903,14:10,Host1+User1,1,00000,00000,HSES +,User2@192.168.1.2
- 20080903,14:10,Host1+User1,2,00000,00000,HSESRC +,User2@192.168.1.2
- 20080903,14:10,Host1+User1,3,00000,00000,HSESFXFER+,User2@192.168.1.2
- 20080903,14:10,Host1+User1,4,00000,00000,HSESCHAT +,User2@192.168.1.2
- 20080903,14:10,Host1+User1,5,00000,00000,HSESAUDIO+,User2@192.168.1.2
- 20080903,14:10,Host1+User1,6,00000,00000,HSESAUDIO-,User2@192.168.1.2
- 20080903,14:10,Host1+User1,7,00000,00000,HSESCHAT -,User2@192.168.1.2
- 20080903,14:11,Host1+User1,8,00000,00000,HSESFXFER-,User2@192.168.1.2
- 20080903,14:11,Host1+User1,9,00000,00000,HSESRC -,User2@192.168.1.2
- 20080903,14:11,Host1+User1,10,00000,00000,HSES -,User2@192.168.1.2

The Host name was customized as %C+%L. The Guest name was customized as %U@%A.

The Host was started and the Guest started a remote control session, a file transfer session, a chat session and an audio-video chat session and ended sessions in reverse order.
Common Tools

5.3.1.2 Netop Local Tab

This is the Log Setup window Netop Local tab:

It selects which Netop events shall be logged and specifies the local Netop log file.

Select Events to view in list

Select one of these options to show check boxed event names in the Events to log pane:

- **View all Events**: Show all available events (default selection).
- **View Selected**: Enable these options:
  - **Connection**: Check this box to show available connection events.
  - **Session**: Check this box to show available session events.
  - **Action**: Check this box to show available action events.
  - **Security**: Check this box to show available security events.
  - **Configuration**: Check this box to show available configuration events.

Events to log: []: This pane will show check boxed names of events of the types selected to the left. Check boxes to select logging of events (default: all unchecked).

- **Select all**: Click this button to check all boxes in the Events to log pane.
- **Deselect all**: Click this button to uncheck all boxes in the Events to log pane.

**Note**: Available Netop log event codes and arguments are tabulated in Netop Log Events.

Log File

**Note**: This section will be enabled only if the Log locally box is checked on the Log Setup Tab.

Log file name: []: This field will show the (path and) name of the log file (default: NETOP_LOG). If no path is specified, the log file will reside in the Netop Configuration Files directory, typically C:
\Documents and Settings\<User name>\Application Data\Danware Data\Netop Remote Control\<Module name>.

- **Write to disk for each log entry:** Leave this box checked to write each Netop event to the local Netop log file immediately (default: checked). Uncheck this box to write Netop events to the local Netop log file when the Netop module is unloaded, which consumes less processor capacity.

**Note:** A new local Netop log file that will be created when the Netop module is loaded will overwrite an old local Netop log file with the same path and file name.

### 5.3.1.3 Netop Server Tab

This is the **Log Setup** window **Netop Server** tab:

![Log Setup window](image)

It selects which Netop events shall be logged and specifies the Host ID of the logging server.

**Select Events to view in list**

Select one of these options to show check boxed event names in the **Events to log** pane:

- **View all Events:** Show all available events (default selection).
- **View Selected:** Enable these options:
  - **Connection:** Check this box to show available connection events.
  - **Session:** Check this box to show available session events.
  - **Action:** Check this box to show available action events.
  - **Security:** Check this box to show available security events.
  - **Configuration:** Check this box to show available configuration events.

**Events to log:** This pane will show check boxed names of events of the types selected to the left. Check boxes to select logging of events (default: all unchecked).

**Select all:** Click this button to check all boxes in the **Events to log** pane.
Common Tools

Deselect all: Click this button to uncheck all boxes in the Events to log pane.

**Note:** Available Netop log event codes and arguments are tabulated in Netop Log Events.

**Host ID for Log Server**

**Note:** This section will be enabled only if the Log on Netop server box is checked on the Log Setup Tab.

The field will contain the Host ID of the Netop server on which Netop events shall be logged (initially empty). Click Browse to browse the network for available logging Netop servers to show this window:

The pane will show the Host IDs of found logging Netop servers.

**Select:** Select a Host ID in the pane and click this button to show it in the field.

**Note:** If on a Host or extended Host the Guest Access Security option Use Netop Security Server is selected, leave the Host ID for Log Server field empty to log in the specified security server group security database Netop Log.
5.3.1.4 Windows Event Log Tab

This is the Log Setup window Windows Event Log tab:

<table>
<thead>
<tr>
<th>View Events to view in list</th>
<th>Events to log</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ View all Events</td>
<td>☑ Act: Execute Command</td>
</tr>
<tr>
<td>☑ View Selected</td>
<td>☑ Act: File received</td>
</tr>
<tr>
<td></td>
<td>☑ Act: File Sent</td>
</tr>
<tr>
<td>Connection</td>
<td>☑ Act: Gateway Login</td>
</tr>
<tr>
<td>Session</td>
<td>☑ Act: Help request canceled</td>
</tr>
<tr>
<td>Action</td>
<td>☑ Act: Help request sent</td>
</tr>
<tr>
<td>Security</td>
<td>☑ Act: Host Reboot</td>
</tr>
<tr>
<td>Configuration</td>
<td>☑ Act: Host user logged off</td>
</tr>
<tr>
<td></td>
<td>☑ Act: Inventory sent</td>
</tr>
<tr>
<td></td>
<td>☑ Act: Keyboard Locked</td>
</tr>
<tr>
<td></td>
<td>☑ Act: Keyboard Unlocked</td>
</tr>
<tr>
<td></td>
<td>☑ Act: Message received</td>
</tr>
<tr>
<td></td>
<td>☑ Act: Received Cloudburd</td>
</tr>
</tbody>
</table>

Use Windows Event Log

- Local: Leave this box checked to log Netop events in the Windows event log of the computer (default: checked).

It selects which Netop events shall be logged and specifies Windows event logs.

Select Events to view in list

Select one of these options to show check boxed event names in the Events to log pane:

☑ View all Events: Show all available events (default selection).

☑ View Selected: Enable these options:

- Connection: Check this box to show available connection events.
- Session: Check this box to show available session events.
- Action: Check this box to show available action events.
- Security: Check this box to show available security events.
- Configuration: Check this box to show available configuration events.

Events to log: []: This pane will show check boxed names of events of the types selected to the left. Check boxes to select logging of events (default: all unchecked).

Select all: Click this button to check all boxes in the Events to log pane.

Deselect all: Click this button to uncheck all boxes in the Events to log pane.

Note: Available Netop log event codes and arguments are tabulated in Netop Log Events.

Use Windows event log

Note: This section will be enabled only if the Log to Windows event log box is checked on the Log Setup Tab.
Common Tools

☐ Remote: [ ] Check this box to log Netop events in the Windows event log of a remote Windows 2003/XP/2000/NT computer (default: unchecked). Specify in the field the Windows name of the remote computer.

5.3.1.5 SNMP Traps Tab

This is the Log Setup window SNMP Traps tab:

![Log Setup window](image)

It selects which Netop events to log in a management information system.

Select Events to view in list

Select one of these options to show check boxed event names in the Events to log pane:

- **View all Events**: Show all available events (default selection).
- **View Selected**: Enable these options:
  - **Connection**: Check this box to show available connection events.
  - **Session**: Check this box to show available session events.
  - **Action**: Check this box to show available action events.
  - **Security**: Check this box to show available security events.
  - **Configuration**: Check this box to show available configuration events.

Events to log: [ ] This pane will show check boxed names of events of the types selected to the left. Check boxes to select logging of events (default: all unchecked).

Select all: Click this button to check all boxes in the Events to log pane.

Deselect all: Click this button to uncheck all boxes in the Events to log pane.

Note: Available Netop log event codes and arguments are tabulated in Netop Log Events.
If the Log using SNMP Traps box is checked on the Log Setup Tab, a Simple Network Management Protocol (SNMP) message will be sent when a selected Netop event occurs. Netop SNMP events are defined in the danware.mib file that resides in the directory where the Netop module is installed.

5.3.1.6 WebConnect Tab

This is the Log Setup window WebConnect tab:

**Note**: This tab is only present in the Host Log Setup window and if the WebConnect communication profile has been activated.

Here you select which Netop events should be logged to the activity log of the WebConnect service that facilitates the WebConnect connection.

Select Events to view in list

Select one of these options to display event names in the Events to log pane:

- **View all Events**: Show all available events (default selection).
- **View Selected**: Enable these options:
  - **Connection**: Select this check box to display available connection events.
  - **Session**: Select this check box to display available session events.
  - **Action**: Select this check box to display available action events.
  - **Security**: Select this check box to display available security events.
  - **Configuration**: Select this check box to display available configuration events.

**Events to log**: This pane will display names of events of the types selected to the left. Select check boxes to select logging of events (default: all unchecked).

- **Select all**: Click this button to select all check boxes in the Events to log pane.
- **Deselect all**: Click this button to clear all check boxes in the Events to log pane.
5.3.2 Local Netop Log

The local Netop Log file is a plain text file with text lines that each log a Netop event. Events are ordered chronologically. This example from a Guest log illustrates the typical contents of a log:

```
20011009,15:41,Guest1,0,00000,00000,GACTCOMPR+,TCP/IP
20011009,15:41,Guest1,1,00000,00000,GCONCALL ,192.168.1.3
20011009,15:41,Guest1,2,00000,00000,GSESFXFER+,
20011009,15:42,Guest1,3,00000,00000,*ACTFILE -,C:\test.txt
20011009,15:42,Guest1,4,00000,00000,GSESFXFER-,
20011009,15:42,Guest1,5,00000,00000,GSESRC -,
20011009,15:42,Guest1,6,00000,00000,GCONHNGUP ,192.168.1.3
20011009,15:42,Guest1,7,00000,00000,GACTCOMPR-,
```

Note: Available Netop log event codes and arguments are tabulated in Netop Log Events.

Each line contains this information: date, time, Netop module name, event number, error code 1, error code 2, event code, arguments.

Note: Error codes are currently not implemented and should always be 00000.

The log file above recorded these events:

On October 9, 2001 at 15:41 hours the Guest Guest1 enabled the communication profile TCP/IP.

It connected to the Host with the name 192.168.1.3.

It started a file transfer session.

It sent the file C:\test.txt.

Find out yourself what then happened.

5.3.3 Netop Log Events

Netop Log events and their codes are explained in these sections:

- Guest Netop Log Events
- Host and Extended Host Netop Log Events

5.3.3.1 Guest Netop Log Events

Netop Guest can log these Netop Log events:

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Con: Call Host</td>
<td>GCONCALL</td>
<td>Host name</td>
</tr>
<tr>
<td>Con: Disconnect Host</td>
<td>GCONHNGUP</td>
<td>Host name</td>
</tr>
<tr>
<td>Con: Connection lost</td>
<td>*CONLOST</td>
<td>Host name</td>
</tr>
<tr>
<td>Con: User authenticated</td>
<td>GCONUSER</td>
<td>(none)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ses: Remote control started</td>
<td>GSESRC +</td>
<td>Host name</td>
</tr>
<tr>
<td>Ses: Remote control stopped</td>
<td>GSESRC -</td>
<td>Host name</td>
</tr>
<tr>
<td>Ses: File transfer started</td>
<td>GSESFXFER+</td>
<td>(none)</td>
</tr>
</tbody>
</table>
### Action

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Act: Help service start</td>
<td>GACTHLPSV+</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Help service stop</td>
<td>GACTHLPSV-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Help request received</td>
<td>GACTHLPRQ+</td>
<td>Host name</td>
</tr>
<tr>
<td>Act: Help request cancelled</td>
<td>GACTHLPRQ-</td>
<td>Host name</td>
</tr>
<tr>
<td>Act: File sent</td>
<td>*ACTFILE +</td>
<td>File path and name</td>
</tr>
<tr>
<td>Act: File Sent</td>
<td>*ACTFILE -</td>
<td>File path and name</td>
</tr>
<tr>
<td>Act: Host Rebooted</td>
<td>*ACTBOOT</td>
<td>Host name</td>
</tr>
<tr>
<td>Act: Session recording started</td>
<td>GACTREC +</td>
<td>Recording file path and name</td>
</tr>
<tr>
<td>Act: Session recording stopped</td>
<td>GACTREC -</td>
<td>Recording file path and name</td>
</tr>
<tr>
<td>Act: Windows event logging failed</td>
<td>*ACTWIN !</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: SNMP trapping failed</td>
<td>*ACTSNMP !</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Received Clipboard</td>
<td>*ACTCLPB +</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Sent Clipboard</td>
<td>*ACTCLPB -</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Received Print Job</td>
<td>*ACTPRINT+</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Sent Print Job</td>
<td>*ACTPRINT-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Communication Profile Started</td>
<td>GACTCOMPR+</td>
<td>Communication profile name</td>
</tr>
<tr>
<td>Act: Communication Profile Stopped</td>
<td>GACTCOMPR-</td>
<td>[Communication profile name]</td>
</tr>
<tr>
<td>Act: Inventory received</td>
<td>GACTINV</td>
<td>Host name</td>
</tr>
<tr>
<td>Act: Message sent</td>
<td>GACTMSG</td>
<td>Host name</td>
</tr>
</tbody>
</table>

### Security

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sec: Password rejected</td>
<td>*SECPW !</td>
<td>Host name</td>
</tr>
<tr>
<td>Sec: Confirm access denied</td>
<td>*SECCA !</td>
<td>Host name</td>
</tr>
<tr>
<td>Sec: Security Server logon</td>
<td>GSECACSRV+</td>
<td>Logon name</td>
</tr>
<tr>
<td>Sec: Security Server logoff</td>
<td>GSECACSRV-</td>
<td>(none)</td>
</tr>
</tbody>
</table>

### Configuration

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cfg: Help service name defined</td>
<td>GCFGHLPSV+</td>
<td>Help service name</td>
</tr>
<tr>
<td>Cfg: Help service name deleted</td>
<td>GCFGHLPSV-</td>
<td>Help service name</td>
</tr>
<tr>
<td>Cfg: Local logging turned on</td>
<td>*CFGLLOC +</td>
<td>Log file name</td>
</tr>
<tr>
<td>Cfg: Local logging turned off</td>
<td>*CFGLLOC -</td>
<td>Log file name</td>
</tr>
<tr>
<td>Cfg: Local logging filename changed</td>
<td><em>CFGLFILE</em></td>
<td>New log file name</td>
</tr>
<tr>
<td>Cfg: Server logging turned on</td>
<td>*CFGLSRV +</td>
<td>Log server name</td>
</tr>
<tr>
<td>Cfg: Server logging turned off</td>
<td>*CFGLSRV -</td>
<td>Log server name</td>
</tr>
<tr>
<td>Cfg: Windows event logging turned on</td>
<td>*CFGLWIN +</td>
<td>If remote: computer name</td>
</tr>
<tr>
<td>Cfg: Windows event logging turned off</td>
<td>*CFGLWIN -</td>
<td>If remote: computer name</td>
</tr>
<tr>
<td>Cfg: Sending SNMP traps turned on</td>
<td>*CFGLSNMP+</td>
<td>(none)</td>
</tr>
</tbody>
</table>
### Common Tools

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cfg: Sending SNMP traps turned off</td>
<td>*CFGLSNMP-</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Security Server password changed</td>
<td>GCFGACPW *</td>
<td>Netop Guest ID</td>
</tr>
<tr>
<td>Cfg: Web update check</td>
<td>*CFGWUCHK</td>
<td>Old build, new build, [timeout error]</td>
</tr>
<tr>
<td>Cfg: Web update download</td>
<td>*CFGWUDL</td>
<td>File name, [timeout error]</td>
</tr>
<tr>
<td>Cfg: Web update install</td>
<td>*CFGWUINST</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Web update success</td>
<td>*CFGWU *</td>
<td>Old build, new build</td>
</tr>
<tr>
<td>Cfg: Web update failed</td>
<td>*CFGWU !</td>
<td>Old build, error message</td>
</tr>
</tbody>
</table>

### 5.3.3.2 Host and Extended Host Netop Log Events

Netop Host or extended Host can log these [Netop Log] events:

#### Connection

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Con: Host started</td>
<td>HCON +</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Host stopped</td>
<td>HCON -</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Callback</td>
<td>HCONCALLB</td>
<td>Callback number</td>
</tr>
<tr>
<td>Con: Connection lost</td>
<td>*CONLOST</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Name Server started</td>
<td>HCONNNS +</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Name Server stopped</td>
<td>HCONNNS -</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Security Server started</td>
<td>HCONNSS +</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Security Server stopped</td>
<td>HCONNSS -</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Gateway started</td>
<td>HCONGW +</td>
<td>(none)</td>
</tr>
<tr>
<td>Con: Gateway stopped</td>
<td>HCONGW -</td>
<td>(none)</td>
</tr>
</tbody>
</table>

#### Session

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ses: Session started</td>
<td>HSES +</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Session stopped</td>
<td>HSES -</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Remote control started</td>
<td>HSESRC +</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Remote control stopped</td>
<td>HSESRC -</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: File transfer started</td>
<td>HSESFXFER+</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: File transfer stopped</td>
<td>HSESFXFER-</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Chat started</td>
<td>HSESCHAT+</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Chat stopped</td>
<td>HSESCHAT-</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Audio started</td>
<td>HSESAUDIO+</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Audio stopped</td>
<td>HSESAUDIO-</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Remote Management started</td>
<td>HSESRM +</td>
<td>Guest name</td>
</tr>
<tr>
<td>Ses: Remote</td>
<td>HSESRM -</td>
<td>Guest name</td>
</tr>
</tbody>
</table>
### Action

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Act: Help request sent</td>
<td>HACTHLPRQ+</td>
<td>Help service name, problem description</td>
</tr>
<tr>
<td>Act: Help request canceled</td>
<td>HACTHLPRQ-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: File received</td>
<td>*ACTFILE+</td>
<td>File path and name</td>
</tr>
<tr>
<td>Act: File sent</td>
<td>*ACTFILE-</td>
<td>File path and name</td>
</tr>
<tr>
<td>Act: Host reboot</td>
<td>*ACTBOOT</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Run Program</td>
<td>HACTRUN</td>
<td>Program name</td>
</tr>
<tr>
<td>Act: Execute Command</td>
<td>HACTEXE</td>
<td>Command name</td>
</tr>
<tr>
<td>Act: Windows event logging failed</td>
<td>*ACTWIN!</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: SNMP trapping failed</td>
<td>*ACTSNMP!</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Received clipboard</td>
<td>*ACTCLPB+</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Sent clipboard</td>
<td>*ACTCLPB-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Received print job</td>
<td>*ACTPRINT+</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Sent print job</td>
<td>*ACTPRINT-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Keyboard and mouse assigned</td>
<td>*HACTKBDMS-</td>
<td>Guest name</td>
</tr>
<tr>
<td>Act: Keyboard and mouse revoked</td>
<td>*HACTKBDMS+</td>
<td>Guest name</td>
</tr>
<tr>
<td>Act: Keyboard locked</td>
<td>HACTKBD-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Keyboard unlocked</td>
<td>HACTKBD+</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Screen blanked</td>
<td>HACTSCR-</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Screen unblanked</td>
<td>HACTSCR+</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Host user logged off</td>
<td>HACTLOFF</td>
<td>(none)</td>
</tr>
<tr>
<td>Act: Gateway logon</td>
<td>HACTGW+</td>
<td>Connecting module name</td>
</tr>
<tr>
<td>Act: Inventory sent</td>
<td>HACTINV</td>
<td>Guest name</td>
</tr>
<tr>
<td>Act: Message received</td>
<td>HACTMSG</td>
<td>Guest name</td>
</tr>
</tbody>
</table>

### Security

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sec: Individual security enabled or changed</td>
<td>HSECINDIV+</td>
<td>Guest access method</td>
</tr>
<tr>
<td>Sec: Individual security disabled</td>
<td>HSECINDIV-</td>
<td>Guest access method</td>
</tr>
<tr>
<td>Sec: Security role added</td>
<td>HSECROLE +</td>
<td>Security role name</td>
</tr>
<tr>
<td>Sec: Security role deleted</td>
<td>HSECROLE -</td>
<td>Security role name</td>
</tr>
<tr>
<td>Sec: Security role changed</td>
<td>HSECROLE *</td>
<td>Security role name</td>
</tr>
<tr>
<td>Sec: Guest added to role</td>
<td>HSEC Guest+</td>
<td>Guest name</td>
</tr>
</tbody>
</table>
### Common Tools

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security: Guest deleted from role</td>
<td>Sec: Guest deleted from role</td>
<td>HSECGuest-</td>
<td>Guest name</td>
</tr>
<tr>
<td>Security: Guest changed in role</td>
<td>Sec: Guest changed in role</td>
<td>HSECGuest*</td>
<td>Guest name</td>
</tr>
<tr>
<td>Security: Password enabled</td>
<td>Sec: Password enabled</td>
<td>HSECPW+</td>
<td>If individual: Guest name</td>
</tr>
<tr>
<td>Security: Password disabled</td>
<td>Sec: Password disabled</td>
<td>HSECPW-</td>
<td>If individual: Guest name</td>
</tr>
<tr>
<td>Security: Password changed</td>
<td>Sec: Password changed</td>
<td>HSECPW*</td>
<td>If individual: Guest name</td>
</tr>
<tr>
<td>Security: Callback enabled (default only)</td>
<td>Sec: Callback enabled (default only)</td>
<td>HSECCALLB+</td>
<td>(none)</td>
</tr>
<tr>
<td>Security: Callback disabled (default only)</td>
<td>Sec: Callback disabled (default only)</td>
<td>HSECCALLB-</td>
<td>(none)</td>
</tr>
<tr>
<td>Security: Callback changed (default only)</td>
<td>Sec: Callback changed (default only)</td>
<td>HSECCALLB*</td>
<td>(none)</td>
</tr>
<tr>
<td>Security: Confirm access enabled</td>
<td>Sec: Confirm access enabled</td>
<td>HSECCA+</td>
<td>If individual: security role name</td>
</tr>
<tr>
<td>Security: Confirm access disabled</td>
<td>Sec: Confirm access disabled</td>
<td>HSECCA-</td>
<td>If individual: security role name</td>
</tr>
<tr>
<td>Security: Confirm access rejected</td>
<td>Sec: Confirm access rejected</td>
<td>*SECPw !</td>
<td>Guest name</td>
</tr>
<tr>
<td>Security: Confirm access denied</td>
<td>Sec: Confirm access denied</td>
<td>*SECCA !</td>
<td>(none)</td>
</tr>
<tr>
<td>Security: Illegal password limit reached</td>
<td>Sec: Illegal password limit reached</td>
<td>HSECPWLM!</td>
<td>(none)</td>
</tr>
<tr>
<td>Security: Timeout limit exceeded</td>
<td>Sec: Timeout limit exceeded</td>
<td>HSECTMOUT</td>
<td>AC (inactivity), AU (authentication) or CA (confirm access).</td>
</tr>
</tbody>
</table>

### Configuration

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration: Local logging started</td>
<td>*CFGLLLOC+</td>
<td>Log file name</td>
</tr>
<tr>
<td>Configuration: Local logging stopped</td>
<td>*CFGLLLOC-</td>
<td>Log file name</td>
</tr>
<tr>
<td>Configuration: Local logging filename changed</td>
<td><em>CFGLFILE</em></td>
<td>New log file name</td>
</tr>
<tr>
<td>Configuration: Server logging started</td>
<td>*CFGLSRV+</td>
<td>Log server name</td>
</tr>
<tr>
<td>Configuration: Server logging stopped</td>
<td>*CFGLSRV-</td>
<td>Log server name</td>
</tr>
<tr>
<td>Configuration: Windows event logging started</td>
<td>*CFGLWIN+</td>
<td>If remote: computer name</td>
</tr>
<tr>
<td>Configuration: Windows event logging stopped</td>
<td>*CFGLWIN-</td>
<td>If remote: computer name</td>
</tr>
<tr>
<td>Configuration: Sending SNMP traps started</td>
<td>*CFGLSNMP+</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Sending SNMP traps stopped</td>
<td>*CFGLSNMP-</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Start at load</td>
<td>HCFGOWAIT*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Load with OS</td>
<td>HCFGOLOAD*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Minimize at startup</td>
<td>HCFGOMIST*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Stealth mode</td>
<td>HCFGOSTLT*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Minimize on connection</td>
<td>HCFGOMICO*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: On top</td>
<td>HCFGOTOP *</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Show file transfer</td>
<td>HCFGOSFX *</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Send keep alive</td>
<td>HCFGOALIV*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option selected: Boot after disconnect</td>
<td>HCFG0BOOT+</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option selected: Logoff after disconnect</td>
<td>HCFGOLOGO+</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option selected: Lock after disconnect</td>
<td>HCFGOLOCK+</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option selected: Nothing after disconnect</td>
<td>HCFGNUOTH+</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Naming method</td>
<td>HCFG0NAME*</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Public Host name</td>
<td>HCFGPUBN*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Enable user name</td>
<td>HCFG0USRN*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Connection notification</td>
<td>HCFGONOTTI*</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Help Request description</td>
<td>HCFG0HRD*</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Help Request provider</td>
<td>HCFGOHRP*</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Help Request communication</td>
<td>HCFGOHRC*</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Help Request phone/IP</td>
<td>HCFGOHRPI*</td>
<td>(none)</td>
</tr>
<tr>
<td>Configuration: Option change: Help Request show icon</td>
<td>HCFGOHRSI*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Audio full duplex</td>
<td>HCFG0AUFD*</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>Configuration: Option change: Audio silence level</td>
<td>HCFG0AUSL*</td>
<td>(none)</td>
</tr>
</tbody>
</table>
### Common Tools

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cfg: Option change: Audio line hold</td>
<td>HCFGDAULH*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Option change: Name space ID</td>
<td>HCFGONSID*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Maintenance required for Guest</td>
<td>HCFGMRQG*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Maintenance required for Gateway</td>
<td>HCFGMRQGW*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Maintenance required for other</td>
<td>HCFGMRQO*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Maintenance required for exit/stop</td>
<td>HCFGMRQEX*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Protect files changed</td>
<td>HCFGPROTS*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Maintenance password changed</td>
<td>HCFGMTPW*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Guest access allowed to changed (default only)</td>
<td>HCFGGALLW*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: MAC/IP address list changed</td>
<td>HCFGMACIP*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: File transfer disable changed</td>
<td>HCFGFX*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Security Server group ID changed</td>
<td>HCFGSSG*</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Web update check</td>
<td>*CFGWUCHK</td>
<td>Old build, new build, [timeout error]</td>
</tr>
<tr>
<td>Cfg: Web update download</td>
<td>*CFGWUDL</td>
<td>File name, [timeout error]</td>
</tr>
<tr>
<td>Cfg: Web update install</td>
<td>*CFGWUINST</td>
<td>(none)</td>
</tr>
<tr>
<td>Cfg: Web update success</td>
<td><em>CFGWU</em></td>
<td>Old build, new build</td>
</tr>
<tr>
<td>Cfg: Web update failed</td>
<td>*CFGWU !</td>
<td>Old build, error message</td>
</tr>
</tbody>
</table>

Netop Gateway can log these [Netop Log](#) special Gateway events:

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Code</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>GW: Gateway access allowed</td>
<td>HGW ACCES+</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway callback</td>
<td>HGW CALLB</td>
<td>Callback number</td>
</tr>
<tr>
<td>GW: Gateway callback changed (default only)</td>
<td>HGW CALLB*</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway callback disabled (default only)</td>
<td>HGW CALLB-</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway callback enabled (default only)</td>
<td>HGW CALLB+</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway group defined</td>
<td>HGW GROUP+</td>
<td>Security role name</td>
</tr>
<tr>
<td>GW: Gateway group deleted</td>
<td>HGW GROUP-</td>
<td>Security role name</td>
</tr>
<tr>
<td>GW: Gateway Guest added</td>
<td>HGW GUEST+</td>
<td>Guest name</td>
</tr>
<tr>
<td>GW: Gateway Guest changed</td>
<td>HGW GUEST*</td>
<td>Guest name</td>
</tr>
<tr>
<td>GW: Gateway Guest deleted</td>
<td>HGW GUEST-</td>
<td>Guest name</td>
</tr>
<tr>
<td>GW: Gateway individual security disabled</td>
<td>HGW INSEC-</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway individual security enabled (or changed)</td>
<td>HGW INSEC+</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway NSS GID changed</td>
<td>HGW SSGID*</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway password changed (default only)</td>
<td>HGW PW *</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway password disabled (default only)</td>
<td>HGW PW -</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway password enabled (default only)</td>
<td>HGW PW +</td>
<td>(none)</td>
</tr>
<tr>
<td>GW: Gateway password rejected</td>
<td>*SECGWPW !</td>
<td>Connecting module name</td>
</tr>
</tbody>
</table>
5.4 System Info

In the About Netop Remote Control Guest or About Netop Remote Control Host window, click System Info to show this window:

It has two menus, see below, and shows selected system information in three sections:

- The upper section shows summary program and system information.
- The middle section shows summary screen information.
- The lower section shows summary driver information.

Advanced Display Info Menu

Select a command to show detailed information on the current screen in a Screen Info window.

Communication Info Menu

Net Addresses: Select this command to show this window:
Net Addresses []: The pane will show enabled computer network addresses.

Note: Netop module network addresses are enabled only if Communication Profiles that use Networking Communication Devices are enabled.

5.5 NETOP.INI

When Netop is installed on a computer for the first time, a file named NETOP.INI will be created in the computer operating system directory (C:\Windows or C:\WINNT).

NETOP.INI contains settings that determine how Netop modules will be installed and loaded. It will be read when a Netop module is installed or loaded on the computer.

Typically, you do not need to worry about the NETOP.INI file, but you can edit it to apply certain options.

NETOP.INI uses the standard Windows INI file format with sections, keys and values. It is a plain text file that can be edited with a standard text editor like Notepad.

NETOP.INI can contain these sections:

- [INSTALL]: Specifies Netop installation settings.
- [COEXISTENCE]: Specifies settings for running different Netop modules on a computer at the same time.
- [GUEST], [HOST], [GATEWAY], [NNS], [NSS]: Specify startup settings for Netop modules.
- [IPX]: Specifies startup settings for the IPX communication device.
- [NETBIOS]: Specifies startup settings for the NetBIOS communication device.
- [TCP]: Specifies startup settings for the TCP communication device.
- [DTL]: Specifies special communication settings.
- [AUDIO]: Specifies special audio settings.

Other sections can be included.

Note: In the Netop KnowledgeBase, look into the Documentation section Netop.ini settings section to view all currently available NETOP.INI setting options.

5.5.1 [INSTALL] Section

This NETOP.INI file section that by default is included specifies the installation directories and program folders of the most recently installed Netop programs. These specifications will be the default suggestions when reinstalling Netop.
5.5.2 [COEXISTENCE] Section

This NETOP.INI file section that by default is included specifies settings for replacing one running Netop module by another and running different Netop modules at the same time.

Low level coexistence allows Netop Guest to be loaded on a computer that runs Netop Host or an extended Netop Host, temporarily suspending Netop Host, or vice versa. A Host connected to a Guest cannot be suspended. Guest connections to Hosts will be broken when a running Guest is replaced by a Host.

High level coexistence allows a Netop Guest to run on a computer at the same time as a Netop Host or extended Host. This will enable cascading remote control, i.e. a Guest remote controlling a Host on a computer that is running a Guest that in turn remote controls another Host. Running a Guest and a Host on a computer at the same time requires that they use different Communication Profiles. If Communication Profiles that use TCP/IP are used, they must use different Receive port numbers.

This section can contain these keys:

- COEXIST=<1, 0 or 2>
  The default value 1 will enable low level coexistence, the value 0 will disable coexistence and the value 2 will enable high level coexistence. If the key is missing, coexistence will be disabled.
- LOAD_WARNING=<1 or 0>
  The default value 1 will show a warning message when the user attempts low level coexistence. The user will have the options to proceed or cancel. The value 0 will show no warning message. If the key is missing, a warning message will be shown.
- DEBUG=<0 or 1>
  This optional key can be added to show the loader program commands executing in a separate window. If the key is missing or its value is set to 0, the loader program window will not be shown. If the value is set to 1, the loader program window will be shown.

5.5.3 [GUEST], [HOST], [GATEWAY], [NNS] and [NSS] Sections

You can use these optional NETOP.INI file sections to specify non-default locations of configuration and other files created and used by Netop modules, see Other Locations of Netop Configuration Files. These sections and keys can be used:

- [GUEST]
  DataPath=<Path> that specifies the path to Guest configuration files.
  HistoryPath=<Path> that specifies the path to Guest history files.
  InventoryPath=<Path> that specifies the path to Guest inventory files.
  PhonebookPath=<Path> that specifies the path to Guest phonebook files.
  RecordPath=<Path> that specifies the path to Guest record files.
  ScriptPath=<Path> that specifies the path to Guest script files.

and/or

- [HOST]
  DataPath=<Path> that specifies the path to Host configuration files.
  MessagePath=<Path> that specifies the path to Host message files.

and/or

- [GATEWAY]
  DataPath=<Path> that specifies the path to Gateway configuration files.
  MessagePath=<Path> that specifies the path to Gateway message files.
and/or

[Common Tools

DataPath=<Path> that specifies the path to Name Server configuration files.
MessagePath=<Path> that specifies the path to Name Server message files.

and/or

[NSS]

DataPath=<Path> that specifies the path to Security Server configuration files.
MessagePath=<Path> that specifies the path to Security Server message files.

Other keys can be included in the sections.

Note: The [HOST] key ActualBufferReleaseBlock=<Numbers> is information written by the Host program to the NETOP.INI file. It is unimportant to the user but can be used by Netop specialists for troubleshooting.

5.5.4 [IPX] Section

This optional NETOP.INI file section can contain this key:

Max_Packet_Size=<Number>, where <Number> meaning the maximum communication packet size in bytes can be set between 512 and 5000.

This setting can be used to solve communication problems, see IPX Settings.

5.5.5 [NetBIOS] Section

This optional NETOP.INI file section can contain this key:

Max_Packet_Size=<Number>, where <Number> meaning the maximum communication packet size in bytes can be set between 512 and 5000.

This setting can be used to solve communication problems, see NetBIOS Settings.

5.5.6 [TCP] Section

This optional NETOP.INI file section can contain this key:

BindToRecvPort=True

TCP/IP (TCP) listens by the specified Receive port number but includes by default another available Receive port number in sent communication to receive return communication by it. To include the specified Receive port number in sent TCP/IP (TCP) communication, use this key.

5.5.7 [DTL] Section

This optional NETOP.INI file section can contain this key:

TimeOutTimes=<Number>, where <Number> meaning the number of resends in addition to the default 10 that will be applied to get data packets through can be set between 1 and 50.

Setting this key may be necessary if data packets take a long time to get through or get lost.

5.5.8 [AUDIO] Section

This optional NETOP.INI file section can contain this key:

Sound_Mix=<Sound mix recording mode name>

This key may be necessary on Netop Host to enable Transfer Sound if the sound mix recording mode name of the Host computer audio device (sound card) is different from Wave Out Mix.
5.5.9 NETOP.INI Example

For clarification, a sample NETOP.INI file is shown below with explanations to the right.

### NETOP.INI file

#### [INSTALL]

- **DIRECTOR{Y=C:\Program Files \Danware Data\Netop Remote Control**
The Netop program files reside in the directory `C:\Program Files\Danware Data\Netop Remote Control`.
- **FOLDER=Netop Remote Control**
The name of the program folder is `Netop Remote Control`.

#### [COEXISTENCE]

- **COEXIST=1**
  Low level coexistence shall be enabled.
- **DEBUG=1**
  Loader program commands shall be shown.
- **LOAD_WARNING=1**
  A load warning window shall be shown.

#### [Guest]

- **DataPath=F:\SHARED\DATA\Guest**
The Guest configuration files reside in the directory `F:\SHARED\DATA\Guest`.

#### [Host]

- **DataPath=F:\SHARED\DATA\Host**
The Host configuration files reside in the directory `F:\SHARED\DATA\Host`.

#### [IPX]

- **Max_Packet_Size=512**
  Transmit IPX data in packets not larger than 512 bytes.

#### [NETBIOS]

- **Max_Packet_Size=2500**
  Transmit NetBIOS data in packets not larger than 2500 bytes.

#### [DTL]

- **TimeOutTimes=10**
  Add 10 resends to the default 10.

### 5.6 Netop Configuration Files

The setup of Netop modules is stored in configuration files, typically with the extension ndb (Netop Data Base).

When a Netop module is installed on a computer, configuration files that specify the installed setup are created in the directory where the Netop module is installed.

When a user loads a Netop module for the first time after installation, configuration files will be copied from the directory where the Netop module is installed to a user configuration directory. The Setup Wizard will run for the user to create a customized setup, the settings of which will be written to the configuration files in the user configuration directory.

Directory folders for other Netop files created by the user will be created in the user configuration directory.

Netop log files created by the user will by default be saved in the user configuration directory.

This table gives an overview of Netop configuration and other files, their default location and contents:

<table>
<thead>
<tr>
<th>File name</th>
<th>Default location</th>
<th>File contents</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

432
The meanings of <Guest>, <Host> and <Gateway> are explained in Default Location of Netop Configuration Files.

When a user changes the setup of a Netop module during use, changes are written to the configuration files in the user configuration directory immediately or when the Netop module is unloaded.

When a user loads a Netop module, the configuration files in the user configuration directory are read to re-establish the setup that existed when the user last unloaded the Netop module.

If the user configuration files are write protected or access to the directories in which they reside is denied, user setup changes cannot be written to files and will not be retained.

The setup of a Netop module can be protected by applying a Maintenance Password. Host user configuration files can be protected when the Host is running or connected.

If user configuration files are deleted, the user setup of deleted user configuration files will be lost. When the module is loaded after deleting user configuration files, a new user setup in new user configuration files will be created.

Most ndb files are written in a Netop proprietary format and cannot be read or edited separately.

This section includes these sections:
5.6.1 Default Location of Netop Configuration Files

If user profiles are implemented, Netop Configuration Files will by default reside in Windows user profile directories.

User profiles are implemented with Windows NT systems (Windows 2003, XP, 2000 and NT), and user profiles can be implemented with Windows 9x systems (Windows ME, 98 and 95).

- On Windows 2003, XP and 2000, user profile directories are typically `C:\Documents and Settings\<Windows logon user name>`.
- On Windows NT, user profile directories are typically `C:\WINNT\Profiles\<Windows logon user name>`.
- On Windows 9x (ME, 98 and 95), user profile directories, if implemented, are typically `C:\Windows\Profiles\<Windows logon user name>`.

By default, user configuration files will reside in the path `<User profile directory>\Application Data\<Netop module path>`, where `<Netop module path>` is the full path to the directory where the Netop module is installed. If the Netop module is installed in the `C:\Program Files` directory, only the path from that directory will be used in `<Netop module path>`.

**Note:** Application Data is typically a hidden folder that will be shown only if you select to show hidden folders.

If user profiles are implemented on a computer, user Guest configuration files will by default reside in the user profile directory of the user logged on to Windows and will be individual to each user (<Guest>).

If user profiles are implemented on a computer, user Host or extended Host configuration files will by default reside in the All Users user profile directory and will be shared by all users of the computer (<Host> and <Gateway>).

If user profiles are not implemented on a computer, user configuration files will by default reside in a Config directory in the directory where the Netop module is installed and will be shared by all users of the computer (<Guest>, <Host> and <Gateway>).

5.6.2 Other Locations of Netop Configuration Files

You can place Netop Configuration Files in a non-default user individual or shared location by using these NETOP.INI file keys:

```
[GUEST]
DataPath=<Path>
HistoryPath=<Path>
InventoryPath=<Path>
PhonebookPath=<Path>
RecordPath=<Path>
ScriptPath=<Path>
```

and/or

```
[HOST]
DataPath=<Path>
MessagePath=<Path>
```

and/or

```
[GATEWAY]
```
DataPath=<Path>
MessagePath=<Path>

and/or

[NNS]
DataPath=<Path>
MessagePath=<Path>

and/or

[NSS]
DataPath=<Path>
MessagePath=<Path>

- where <Path> is the full path to the directory where user configuration files shall be stored.
Index

[AUDIO] Section 431
[COEXISTENCE] Section 430
[DTL] Section 431
[GUEST] [HOST] [GATEWAY] [NNS] and [NSS] Sections 430
[INSTALL] Section 429
[IPX] Section 431
[NetBIOS] Section 431
[TCP] Section 431

<

<Management tool> Menu 186

A

About command 61, 310
About Menu 282
About NetOp Remote Control Guest window 61
About NetOp Remote Control Host window 310
Action Buttons 147, 310
Action Command 267
Action Commands 57
Action Menu 307
Action to perform section 224
Add button 207, 215, 251
Add command 206, 215
Add Phonebook Reference window 66
Add Printer Guidelines window 121, 328
Add to Favorites button 204
Add to Favorites command 202
Add to Favorites window 203
Add/Edit MAC/IP Address List window 357
Address Check 52
Address field 313
Advanced Audio Settings window 118, 326
Advanced button 398
Advanced Help Request Options window 330
Advanced Help Service window 126
Advanced Inventory Options window 132
Advanced TCP/IP Configuration 398
Advanced Video window  119, 326
After connection section  324
Allow Guest To  48
Allow guest to options  341
Allow Guest to section  48
Allow Multiple Simultaneous Guest Sessions option  321
Allowed ISDN Numbers  391
AMT  78
Applications tab  195
Apply License command  60, 309
Arrange Icons command  166
Audio-Video Chat  181, 367
Audio-Video Chat button  62, 147, 311
Audio-Video Chat command  55, 308, 364
Audio-Video Chat Tab  117, 325
Audio-Video Chat window  181, 368

B
BIOS  78
Bitmap Mode  240
Blank Display button  150
Blank Display command  145
Bold button  290
Bold command  289
boot  78
Browse button  75
Browse for device groups option  407
Browse for Hosts  88
Buttons  75

C
Cache Tab  107
Call back section  343
Callback window  50
Cancel Help command  308
Change Current Destination Folder window  28
Change guest access privileges command  313
Change Maintenance Password window  139, 360
Change or Remove  31
Change Password window  46
Chat  179, 366
Index

Chat > All command 364
Chat button 62, 147, 311
Chat command 55, 308, 364
Check for New Updates 141, 362
Check for New Updates command 319
Choose Account window 348
Clear All button 246, 373
Clear All command 289
Clear button 195
Clear command 194
Clear Event Log window 194
Clear Selection command 165
Clipboard Buttons 149
Clipboard Tab 115
Clone Files button 176
Clone Files command 157
Close button 288
Close command 19, 159
Close Guest when finished check box 257
Command Console 223
Command Console command 185
Command Console display 223
Command Console Menu 224
Command Console Toolbar 224
Command Mode 239
Command Progress Status Session window 56
Command Progress Status window 284
Commands 258
Commands in the Script File 269
Comment column 67
Common Controls 19
Common Tools 384
Communication Device 384
Communication devicedrop-down box 384
Communication Devices 16
Communication Profile 384
Communication profile drop-down box 232
Communication Profile Edit window 384
Communication Profile Section 75
Communication Profile Setup window 140, 362
Communication Profiles 140, 362
Communication Profiles Button 311
Communication Profiles command 319
Communication section 232
Communication Tab 316
Completing the Netop Remote Control Guest Setup Wizard window 30
Compression/Encryption Tab 239
Confirm Access 49
Confirm access options 342
Confirm Access section 49
Confirm Access window 342
Confirmation Tab 170
Connect button 75
Connect by a Name and/or Address 87
Connect Command 258, 259
Connect Guide 41
Connect Problems 42
Connect Tab 231
Connect to Help Provider window 379
Connect to Host (Communication profile) window 260
Connect to Host (Phonebook file) window 259
Connected 305
Connection List command 293
Connection List window 293
Connection Menu 54
Connection Notification Tab 323
Connection Properties 230
Connection Properties button 63, 75, 148
Connection Properties command 59, 145
Connection section 321
Connections Tab 89, 313
Contents command 60, 309
Contents Pane 99
Control Buttons 148
Copy button 290, 383
Copy command 58, 289, 382
Copy Dialog window 264
Copy Files button 176
Copy Files command 157
Copy Guest to Removable Media 141
Index

Copy Key Name button 204
Copy Key Name command 202
Copy Tab 266
Copy/Move/Synchronize/Clone 159
Create New Task window 196
Create Task button 197
Custom Inventory Item window 133
Custom selection 296
Custom Setup window 27
Custom Tab 243
Custom Track 300
Customer Information window 25
Cut button 290
Cut command 58, 289

D

Debug Trace 141, 362
Debug Trace command 319
Default Host Name Qualifier 109
Default Location of Netop Configuration Files 434
Default Security Role 340
Default selection 296
Default Track 297
Default User 342
Delete 267
Delete button 63, 176, 203
Delete command 58, 158, 202, 289, 315, 317
Delete History command 306
Delete Markers 250, 377
Delete Messages command 306
Demonstrate 369
Demonstrate button 62, 147
Demonstrate command 55
Demonstrate toolbox 229
Dependencies Tab 214
Description column 67
Description of communication profile field 384
Deselect By command 165
Deselect window 165
Desktop Tab 241
Index

Details 190, 227
Details button 63, 177
Details command 59, 165
Details Pane 99
Details section 187
Dialog pane 367
Dial-up Network Connection section 398
Directory server field 333
Directory service section 352
Directory Service window 333
Directory Services Authentication 44
Directory Services Login window 45
Directory Services section 332
Directory Services Tab 111, 332
Disconnect All Guests Except Your Own button 149
Disconnect button 63, 75, 148, 311
Disconnect command 57, 308, 364
Disk Drive Properties window 191
Disk Drive Types 192
Disk Drives 189
Disk Drives command 185
Disk Drives Menu 190
Disk Drives Toolbar 191
Disk Space Requirements window 28
Display Guest name (if available) in the title bar option 324
Display Panel 188
Display Tab 236
Documentation 17
Domain section 348
Download Installation Files 22
Draw Arrow button 372
Draw Ellipse button 372
Draw Freehand button 372
Draw Lines button 372
Draw Rectangle button 372
Drive Info command 157
Drive Information window 158
During Connection section 324
Index

E

Edit allowed ISDN numbers button  391
Edit Binary Value window  200
Edit button  251
Edit command  98
Edit DWORD Value window  200
Edit Menu  288, 382
Edit Multi-String window  201
Edit Script command  59
Edit String window  199
Enable help service option  330
Enable service tickets option  331
Enable user name option  322
Encryption  52
Encryption Tab  130, 357
End Process command  196
End Task command  196
End Task/Process button  197
End-User License Agreement window  25
Enter name or leave name field blank option  322
Error No 6x Encryption window  240
Error No Common Encryption Type window  240
Event Properties command  194
Event Properties window  194
Event Viewer  192
Event Viewer command  185
Event Viewer Menu  193
Event Viewer Toolbar  194
Events to log pane  416, 417, 419, 420, 421
Execute Command  286, 381
Execute Command button  62, 147
Execute Command command  57
Execute Command menu  286
Exit command  54, 293, 307
Export button  204
Export command  202
Export from Phonebook command  54
Export from Phonebook window  69
Extended tab  205
F
Favorites drop-down box 204
Features 14
Figure Marker Menu 247, 374
Figure Marker Tool Menu 247, 374
Figure Markers 246, 373
File Manager Options 139
File Menu 276, 288, 306
File Transfer 155, 365
File Transfer button 62, 147
File Transfer Buttons 176
File Transfer Command 55, 264
File Transfer Status command 307
File Transfer Status window 366
Find button 204, 290, 383
Find command 201, 289, 382
Find Next command 202
Find window 201
For Advanced Computer Users 293
For Typical Computer Users 292
Format Menu 289
From section 253, 265
Full Screen button 148
Full Screen command 145

G
Gateway 406
Gateway Communication Profile Edit 406
Gateway Connection 74
Gateway Connection window 74
Gateway Device Group List 407
Gateway device group section 407
Gateway login section 330
Gateway logon 379
Gateway Settings 406
General Tab 211, 253, 265, 320
Get Inventory 291, 383
Get Inventory button 62, 147
Get Inventory command 57
Global Settings 252
Index

Global Settings in the Script File  257
Grant All Guests Default Access Privileges  340
Grant Each Guest Individual Access Privileges Using Directory Services  350
Grant Each Guest Individual Access Privileges Using NetOp Authentication  344
Grant Each Guest Individual Access Privileges Using Windows Security Management  347
Guest Access Method selection  339
Guest Access Privileges Tab  339
Guest Access Security  42, 338
Guest Access Security button  311
Guest Access Security command  318
Guest Actions  283
Guest Authentication  43
Guest Commands  258
Guest Netop Log Events  422
Guest Policy  51
Guest Policy Tab  51, 354
Guest Profile  50
Guest Profile window  50, 345
Guest Security Server Login window  45
Guest Sessions  142
Guest Tools  101

H

Help button  246, 373
Help for this Tab button  63
Help for this Tab command  61
Help Menu  185, 309
Help provider field  329
Help Providers window  380
Help Request Notification window  127
Help Request Select Type window  378
Help Request Tab  125, 329
Help requested  306
Help service  126
Hide command  308
History List command  293
History List window  293
History Records  92
History Tab  314
Host Actions  377
Host and Extended Host Netop Log Events  424
Host Commands  258
Host Computer Inventories  100
Host ID field  312
Host ID for log server section  418
Host Name Qualifiers window  110
Host Name Tab  109, 321
Host Section  71
Host Security Guide  42
Host Sessions  363
Host Startup Guide  292
Host Tools  318
Host top most window on connection with Guest option  321
How to Use Netop Documentation  18
HTTP  402

I
Import button  204
Import command  202
Import to Phonebook command  54
Import to Phonebook window  70
Individual Netop Authentication  44
Individual Netop Authentication window  379
Infrared  74
Infrared (IrDA)  408
Infrared (IrDA) Communication Profile Edit  408
Infrared (IrDA) Settings  408
Install  24
Install Alternatives  31
Install from a Directory  32
Installation  21
Intel Active Management Technology  78
Intel Setup and Configuration Service  78
Intel vPro Entry  67
Intel vPro Tab, Program Options  135
Intel vPro Tab, Quick Connect Tab  78
Introduction  14
Inventory  222
Inventory command  185
Inventory Menu  222
Index

Inventory Tab  131
Inventory Toolbar  222
Inventory window  268
Invert Selection command  165
IP Address  396
IP Address field  399
IP Broadcast List  401
IP Broadcast List (Enter) window  401
IP Broadcast List button  398
IP Broadcast List window  401
IPX  387
IPX Communication Profile Edit  388
IPX Settings  387
ISDN (CAPI)  389
ISDN (CAPI) Communication Profile Edit  390
ISDN (CAPI) Settings  390
Italic button  290
Italic command  289

K
Key context menu  203
Keyboard/Mouse Tab  237
Keys pane  198

L
Large Icons button  63, 177
Large Icons command  59, 165
Layout Tab  103
Line hold slide  325
Line or Gateway  72
List button  63, 177, 386
List command  59, 165
Load and Unload  33
Load Host at Windows startup option  320
Loading Alternatives  33, 294
Local button  177
Local command  165
Local File Transfer button  63
Local File Transfer command  57
Local Netop Log  422
Lock Keyboard and Mouse button  150
Index

Lock Keyboard and Mouse command 145
Log file section 257
Log locally option 414
Log on Netop server option 414
Log On Tab 212
Log Properties command 194
Log Properties window 194
Log Servers window 418
Log Setup 139, 361, 413
Log Setup command 318
Log Setup Tab 414
Log to Windows event log option 414
Log using SNMP traps option 414
Logging Tab 175
Logon Tab 108
Logon Using Netop Authentication (Guest credentials) window 44
Logon Using Netop Authentication (Password) window 43
Logon Using Windows Authentication window 44
Lower Toolbar 246, 373

M

MAC/IP Address List Setup Tab 52, 356
Magnifier Menu 376
Maintenance Password 139, 360
Maintenance Password (Enter) window 139
Maintenance Password command 318
Maintenance Password Enter window 361
Management 188
Management Menu 185
Management section 187
Marker Mode button 149
Marker Mode command 145
Marker Properties and Help 250, 377
Mask Windows window 228
Menu and Toolbar Control 19
Menu Bar 276, 287, 306
Message Pane 291, 383
Message window 287
Messages Tab 317
Minimize command 19
Index

Minimize Host on connection with Guest option 321
Minimize Host when loaded option 320
Modem Configuration 411
Modem Configuration window 411
Modem Database 141, 362, 410
Modem Database and Dialog 409
Modem Database command 319
Modem Dialog 412
Modem Dialog command 59, 307
Modem Dialog window 412
Modem window 410
Modify button 204
Modify command 202
Monitor 152, 365
Monitor button 62
Monitor command 55
Monitor Tab 116
Monitor Toolbox 154
Monitor window 153
Mouse marker button 150
Mouse marker command 145
Move Files button 176
Move Files command 157
Multi Chat Session 180, 366
Multi Guest Session 152, 365
Multi Guest Session Buttons 148
Multiple Host Names Found window 110

N
Name field 232
Name Not Found window 42
Name options section 322
Name Resolution 396
Name Response 396
Name Space ID 322
Names Tab 316
Naming section 322
Navigation Panel 187
Navigation Panel command 184
Net Addresses window 429
NetBIOS  385
NetBIOS Adapter Numbers  387
NetBIOS Communication Profile Edit  386
NetBIOS Settings  386
Netop Configuration Files  432
Netop demonstration window  369
Netop File Manager window  156
Netop File Manager-Advanced (Delete) window  171
Netop File Manager-Advanced (Overwrite) window  172
Netop File Manager-Delete window  170
Netop File Manager-Options window  168
Netop File Manager-Overwrite window  171
Netop Guest  33
Netop Guest Window  53
Netop Help Request Button  330
Netop Host  292
Netop Host button  292
Netop Host Button Connected Menu  364
Netop Host Button Menu  293
Netop Host Window  305
NETOP INI Example  432
Netop License window  60, 309
Netop Local Tab  416
Netop Log  412
Netop Log Events  422
Netop Magnifier  249, 375
Netop Magnifier window  249, 376
Netop Marker Utility  243, 369
Netop Marker Utility Button Menu  245, 372
Netop Marker Utility Title Bar Menu  244, 371
Netop Marker Utility window  244, 370
Netop Message  286, 381
Netop Message window  287, 381
Netop Name Server section  111, 322
Netop Network Tab  75
Netop Screen Video  275
Netop Script  250
Netop Security Server Authentication  45
Netop Server Tab  417
Netop Sessions  226
Index

Netop Sessions command  184
Netop Sessions section  187
NETOP.INI  429
Network Point-to-Point  385
Networking  385
New Binary Value command  200
New button  203, 290
New command  199, 288
New DWORD Value command  200
New Expandable String Value command  201
New Folder button  176
New Folder command  58, 157
New Folder window  59, 157
New Key command  199
New Modem command  393
New Multi-String Value command  200
New Phonebook Entry command  58
New Script command  58
New String Value command  199
New Task command  196
New Window window  228
Next command  289
NFM Log Viewer window  167
Novell Network Number window  389
Novell Network Numbers  389
Novell Network Numbers window  389

O

Online Registration command  60, 309
Online Support command  60, 309
Open button  194, 290
Open command  193, 288
Open Files Tab  217
Open Saved Event Log window  193
Operating Systems  15
Options  167
Options button  160, 177
Options command  166
Options Menu  166, 278
Options section  225, 330
Index

Organize Favorites command 202
Organize Favorites window 202
Other Buttons 176
Other Commands 57
Other Interaction 15
Other Locations of NetOp Configuration Files 434
Overwrite/Delete Tab 255

P
Pack’n Deploy 32
Pass Control command 364
Password section 342
Password window 234
Paste button 290
Paste command 58, 289
Pause button 207
Pause command 206, 276
Phone Number window 391
Phone Number/IP Address field 232
Phonebook Entry 67
Phonebook Entry button 63
Phonebook Export and Import 69
Phonebook Records 68
Phonebook Tab 65, 67
PING 42
Playback Session Recording command 57
Point-to-Point 385
Prefix with computer workgroup name option 322
Print button 290, 383
Print command 288, 382
Problem description field 329
Processes tab 195
Program Options 102, 319
Program Options button 311
Program Options command 318
Properties button 176, 191, 195, 216
Properties command 158, 190, 207, 215
Properties window 159
Protect Item Tab 233
Protect security configuration files 361
Index

provisioning 78
Proxy 402
Public Host name option 322
Publish New Updates 141

Q
Quick Connect Tab 71
Quick Guide command 61, 310

R
RAS section 349
Ready to Install window 30
Receive port 399
Record button 283
Record command 276
Record Panel 177
Record Tab 242
Record/Pause key 282
Recording Playback window 95
Recording Records 96
Recording Tab 123
Recordings Tab 93
Records Pane 97
redirection 78
Refresh button 191, 195, 197, 204, 207, 215, 222, 226
Refresh command 59, 166, 190, 194, 197, 202, 207, 215, 222, 226
Refresh Rate window 249, 376
Region Menu 277
Registry 197
Registry command 185
Registry Menu 199
Registry Toolbar 203
Remote Control 14, 365
Remote Control button 62, 147
Remote Control command 55
Remote Control Display 151
Remote Control Tab 113
Remote Control window 143
Remote Desktop Entry 67
Remote Management 182, 368
Remote Management button 62, 147
Remote Management command  55
Remote Printing Tab  120, 327
Remove button  207, 215
Remove command  206, 215
Rename command  58, 158, 202
Rename window  58, 158, 346
Replace command  289
Request Help  377
Request Help button  311
Request Help command  308
Request Help/Cancel Help command  293
Requirements  21
Restart button  207, 224, 311
Restart command  206, 224, 308
Restart Host PC button  148
Restart Host PC command  145
Restart script when finished check box  257
Restart Warning window  29
Restore/Show command  293
Resume command  206
Retrieve Clipboard button  149
Retrieve Clipboard from Host command  144
RSA SecurID Authentication  46
RSA SecurID Logon window  46
Run As Tab  331
Run Command  258, 263
Run Program  284, 381
Run Program Browse  285
Run Program button  62, 147
Run Program command  57
Run Program menu  284
Run Program window  263
Run Script button  251
Run Setup Wizard  141, 363
Run Setup Wizard command  319
Run Tab  128
Run window  129, 285
Running  305
Index

S
Save As command  288, 315
Save button  194, 290
Save command  193, 288
Save Event Log window  194
Save History As command  306
Save Screen to Clipboard button  149
Save Screen to Clipboard command  145
Save Screen to File button  149
Save Screen to File command  145
Script button  177
Script command  167
Script File  271
Script Log  273
Script Records  98
Script Tab  96
Script window  251
SCS  78
SCS Web Service URL  135
Search Menu  289, 382
Security  15
Security Role  47
Security role section  47, 340
Security Role window  345
Security Warning window  307
Select All command  164
Select By button  177
Select By command  164
Select Color button  246, 373
Select Directory Service window  112, 334
Select Directory Services Groups window  351
Select Directory Services Users window  351
Select driver to use drop-down box  326
Select Font button  246, 373
Select Help Request Communication Profile window  378
Select Pen Thickness button  246, 373
Select Print Redirection Host window  121
Select Print Redirection Printer  122
Select Users window  213
Index

Select window 164
Send Alt+Print Screen command 144
Send Alt+Shift+Tab command 144
Send Alt+Tab command 144
Send button 225, 226, 290
Send Clipboard button 149
Send Clipboard to Host command 144
Send command 226
Send Ctrl+Alt+Del button 148
Send Ctrl+Alt+Del command 144
Send Ctrl+Esc button 148
Send Ctrl+Esc command 144
Send keep alive message option 321
Send Keystrokes command 144
Send Message button 62, 147
Send Message command 57, 288
Send Message window 268
Send port 399
Send Print Screen command 144
Serial 392
Serial Communication Profile Edit 393
Serial Settings 392
Service Installation 208
Service Installation File window 208
Service Installation Log On window 209
Service Installation Name window 208
Service Installation Startup window 209
Service Properties 210
Services 205
Services command 185
Services Menu 206
Services Tab 315
Services Toolbar 207
Session Buttons 146, 311
Session Commands 55
Session Menu 308
Session Tools 229, 369
Sessions Tab 217
Settings tab 334
Setup Type window 26
Index

Setup Wizard 35, 295
Setup Wizard Add a Guest Account window 302
Setup Wizard Add a Windows Account window 304
Setup Wizard Add Another Account window 303
Setup Wizard Completed window 40, 299
Setup Wizard Create Windows Modem Communication Profiles window 36
Setup Wizard Default Guest Access Password window 298
Setup Wizard Default TCP/IP Communication Profile window 36
Setup Wizard Guest Credentials window 302
Setup Wizard Host Program Options window 300
Setup Wizard Mode window 296
Setup Wizard Netop Host Startup Mode window 297
Setup Wizard Register Your Netop License On-Line window 40, 298
Setup Wizard Security Options window 301
Setup Wizard Select Communication Profiles window 300
Setup Wizard Web Connect window 37
Setup Wizard Welcome window 35, 295
Share a Folder 217
Share a Folder Wizard Name window 219
Share a Folder Wizard Path window 218
Share a Folder Wizard Welcome window 218
Share Properties 219
Share Properties General tab 220
Share Properties Share Permissions tab 221
Shared Folders 214
Shared Folders command 185
Shared Folders Menu 215
Shared Folders Toolbar 215
Shared Netop Authentication 43
Shared Netop Authentication window 379
Shares Tab 216
Short-hold mode option 390
Show Connection List button 149
Show file transfer status option 321
Show Free Text button 246, 372
Show Magnifier button 246, 372
Silence level slide 325
Small Icons button 63, 177
Small Icons command 59, 165
Smart Card Authentication 47
Smart Card Tab  134, 359
Smart Card window  47
SNMP Traps Tab  420
Sounds Tab  124
Special Note on Receive Port Number  400
Special Shares  216
Standard Buttons  18
Standard tab  205
Start button  310
Start command  206, 307
Start Host when loaded option  320
Start Multi Chat button  149
Start/Resume button  207
Startup Information window  223
Startup section  320
Startup Tab  234
Status Bar  291, 318
Status Bar command  184
Status field  312
Stealth mode option  321
Stop button  195, 207, 283, 310
Stop command  206, 276, 308
Stop key  282
Stopped  305
Strikeout command  289
Suspend Connect command  364
Suspend Further Connections button  149
Sync Files command  157
Synchronize  169
Synchronize Files button  176
System Control  224
System Control command  185
System Control Host User Message  225
System Control Menu  226
System Control Toolbar  226
System Info  428
System Info button  61, 310

T
Tab Panel  64, 312
Index

Table Control  20
Take Keyboard and Mouse Control button  148
Task Manager  195
Task Manager command  185
Task Manager Menu  196
Task Manager Toolbar  197
TCP IPv6 section  404
TCP section  402, 405
TCP/IP  396
TCP/IP (TCP IPv6)  403
TCP/IP (TCP IPv6) Communication Profile Edit  404
TCP/IP (TCP IPv6) Settings  403
TCP/IP (TCP)  402
TCP/IP (TCP) Communication Profile Edit  402
TCP/IP (TCP) Settings  402
TCP/IP Communication Profile Edit  397
TCP/IP section  398
TCP/IP Settings  396
Terminal Server  32, 409
Terminal Server Communication Profile Edit  409
Terminal Server Settings  409
Test a Netop Script  272
Text Marker  247, 374
Text Marker Menu  375
Text Marker window  248, 375
Title Bar  276, 287, 382
Tool Buttons  149, 311
Toolbar  283, 290, 310
Toolbar command  184, 307
Toolbar or Toolbox  146
Tools Menu  60, 309
Transfer only if file exists  169
Transfer only one way  169
Transfer Sound  367
Transfer Sound button  150
Transfer Sound command  145
Transfer Status  161
Transfer Tab  254
Tree Pane  97
Tree Window button  63
Index

Tree Window command 59
Type drop-down box 261
Typographical Conventions 18

U
Unavailable Networking Communication Devices 88
Underline button 290
Underline command 289
Undo button 246, 372
Undo/Redo button 290
Undo/Redo command 289
Unload and Stop option 361
Updates 18
Upon connection section 323
Upper Toolbar 245, 372
Use current Host communication profiles option 329
Use default port numbers check box 399
Use dial-up networking check box 385
Use environment variable option 322
Use Netop Name Server 400
Use Netop Security Server 353
Use Windows computer name option 322

V
Values pane 198
View button 191
View command 317
View File Manager Log command 59, 166
View Menu 184, 307
View Message command 306
View submenu 190
vPro Console 78

W
Wait Command 258, 260
Wait Dialog window 261
Waiting for confirm access window 49
Wait-Select Dates (of month) window 263
Wait-Select Days (of month) window 262
Wait-Select Days (of week) window 262
Wake on LAN MAC Address field 232
Warning Active Sessions window 106
Index

Warning Invalid Logon window 355
Web Update Schedule window 137, 336
Web Update Tab 136, 335
WebConnect 125
WebConnect Communication Profile Edit 405
WebConnect Tab 421
Welcome to Netop Remote Control Guest Setup Wizard window 24
Window Control 19
Windows Authentication 44
Windows Authentication window 380
Windows Event Log Tab 419
Windows Firewall Configuration window 29
Windows Modem 394
Windows Modem Communication Profile Edit 395
Windows Modem Settings 394
Windows Network Tab 77